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Preface

This document describes the steps for installing and configuring the components of 
the Argus Safety Solution application.

The Oracle Health Sciences Safety Suite
This product is part of the Oracle Health Sciences Safety Suite, an integrated solution 
for end-to-end vigilance from adverse event management to signal management, 
through the entire lifecycle of a medicinal product from clinical trials to 
post-marketing surveillance. 

The Oracle Health Sciences Safety Suite consists of the following components:

■ Oracle Argus Standard Edition: Manage and report adverse events through a 
workflow including case intake, data entry, coding, quality review, medical review, 
expedited reporting, and periodic reporting. Modules include Oracle Argus Safety, 
Oracle Argus Interchange, Oracle Argus Affiliate, Oracle Argus Dossier, Oracle 
Argus Unblinding, and the Oracle Health Sciences Adverse Event Integration Pack 
for Oracle Health Sciences InForm and Oracle Argus.

■ Oracle Argus Enterprise Edition: In addition to managing the adverse event 
workflow and reporting, employ a powerful and flexible business analytics and 
intelligence platform for both scientific analysis and operational metrics. Modules 
include Oracle Argus Analytics, Oracle Argus Insight, Oracle Argus Mart, Oracle 
Argus Safety, Oracle Argus Interchange, Oracle Argus Affiliate, Oracle Argus 



xx

Dossier, Oracle Argus Unblinding, and the Oracle Health Sciences Adverse Event 
Integration Pack for Oracle Health Sciences InForm and Oracle Argus.

■ Oracle Argus Safety Japan: Manage and report adverse events in Japan, and 
connect the global and local workflows using a single database.

■ Oracle Health Sciences Empirica Topics: Manage and document safety signals 
through a workflow including validation, prioritization, assessment, 
confirmation/refutation, and resulting actions.

■ Oracle Health Sciences Empirica Study: Detect and analyze safety signals in 
clinical trial data including adverse events, clinically significant labs, 
electrocardiograms, vital signs, and shifts from baseline.

■ Oracle Health Sciences Empirica Signal: Detect and analyze safety signals in 
post-marketing spontaneous adverse reaction data including public health 
authority databases and/or private inhouse databases such as Oracle Argus.

■ Oracle Health Sciences Empirica Healthcare Analysis: Evaluate safety signals in 
healthcare data including electronic medical records and administrative claims, 
and support pharmacoepidemiology, comparative effectiveness analysis, and 
health economics and outcomes research.

For more information on Argus Safety, visit the Oracle Health Sciences Safety suite 
page at:

http://www.oracle.com/goto/pharmacovigilance.html

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Related Documents
This section lists the manuals for all Oracle Argus Safety products. You can order 
printed manuals from the Oracle iStore.

Oracle Argus Documentation

The documentation set includes: 

■ Argus Safety Affiliate User Guide

■ Argus Safety Administrator’s User Guide

■ Argus Safety Dossier User Guide

■ Argus Safety Interchange User Guide

■ Argus Safety Installation Guide

http://www.oracle.com/technetwork/documentation/hsgbu-154445.html
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■ Argus Safety Service Administrator Guide

■ Argus Safety Flexible Aggregate Reporting Extensibility Guide

■ Argus Safety BIP Aggregate Reporting User's Guide

■ Argus Safety User’s Guide

■ Argus Safety Unblinding User Guide

■ Argus Safety Minimum Security Configuration Guide

■ Argus Safety Japanese Administrator’s Guide

■ Argus Interchange Japanese User’s Guide

■ Argus Safety Japanese User’s Guide

Checking My Oracle Support
The Oracle Argus Safety product suite continues to grow and evolve. To help you use 
it and stay abreast of updates we provide between releases, it is a good practice to 
check My Oracle Support for information that enhances our released documentation. 

To open the Oracle Argus Safety product page on My Oracle Support, complete the 
following steps:

1. Open a Web browser to https://support.oracle.com/CSP/ui/flash.html#.

2. Click the Sign In button and log in. The My Oracle Support portal opens, 
displaying general news from several categories. If you do not yet have an 
account, click "Register here" and follow the instructions given on the registration 
page. 

3. Click the Knowledge link.

4. In the "Browse any Product, by Name" field, enter "Oracle Argus Safety". 

5. Click the Go button to the right of the drop down field. My Oracle Support loads 
the Oracle Argus Safety Knowledge Browser Product Page. 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Getting Started

This chapter discusses how to start working with the Argus application and access 
Help files. It also explains how to perform some generic operations in the application.

■ Product Overview

■ Logging In

■ About the Argus Home Page

■ Basic Features

1.1 Product Overview
Argus Safety is a complete pharmacovigilance software system designed to solve the 
pharmaceutical industry's toughest regulatory challenges. Argus Safety supports drug 
safety business processes from an easy-to-understand user interface.

1.2 Logging In and Out
Ensure that before starting Argus Safety, the Argus Safety Administrator of your 
company has created an account for you and that you have the correct Username and 
Password for the system. Be aware of the following:

■ If you enter an incorrect password three (3) consecutive times, the system disables 
the Login button and displays the following message:

Your account has been locked due to 3 consecutive failed login attempts. Please 
contact your System Administrator.

The number of times the user is permitted to enter an incorrect password is 
configurable. The default is 3. For information about configuring Argus Safety see 
the Oracle Argus Administrator’s Guide.

■ The Date/Time format reflect s the 24-hour format used by the Web server.

1.2.1 Logging into the Argus Application
Use the following procedure to login to the Argus application:

Note: It is recommended that you use the Application Access portlet 
to open the Argus Safety application for different enterprises, as it 
takes care of closing the previous enterprise before opening the new 
one. 
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1. Open Microsoft Internet Explorer and enter the Uniform Resource Locator (URL) 
for Argus Safety Web in the Address bar. 

2. When the Argus login screen opens, enter your username and password in the 
appropriate fields.

3. Select the appropriate database from the Database drop-down list and click Login.

4. Once the system authenticates your log in, you can access the modules whose 
names are in Bold text. For more information, click the following Single Signon 
link.

To log out of the Argus application
Click Logout on the top-right frame of the window to log out of the application.

1.2.2 User Password Complexity Enhancement
User Password complexity has been enhanced to meet the following requirements:

■ At least 8 characters

■ At least 2 non-alpha characters 

■ At least one of each numeric (0-9), upper case (A-Z), lower case (a-z), and a special 
character (such as @, *)

■ Should NOT contain the username (this check is not case-sensitive)

■ User Configuration > Force password change at login must be checked and 
disabled when Reset Password is checked.

1.3 About the Argus Home Page
The Argus Safety application Home page displays a list of Cases Assigned, Contact 
Log Entries and Action Item Entries sections specifically for the logged-in user.

Note: If you need to use ActiveX controls, make sure that you have 
administrative privileges when you run Internet Explorer. 

Note: Available modules appear in bold text on the log-in screen. 
Once the system authenticates your log-in information, you will be 
able to access these modules. 

Note: If you get an error message such "Unable to connect to the 
database," you may not have permissions to access the database. 
Please contact your database administrator for assistance. 

Note: If your login ID fails three times in a row, the system presents 
the following error message: "The log in button has been disabled due 
to 3 consecutive incorrect entries of Username or Password. Please 
refresh the page to enable the Login button."
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Home Page Sections and Fields
The following table lists and describes the section and the fields it contains.

1.4 Additional Tabs
The Argus Safety menu displays additional tabs, if you have permission to use the 
associated applications. 

1.4.1 Quick Launch Toolbar
Quick Launch enables you to navigate through the application more quickly and more 
efficiently. Click the relevant

Quick Launch icons allow you to perform different actions. The Quick Launch Toolbar 
is on the top right side of the screen. 

Section Name Field/ Control Name Description

Search Case Case Quick Launch Enables you to enter number 
of a specific case to search for.

Cases Assigned (Country) Case Number Displays the name of the 
country the case belongs to. 
The Country is in brackets.

Report Type Displays the report type of the 
case.

Product Displays the product name.

Workflow State Displays the workflow state.

Event Displays the event name.

Contact Log Entries (Country) Case Number Displays the name of the 
country to which the case 
belongs, with the Country 
listed in brackets.

Contact Date Displays the contact date.

Description Displays the description of the 
case.

Action Item Entries (Country) Case Number Displays the name of the 
country the case belongs to. 
The Country is in brackets.

Due On Displays the date when the 
case is due.

Description Displays a description of the 
case.

Tab Name Description

Argus Console The system displays this tab if you have administrator 
permissions.

Argus Insight The system displays this tab if you have permission to 
use Argus Insight.
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To enable you to perform the quick launch, the menu bar also lists the quick launch 
shortcut keys in parentheses.

Place the cursor over each icon to view the tool tip, which describes the role of each 
icon.The following table lists and describes the function of each icon and includes each 
associated shortcut key. 

Note:  Shortcut keys are driven off a combination of Common Profile 
switches and menu access rights. For example, the "Case Save" 
shortcut / icon is visible only to users who have been granted access 
to save the case in the group configuration. If the menu option is 
disabled in the group configuration for a user, the respective shortcut 
/ icon will be removed as well. Certain shortcuts / icons such as Field 
Validation are enabled only through a common profile switch. These 
switches are described in the Common Profile Switch document. 
Shortcuts / icons that are driven through common profile switches are 
global to all users and are not controlled by group permissions.

Icon Tool Tip Description Shortcut Key

New Case from 
Image

Displays a new case from an 
image.

CTRL+ALT+G

New Case Displays the Initial Case Entry 
dialog. This is similar to 
performing Case Actions - 
New Case.

CTRL+ALT+N

Open Case Displays the Case Search 
dialog. This is similar to 
performing Case Actions - 
Open Case.

CTRL+ALT+O

Close Case Performs the same functionality 
as Case Actions - Close Case.

CTRL+ALT+C

Print Case Displays the Case Print dialog. 
This is similar to performing 
Case Actions - Print Case.

CTRL+ALT+P

Save Case Saves the case with any changes 
made.

CTRL+ALT+S

Forward Case Displays the Case Routing 
dialog and enables you to 
forward the case.

CTRL+ALT+>

Return Case Displays the Case Routing 
dialog and enables you to 
return the case.

CTRL+ALT+<
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Worklist Displays the Worklist dialog. 
This is similar to performing 
Worklist - XXX option.

Note: XXX is defined within the 
User Configuration for the 
default Worklist option. If no 
default Worklist option is 
defined, then Worklist - New is 
displayed.

CTRL+ALT+W

Lock Case Displays the Case Lock or Case 
Unlock dialog. This icon is 
enabled only for a Local PRPT 
Case and only if the case has 
been globally locked.

CTRL+ALT+L

Local Lock Displays the Local Lock or 
Local Unlock dialog to allow a 
user to locally lock or unlock a 
case. For additional details, 
refer to the Local Lock section.

This icon is a toggle icon that 
allows users to do a Local lock 
or Local unlock depending on 
the global and local lock state of 
the case.

Note: This icon shall be visible 
only for a Local Potential 
Reportable Case (Local PRPT 
Case) and only if the case has 
been globally locked.

CTRL+ALT+K

Medical Review Displays the Medical Review 
dialog. This is similar to 
performing Case Actions - 
Medical Review.

CTRL+ALT+M

Coding Review Displays the Coding Review 
dialog. This is similar to 
performing Case Actions - 
Coding Review.

CTRL+ALT+Q

Draft Report Displays the Report List of All 
the Expedited Reports. This is 
similar to selecting View Draft 
Report.

CTRL+ALT+R

E2B Check Performs the function that 
prints the E2B Report - DTD 
Length Check Warnings and 
E2B report - DTD Validation.

CTRL+ALT+E

Validation Check Performs case validation. CTRL+ALT+V

Icon Tool Tip Description Shortcut Key
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1.4.2 Error Messages
The system displays error messages in pop-up boxes. Every popup box has a Copy 
link that enables you to copy the message text to the clipboard so that you can use it 
later.

1.4.3 Searching for a Case
You can search for the following:

■ A specific case

■ An existing case

■ A duplicate case

■ Incoming E2B (Reports-> E2B Pendings)

To search for a specific case
1. Type the case number in the Case Quick Launch field of the Home page and click 

Open.

2. The system displays the case details

To search for an existing case
1. Select Case Actions --> Open.

2. Enter the case search criteria in the appropriate fields.

3. Click the link displaying a case number to view the case details. By default, each 
section and header column is sorted by Case Number in ascending order.

4. Select the checkbox for any of the headers to enable that section. The sections in 
which the checkbox is not selected display at the bottom of the screen.

To search for a duplicate case
1. Select Case Actions --> New.
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2. Enter the case search criteria in the appropriate fields to determine whether a 
duplicate case is already in the system. 

1.4.4 Argus Insight Integration 
Argus Safety has following integration points with Argus Insight. All these integration 
point  operate within the same enterprise for both Argus Safety and Insight. 

■ Case Series sharing: In case of multi-tenant installations, Argus Safety Case 
Actions Case Open screen Result from Argus Insight button imports the active 
case series for the user from the same enterprise partition of Insight which is 
currently opened in Argus Safety.

■ Argus Insight application launch: Argus Insight button in the main Argus 
Navigation bar opens the same enterprise partition of Insight which is currently 
opened in Argus Safety. 

1.4.5 Sharing a Case Series
You can share a case series between Argus and Argus Insight as follows:

■ Sharing a Case Series in Argus with Argus Insight

■ Sharing a Case Series in Argus Insight with Argus

Sharing a Case Series in Argus with Argus Insight
In Argus, a case series can be made available through the Case Search dialog.

1. Search for and select a case in Argus.

Note: Users can also perform 'Duplicate Search' through other 
options in the application, such as through:

1. Incoming E2B (Reports-> E2B Pendings).

2. Local Affiliate -> Incoming Review.

3. LAM
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2. Open Argus Insight.

3. The system writes case series belonging to the alert to the Argus case-sharing 
table. 

4. Select Make Active from Argus to make the Case Search dialog case series active in 
Argus Insight.

5. If Argus Insight was already open, the Active Case series in Argus Insight is 
replaced with cases from Argus.

Sharing a Case Series in Argus Insight with Argus
A case series can be made available from Argus Insight through Active Case Series. To 
share a case series in Argus Insight with Argus

1. Go to Case Actions and then click Open.

2. Click Result from Argus Insight to create a search result with the same cases as the 
Active case series in Argus Insight.

1.4.6 Basic Features and User Actions
This section discusses the basic features and common user actions available 
throughout Argus Safety. These features can be used when working in different 
sections of the Argus application. 

Common Icons. The icons shown below are common to all modules within Argus:

1.4.6.1 Sorting on Columns
The user can sort on all the columns by clicking the header column. 

Icons Description

These icons help the user to traverse to the left or right side in a page.

Note: These arrows will not be visible if there is no need to scroll the tabs.

A standard Notes dialog is available.

Note: If the notes are filled in, the dialog displays a Notepad icon. 
Otherwise, it is shown as empty by the icon, without any flags.

Re-arranges the entered items by moving them up or down.

Depicts the column that is being sorted currently.

Enter a justification for an optional field.

Indicates that a field has been overwritten or that you can enter data in an 
initial justification field.

Tip: Click the same column header again to toggle between 
ascending and descending order.
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1.4.6.1.1 Field Justifications  The fields that display in the application are either required 
or optional. Each field type displays with a different colored icon:

■ Required fields display with a red icon.

■ Optional fields are displayed with a green icon.

Click the icon next to a field to view its corresponding Field Justification dialog. The 
image below shows the Field Justification Dialog:

This field warning justification dialog asks the user for a justification to perform the 
selected action. To overwrite the warning:

■ Enter a specific reason

■ Select a standard reason from the message box.

Enter a justification by doing one of the following:

3. Click OK to overwrite the field justification warning.

4. The orange icon changes to green.

Common Right Click Options
The following table lists and describes common right-click options.

1.4.6.2 Getting Help
Argus Safety provides you with two main sources of online help: 

■ Field-level Help

Right-click option Description

Re-arrange Re-arranges all the information.

Copy Copies all the information.

Delete Deletes all the information entered in the tab.
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■ Task-based Online Help

To get help performing a particular task
■ From the Help menu, select Online Help.

■ When the Argus Safety Online Help opens use the Contents, Index, or Search tabs 
to locate the required information.

To get information about a particular field on the Case Form
Double-click the label associated with the field. For instance, on the Case Form, you 
can double-click the Country label to obtain information about this field.

1.4.6.3 Changing Your Password
When you log on to the system for the first time, it change the password that has been 
assigned to you.

To change your password
1. Select Change Password from the Utilities menu. 

2. The Change Password dialog box opens.

3. Enter your current password in the Old Password field.

Note: LDAP users cannot change their passwords.
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4. Enter the new password in the New Password field and confirm the new 
password by re-entering it.

5. Click OK to change your password. Your password has now been changed.

1.4.6.4 Entering Dates
Several fields in the Argus Safety user interface enable you to enter dates. Fields that 
accept full dates appear in the "dd-mmm-yyyy" format. You enter the month using 
numbers, or alphabetic characters.

Appropriate formats for entering English dates are as follows:

■ DDMMMYYYY where MMM is the three-character abbreviation for the month 
(e.g., MAR, APR, JUN, etc.)

■ DDMMMYY where MMM is the three-character abbreviation for the month and 
YY is the two-digit numeric value for the year (e.g. 09, 10, etc.)

■ DDMMYYYY where MM is the two-digit value identifying the month (e.g. , 01 = 
January, 02 = February, etc.) and YYYY is the four-digit value for the year.

■ DDMMYY

■ DD-MMM-YYYY

■ DD-MMM-YY

■ DD-MM-YYYY

■ DD-MM-YY

■ DD.MM.YY

■ DD.MMM.YY

■ DD.MM.YYYY

■ DD.MM.YY

■ DD/MMM/YYYY

■ DD/MMM/YY

■ DD/MM/YYYY

■ DD/MM/YY
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1.4.6.5 Using Null Flavor Data
Null flavors are used to describe the reason for missing data. ICH E2B(R3) and 
Regional Agencies such as CBER, EMA, and PMDA have published guidelines on the 
allowed Null Flavors for various fields that are part of E2B (R3) report. Null Flavors 
can be configured to a Case Form field by associating Null Flavor sets in Field 
Properties Configuration. A Null Flavor set is a collection of Null Flavors and  sets are 
provided by default for various combinations of Null flavors in the Flexible 
Re-categorization Codelist.

Null flavor data can be selected for fields in the Case Form by clicking on the Null 
Flavor button ( ) next to the fields. On clicking the button, a drop-down list appears 
and allows you to select Null Flavor data as configured in the Field Properties 
Configuration in the Console. The background color of the NF button changes when a 
null flavor is selected from the drop-down list.

When the Case Form field has data and the user clicks the button, the system displays 
a warning message that data will be cleared on switching to the Null Flavor field. The 
data is cleared or retained based on user confirmation. When data pertaining to the 
field is received, Null Flavor data can be overwritten by actual data by switching the 
back field view on clicking the NF button.

1.4.6.6 Entering Multiple Language Text
Certain fields on the Case Form let you enter text in languages other than English. The 
non-English text that is entered in these fields can also appear on expedited reports.

To enter text in a language other than English:

1. Click the English language icon.

2. Use the pane associated with English to enter the English language text. Select the 
required language from the Select Language drop-down list to enter text in that 
language.

3. After completing text entry, you can perform a spell-check for the text.

The table below displays different icons representing different languages.

Icon Language

 

English

    

Japanese

    

Language other than English or Japanese
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2Argus Affiliate Module

2.1 Argus Affiliate Module Information
Please see the Oracle® Argus Affiliate User's Guide for detailed information about each 
option available to Central and Affiliate Users under the Local Affiliate menu.
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3Active Cases

Active Cases are cases that have already been opened or are currently in use. The 
system logs any cases you view in the active case list.

3.1 Opening Active Cases
Follow these steps:

1. Log in to Argus.

2. When system opens the Home page, click Active Cases.

3. The system displays a list of the last 10 cases you accessed in the Last Accessed 
Cases drop-down list.

4. Click any of the links to select and open an active case
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4Local Lock Functionality

Till the Argus Safety 7.x release cycle, Argus Safety has allowed only a single global 
case lock which locks all the data fields in the case for reporting. However, customers 
with global workflows and reporting needs across the world have a requirement to be 
able to do local case data locks at country level, to be able to do expedited reporting 
for specific countries, without having to wait for the single global case lock.

Most large global customers try to achieve this doing double case lock - one for global 
and second for Japan.

The Argus Safety application has now been enhanced to support a concept of global 
lock that indicates the readiness of case data for global reporting, and a concept of 
local data locks that indicates the readiness of case data for local reporting having 
fulfilled the local data entry and assessment needs. 

The following enhancements are available with this release:

Local Potential Reportable Case (Local PRPT Case)
A case that has local data entry and reporting needs is referred to as a Local Potential 
Reportable Case (Local PRPT Case) in this document. A case that has a suspect 
product with Japanese License and that tests true to the Truly Local Case system 
criteria (as described in the Argus Console Guide) or a case that has a Local Japan 
Report (refer Local Reports) pending generation (i.e., Scheduled / New data available 
report states) even if there are no suspect products with Japanese Licenses is referred 
to as a Local PRPT Case.

Global Lock
The current case lock feature in the Argus application is now referred as global lock. 
Upon performing global lock, the system has been enhanced to ensure that the case is 
available for:

1. Japan Local Data Entry

2. Scheduling and Generation of Global Reports

3. Scheduling of Local Japan Reports

Local Lock
Once a case that has Japan local data entry needs has been globally locked, the system 
allows Argus J users to open the case for Japan data entry and assessments, without 
burdening the user to perform a global unlock. After completing the Japan data 
entry/assessments, the system further supports the Argus J user to perform a "Local 
Lock" that triggers Japan local reports that are still relevant based on Japan data entry, 
for generation.
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Completion of a global lock and the subsequent local lock along with report 
distribution ensures a complete cycle of case reporting fulfilling both global and local 
reporting obligations.

Local Fields
In order to enable independent entry of local data in a case and at the same time 
maintain the integrity of the "global" case data, the system can segregate the case form 
fields in to two categories of global and local fields.

Global Fields: All the fields that are available for editing to a user before global case 
lock is performed are referred to as "Global fields". 

Local Fields: All the fields that are available for Japan specific local data entry after a 
global lock is performed are referred to as "Local Fields". These fields remain editable 
during both Global unlock and Local Unlock and are non-editable after local lock.

Local Reports
In order to control which reports needed to be generated only after Local data entry is 
done, the system can identify specific reports as "Local Reports".

4.1 Enabling Local Data Entry
The application allows local users to open a case for entering local data without 
globally unlocking the case and at the same time maintain the integrity of the "global" 
case data. 

In order to achieve this:

1. The fields in the system are categorized into global and local fields. The local fields 
have been identified as local to one or more countries. The local fields for only 
Japan are supported in this release.

2. All Argus J users are considered as Japan Local user in this release and as having 
access to edit the Japan local fields.

4.1.1 Local Fields
A field is identified as a Local field to one or more countries based on a new attribute 
in the CMN_FIELDS table. The local fields for only Japan are supported in this release.

Customers can configure any field in the Case Form > General, Patient, Products, 
Events tabs, and in the Analysis > PMDA tab as a Local field for Japan through 
back-end updates to the CMN_FIELDS table.

The Enterprise copy configuration action will copy these updates as per existing 
functionality.

If a customer configures a field that could update global value as a local field, it is 
expected that the customers maintain the integrity of the global data by business SOPs 
or custom software processes.

All the fields in a case that is not a Local PRPT case are simply treated as global fields.

All Argus J users are considered as having access to edit the Japan local fields.

All Japanese text fields, including J User-Defined fields are considered as Local fields 
for Japan.

   i. All Japanese text fields are the fields that currently has separate _J columns.

  ii. All fields from PMDA tab, PMDA Device Information section.
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The system allows selection of secondary LLT (stored in LLT_J or LLT_CODE_J field) 
or Synonym (SYN_CODE_J) encoding using MedDRA J browser that does not change 
the base MedDRA hierarchy of English.

The Event Assessment > Listedness field in the tab for for the licenses of the local 
country corresponding to the local user is considered as local field. However, this field 
is available for editing for the user only when the local user has listedness privilege for 
that local country assigned to them via the User Group > Listedness Determination - 
Countries access and the datasheet associated with that local country license is 
configured with "Global / No Local Assessment Required" checkbox as unchecked.

The Events tab > Infection and Event Exclusion checkbox are also considered as local 
field for Japan.

Any field where an update to a global field can occur is NOT considered as Local field.

All numeric fields, date fields, dropdown fields which share same data value for 
English and Japan sides shall not be considered as Local fields.

However, there are exceptions to this rule where some fields that contain global values 
are available for update to local users and in such a scenario, it is expected that the 
global value should be protected by customer's business SOPs.

Case classification is such a field that can cause update to global value and it is 
available as a Local field in the system out of the box.

Study section under General tab requires special handling by the application during 
local editing. Study Name, Study Description, Protocol Number, Clinical Compound 
Number and Center Name are local fields.  Select button shall not be available during 
local editing.

When the study is a configured study, the system shall disable all these fields for local 
editing except Center Name (J).  Center Name (J) shall be available as editable local 
field.

When the study is a non-configured study, the Protocol Number, Center Name, Study 
Name and Study Description shall be available as editable fields during local editing. 
However, when the Argus J user updates the Japanese Protocol Number that changes 
the non-configured study to a configured study, the system shall stop the action by 
displaying an error message - "You cannot change a non-configured study to a 
configured study".

Product Information section in Products tab requires special handling by the 
application during local editing.  J Drug Code type and the corresponding J Drug 
Code/OTC Drug Code/Temporary Code (i.e., DRUG_CODE_TYPE_J, DRUG_CODE_
J,), J Generic Name and J Product Name fields are local fields.

When the Product is a configured company product (i.e., has global configuration 
irrespective of whether Japan Product configuration exists or not), the system shall 
disable all these fields for local editing as changing these values will affect the Product 
ID or the Pat Exposure ID and affect the Global value. The "Select" and "Encode" 
buttons shall also be disabled.

Note that there are situations where the Japan configuration for the product may not 
exist such as in cases where the product is not sold in Japan but a case is still 
reportable due to another Japan product in the case. This scenario is expected only for 
foreign (non-Japan cases), hence PMDA E2B and Paper Report still be able to report 
these products based on the English Product Name and Generic Name present in the 
case which is acceptable to PMDA for foreign cases.

When the Product is a non-configured product including a WHO product, the J Drug 
Code/OTC Drug Code/Temporary Code (i.e., DRUG_CODE_J), J Generic Name and J 
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Product Name fields shall be available as editable fields during local editing. The 
"Encode" button shall be enabled and the "Select" button shall be disabled. This shall 
allow the local Argus J user to choose the J Drug from the J Drug dictionary.

The local fields remain editable during both Global unlock and Local Unlock and is 
non-editable after local lock. 

Any field that is already editable after case lock will remain editable even after local 
lock.

An auto-narrative generation performed during Japan Local data entry (after global 
lock) only updates the J field value and does not update the English or any other 
language field value.

If an auto-narrative is not configured for some languages in the template, then 
"Replace" option chosen by user during auto-narrative generation shall not replace the 
narrative text for those languages. This shall also be applicable for the case in Global 
data entry, i.e. "Replace" option shall not replace auto-narrative for those languages for 
which auto-narrative is not configured in the template.

A new common profile switch "Generate auto-narrative for the other language without 
user confirmation" has been introduced under Case Processing to suppress user 
confirmation while generating auto-narrative for the other language while the user 
performs the operation in the English side or Japanese side.

The switch has the following radio buttons as options: Yes, and No (default).

This field is partitioned by enterprises for Multi tenant customers. Any change to this 
field is audit logged.

If auto-narrative is being performed prior to global lock:

If a user is performing the auto-narrative from the Japanese side of the case form and if 
the auto-narrative template has any other language other than Japanese configured, 
and if the new common profile switch "Generate auto-narrative for the other language 
without user confirmation" is set to "No", the system shall first prompt the user if they 
wanted to generate the English and other language narratives as well. The system 
shall proceed with all the non-Japanese language narrative generation steps only if the 
user chose Yes to this dialog (note that existing generation steps and prompts still hold 
good) or if the new common profile switch "Generate auto-narrative for the other 
language without user confirmation" is set to "Yes. If they chose No to the user 
prompt, the system shall proceed with only Japanese narrative generation (note that 
existing generation steps and prompts still holds true). If they chose Cancel, the 
system shall not proceed with auto-narrative generation for any language.

If a user is performing the auto-narrative from the English side of the case form and if 
the chosen Narrative template has Japanese language configured, and if the new 
common profile switch "Generate auto-narrative for the other language without user 
confirmation" is set to "No", the system shall first prompt the user if they wanted to 
generate the Japanese narrative as well. The system shall proceed with the Japanese 
language narrative generation steps only if the user chose Yes to this dialog (note that 
existing generation steps and prompts still hold good) ) or if the new common profile 
switch "Generate auto-narrative for the other language without user confirmation" is 
set to "Yes". If they chose No to the user prompt, the system shall proceed with only 
the non-Japanese (English and all other languages except Japanese) narrative 
generation (note that existing generation steps and prompts still holds true). Note that 
the prompt shall not display if Japanese language was not configured in the template. 
If they chose Cancel, the system shall not proceed with auto-narrative generation for 
any language.
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4.2 References for Details on Local Case Data Lock Functionality
This section lists the different sections where the functionality for Local Case Data 
Lock has been documented in the Argus Safety suite of documentation.

Refer to the following table for the list of features and the corresponding Guides where 
they have been documented:

Local Lock Feature Overview Documented in

Local Locking and 
Local Unlocking - 
Configuration

Introduction of new switches: Allow 
Local Locking - to allow a local user to 
be set up with the privilege to locally 
lock or unlock a case 

Enable Local Unlocking - to provide a 
system level control permitting local 
users to locally unlock a case and make 
any corrections to the previously 
entered local data.

Oracle Argus Safety Administrator’s Guide > 
2 Access Management > Configuring Users

Oracle Argus Safety Administrator’s Guide > 
4 System Configuration > Configuring System 
Management - Common Profile Switches

Oracle Argus Safety User’s Guide > Global 
User Management

Changes to the Case 
Locking Mechanism 
in Argus Safety - 
Case Form Changes

Introduction of action icon - Local Lock - 
to allow a user to locally lock or unlock 
a case

Oracle Argus Safety User's Guide > 1 Getting 
Started > Quick Launch Toolbar

Changes to the Case 
Locking Mechanism 
in Argus Safety - 
Changes to global 
locking, One Step 
Global and Local 
Lock

Allow Global locking and triggering of 
global and local reports, and allow one 
step global and local locking

Oracle Argus Safety User's Guide >  
Section 5.1.7.4.1, "Locking a Case"

Changes to the Case 
Locking Mechanism 
in Argus Safety - 
Changes to Global 
Unlocking - 
Configuration

Introduction of new switches: 

Allow Forced unlock (Global and Local) 
- to allow users to be set up with the 
privilege to forcibly unlock a case that 
been globally and/or locally locked but 
pending report generation 

Allow Global Unlock on Pending Local 
Lock - to allow users to be set up with 
the privilege to forcibly unlock a case 
that is still pending a local lock

Oracle Argus Safety Administrator’s Guide > 
2 Access Management > Configuring Users

Oracle Argus Safety Administrator’s Guide > 
2 System Configuration > Configuring System 
Management - Common Profile Switches

Oracle Argus Safety User’s Guide > Global 
User Management

Changes to the Case 
Locking mechanism 
in Argus Safety - 
Changes to global 
unlocking - Case 
Form changes 

Control globally unlocking a case based 
on local/global reports pending 
generation and /or cases pending local 
lock

Oracle Argus Safety User’s Guide > 
Unlocking a Case

Case Form changes - 
Local Reports 
Configuration - Local 
Reporting Rule and 
Local Reports 

Configuring Local Reporting Rules and 
Local Reports

Oracle Argus Safety Japanese Administrator's 
Guide > 3 System Configuration > 
Configuring Local Reports - Local Reporting 
Rule and Local Reports

Triggering Local 
Reports - Changes to 
Report Scheduling 
and Generation 
Algorithm - Auto 
Scheduling

Changes to report auto-scheduling for 
scheduling local reports

Oracle Argus Safety User’s Guide > Changes 
to Report Scheduling - Auto-Scheduling
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4.3 Changes to Report Scheduling - Auto-Scheduling
The changes described below are applicable only when local reports are configured in 
the system (that is, when there is data in the Local Reports Configuration table).

On the Global lock of a case by a user, the system shall trigger the qualifying reporting 
rules including the Japan reporting rules and schedule the relevant global and local 
reports . There are modifications to the Report Generation functionality however, and 
is explained under section Changes to Report Generation.

On the Local Lock of a case by a user, the Local Reporting Rules for Japan are triggered 
again as follows, depending on the value in the configuration switch "Case Form 
Configuration | Auto Regulatory Scheduling":

■ If the value is set to Always: The Local Japan reporting rules are triggered on case 
save during the follow-up cycles of case processing when any of the local fields 
caused the "Significant" data change. If any of the other fields caused the 
"Significant" data change, then all the reporting rules are triggered as with the 

Triggering Local 
Reports - Changes to 
Report Scheduling 
Algorithm - Manual 
Scheduling

Changes to report manual scheduling 
for scheduling local reports

Oracle Argus Safety User’s Guide > Changes 
to Report Scheduling - Manual Scheduling

Triggering Local 
Reports - Changes to 
Report Generation 
Algorithm

Changes to report generation for 
generating local reports

Oracle Argus Safety User’s Guide > 
Triggering Local Reports - Changes to the 
Report Generation Algorithm

Changes to 
Expedited Reports 
and Periodic Reports 
on DLP

Changes to DLP while generating local 
expedited and periodic reports

Oracle Argus Safety Japanese User’s Guide > 
4 Reports

Local Lock icon in 
Screens

Local/Global Report 
icon in Screens

Oracle Argus Safety User's Guide > 
Section 5.1.7.4.1, "Locking a Case"

Routing Comments 
Log and Case Print

Oracle Argus Safety User's Guide > Routing 
Comments Log and Case Print

Local Labeling 
Changes

Oracle Argus Safety User's Guide > 
Section 8.1.12, "Local Labeling"

Bulk Reporting Oracle Argus Safety User's Guide > 
Section 11.1.9, "Bulk Reporting"

Oracle Argus Safety Administrator’s Guide > 
4 System Configuration

Archiving Oracle Argus Safety User's Guide > 
Section 5.1.7, "Activities Tab"

End of Study 
Unblinding

Oracle Argus Safety Unblinding User's Guide 
> Using the EOSU Report Viewer > EOSU 
Updates

Outlier Processing Oracle Argus Safety User's Guide > Outlier 
Processing

Upgrade Changes Oracle Argus Safety User's Guide > Upgrade 
Changes - Enabling Local Locking in Argus 
Safety

Local Lock Feature Overview Documented in
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existing algorithm. Also, for the initial case cycle, only local reporting rules are 
triggered on Local lock.

Currently, the following are not considered a "Significant data change". The system 
shall be enhanced to respect any change to these fields as significant data change 
as well:

Events tab > Event Exclusion flag

Analysis tab > PMDA > General tab > Japan Reporting category

Analysis tab > PMDA > General tab > New Drug category

Analysis tab > PMDA > General tab > Completion Report flag

Analysis tab > PMDA > General tab > Product J Keyword Reportable section 
(middle section of the PMDA tab) - changes caused directly by the user or 
indirectly by the system (example changes to Causality by the user, changes to the 
products and licenses listed in the section due to changes in the J reportable 
keyword, changes to Product type suspect vs. concomitant, changes in COI etc.) 
Note: Changes to causality only on this section of the PMDA tab should be 
considered significant and not the global  causality level changes.

Analysis tab > PMDA > General tab > Product Licenses section(bottom section of 
the PMDA tab) - Any changes to the Products or licenses in this section caused 
directly by user or indirectly by the system

■ If the value is set to Significant: The Local Japan reporting rules are triggered on 
Local Lock but respecting the existing algorithm to check that Significant 
Follow-up was added during the prior global lock cycle during the follow-up 
cycles. For the initial case cycle, as with the existing algorithm, they trigger on 
Local lock.

■ If the value is set to any value other than None, including Manual: A new 
checkbox called Schedule Local Reports Only will be added under the Total 
Number of Rows section in the Regulatory Reports tab of the Case Form. This 
checkbox is visible only when the configuration switch "Case Form Configuration 
> Auto Regulatory Scheduling is not set to None. If a user clicks the 'Auto 
schedule' button and the new checkbox "Schedule Local Reports Only" is checked, 
then the system shall show the following confirmation dialog to the users (refer 
the message below). If the user chose No, the dialog shall exit with no further 
action. If they chose Yes, the system shall trigger only the qualifying local 
reporting rules. After the rules are successfully triggered, the system shall uncheck 
the checkbox. If the checkbox is unchecked, the system shall trigger all the 
qualifying reporting rules keeping the current functionality.

Force Distribution: If force distribute is checked for a reporting rule, the system shall 
trigger that reporting rule as per the existing functionality. However the generation 
and force distribution of the Local Reports shall have the following modifications: 

a. When a Local reporting rule marked for "Force Distribute" has a local report that has 
become due, the report shall be scheduled, generated and force distributed by 
performing the global and local lock on the case using the existing AG Service Force 
Reporting process.

Note: As a result of triggering of local reporting rules again, the 
Local reports that were already scheduled during Global Lock may 
result in being overwritten or being removed.
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i.When a Local report that was already scheduled outside of the force distribution 
process from a local reporting rule marked for "Force Distribute" has become due, the 
system shall not force generate this report keeping it consistent with the existing 
functionality.

b. For the above scenario, AG Service shall use the one step global/local lock comment 
"Case Globally and Locally locked for JP." (refer section Routing Comments Log and 
Case Print) followed by the configured comments under Argus Console ' Reporting ' 
Expedited screen'Forced Distribution comments.

i. Case Globally and Locally locked for JP. << Forced Distribution comments>> 

c. After the report generation is complete, case shall be unlocked globally. AG Service 
shall use the one step global/local unlock comment "Case Globally and Locally 
unlocked for JP." (refer section Routing Comments Log and Case Print) followed by 
the configured comments under Argus Console ' Reporting ' Expedited screen'Forced 
Distribution comments.

i. Case Globally and Locally unlocked for JP. << Forced Distribution comments>>

4.4 Changes to Report Scheduling - Manual Scheduling
The changes described below are applicable only when there are local reports 
configured in the system (i.e., there is data in the Local Reports Configuration table).

On Manual Scheduling of a report by a user, the application identifies if the report is a 
Local Japan report by matching the Country of the License#, Destination and Report 
Form chosen by the user in the "Schedule New Report" manual report scheduling 
dialog with the "Local Reports Configuration".

If DLP is not enabled for Expedited Report Generation:

a. On the Global lock of a case by a user, the system shall generate the global reports 
but shall not generate any Local Japan reports. 

b. The Local Japan reports shall be generated on subsequent local lock for Japan.

If DLP is enabled for Expedited Report Generation, refer to the chapter in Oracle 
Argus Safety Japanese User’s Guide > 4 Reports.

For a Study-based WHO Drug Report, the application identifies if the report is a 
Local Japan report by matching only the Destination and Report Form chosen by the 
user.

For a Study-based WHO Drug Report, the application identifies if the report is a Local 
Japan report by ignoring the country, matching only the Destination and Report 
Form chosen by the user and if the Truly Local Case switch returns value > 0.

Note that if AUTO_FOLLOWUP_MANUAL switch is ON, the existing functionality of 
scheduling a follow-up report for a manual report shall be retained as is and if the 
manual report was a local report, the follow-up shall be treated as a local report as 
well.

4.5 Outlier Processing
In scenarios where the suspect product with local license has been removed on a 
follow-up, the case will remain a Local PRPT Case until the corresponding 
nullification/downgrade local reports have been generated.

If a customer wants to change Local Reports configuration data after being in 
production with this release, it is recommended that customers ensure that 
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cases/reports under processing be completed before changing configuration data to 
avoid unpredictable results. So note that if a customer changes the Local Reports 
configuration data mid-way where the reports are mid-way processing (e.g., 
scheduled), the reports will be determined as local/global based on what type it was 
at the time when the report was scheduled and will be completed processing that way 
irrespective of current configuration even if inconsistent with the configuration. Also 
note that presence of local reports will determine that the case is local case.

It is also recommended that customers ensure that cases/reports under processing be 
completed before up taking the Local Locking feature and (thereby) installing the local 
lock configuration data (refer to Upgrade Changes - Enabling Local Locking in Argus 
Safety). So note that if the case was mid-way processing (e.g., case was open in data 
entry workflow) when customer up took the Local Locking feature, a subsequent case 
save will determine if the case is local or global.

4.6 Upgrade Changes - Enabling Local Locking in Argus Safety
In order to activate the Local Locking feature in Argus Safety, the installer shall 
provide customer the option to install the underlying metadata that enables the local 
lock feature in the system. A customer, who may not prefer to turn on the local locking 
feature due to existing business process that already handle the local processing needs 
for a company, shall choose not to install the metadata and thus not uptake the local 
lock feature in the system.

A separate database script shall be provided with this release that the customer shall 
run to turn on the Local lock feature after an upgrade or fresh install. On executing this 
script, it shall prompt the user to choose to turn on the local locking feature and 
uptake the Local Locking seed data as follows.

Prompt - If "Do you wish to turn on the Local Locking feature for one or more 
enterprises (Yes/No)?".

If the user chose No, the system shall not install any of the Local Locking seed data.

If the user chose Yes, the system shall prompt for the enterprise (s) for which to install 
the Local Locking seed data as explained below:

Prompt - "Please enter comma separated list of enterprise ids for which to turn ON the 
Local Locking feature or say ALL to turn it ON for all enterprises [Default assumed as 
1]".

The system assumes the default value of 1. As there is a technical challenge in 
displaying the default value at the prompt, it need not be displayed but system shall 
process with default of 1 when no enterprise is input by user.

The system parses the user input and install the Local Locking seed data for each of 
the enterprise specified in the comma separated list. If the user input was ALL, the 
system shall install the Local Locking seed data across all enterprises as explained 
below.

If an enterprise does not exist or the enterprise was deleted or was made inactive , the 
script shall log an en error that "The specified enterprise(s) with enterprise id <list of 
invalid enterprise ids> are not valid active enterprise(s) and so the local locking 
feature cannot be turned on for these enterprises" and shall not install the Local 
Locking seed data for the invalid enterprise(s). The script shall however continue to 
seed the valid enterprises.

If an enterprise was already seeded with all the local locking seed data due to prior 
run of the script, the script shall log a message that "Local Lock is already enabled for 
the following enterprise(s): "<list of already seeded enterprises>".
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Local Reports Configuration Seed Data
A new table shall be seeded to identify Local Reports for Japan:

Country - The seed data shall be the country id for Japan (from codelist Countries) for 
this release.

Reporting Destination - The script shall prompt the customer to provide the default 
value of reporting destination for PMDA.

 - The seed data shall be the following Japan reports for this release:.

Prompt -  "Please enter Agency Name for the PMDA reporting destination as 
configured in the "Reporting Destination" codelist. This name will be used to identify 
Local Reports for all enterprises".

If the user enters an Agency name that doesn't match with any agency configured in 
the Reporting destination codelist for one or more enterprises (entered as input to 3.a) 
even after using case insensitive and trimmed spaces matching, display an error "This 
agency is not configured in the "Reporting Destination" codelist for the enterprises 
with the enterprise id <list of enterprise ids where agency is missing>. The Local lock 
seeding utility will now abort. No local seed data changes have been committed. 
Please rerun this utility again with valid agencies" and exit the script without 
committing any changes so that there is no data inconsistencies when the user runs the 
script again.

Report Form - The seed data is the following Japan reports:

Local Users Seed Data
The upgrade upgrade installer script shall prompt the user to choose if all the Argus J 
users shall be updated to have local locking privileges:

Prompt - "Do you wish to enable all the Argus J users to have Local Locking privileges 
across the enterprises you chose earlier (Yes/No)?".

If the user chose Yes, the system shall update all the Argus J users to have "Allow 
Local Locking" ON for the enterprises that the user entered.

Local Fields Seed Data
Note that the CMN_FIELDS are always seeded as part of install/upgrade factory data 
to identify the Local Fields for Japan and will be present irrespective of if the customer 
chooses local locking feature or not.

In case of Multi-tenancy, the customer input value shall be used to set the seed values 
across all enterprises.

This seeding of Local users data shall be audit logged with system user.
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After install/upgrade, if customer has turned on the local locking, the icons in the 
applicable screens shall start reflecting the local/global lock status of the case.

4.7 Triggering Local Reports - Changes to the Report Generation 
Algorithm

The changes described below are applicable only when there are local reports 
configured in the system (i.e. there is data in the Local Reports Configuration table).

The Report Generation functionality does not generate any Japan Local reports, 
including the reports that were scheduled by the local reporting rules that were 
marked as Active Moiety or Super Rules, until a local lock occurs. The global reports 
are generated on global lock.

If the report generation of a local report is invoked manually by user on a case that is 
not yet locally locked, then the system shall display the message "Report cannot be 
generated until the case is locally locked for country Japan".

In Case Form > Regulatory Reports tab, the Final hyper link for a local report shall not 
be available  for  a case that is not yet locally locked  (similar to the existing 
functionality for global report on a global unlocked case).

In Case Form > Regulatory Reports tab, the Regenerate Report menu for a local report 
shall not be available  for  a case that is not yet locally locked  (similar to the existing 
functionality for global report on a global unlocked case).

The Final checkbox in Case Actions > Case Open > Batch Print dialog will remain 
disabled and grayed out when any of the case selected is locally unlocked as it does 
today when a case is globally unlocked.

If report generation is invoked  from the Batch Report Generation AG Service, the 
AGService shall skip the case that is not yet locally locked similar to the existing global 
unlocked cases.

Note that Worklist > Bulk ICSR Transmit > Re-Transmit and Re-Transmit Multiple 
Reports will put a failed report back in generation to be picked up for processing by 
Batch Report Generation AG Service. The above point will apply in this scenario.

If report generation is invoked from other AG Services listed below, the AGService 
today ignores the global locked status and generates reports. This shall be corrected so 
that the AGService skips the case that is not yet globally locked when generating 
global reports similar to the existing Batch Report Generation AG Service. Similarly, 
the AG Services listed below shall skip the locally unlocked cases while generating 
local reports:

Bulk Report Transmit

Bulk Report Transmit Email

Bulk Report Transmit Fax

Bulk Report Transmit ICSR

Bulk Report Print
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5Case Form

This chapter provides information about the Case Form section of the Argus Safety 
user interface.

5.1 Case Form Functions
The Case Form enables you to do the following:

■ Enter case-specific information

■ Log preliminary information about cases

The Case Form has the following tabs:

■ General Tab

■ Patient Tab

■ Products Tab

■ Events Tab

■ Analysis Tab

■ Activities Tab

■ Additional Info Tab

■ Regulatory Reports Tab

Each tab enables you to capture specific information about the case and is designed to 
capture similar information in each of its subsections.

All tabs of the Case Form also display read-only information about case priority and 
status.

To access the Case Form
1. Search for an existing case.

2. When the application displays the search results, locate the appropriate case 
number and click the case number link.

3. The system opens the Case Form with information about the case.

Note: Some sections in each tab enable you to make multiple entries. 
For example, you can have more than one reporter in the Reporter 
Information section of the General tab. Each individual entry is 
identified by another set of tabs in the section.
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5.1.1 Case Form Features
The case form provides features to help you use it more effectively. 

General Case Form Usage Information
When using the Case Form, be aware of the following:

■ The maximum number of Products and Events is 200 per case.

■ The drop down values for elements such as Yes/No/Unk is not hard coded. The 
system retrieves the values from a look-up table. This affects the following:

– Reporter Information | HCP

– Device Information | Improper usage/Storage Field

■ The system defaults to the first button on every message box pop up dialog. When 
the user clicks Enter or the space bar, the system validates the choices.

■ The user can enter a hyperlink (e.g. http://www.oracle.com and 
https://www.oracle.com) in the Field Label Help for the Case Form Fields

■ When the user clicks a hyperlink, the system opens the link in a new Internet 
Explorer browser window.

■ The following Case Form fields are type ahead fields:

– Contact Logs | Group and Users

– Action Items | Groups and Users

■ The WHO Drug browser displays the WHO Drug Version on the browser dialog. 
The browser dialog is configured in System Configuration | Case Form 
Configuration.

■ Users can enter decimal numbers with up to three (3) decimal places in the UDF 
Number fields on all tabs. If the user does not enter a decimal, the system does not 
display trailing zeroes.

5.1.1.1 Using Password Acceptance Dialog Boxes
The system displays the User Name in read-only mode in following dialog boxes 
where the user must enter a password to start processing:

■ Activities Tab: Case Lock/Unlock

■ Activities Tab: Case Archive/Un-Archive

■ General Tab: Unblind Case

■ E2B Acceptance/Rejection for Initial, Follow-up, and Notification

■ Affiliate Acceptance/Rejection of Events

■ Case Actions: Delete/Undelete

5.1.1.2 Initial Case Entry
When using the BookIn dialog box, be aware of the following:

■ You can enter the attachment classifications and their descriptions on the Initial 
Case entry dialog.

■ The field labels are the same as those defined in the Field Labels and the Case 
Form
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– The lengths for the Classifications type ahead field and the Description field 
are the same as those on the Additional Info tab

– The system filters classifications by user sites and the attachment 
classifications permissions.

– When you select the URL Reference, the system hides the Classifications and 
Description fields.

■ The system transfers the values the user enters in the Classifications and 
Description fields after the cases have been booked in.

■ If the system does not find any cases during a duplicate search, it places the 
following message in the search results section: No cases found.

■ When you try to book in a clinical trial case and select a study where the country 
of incidence value does not match the list of countries defined in the study 
configuration, the system displays the following warning message in the standard 
Argus Safety warning message dialog box: 

The country of incidence does not match the country list specified for the selected 
study.

– If no countries are specified in the study configuration for the selected study, 
the warning message does not display.

– If the user selects the study before entering the COI, the system performs the 
validation

■ The user can right click on the row and select the following:

– Case Summary -- The system displays the Case Summary (Current 
functionality).

– Print Medical Summary -- The system displays the Medical Summary report 
PDF only if the user has access to the Medical Review dialog box. If the user 
does not have access, the system hides the Medical Summary Report option. 

– Print -- The system launches the Case Form print dialog box. If the user has 
permission to access the Print Case dialog, the user can print the Case Form. If 
the user does not have access to the Case Form print dialog box, the system 
hides the Print Case option.

Zoom Function
The Zoom feature enables you to increase or decrease the font size of the text.

1. Click the Zoom icon across the Case Form tabs.

2. The Zoom dialog enables you to increase or decrease the Font Size of the text on 
the Zoom dialog.
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3. Click Adjust Font Size to increase or decrease the font size.

■ Click + to increase the font size up to five (5) font sizes in one-size increments. 

■ Click - to decrease the font size to the current by increments of 1.

This feature is available on the following dialogs:

■ Reporter Notes

■ Patient Notes

■ Patient Other Relevant History Notes

■ Patient Lab Data Notes

■ Patient Relevant Test

■ Parent Medical History

■ Parent Other Relevant History Notes

■ Product Notes

■ Case Analysis: Narrative. This is also available on the Medical Review Dialog.

■ Case Analysis: Abbreviated Narrative. This is also available on the Medical 
Review Dialog.

■ Case Analysis: Company Comment. This is also available on the Medical Review 
Dialog.

■ Case Analysis: Local Evaluator Comment. This is also available on the Medical 
Review Dialog.

■ Case Analysis: Administrative Notes. This is also available on the Medical Review 
Dialog.

■ Case Analysis: Evaluation in light of similar events in the past. This is also 
available on the Medical Review Dialog.

■ AffSAPS: Future Actions.
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■ Activities: Contact Log Description. 

■ Activities: Action Item Description. This is also available on the Medical Review 
Dialog.

■ Activities: Routing Comments

■ Notes and Attachments: Description

Case Form Drop-down Options
The Case form for the following fields includes Type Ahead functionality. This feature 
automatically suggests possible options as term names as you are entering the text. If 
you double-click on the field, the system shows the standard drop-down values for the 
field.

The following is a list of fields with type ahead functionality:

■ Accidental Exposure

■ Action Taken

■ Action Type

■ Age Groups

■ Age Units

■ Anatomical Locations

■ Attachment Classification

■ Attachment Keywords

■ Birth Type

■ Case Classification

■ Causality Category

■ Condition Type

■ Contact Type

■ Delivery Types

■ Device Preliminary Comments

■ Device Subcomponents

■ Device Type

■ Dosage Frequency

■ Dosage Units

■ Evaluation Reason

■ Event Frequency

■ Event Intensity

■ Event Outcome

■ Fetal Outcome

■ Formulation

■ Gender

■ Intermediary
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■ Lab Result Assessment Terms

■ Lab Test Type

■ Manufacturers

■ Occupations

■ Package Units

■ Reference Type

■ Report Media

■ Report Type

■ Reporter Type

■ Routes of Administration

■ Study Center 

5.1.1.3 Argus Safety Case Form User Preferences
Argus Safety remembers your actions as you navigate through the Case Form.

The system can return to the same location on the tab after you tab to a different form. 
For example, you are on the 8th reporter in the Reporter Section on the General tab 
and move to another location in the application. When you return to the General tab, 
the system takes you directly to the 8th Reporter because it was the last Case Form 
location that you accessed before moving out of the Case Form.

User preferences are only applicable during the same session for a case, irrespective of 
the Case Status (read-only or editable). If you exit from the case and open a new case, 
the system resets the preferences.

Quick Navigation
Each page displays the navigation flow used to access the page. The following table 
lists shortcut keys to help you navigate more easily and quickly.

5.1.2 General Tab
The General tab is designed to capture case information in categorized sections that 
capture category-specific information. The General tab enables you to enter or view 
information such as type of report, literature information, and so forth.

The General tab has four sections as described in the following table.

Shortcut Key Output

CTRL+SHIFT+# Goes to the tab indicated by the # entered. (1=General tab, 2=Patient 
tab, etc.)

ALT+SHIFT+# Goes to the sub-tab as indicated by the # entered (= Product 1, Product 
2, etc.)Note: The maximum # for the sub entities is 10 which pertains to 
ALT+SHIFT+1 for the first entity within the tab till ALT+SHIFT+0 for 
the 10th entity within the tab.

Section Purpose

General Information Contains information about the report type, receipt dates, etc.

Study Information Contains information about clinical trial details, if appropriate.
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5.1.2.1 General Usage Information
When using the General Tab be aware of the following:

■ The system saves all filtering criteria the user enters on the Reporter Look Up 
dialog as user preferences while it populates the reporter information on the 
General Tab. 

– If you have reporter information in the case, the system continues to display 
the reporter information in the Reporter Lookup dialog and automatically 
performs a search.

– After performing the search the system retains the search criteria as user 
preferences. The next time you perform a search, the system displays these 
preferences. 

– When you log out, the system retains the user preferences and makes them 
available the next time you log in to the system

– You can click Clear to clear all the values in the filtering elements. 

– If the system cannot find any reporters during a search, it displays the 
following message in the reporter look up dialog:

No reporters found

■ If a priority has not been assigned to a case, the system hides the Case Priority 
field label.

■ If a case owner has been assigned to the case, the system displays the name of the 
case at the top of the Case form. If a case owner has not been assigned, the system 
hides the Case Owner label.

■ The Project ID can be 40 characters long. Users can scroll in the field.

■ The Study Name field can be 70 characters long.

■ When the Classifications field is hidden, the system does not display the 
classification section on the Case Form.

■ The mandatory fields identified in the E2B Mapping in the factory or custom 
profiles are identified with an icon on the Case Form fields on the Case From and 
Medical Review dialog boxes.

■ All popup message boxes that had only an OK or Cancel button have a Clipboard 
button that enables you to copy the message content to the clipboard for later use.

5.1.2.2 Dynamic Workflow Indicators
Dynamic workflow indicators track the amount of elapsed time it takes to complete a 
workflow step.

■ The first number represents the time left or exceeded for a given workflow step

■ The second number indicates the time left till the reporting deadline.

■ Time is expressed in days (d), hours (h), and minutes (m) respectively.

The icon changes based on the amount of elapsed time for the workflow step.

Reporter Information Contains information about Reporter details.

Literature 
Information

Contains information about Literature cases.

Section Purpose
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If the time to complete the case process exceeds the allocated time, the system displays 
the value in red with the time displayed as a negative value. Only archived, locked 
cases do not display the dynamic workflow indicator.

5.1.2.3 General Information
This part describes the General Information section on the General tab.

5.1.2.3.1 General Information Fields  The following table lists and describes the fields in 
the General Information section.

Icon Denotes

Traffic Light No status can be indicated, for example if no timing is defined in the 
workflow.

Red Traffic Light The timing has been exceeded.

Yellow Traffic Light The timing is in danger of being exceeded.

Green Traffic Light The timing is in good standing.

Field/Control Name Description

Report Type Select the item that best describes the type of report. Choice of 
report type determines availability of fields relating to clinical 
studies and/or literature references.

Note: Clinical study reports prompt the user for information 
relating to the study, and literature-based reports enable the user to 
select the journal and reference on which the case is based.

Country Select the country where the adverse event occurred. The E2B icon 
identifies fields required for E2B.

Initial Receipt Date Enter the date your company became aware of the case. Argus 
Safety uses this date throughout all reports.

Note: This date can be changed only prior to regulatory report 
submission.

Central Receipt Date Enter the date on which this information was received by Central 
Safety.

Medically Confirm Specify whether the case was medically confirmed or not, by a 
healthcare professional.

Initial Justification Enables you to enter the initial justification reason. The entry in 
this field is displayed as per the reason entered when the case is 
being booked in.

Amendments/Follow-ups The number automatically increments when a new record is added 
to the Amendment/Follow-up section.

Note: On sorting by Follow-up received dates, the serial number 
still displays the order of entering the follow-ups. The follow-up  
information can be sorted by Serial Number, Follow-up Received 
date and Central Received  Date Columns. Click on the header to 
sort in ascending order or to sort in descending order. By default, 
the sorting is in descending order of the Follow-up Received Date.
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5.1.2.4 Study Information
The Study Information section enables you to enter information about case studies.

5.1.2.4.1 Study Information Fields and Field Descriptions  The following table lists and 
describes the fields in the Study Information section.

Follow-up Received Date Click Add to enter the date on which amendment/follow-up 
information was received by your company. You can select 
whether the case has significant follow-up information by 
confirming the message: 'Is this follow-up significant?'.

Note: If you select Yes, the Significant checkbox is selected and the 
Amendment checkbox is enabled. When sorting on follow-ups, by 
default, the dates are sorted in descending order of the Follow-up 
Received Date.

Safety Received Enter the date on which follow-up information was received by 
Central Safety. This field is disabled for an amendment and any 
prior data in this field is cleared.

Significant Click the checkbox if the follow-up is significant. This checkbox is 
automatically marked and disabled if the Amendment checkbox is 
checked.

Data Clean up Click the checkbox to mark the Follow up as a Data Clean up 
version. This version is used in the Data Lock Point for Case 
Versioning in and System Reports. This field is disabled for an 
amendment and any prior data in this field is cleared.

Amendment Enables you to specify if the case was updated with a significant 
change without adding any new information.

The Follow-up Received Date is populated with the previous 
aware date and is disabled for an amendment.

Amendment/Follow-up 
Justification

Enables you to select a pre-defined justification for 
Amendment/Follow-up. Click the icon to view the standard 
justifications dialog. The justification entered in the Amendment 
field is also populated in this field.

You can select a pre-defined justification from this dialog or enter a 
new justification.

Case Requires Follow-up Select this checkbox if the case requires follow-up information.

Classification Select up to 50 case classifications used to categorize a case. Click 
Add to enter additional case classifications.

Field/Control Name Description

Project ID Enter the Project ID, or select one from the list. Selecting a Project ID 
automatically creates items in the Study ID list.

Center ID Select the appropriate center ID from the list.

Study Phase Enables you to enter the Study Phase for the configured study.

Note: This field is pre-populated if you select a Study with an 
already-configured Study Phase.

Study Name The study name is entered automatically based on the study that is 
selected.

Study Type The study type is entered automatically based on the study that is 
selected.

Field/Control Name Description
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5.1.2.4.2 Study Restrictions  To enter pre-defined Study Information

1. Click Select to choose from the already available list of study information. 

2. When the Clinical Trial Selection dialog opens, enter Project, Study, and Center 
information as appropriate.

The Clinical Trial Selection dialog allows you to select a clinical trial from the list 
configured by the Administrator.

Week # Enter the week number of the study during which the adverse event 
occurred.

Visit # Enter the visit number of the study during which the adverse event 
occurred.

Blinding Status Depending on the type of study, this item is entered automatically by 
the system. You need special access rights to use any of the Broken By 
entries.

Note: The Unblind Case dialog appears when you try to unblind a 
study. For Not Blinded studies, saving the case or generating a report, 
you can enter the actual drug (vs. placebo) given to the patient.

Study Description The study description is entered automatically based on the study that 
is selected.

Observe Study Type The value selected from this drop-down list is populated in the Case 
Form Study Section when the Clinical Study is selected.

Unblinding Date This item is automatically entered by the system when the blinding 
status is changed to  'Broken by Sponsor' or 'Broken by Investigator'. If 
you double-click the date in this item, the Unblind Case dialog is 
displayed. If the date of unblinding is more recent than the date for the 
most significant follow-up information, an automatic follow-up is 
generated.

Unblinded date is not editable in the Unblind case dialog when 
blinded status is changed to 'Broken by Sponsor' whereas it is editable 
when the blinded status is changed to 'Broken by Investigator'.

Field/Control Name Description
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3. Click Search to generate the search results.

4. Choose the appropriate study information from the list and click Select.

5. The details of the selected Study Information are added to each field in the Study 
Information section

5.1.2.5 Reporter Information
The Reporter Information section enables you to enter information about the person 
providing the case-related information. The following is an illustration of the Reporter 
Information section.

When using this section, be aware of the following:

■ The Reporter Rearrangement dialog also shows the number of Reporters present 
in the case. It displays the First Name and Last Name, followed by the Reporter 
Type in brackets, as entered in the reporter information dialog.

■ You can also view all the Reporters by clicking the Quick Launch icon. 

■ Click any Reporter Name to view the details of the selected Reporter tab.

Tip: To broaden the search results, enter as little information as 
possible. Select the required clinical study and study center and click 
Select.
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■ Click the New tab to add a new reporter anytime. You can add a maximum of 100 
reporters.

■ The Primary Reporter is identified by the Reporter icon on the Reporter 
Information tab.

Reporter Information Fields
The following table lists and describes the fields in the Reported Information section.

Field/Control 
Name Description

Reporter Notes Click this button to enter free text notes relating to this reporter.

Note: This field supports multiple language entry. You can click on a flag, 
select the language tab, and enter information.

Sal. Enter the reporter's salutation.

First Name Enter the reporter's first name.

Middle Name Enter the reporter's middle name.

Last Name Enter the reporter's last name. The Select button displays the Reporter 
Selection dialog. If you select a reporter from this dialog, the system 
automatically completes the case form reporter fields.

Suffix Enter the reporter's suffix; for example, HR, or MED.

Health Care 
Professional

Select Yes, No, or Unk (Unknown) to indicate whether the reporter is a 
health-care professional.

Occupation Select the reporter's occupation from the list.

Report sent to 
Regulatory 
Authority by 
Reporter?

Make a selection, as appropriate to the case.

Address 1 Enter line 1 of the reporter's address.

Address 2 Enter line 2 of the reporter's address.

Institution Enter the reporter's institution.

Institution ID Enter the reporter's institution ID.

This field value is populated based on the Institution ID selected for the 
Reporter from the Reporter Lookup dialog. This field also allows 
manually entered/updated value directly in the Case Form irrespective 
of the value specified in the Institution field for the reporter. 

Manually entered Institution and institution ID field values are allowed 
in the Reporter Information section even if they are not specified / linked 
to each other as per Console Institution code list.

Department Enter the reporter's department.

City Enter the reporter's city.

Protect 
Confidentiality

If this check box is selected, the name and address of the reporter do not 
appear on regulatory reports and the reporter's information displays 
"NAME AND ADDRESS WITHHELD".

The system also displays ’MSK’ null flavor in the eVAERS report when 
this checkbox is checked. MSK is populated only when the data element 
contains some data and is not null.
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5.1.2.5.1 Adding Reporter Information  You can add reporter information by clicking the 
Select button and entering data in the Reporter Lookup dialog box.

To add reporter information
1. Click Select in the Reporter Information section.

2. When the system opens the Reporter Lookup dialog box, enter the required search 
criteria in the fields and click Search.

Primary Reporter Identifies the primary reporter. Only one primary reporter is permitted 
per case. The primary reporter is the reporter whose name appears on the 
regulatory reports. The tab that identifies the primary reporter is 
displayed in blue as compared to the other reporter tabs.

Correspondence 
Contact

If this check box is selected for a reporter, the reporter's address 
information is used in letters. You can select more than one reporter as 
the correspondence contacts for the case.

State Enter the reporter's state.

Postal Code Enter the reporter's postal code.

County Enter the reporter's county.

Country Select the country name. The Administrator maintains this list.

Phone Number Enter the reporter's telephone number.

Alternate Phone Enter another telephone number for the reporter, if available.

FAX Number Enter the reporter's fax number.

Reporter ID If known, enter the Reporter ID. This automatically completes the Case 
Form reporter fields.

Reporter's 
Reference #

Enter the Reporter's Reference # for the case.

Email Address Enter the reporter's email address.

Reporter Type Select the Reporter Type. The Administrator maintains this list.

Report Media Select the medium of the report. The Administrator maintains this list.

Intermediary If appropriate, select the type of intermediary. The Administrator 
maintains this list.

(New) Tab New) Tab Creates details for a new reporter.

Tip: You can choose to search either by Search Cases or by Search 
List Maintenance.

Field/Control 
Name Description
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3. The Search results for the entered search are displayed.

4. When the system displays the search results, choose the appropriate reporter 
information from the list and click Select.

5. The system adds the selected, pre-defined information to the fields in the Reporter 
Information section.

5.1.2.5.2 Reporter Lookup Dialog Box Fields  The following table lists and describes the 
fields in the Reporter Lookup dialog box.

Field/Control Name Description

First Name Enter the first name of the reporter.

Last Name Enter the last name of the reporter.

Reporter ID Enter the ID of the reporter.

Institution Enter the institution of the reporter.

Institution ID Enter the institution ID of the reporter.

MR Select this button if the reporter is a Medical Representative (MR).

Physician Select this button if the reporter is a Healthcare Physician.

Department Enter the department of the reporter.

Reporter Type Enter the reporter type.

Address 1 Enter line 1 of the reporter's address.

Address 2 Enter line 2 of the reporter's address.

City Enter the city of the reporter.

State/Province Enter the state/province of the reporter.

Postal Code Enter the postal code of the reporter.

Phone Number Enter the phone number of the reporter.

County Enter the reporter's county.
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5.1.2.6 Literature Information Section
This section enables you to enter a literature reference for the case. You can enter the 
information manually or you can enter pre-defined literature information by clicking 
the Select button and selecting from the list of pre-defined references.

Click the Quick Launch icon to view all the items present in the case. This information 
appears in the format: (Journal Name Yea Vol: Pages)

5.1.2.6.1 Literature Information Fields and Field Descriptions  The following table lists and 
describes the fields in the Literature Information section.

To enter pre-defined literature information
1. Click Select to choose from the already available list of literature information.

Country Enter the country of the reporter.

Search Cases Click this button to search for cases that match the specified search 
criteria.

Search List 
Maintenance

Click this button to search the list maintenance for the specified criteria.

Field/Control 
Name Description

Author Enter the name(s) of the author(s) of the article.

Year Enter the year in which the article was published.

Digital Object 
Identifier

Enter the digital object identifier of the article.

Select Selects a literature reference directly from the list of literature articles entered 
by the Administrator.

Note: If the required literature article is not present in the list, details of the 
article can be entered by using the remaining fields in the section.

Title Enter the title of the article.

Volume Enter the volume of the particular journal.

Journal Enter the name of the journal in which the article appeared. This value gets 
displayed in italics.

Pgs Enter the journal page numbers in which the article appears.

Field/Control Name Description
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2. When the Literature Reference dialog opens, locate and select the appropriate 
reference in the list and click Select.

3. The details of the selected literature information are added to each field in 
Literature Information.

5.1.3 Patient Tab
This section of the Case Form helps you to enter patient information such as the 
patient's past medical history and current conditions, and laboratory tests and test 
results. The medical information entered here could be very useful to the person 
analyzing the event. For example, if the adverse event was a rash that developed after 
applying a topical product, the knowledge that the patient has a history of allergic 
reactions could be relevant.

The Patient tab includes the following tabs: Patient and Parent.

■ Patient Tab

■ Parent Tab

The Patient Tab

5.1.3.1 Patient Information
The Patient tab includes the following sections:

■ Patient Information

■ Patient Details

■ Event Death Details

■ Other Relevant History

■ Lab Data

■ Relevant Tests Section
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5.1.3.1.1 Patient Information Fields  The following table lists and describes the function of 
each field.

Field/Control 
Name Description

Address 1 Enter the patient's line 1 address.

Address 2 Enter the patient's line 2 address.

Child only Case If this check box is selected, then the pregnancy [Detail] button is 
accessible from the Parent information tab only and no longer through 
the Patient tab directly.

City Enter the patient's city.

Country Select the country. The Administrator can adjust this list.

County Enter the patient's county.

Current Medical 
Status

Captures details about the history and the current condition of the patient 
from the dialog.

Note: The items that appear in the Current Medical Status dialog 
automatically map to the fields for the German BfArM tab on the 
Analysis tab. Changing the values on the BfArM tab does not affect these 
items.

Email Address Enter the patient's email address.

First Name Enter the first name of the patient.

Note: During book-in, the system transfers the appropriate patient name 
to the relevant name and initials fields. If the Patient Name or Initials are 
three characters or less, this is transferred to the Initials field.

Initials Enter the patient's initials. Existence of the patient's first, middle, or last 
name automatically populates this field.

Last Name Enter the last name of the patient.

MI Enter the middle initial of the patient.

Number of Patients Enter the number of patients involved in the adverse event.

Pat. ID Enter the Patient Identifier number.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection 
dialog.

Phone Number Enables you to enter the phone number of the patient.

Postal Code Enter the patient's postal code.
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Patient Notes

Click  to enter free text notes relating to the Patient. If there is no text data for 
Patient Notes, the Null Flavor can selected using the NF drop-down list.

Note: This field supports multiple language entry. You can click on a flag icon to enter 
data in different languages.

 Icon is displayed when there is no data in Patient Notes and NF data.

 Icon is displayed when there is data in Patient Notes or NF data.

5.1.3.1.2 Entering Current Medical Status  Use the following procedure to enter 
information about the patient's current medical status.

1. Click Current Medical Status in the Patient tab of the Case Form.

2. The Current Medical Status form opens as a pop-up.

Protect 
Confidentiality

If this check box is selected, the patient's name and address will not 
appear on any of the regulatory reports and the patient's information will 
show the word PRIVACY.

The system also displays ’MSK’ null flavor in the eVAERS report when 
this checkbox is checked. MSK is populated only when the data element 
contains some data and is not null.

Randomization # Determines which drug was administered to the patient during the 
course of the study.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection 
dialog.

Sponsor Identifier Enter the Sponsor Identifier of the patient.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection 
dialog.

State Enter the patient's state.

Title Enter the title of the patient.

Field/Control 
Name Description
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3. Select the choices that apply to the patient from the items in the form.

If you don't know whether a particular condition applies for the patient, select 
Unk.

4. Click OK to save the current medical status.

5.1.3.1.3 Copying Patient Information from Reporter Information  If the patient and the 
reporter are the same person, the reporter information entered in the General tab can 
be copied to the Patient tab.

If the patient and the reporter are the same person, the reporter information entered in 
the General tab can be copied to the Patient tab.

Click Patient Info From Reporter in the Patient tab to copy the reporter information. 
The reporter information is copied.

5.1.3.2 Patient Details
The Patient Details section enables you to enter information, including pregnancy 
data, about a patient. The following is an illustration of the Patient Details section.

5.1.3.2.1 Patient Details Fields and Field Descriptions  The following table lists and 
describes the fields in the Patient Details section.

Field/Control 
Name Description

Date of Birth Enter the patient's date of birth. You can enter a partial date if the actual 
date is unavailable.

Age Calculates the patient's age, from the date of birth and earliest event onset 
date, if both full dates are available; otherwise, you can enter the age 
manually.

Units Select the age units. (i.e., days, weeks, months, years)

Note: If both the date of birth and event onset date are available, the Age 
Units field is automatically calculated. The Administrator can adjust this 
list.

Age Group Select an age group. If the age group is entered manually, the Age and Age 
Units fields are disabled. The Administrator can adjust this list.

Note: This field is automatically filled in when the Age and Age Units 
fields are both entered.

Height Enter the patient's height.

Height Units Select the appropriate height unit.

Weight Enter the patient's weight.

Weight Units Select the appropriate weight unit.

Concomitant 
Therapy 
Administered

Check this box, if the patient is treated with concomitant therapies such as 
Physiotherapy, Radiotherapy.
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5.1.3.2.2 Entering Pregnancy Information -  Use the following procedure to enter 
pregnancy information.

1. Select Yes from the Pregnant drop-down list, if applicable.

This field is shown as active only after the Gender field in this section is selected 
as Female.

The Pregnancy Information section is displayed.

2. Enter the available pregnancy information in the form.

3. Click OK to save the pregnancy information.

The following lists and describes the fields on the Pregnancy Information and Neonate 
form.

Gender Select the patient's gender.

Note: If the patient is male, the system automatically disables the 
Pregnancy field.

When the Gender is set to Female, the Pregnancy drop down is enabled 
and set to Unknown.

Pregnant Make the appropriate selection.

Note: If Yes is selected, a Details button will appear. Click Details to enter 
pregnancy information.

Date of LMP Enter the date of the Last Menstrual Period, if applicable. A partial date 
can also be entered.

Breastfeeding Select the checkbox, if applicable.

Occupation Select the patient's occupation. The Administrator can adjust this list.

Age at Vaccination Enter the patient's age at the time of vaccination.

Units (at 
vaccination)

Enter the age units (for example: days, weeks, months, and years) at the 
time of vaccination.

Ethnic Group Enter the patient's ethnic group such as Hispanic or Latino, Not Hispanic 
or Latino, and so on.

Military Status Enter the details of the Military status of the Patient such as Active Duty, 
Reserve, National Guard, TRICARE Beneficiary, and so on.

Race Select the patient's race. You can capture up to 5 Race using the Add and 
Delete buttons.

Note: The system does not let you select the same Race more than once. If 
you try to select the same Race again, an error message appears.

Field/Control Name 
Name Description

Due Date Enter a due date or an approximate due date, if known.

Gestation Period Enter the gestation period when the reaction / event was observed in 
the foetus. Select a unit for the gestation period from the accompanying 
drop-down list.

Number of Fetus This tab allows entry of data for a baby who is born to the patient. Click 
New to make an additional entry.

Field/Control 
Name Description
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5.1.3.3 Event Death Details
The Event Death Details section enables you to enter information about the death of a 
patient.

The following table lists and describes the fields in the Event Death Details section.

Prospective/Retrospe
ctive

Select if the information was Prospective or Retrospective.

Note: A prospective information is one where the company hears of the 
case before the baby is born to the patient who took the drug.

In a retrospective case, a company gets to know after the baby is born.

Delivery Date Enter the date of the delivery.

Weight Enter the birth weight

Weight Units Select the appropriate weight units.

APGAR Score Enter the APGAR scores-up to three per neonate.

Delivery Type Select the delivery type from the list. The Administrator can adjust this 
list.

Birth Type Select the birth type from the list.

Fetal Outcome Select the fetal outcome from the list.

Delivery Notes Enter notes on the case.

Note: When using the Neonate Information section, be aware of the 
following:

■ You can delete neonate information by right clicking the neonate 
and selecting the Delete option.

■ The system tracks changes to the neonate information in the audit 
log.

Field/Control 
Name Description

Date of Death Enter the date of death

Field/Control Name 
Name Description
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5.1.3.4 Other Relevant History
The Other Relevant History section enables you to enter information that might be 
useful. The system lets you copy the Other Relevant History rows by selecting the row 
and clicking Copy. The following is an illustration of the Other Relevant History 
section.

5.1.3.4.1 Other Relevant History Fields and Field Descriptions  The following table lists and 
describes the fields in the Other Relevant History section.

Autopsy Done? Select whether autopsy was done.

Note: If Autopsy Done is set to No or Unknown, the Autopsy Results 
Available is shown as No.

Autopsy Results 
Available?

Select if autopsy results are available.

Note: The Autopsy Results Available? field is enabled only if the 
Autopsy Done? field is marked as Yes. However, if Autopsy Results 
Available is changed to No and Autopsy Result rows exist, you will be 
asked to delete the rows first. Click Yes to delete the data.

Add Click this button to add a Cause of Death and Autopsy Results row.

Note: A user can add multiple records, up to 50 entries.

Delete Enables you to delete a highlighted row.

Up/Down Click Up to move the record up and click Down to move the record down.

Note: Ordering reflected on the case form displays the same ordering as 
displayed in the E2B report repeatable tags.

Cause of Death Describes the cause of death.

Description as 
Reported

Displays the description reported by the reporter.

Autopsy Result Describes the autopsy results.

Encode Encodes the event reported by the reporter.

Field/Control 
Name Description

Copy Enables you to copy a row. After you copy the row, the focus will be on 
the newly copied row.

Add Enables you to add a row to the relevant history. After you add the row, 
the focus will be on the new row.

Delete Enables you to delete a row from the relevant history.

Up Enables you to move up a row in the relevant history.

Down Enables you to move down a row in the relevant history.

Field/Control 
Name Description
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Start Date Enter the start date of the condition. You can enter a partial date if the 
actual date is not available. You can also choose not to enter a date.

Note: If you click Add but do not enter a date, the Date column is 
removed.

Once the date is entered and there is a test associated with the date, you 
cannot clear the date but can only modify it. To remove the date column, 
individually delete all the cells in that Date column.

Stop Date Enter the stop date of the condition. You can enter a partial date if the 
actual date is not available. You can also choose not to enter a date. 

If you select Ongoing as Yes or Unknown, the system clears and disables 
the Stop date.

Age and Units Age and Age units are enabled only for condition type with Patient Other 
Relevant Therapy being set.

Family History Check this checkbox, if this relevant history is reported to be present in 
another family member. The Family History checkbox is enabled only for 
Condition types that are mapped to ‘Medical History Episode’ in the 
Condition Type codelist.

Condition 
Type/Verbatim/In
dication/Reaction

Select a condition type from the list. The Administrator can adjust this list.

Substance 
Information

Displays the substance name, term ID, and strength unit of the Product 
separated by commas. If there are multiple records, they are displayed in 
subsequent rows.

Substance Click Substance to enter the Substance Name, Term ID, and Strength Unit 
details.

Substance Name Displays the Ingredient name.

Substance Term ID Displays the Term ID of the substance selected.

Strength Unit Displays the strength unit of the substance selected.

Name Part Displays the name part and name part type information. If there are 
multiple records, they are displayed in subsequent rows.

Click Name Part button to enter Product Name Part Type and Product 
Name Part details.

Name Part Displays the Name of Product Name Part.

Name Part Type Displays the type of Product Name Part such as Container Name, Device 
Name, Form Name, Invented Name, Scientific Name and so on.

Product Name 
Parts Information

Displays the Product Name Part information. Enabled only for condition 
type with Patient Other Relevant Therapy being set.

Product Identifier 
Type

Displays the type of Product Identifier such as MPID, PhPID, and so on. 
Enabled only for condition type with Patient Other Relevant Therapy being 
set.

Product Identifier 
Version

Displays the Date or Version of the Product Identifier. Enabled only for 
condition type with Patient Other Relevant Therapy being set.

Field/Control 
Name Description
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5.1.3.5 Lab Data
The Lab Data section provides data about lab test and test results. The maximum 
number of lab test data on the Case Form is 1500. The following is an illustration of the 
Lab Data section.

5.1.3.5.1 Lab Data Fields and Field Descriptions  The following table lists and describes the 
fields in the Lab Data section.

Coded 
PT/Description of 
condition 
LLT/Indication 
PT/Reaction PT

Enter a term to describe the condition. You can either manually encode or 
auto-encode, if you have been so configured by the Administrator.

In manual mode, type the description (for example, Fever).

In Auto-encode mode, enter a partial description and press ENTER or 
TAB.

The appropriate coding dialog appears.

In either mode, you can click Encode and modify the encoding. If the 
condition type is historical drug, the encoding will be done with WHO 
drugs.

Note: To view the complete MEDDRA hierarchy for the encoded term, 
click the encoding status icon.

Notes Enter any notes that are relevant to the condition.

Encode Click this button to encode the term. Encode is used in multiple contexts 
such as coding with MedDRA for reactions and indications, and coding 
for products using WHO drug browser.

Note: To view the complete MedDRA hierarchy for the encoded term, 
click the encoding status icon.

Indication PT Enter a term to describe the indication.

Note: This field is visible on the case form only if the condition type 
selected in the List maintenance is Patient Other Relevant Therapy.

Ongoing Indicates whether the condition is continuing. If it is set to Yes or 
Unknown, the Stop date is disabled.

Reaction PT Enter a term to describe the reaction.

Note: This field is visible on the case form only if the condition type 
selected in the List maintenance is Patient Other Relevant Therapy.

Field/Control Name 
Name Description

Lab data Test as 
Reported

Test Name Enter a lab test name, or select from the list.

Field/Control 
Name Description



Case Form Functions

Case Form 5-25

5.1.3.5.2 Using the Lab Data Section  When using the Lab Data section, be aware of the 
following:

■ A single, vertical scroll bar has been placed beneath the header and date 
information in the Lab Data section. This enables the date to be seen at all times.

– To keep all the rows together, all rows in the Lab Data Test as Reported " and 
Results/Units use this scroll bar.

– A maximum of three (3) rows is visible at all times.

You can perform several different actions in the Lab Data section as follows:

To enter a Lab Test Name
1. Click Add Test.

2. Enter a partial description of the lab test in the Lab Test Name dialog.

3. Click Search. Select the required lab test from the search results.

Selecting a Lab Test Group
The system enables you to select a lab test group from the dialog box. 

When selecting a lab test group, be aware of the following:

■ When you click Select, the system populates the Lab Test Group with a list of lab 
tests that match the selected lab test group.

■ If lab test data is already on the Case form, the system appends the lab test group 
after the last lab test. 

Arranging Entries in a Specific Order
Click the Order icons to arrange entries in a specific order.

Adding Additional Rows of Lab Test Data
Right-click on an empty cell as shown below. Click the Add option that gets displayed, 
to add more rows of lab test data.

Units Select the unit of the lab test result.

Select Lab Test Group Enables you to select one or more lab test groups.

Norm Low/Norm 
High

The Test Name list can retrieve details of the normal range for the test 
selected (if the Administrator has entered the normal range into the 
list). Otherwise, enter the values manually.

Date Enter the date the test was carried out. Partial dates are allowed for in 
this field.

Result/Units Enter the test result, including the appropriate units and select a term to 
describe the qualitative assessment of the results. The Administrator 
can modify the list of possible assessments.

Assessment Select a qualitative assessment term to describe the lab test results.

More Info Available Check this checkbox, if there is additional information is available for 
this Lab test in Additional Info tab.

Notes Enter notes pertinent to this case.

Comments Enter comments made by the reporter about the test result.

Field/Control Name 
Name Description
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Deleting or Copying Rows in Lab Data
Right-click the row to be deleted or copied to an empty cell after a Test Date has been 
added, as shown below. 

The Copy and Delete options are displayed. Select the applicable option, as required.

Sorting the Entries
The Lab data will be displayed in chronological order by Date of the Test and 
alphabetically by the Test Name.

If there are partial dates entered, the date is displayed at the beginning of the month, 
and year for the date entered.

Viewing the Hierarchy of the Event Term
1. Click the icon to view the entire hierarchy of the Event Term.

2. Click outside the MedDRA hierarchy dialog to close this hierarchy listing.



Case Form Functions

Case Form 5-27

Viewing Notes
Click the icon to view display the Notes in a Zoom dialog.

5.1.3.5.3 Arranging the Lab Test data  Click the arrow button to arrange the Lab Test to 
the right Lab Test. This is available only when the Lab Test has been entered for the 
same date.

Click the arrow button to arrange the Lab Test to the Left Lab Test. This is available 
only when the Lab Test has been entered for the same date.

5.1.3.6 Relevant Tests Section
This section enables you to enter additional information about any relevant tests, such 
as toxicology. The following is an illustration of this section.

The Parent Tab

5.1.3.7 Parent Information
The following is an illustration of the Parent tab.

Parent Tab Fields and Field Descriptions
The following table lists and describes the fields on the Parent tab.

Field/Control Name 
Name Description

Title Enter the title of the parent.

First Name Enter the first name of the parent.

Middle Name Enter the middle name of the parent.

Last Name Enter the last name of the parent.

Parent Initials Enter initials about the parent.

Date of Birth Enter the parent's date of birth. You can enter a partial date if the actual 
date is unavailable.

Age Calculates the parent's age, from the date of birth and earliest event 
onset date, if both full dates are available; otherwise, you can enter the 
age manually.
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5.1.3.7.1 Other Relevant History  The Other Relevant History section for the Parent tab is 
similar to that of the Patient tab. However, the Family history, Age, and Units fields are 
unavailable.

5.1.4 Products Tab
The Products tab enables you to enter and view details about products and dosage 
regimens. The Products tab contains the name of the drug that has been entered within 
that tab. For Blinded Studies, the Blinded Product Name gets displayed in the tab.

When a user has no access to view unblinded information on the Case Form, the 
following fields are hidden:

■ Drug Code

■ Study Drug

■ Formulation

■ Concentration

■ Outside Therapeutic Range

Units Select the age units.

Note: If both the date of birth and event onset date are available, age 
units field is automatically calculated. The Administrator can adjust 
this list.

Weight Enter the parent's weight.

Weight Units Select the appropriate weight unit.

Height Enter the parent's height.

Height Units Select the appropriate height unit.

Gender Select the parent's gender.

Note: If the parent is male, the system automatically disables the 
Pregnancy field.

When the Gender is set to Female, the Pregnancy drop down is enabled 
and set to Unknown.

Date of LMP Enter the date of the Last Menstrual Period, if applicable. A partial date 
can also be entered.

Parent Breastfeeding Select the check box, if applicable.

Age at Vaccination Parent age at vaccination is auto-calculated using Parent Date of Birth 
and Block 10 date (similar logic is used for Patient Age at Vaccination) 
only if both the dates are full dates.

Units (at Vaccination) Displays the data from Age unit codelist for which 'Age unit' flag is 
marked as checked in Codelist Maintenance.

Ethnic Group Enter the ethnic group of the parent.

Race Select the parent's race. You can capture up to 5 Race using the Add and 
Delete buttons.

Note: The system does not let you select the same Race more than once. 
If you try to select the same Race again, an error message appears.

Medical History Captures information about the parent's medical history.

Field/Control Name 
Name Description
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■ Dose

■ Dose Description

■ Daily Dosage

■ Regimen Dosage

■ Patient Route of Administration

■ Parent Route of Administration

■ Package ID

■ Pack Units

■ Batch\Lot

■ Expiration Date

■ Total Dosage Units

■ Total Dose to Primary Event

5.1.4.1 General Usage Information
When using the Products tab, be aware of the following:

If the study has been unblinded and a study drug had been selected, the selected 
Study Drug Name is displayed. You cannot view unblinded information and the tab 
continues to show the Blinded Product Name.

You can enter details of more than one product and more than one dosage regimen for 
a company product for which multiple licenses exist (for example, drug and vaccine, 
or drug and device).

Depending on the type of license (drug, vaccine, or device), different views are 
available in the Products tab. If the selected item is not a company product or if a 
license for a company product does not exist, all three views are always available.

5.1.4.1.1 Time Measurement Fields  You can enter seconds in the following fields:

■ Argus > Case Actions > Open > (Select a Case) > Event tab > Event sub tab > 
{event description} sub tab > Event Information section (middle of screen)

– Onset From Last Dose field

– Duration field

– Onset Latency field

■ Argus > Case Actions > Open > (Select a Case) > Products tab > Product sub tab > 
{Product Name} sub-sub tab (drug) > Dosage Regimen section (lower 1/3 of 
screen)

– Duration of Regimen

■ Argus > Case Actions > Open > (Select a Case) > Products tab > Product sub tab > 
{Product Name} sub-sub tab (drug) > Product Details section (lower 1/3 of screen

– Duration of Administration

– Time between First Dose/Primary Event

– Time between First Dose/Primary Event

■ Any number following by the letter "s" defaults to "#sec."

■ The system interprets the seconds the user enters in the following formats where:
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# is a number from 0 to 9

#s -- The system automatically changes the format to # sec.

# s -- The system automatically changes the format to # sec. 

# sxx

where: 

x is other letters -- The system automatically changes the format to # sec

■ The Temporal View and the Case Form printout display the seconds.

■ The E2B import and export case functions support seconds and M2 Validation for 
the defined fields.

5.1.4.1.2 Date of Mfr Field  You can enter a partial date in the Date of Mfr field. The 
MedWatch (Device) and EU Device Reports print the partial dates entered in the field.

The Products tab includes three tabs: Drug, Device, and Vaccine.

5.1.4.2 Drug Tab
The Products tab displays the Drug section by default as shown in the following 
illustration.

The Drug tab includes the following sections:

■ Product Information 

■ Product Indication

■ Quality Control

■ Dosage Regimens

■ Product Details

5.1.4.2.1 The Product Information Section  This section enables you to enter information 
about the drug being used for the case. The following is an illustration of the Product 
Information section.
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Product Information - Fields and Field Descriptions
The following table lists and describes the fields and controls in the Product 
Information section.

Table 5–1

Field/Control Name Description

Product Information

Product Name The name of the product associated with the adverse event.

Suspect/ 
Concomitant/Treatment

Indicates whether the drug is suspect, concomitant or meant for 
treatment.

Generic Name The generic name of the product

Product Identifier Type The type of product Identifier selected.

Product Identifier Displays the type of Product Identifier such as MPID, PhPID, 
and so on.

Version Displays the Date or Version of the Product Identifier.

Company Drug Code The unique value the company uses to identify the drug.

Obtain Drug Country The name of the country where the drug was obtained.

Drug Code The unique value that identifies the drug.

WHO Medicinal Product ID The WHO Drug code used to identify the drug.

Formulation The form in which the drug was administered (liquid, tablet, 
capsule, and so on.)

Drug Authorization 
Country

The country where the drug was authorized for use.

Manufacturer The company that manufactured the drug.

Concentration The amount of the drug that was administered.

Units The drug unit (such as mg, tsp, and so on).

Interaction Identifies the drug interaction, if any.

Contraindicated? Identifies the contraindication, if any.

Drug Not Administered Check this box, if the patient was not administered with the 
drug.

Substance Information

Substance Name Displays the Ingredient’s name.

Substance Term ID Displays the Term ID of the substance selected.
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5.1.4.2.2 The Product Indication Section   The Product Indication section enables you to 
enter information about the indicator of the adverse event. It includes two fields: 
Reported Indication and Coded Indication.

Reported indication is the reported reaction and Coded Indication is the code for the 
reaction. The two values may be the same, but they may also be different.

5.1.4.2.3 The Quality Control Section  The Quality Control section enables you to enter 
quality control information. 

Quality Control Fields and Controls
The following table lists and describes the fields in the Quality Control section.

Version The Substance Term ID Version Date/Number of the substance 
used in the Product.

Strength The Strength of the substance used in the Product.

Units The drug unit (such as mg, tsp, and so on).

Product Name Parts 
Information

Name Part Type The type of Product Name parts used in the product.

Name Part The Product Name parts used in the product.

Field/Control Name Description

Quality Control Safety Date Enter the Quality Control department reference number for 
the analysis.

Quality Control Sent Date Enter the sent date.

Quality Control Cross Reference Enter the Quality Control department reference number for 
the analysis.

Date Returned Enter the date returned.

Table 5–1 (Cont.)

Field/Control Name Description
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5.1.4.2.4 The Dosage Regimens Section  The Dosage Regimens section enables you to 
enter information about the size and frequency of drug doses being given to a patient. 
The following is an illustration of the Dosage Regimens section.

Dosage Regimens Fields and Field Descriptions
The following lists and describes the fields in the Dosage Regimens section of the Drug 
tab.

Global ID Enter the global number.

Quantity Enter the quantity.

# CID Number Enter the Control Identification Number.

PCID Number Enter the Product Control Identification Number.

Lot Number Enter the lot number. If the Lot Number entered is 
incorrect, a Lot Number Lookup dialog is displayed, that 
allows you to enter select from the existing lot numbers.

Complaint Categories Date Enter a date for complaint categories.

Complaint Categories Text Enter a text explanation as necessary. Use the zoom icon to 
open the zoom notes and view or edit the text.

Analysis Categories Date Enter a date for analysis categories.

Analysis Categories Text Enter a text explanation as necessary. Use the zoom icon to 
open the zoom notes and view or edit the text.

Analysis Summary Date Enter a date for an analysis summary.

Analysis Summary Text Enter a text explanation as necessary. Use the zoom icon to 
open the zoom notes and view or edit the text.

Quality Control Result Date Enter the date the result of the analysis was received by the 
Quality Control department.

Quality Control Result Enter a text explanation as necessary. Use the zoom icon to 
open the zoom notes and view or edit the text.

Quality Control Comment Enter any comment relating to the analysis.

Field/Control Name Description

Start Date/Time Enter the start date and time of the dosage. Entry of time information is 
optional, and you can enter partial dates.

Stop Date/Time Enter the stop date and time of the dosage. Entry of time information is 
optional, and you can enter partial dates.

Note: If no Stop Date is entered, Onset from Last Dose is calculated 
automatically from the Event Onset Date and the most recent Stop Date 
or the most recent Start Date.

Ongoing Select this check box if the drug treatment is ongoing. The Stop Date, 
Duration of Regimen, and Last Dose fields are removed if this check 
box is selected.

Field/Control Name Description
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5.1.4.2.5 The Product Details Section  Product Details Fields and Field Descriptions
The following is an illustration of the fields in the Product Details section of the Drug 
tab.

Outside Therapeutic 
Range

Select this check box if the drug has not been used in accordance with 
the label or has been used for outside the Therapeutic Range. Consult 
your Administrator for further company-specific information on the 
use of this field.

Duration of Regimen This value is calculated automatically, based on regimen start and stop 
dates (if full dates are entered for the start and stop dates). If the value 
is entered manually, the duration units (for example: minutes, hours, 
days, months, or years) must also be entered along with the actual 
duration.

Note: The Administrator can set the duration to be inclusive or 
exclusive. In Inclusive mode, the starting day counts in the calculation 
of the duration; in Exclusive mode, it does not.

Dose Number Enter the drug dose number.

Dose Enter the dose received by the patient.

Dose Units Select the dose unit. The Administrator can adjust this list.

Frequency Select the frequency. The Administrator can adjust this list.

Dose Description This value is automatically entered by using the values from Dose, 
Dose Units, and Frequency. If necessary, you can change this value. 
However, if Dose, Units, or Frequency information is changed, this 
value will be recalculated.

Daily Dosage This value is calculated automatically depending on the dose and 
frequency. It can be manually overwritten. If either the dose or the 
frequency fields are blank, this field is not calculated automatically.

Daily Dosage Units This value is derived automatically from the dose unit.

Regimen Dosage This value is calculated automatically depending on the daily dose, 
duration, and frequency. This total can be overridden. If the daily dose 
is blank or the frequency fields are 0, this field is not calculated 
automatically.

Regimen Dosage 
Unit

This value is derived depending on the Daily Dose Units.

 Route of 
Administration

Select the route of administration. The Administrator can adjust this 
list.

Parent Route of 
Administration

Select the route of administration for the parent. The Administrator can 
adjust this list.

Accidental Exposure Select the type of Accidental Exposure from the list. A non-modifiable 
list of items is provided for this list.

Package ID Enter the package ID.

Pack Units Select the package presentation information of the product. The 
Administrator can adjust this list.

Batch/Lot # Enter the batch and/or lot number(s).

Expiration Date Enter the expiration date. Enter a partial date if the full date is not 
known.

(New) Tab Click this tab to create a new dosage regimen entry.

Field/Control Name Description
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The following table lists and describes the fields in the Product Details section.

Field/Control Name Description

First Dose The earliest regimen start date, completed automatically.

Last Dose The latest regimen stop date, completed automatically.

Duration of 
Administration

Calculated automatically if full dates are available for the first and last 
doses.

Total Dosage Calculated automatically based on daily dose and duration.

Time Between First 
Dose/Primary Event

The time from the first dose to primary event onset.

Time between Last 
Dose/Primary Event

The time from the last dose to primary event onset.

Total Dose to Primary 
Event

The cumulative dose to time of the event.

Action Taken Select the appropriate term. If you select Dose Increased or No change, 
the dechallenge and rechallenge fields are disabled. The Administrator 
can adjust this list.

Dechallenge Results Indicates the drug stopped for the purpose of determining if it was the 
drug that caused the adverse event. Click the appropriate button.

Date Enter the date the dechallenge was carried out

Gestation Period at 
Exposure

Gestation Period at Exposure is automatically calculated for all 
Products in the case by using the formula: Date of First Dose of the 
respective Product – LMP Date. It is calculated only if full dates 
available for both fields.

Taken Previously / 
Tolerated

Select the appropriate response from the list.

Rechallenge Results Make the appropriate selection depending on whether the drug was 
taken again. If Pos or Neg or UNK is selected for the Rechallenge field, 
the Rechallenge Start Date/Time, Rechallenge Stop Date/Time, and 
the Rechallenge Outcome fields are enabled.

Start Date/Time Enter the date and/or time when the rechallenge was started.

Stop Date/Time Enter the date and/or time when the rechallenge was stopped.

Specialized Product 
Category

Select specialized FDA product categories such as combination 
products, compounded and repackaged products used in eVAERS 
reports.

Abuse Select this checkbox if the patient abused the product (For example: 
Painkillers taken without pain).

Batch and lot tested 
and found within 
specifications

Check this checkbox if the batch and lot was found to be within 
specifications, after being tested.
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5.1.4.2.6 Study Drug Information  

You can enter a Study Drug for a Non-Configured Study entered in a case and mark a 
current product as a study drug.

To mark a product as a study drug
1. Right click on any suspect product in the case.

2. Select Make Study Drug to mark the current product as a study drug.

Be aware of the following:

■ The system disables the drug type to make the product a Concomitant or 
Treatment option.

■ Study Drug is a read-only field that contains the product name selected by the 
user.

■ For non-configured studies in the case, the system displays the following for all 
study drugs in the case:

Drug Not Administered.

5.1.4.3 The Device Tab
The Device tab enables you to enter information about devices being used for a 
particular case. It has the following subsections:

■ Product Information

■ Product Indication

■ Product Delivered by Device

■ Device Information

5.1.4.3.1 Product Information Section  The following is an illustration of the Product 
Information section of the Device tab.

Batch and lot tested 
and found not within 
specifications

Check this checkbox if the batch and lot was not found to be within 
specifications, after being tested.

Counterfeit Check this checkbox if the patient took a counterfeit drug.

Drug taken by the 
father

Check this checkbox if the father of the patient had taken the drug.

Drug taken beyond 
expiry date

Check this checkbox if the drug was taken after its expiry date.

Medication Error Check this checkbox if there was a medication error in administering 
the drug.

Misuse Check this checkbox in case of possible misuse.

Occupational 
Exposure

Check this checkbox in case of occupational exposure.

Off Label Use Check this checkbox in case of off-label use of the drug.

Overdose Check this checkbox if the patient took an overdose of the product.

Tampering Check this checkbox if the product appeared to have been tampered 
with before it was used.

Field/Control Name Description
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Fields and Field Descriptions

The following table lists and describes the fields in the Product Information section.

Field/Control Name Description

Product Information 

Product Name Enter the name of the product using the Select button or by entering a 
partial product name. Type a partial product name and press TAB. This 
displays the Product Selection dialog. If only one product is found, this 
information is entered without showing the dialog. If no match is found 
in the company product list, the WHO Drug Dictionary is searched for 
a possible match through the WHO Drug Dictionary Dialog. If a match 
is still not found, the text you initially typed in, is used as is.

Note: If the study is blinded, the Blinded Name of the clinical study is 
displayed in this field. After unblinding, the selected study’s Product 
Name for Unblinded cases is not shown.

Select Displays the product selection dialog.

Select a product from the list of company products click Select.

The relevant fields are added to the Case Form.

Encode Click Encode to retrieve the code.

Suspect/ 
Concomitant/ 
Treatment

Make the appropriate selection for the product you are entering. The 
drug types indicate the involvement of the product with the adverse 
event(s) reported for the case.

Suspect indicates that the product may have caused the adverse 
event(s).

Concomitant indicates drugs that are taken with the suspect drug.

Treatment is the drug taken to treat the adverse event.

Generic Name Enter the generic name of the drug in a manner similar to the Product 
Name. If the study is blinded, the Generic Name is replaced with the 
Study Name of the product.

Note: This name is entered automatically, depending on the chosen 
company product.

Note: If the study is blinded, the Blinded Name of the clinical study is 
displayed in this field. After unblinding, the selected study’s Product 
Name for Unblinded cases is not shown.

Product Identifier 
Type

The type of product Identifier selected.

Product Identifier Displays the type of  Product Identifier such as MPID, PhPID, and so 
on.

Version Displays the Date or Version of the Product Identifier.
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Company Drug Code Displays the licensed country for the selected company product.

Obtain Drug Country Country the drug is licensed in.

Drug Code Enter the WHO-DRUG code.

WHO Medicinal 
Product ID

Displays the Medicinal ID associated with the selected WHO drug.

Note: This ID is populated only if a WHO-drug is selected.

Device Type Indicates the type of device being used for this case.

Formulation Select the formulation of the product. The Administrator can adjust this 
list.

Note: This field is entered automatically depending on the product.

Drug Authorization 
Country

Enter the company drug code.

Note: This name is entered automatically depending on the chosen 
company product.

Manufacturer A different Manufacturer can be selected from the drop-down list and 
can still be kept as a company product.

Concentration After a drug and formulation have been entered, select the 
concentration from the list, or enter the concentration. If this 
information is changed manually, the product is marked as a 
non-company product.

Note: This field is entered automatically depending on the chosen 
product. The concentration cannot be modified for a Study drug.

Units Select a concentration unit. The Administrator can adjust this list.

Interaction? Indicates whether the case involves a drug interaction

Contraindicated? Indicates whether the drug was administered contrary to its indication. 
Make the appropriate selection to indicate whether the drug was 
contraindicated in this case.

Drug Not 
Administered

Check this checkbox if no drug was administered.

Substance 
Information

Substance Name Displays the Ingredient’s name.

Substance Term ID Displays the Term ID of the substance selected.

Version Displays the Date or Version of the substance selected.

Strength The strength of the substance used in the product.

Units The drug unit (such as mg, tsp, and so on).

Product Name Parts 
Information

Name Part Type The type of Product Name part used in the Product.

Name Part The Product Name part used in the Product.

Field/Control Name Description
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M/W Info The MW Info dialog allows you to enter the following device 
information:

■ Is this a single-use device that was reprocessed and reused on a 
patient?: Indicate whether the device was labeled for single use. If 
the question is not relevant to the device being reported (for 
example, an X-ray machine), leave the select box cleared.

■ Reprocessor Name: Enter information for Address 1, Address 2, 
City, State, Country, Postal Code, Fax, and Email Address. 

■ Select if the device was an Adverse Event or a Product Problem.

■ Type of Follow-up Report: Select the appropriate check boxes that 
most accurately describe the nature of the follow-up 
(supplemental) report as follows:

Correction - Changes to previously submitted information.

Additional information - Information concerning the event that 
was not provided in the initial report because it was not 
known/available when the report was originally submitted.

Response to FDA request - Additional information requested by 
FDA concerning the device/event.

Device Evaluation - Evaluation/analysis of device.

■ Enter information for Address 1, Address 2, City, State, Country, 
Postal Code, Fax, and Email Address.

■ Device Evaluated by Mfr: Select the Not returned to mfr. check 
box if an evaluation could not be made because the device was not 
returned to or made available to the manufacturer. Select Yes if an 
evaluation was made for the suspect medical device. You can 
attach a summary of the evaluation and select Yes, Summary 
Attached. If an evaluation of a returned suspect or related medical 
device was not conducted, check the No check box and attach an 
explanation or provide an appropriate code from the coding 
manual (Part II, Subpart A).

■ Reason for Non-Evaluation: Enter the reason for the device not 
being evaluated by the manufacturer.

■ Other Reason for Non-Evaluation: Enter other reasons for 
non-evaluation of the device.

Field/Control Name Description
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■ Patient Codes: Click Select to display the 'FDA Codes' dialog and 
to select the Patient codes.

■ Device Codes: Click Select to display the 'FDA Codes' dialog and 
to select the Device codes.

■ Evaluation Codes Information: Click Select to enter the applicable 
codes from the categories listed. Follow the instructions in the 
dialog to enter the evaluation codes. Conclusion codes must be 
entered even if the device was not evaluated.

■ If reedial action initiated, check type: Select the applicable 
actions. If other, specify the type of action in the space provided 
(for further reference, see 21 U.S.C. 360h and 21 CFR part 803).

■ Usage of Device: Make the appropriate selection to indicate 
whether the use of the suspect medical device was the initial use, 
reuse, or unknown.

■ USC 360i(f) correction/removal reporting number: Enter the 
number that the FDA assigned to the corrective action. If the FDA 
has not yet assigned a number, the internal number assigned to the 
action by the company is used.

■ Additional manufacturer narrative: Select the check box (if 
applicable) and enter any additional information, evaluation, or 
clarification of data presented in previous sections.

■ Corrected Data: Select the check box if corrected data.

EU / CA Device The EU/CA Device dialog allows you to enter the device information. 
Fields are marked by either an EU flag or a Canadian flag to indicate 
which entity is mapped to the field. The following list describes each 
field in detail:

■ Accessories / Associated Devices: Enter associated devices and/or 
accessories involved in the incident.

■ Does the Incident represent a serious public threat?: Select the 
appropriate incidence type.

■ Number of similar incidents: Enter the number of similar 
incidents.

■ Software Version: Enter relevant software version.

■ Identification of Notified Body involved in Conformity 
Assessment: Enter identification number of the Notified Body 
involved in the conformity assessment procedure (if any) and the 
date(s) of the attestation(s).

■ User facility reference number: Enter the user facility reference 
number.

■ NCA Reference Number: Enter the NCA reference number.

■ Number of Patients Involved: Enter the number of patients 
involved in the incident.

■ Number of Devices Involved: Enter the number of devices 
involved.

■ Identify to what other NCAs this report was also sent: Enter the 
other NCAs to which this report was sent.

■ Remedial Action by HC Facility: Enter the remedial action taken 
by the Health care facility.

Field/Control Name Description
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5.1.4.3.2 Searching for Products  You can perform two types of searches in the section:

■ Product Browser Search

■ WHO Drug Coding Search

■ Usage of Medical Device: Select the relevant option.

■ Update to Initial Report (Follow-up Report): Select this check box 
if the Follow-up report must be updated to an Initial report.

■ Final Report: Select this check box if this is the final report.

■ Was the device labeled sterile?: Select the appropriate choice.

■ Importer Reported to Manufacturer: Select Yes or No.

■ During Investigational Testing: Select Yes or No.

■ Importer Submitted on behalf of Manufacturer: Select Yes or No.

■ Special Access Program Device: Select Yes or No.

■ Number of Years since Manufacturing Date: enter the number of 
years since the manufacturing date.

■ Radiation Emitting Device: Select Yes or No.

■ Availability of Device: Select whether the device was Destroyed, 
Returned to Manufacturer/Importer, or Neither.

■ Explanation: Enter the explanation in the text box provided.

■ Name of Health Care Facility: Enter the name of the health care 
facility.

■ Reporting firm is aware of other similar incidents having an 
impact on the current report: Select the appropriate choice.

■ If yes, to which countries (EEA countries): Enter appropriate 
countries.

■ Device distributed within the following EEA Countries: Enter 
appropriate countries.

■ Current location of device: Enter the present location of the device 
that was involved in the incident.

■ Where was the device purchased: Enter the establishment where 
the device was purchased.

■ Address: Enter the address of the location where the device was 
purchased.

■ Expected date of follow-up report: Enter the expected date of 
follow-up report.

■ Initial Corrective Action: Enter corrective action for the Initial 
report.

■ Initial Project Timing: Enter projected timing for the Initial report.

■ Final Corrective Action: Enter corrective action for the Final 
report.

■ Final Project Timing: Enter projected timing for the Final report.

■ Investigation Result: Enter the results of investigation from the 
follow-up.

■ Further Investigation: Enter the details of further investigation 
from the follow-up.

■ Comments: Enter any manufacturer comments.

Field/Control Name Description
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Product Browser Search
To search for a product

1. Click Select in the Products tab.

2. The Product Browser dialog is displayed.

3. Click Select to start searching.

4. When the system opens the Product Browser dialog box, Click the entities 
displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For 
example, if Product Name is searched, it displays the Product Name as well as the 
Family Name and Trade Name.

5. Search for Products based on the following criteria:

■ Ingredient

■ Family

■ Product Name

■ Trade Name - Searches the License Trade Name

6. Click the Full Search check box to select all these criteria when searching.

7. Click Select.

8. The results based on the search criteria are displayed and the user can select the 
Product.

9. Click Clear to remove the entered search criteria.

WHO Drug Browser Search
Be aware of the following when using the WHO Drug Browser search function:

■ The system enables you to perform a full search from the WHO Drug browser 
when you select the Full Search option.
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– By default, the system performs a like search (e.g., CUREALL%)

– You can use the percent (%) sign to perform wildcard searches

– If you click Full Search, the system performs a full search (e.g., %CUREALL%)

■ The system also enables you to search for drug formulation and country. However, 
this is available only if you select the WHO Drug C format. Otherwise, the option 
is disabled.

■ When you click Clear, the system clears the search criteria you entered.

■ After the system performs the search, you can sort the results on all the fields.

To perform a WHO Drug Browser Search
1. Select the Encode button to open the WHO Drug Coding dialog.

2. You can use both the WHO Drug B Format as well as the WHO Drug C Format 
using the same browser.

Select either the WHO Drug B format or the WHO Drug C format from the Case 
Form Configuration dialog where the Dictionaries are chosen for encoding.

3. Enter your search criteria in these fields and click Search to display the product 
attributes that match the given search criteria:

■ Trade Name - the trade name of the product

■ Formulation / Strength - the Formulation / Strength (sequence 3 and 
sequence 4) of the product.

■ Country - The Sales Country Code of the Product as defined in the WHO 
Dictionary

■ Generic - Whether Generic - Yes or No.

The following criteria are not available for display or searching in the WHO 
Drug B Format:

– Formulation
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– Country

– Strength 

– Generic

– Medicinal Product ID

– Product Type

4. Click Select to copy the selected drug to the Product tab.

5. Click Cancel to close the selection dialog without making any updates to the 
Product tab.

The WHO Drug Coding Dialog has the following fields:

5.1.4.3.3 Entering Quality Control Information  You can enter quality control information 
by clicking the Quality Control button and entering the appropriate information in the 
Quality Control dialog box. 

About the Quality Control Dialog Box
The following is an illustration of the Quality Control dialog box.

Field Description

Product Type Select the type of product from the drop-down list. Note: All is 
displayed as the Product Type by default.

ATC Code Enter the ATC Code up to a maximum of 10 characters.

Drug Code / 
Medicinal Prod ID

Searches on either criterion as per the radio button selected for the 
search. By default, the Drug Code option is selected.

Trade Name / 
Ingredient

Searches on either criterion as per the radio button selected for the 
search. By default, the Trade Name option is selected.

Formulation Enables you to search based on the drug formulation.

Country Enables you to search for a drug based on the country where the drug 
was sold.
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The following table lists and describes the fields in the Quality Control dialog box.

5.1.4.3.4 Product Indication Section  The following is an illustration of the Product 
Indication section of the Device tab.

Product Indication Fields and Field Descriptions
The following table lists and describes the fields in the Product Indication section.

Field Description

Quality Control 
Safety Date

Enter the Quality Control department reference number for the 
analysis.

Quality Control Sent 
Date

Enter the sent date.

Quality Control 
Cross Reference

Enter the Quality Control department reference number for the 
analysis.

Date Returned Enter the date returned.

Global ID Enter the global number.

Quantity Enter the quantity.

# CID Number Enter the Control Identification Number.

PCID Number Enter the Product Control Identification Number.

Lot Number Enter the lot number. If the Lot Number entered is incorrect, a Lot 
Number Lookup dialog is displayed, that allows you to enter select 
from the existing lot numbers.

Complaint 
Categories Date

Enter a date for complaint categories.

Complaint 
Categories Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Analysis Categories 
Date

Enter a date for analysis categories.

Analysis Categories 
Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Analysis Summary 
Date

Enter a date for an analysis summary.

Analysis Summary 
Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Quality Control 
Result Date

Enter the date the result of the analysis was received by the Quality 
Control department.

Quality Control 
Result

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Quality Control 
Comment

Enter any comment relating to the analysis.
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5.1.4.3.5 Product Delivered by Device Section  The following is an illustration of the 
Product Delivered by Device section

5.1.4.3.6 Product Delivered by Device Fields and Field Descriptions  The following table lists 
and describes the fields in the Product Delivered by Device section.

5.1.4.3.7 Device Component Information  This section enables you to enter information 
about the device component being used. The following is an illustration of the section.

Field/Control 
Name Description

Reported 
Indication

By default, the value of this field is populated with the Product Indication 
from the Product Configuration, if set up by the user. If not, you can enter a 
term into the Reported Indication field.

Note: Argus Safety automatically encodes this information. You can also 
click Encode to open the coding dictionary dialog.

Coded Indication This field is populated with the encoded term when the user enters data in 
the reported indication field and tabs out.

Encode 
(Indication)

Opens the MedDRA Browser with the term already populated from the 
Coded Indication field.

Note: To view the complete MEDDRA hierarchy for the encoded term, click 
the Encoding Status icon.

Add Adds a new Indication row.

Note: Only two indications are visible at a time

Delete Click this button to delete the selected Indication row.

Field/Control Name Description

Type of Drug Select the type of drug from the drop-down list.

Other Mfg Product Displays the Other Manufacturing Product.

Add Adds another row.

Delete Deletes the highlighted row.

Field/Control Name Description

Component Name The device component name used in the product.
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5.1.4.3.8 Device Information Section  This section enables you to enter information about 
the device being used. The following is an illustration of the section.

5.1.4.3.9 Device Information Fields and Field Descriptions  When using the Device 
Information section, be aware of the following:

■ You can enter up to 10,000 characters in the Additional Manufacturer Narrative 
field.

■ The device evaluation codes have been updated to reflect FDA standards. Go to 
the following link for more information: 
http://www.fda.gov/cdrh/mdr/373_appdxb.html.

■ The evaluation method is available is the following site: 
http://www.fda.gov/cdrh/mdr/373.html.

■ The evaluation results are available at the following site: 
http://www.fda.gov/cdrh/mdr/373_appdxd.html.

The following table lists and describes the fields in the Device Information Section

Component Term ID The device component term ID of the device component used in the 
product.

Version The Date or Version of the device component term ID of the device 
component used in the product.

Batch Lot # The batch lot number of the device component name used in the 
product.

Add Adds another row.

Delete Deletes the highlighted row.

Field/Control Name Description

Product Information 

Lot # Enter the lot number of the device.

Expiration Date Enter the expiration date. Enter a partial date or no date if the full date 
is not available.

Date of Mfr Enter the month and year of manufacture of the suspect medical device.

Device Age Enter the age of the device.

Units Enter the unit.

Model # Enter the model number of the device.

Serial # Enter the serial number of the device.

Catalog # Under Catalog#, enter the exact catalog number as it appears in the 
manufacturer's catalog, device labeling, or accompanying packaging.

Field/Control Name Description
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EU/CA Device Dialog Fields and Field Descriptions
The EU/CADevice Fields dialog includes the following fields:

■ NCA Reference Number

■ Identify to what other NCA's this report was also sent

■ Number of Patients Involved

■ Number of Devices Involved

Unique Identifier 
(UDI) #

Under Unique Identifier (UDI) #, enter any other applicable 
identification number (for example: component number, product 
number, part number, bar-coded product ID).

Date Implanted If the device is implantable, enter the date of the implant. Enter a partial 
date if the full date is not available.

Date Explanted If the device is implantable, enter the date of the explant, if any. Enter a 
partial date if the full date is not available.

Improper 
Use/Storage

Indicate if the device was improperly used or stored.

Operator of Device Select the type of person operating or using the suspect medical device 
on the patient at the time of the event such as Health Care Professional, 
Patient, Paramedic and so on.

If other If the operator of the device is other, enter the operator of the device.

Trained User Indicate if the operator of the devices was trained to use the device.

Duration of 
implantation

The duration of implantation.

Malfunction Indicate if the devices malfunctioned.

Malfunction Type Make the appropriate selection to indicate the type of reportable event. 
For an event associated with a malfunction, the FDA refers users to 
applicable sections in 21 CFR Part 803 reporting guidelines.

Manufacturer/Impor
ter Awareness Date

Enter the date when the manufacturer became aware of the event

Device Available for 
Evaluation

Indicate whether the device is available for evaluation. Also, indicate 
whether the device was returned to the manufacturer and if so, the date 
of the return.

Returned to 
manufacturer on

Enter the Device Return Date.

Preliminary 
Comments

Enter or select preliminary comments.

Malfunction 
Information

-

Reported 
Malfunction 

Enter the malfunction as entered by the reporter.

Determined 
Malfunction

Enter the malfunction as determined by the company.

Listedness Enter the listedness of malfunction in respect of the device.

Reportable Select the reportability of the malfunction.

Field/Control Name Description
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■ User facility reference number

■ Remedial Action by HC Facility

■ Usage of Medical Device

■ Other

■ Update to Initial Report (Follow-up Report)

■ Final Report

The following table provides attribute information for the device fields

When you select the EU/CA Device option, the system prints the fields on the Case 
form. The system tracks the fields and any updates in the audit log.

5.1.4.4 Vaccine Tab
The Vaccine section of the Products tab enables you to enter information about a 
vaccine. The Vaccine tab includes the following sections:

■ Product Information Section

■ Product Indication Section

■ Quality Control Section

■ Vaccine Information Section

■ Product Details Section

■ Vaccine Administration

■ Prior Adverse Events

■ Vaccine History Section

5.1.4.4.1  Product Information Section  Fields and Field Descriptions
The following table lists and describes the fields in the Product Information section.

Field/Control Name Name Field Length Field Type

NCA Reference Number 100 characters Alphanumeric

Identify to what other NCA's 
this report was also sent

2000 characters Alphanumeric

Number of Patients Involved 3 characters Numeric

Number of Devices 3 characters Numeric

User facility reference number 20 characters Alphanumeric

Remedial Action by HC 
Facility

1000 characters Alphanumeric

Usage of Medical Device N/A Check box

Other 15 characters Alphanumeric

Update to Initial Report 
(Follow-up Report)

N/A Check box

Final Report N/A Check box
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Field/Control Name Description

Product Name Enter the name of the product using the Select button or by entering a 
partial product name.

Type a partial product name and press TAB. This displays the Product 
Selection dialog. If only one product is found, this information is 
entered without showing the dialog. If no match is found in the 
company product list, the WHO Drug Dictionary is searched for a 
possible match through the WHO Drug Dictionary Dialog. If a match is 
still not found, the text you initially typed in, is used as is.

Note: If the study is blinded, the Blinded Name of the clinical study is 
displayed in this field. After unblinding, the selected study’s Product 
Name for Unblinded cases is not shown.

Select Displays the product selection dialog.

Select a product from the list of company products click Select.

The relevant fields are added to the Case Form.

Encode Click Encode to retrieve the code.

Include in VAERS 
Block

Select the VAERS Form block that this vaccine needs to be printed in.

Suspect/Concomitan
t/Treatment

Make the appropriate selection for the product you are entering. The 
drug types indicate the involvement of the product with the adverse 
event(s) reported for the case.

Suspect indicates that the product may have caused the adverse 
event(s).

Concomitant indicates drugs that are taken with the suspect drug.

Treatment is the drug taken to treat the adverse event.

Generic Name Enter the generic name of the drug in a manner similar to the Product 
Name. If the study is blinded, the Generic Name is replaced with the 
Study Name of the product.

Note: This name is entered automatically depending on the chosen 
company product.

Product Identifier 
Type  

The type of product Identifier selected.

Product Identifier  Displays the type of Product Identifier such as MPID, PhPID, and so 
on.

Version Displays the Date or Version of the Product Identifier.

Company Drug Code Enter the company drug code.

Note: This name is entered automatically depending on the chosen 
company product.

Obtain Drug Country Enter the country where the drug was purchased.

Drug Code Enter the WHO-DRUG code.

WHO Medicinal 
Product ID

Displays the Medicinal ID associated with the selected WHO drug.

Note: This ID is populated only if a WHO-drug is selected.

Formulation Select the formulation of the product. The Administrator can adjust this 
list.

Note: This field is entered automatically depending on the product.

Drug Authorization 
Country

Displays the licensed country for the selected company product.
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5.1.4.4.2 Searching for Products  You can perform two types of searches in the  section:

■ Product Browser Search

■ WHO Drug Coding Search

5.1.4.4.3 To perform a search in the Product Browser dialog box  1.Click Select in the 
Products tab.

2. The Product Browser dialog is displayed.

3. Click Select to start searching.

4. When the system opens the Product Browser dialog box, Click the entities 
displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For 
example, if Product Name is searched, it displays the Product Name as well as the 
Family Name and Trade Name.

5. Search for Products based on the following criteria:

■ Ingredient

■ Family

■ Product Name

■ Trade Name - Searches the License Trade Name

6. Click the Full Search check box to select all these criteria when searching.

7. Click Select.

8. The results based on the search criteria are displayed and the user can select the 
Product.

9. Click Clear to remove the entered search criteria.

Manufacturer A different Manufacturer can be selected from the drop-down list and 
can still be kept as a company product.

Concentration After a drug and formulation have been entered, select the 
concentration from the list, or enter the concentration. If this 
information is changed manually, the product is marked as a 
non-company product.

Note: This field is entered automatically depending on the chosen 
product. The concentration cannot be modified for a Study drug.

Units Select a concentration unit. The Administrator can adjust this list.

Interaction? Indicates whether the case involves a drug interaction

Contraindicated? Indicates whether the drug was administered contrary to its indication. 
Make the appropriate selection to indicate whether the drug was 
contraindicated in this case.

# of Siblings Enter the number of siblings for patients who are children under the 
age of five.

Birth Weight For patients who are children under the age of five, enter the birth 
weight. For example: 3260g, 3.26kg, or 7lb 4oz. If a number without 
units is entered, the following units are assumed: < 32 - Pounds 32-200 - 
Ounces >200 - Grams

Birth Weight Units Select the appropriate weight units.

Field/Control Name Description
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5.1.4.4.4 WHO Drug Browser Search  Be aware of the following when using the WHO 
Drug Browser search function:

■ The system enables you to perform a full search from the WHO Drug browser 
when you select the Full Search option. 

– By default, the system performs a like search (e.g., CUREALL%)

– You can use the percent (%) sign to perform wildcard searches

– If you click Full Search, the system performs a full search (e.g., %CUREALL%)

■ The system also enables you to search for drug formulation and country. However, 
this is available only if you select the WHO Drug C format. Otherwise, the option 
is disabled.

■ When you click Clear, the system clears the search criteria you entered.

■ After the system performs the search, you can sort the results on all the fields.

To perform a WHO Drug Browser Search
1. Select the Encode button to open the WHO Drug Coding dialog.

2. You can use both the WHO Drug B Format as well as the WHO Drug C Format 
using the same browser.

Select either the WHO Drug B format or the WHO Drug C format from the Case 
Form Configuration dialog where the Dictionaries are chosen for encoding.

The WHO Drug Coding Dialog has the following fields:

3. Enter your search criteria in these fields and click Search to display the product 
attributes that match the given search criteria:

■ Trade Name  -- the trade name of the product

■ Formulation / Strength  -- the Formulation / Strength (sequence 3 and 
sequence 4) of the product.

■ Country  -- The Sales Country Code of the Product as defined in the WHO 
Dictionary

■ Generic - Whether Generic - Yes or No.

The following criteria are not available for display or searching in the WHO 
Drug B Format:

– Formulation

Field/Control Name Description

Product Type Select the type of product from the drop-down list. Note: All is 
displayed as the Product Type by default.

ATC Code Enter the ATC Code up to a maximum of 10 characters.

Drug Code / Medicinal 
Prod ID

Searches on either criterion as per the radio button selected for the 
search. By default, the Drug Code option is selected.

Trade Name / 
Ingredient

Searches on either criterion as per the radio button selected for the 
search. By default, the Trade Name option is selected.

Formulation Enables you to search based on the drug formulation.

Country Enables you to search for a drug based on the country where the 
drug was sold.
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– Country

– Strength

– Generic

– Medicinal Product ID

– Product Type

4. Click Select to copy the selected drug to the Product tab.

5. Click Cancel to close the selection dialog without making any updates to the 
Product tab.

5.1.4.4.5 Product Indication Section  The following is an illustration of the fields in the 
Product Indication section of the Vaccine tab.

Product Indication Fields and Field Descriptions
The following table lists and describes the fields in the Product Indication section.

5.1.4.4.6 Quality Control Section  You can enter quality control information and enter the 
appropriate information in the Quality Control section. The following is an illustration 
of the section.

Field/Control Name Description

Product Indication Section

Reported Indication By default, the value of this field is populated with the Product 
Indication from the Product Configuration, if set up by the user. If not, 
you can enter a term into the Reported Indication field.

Note: Argus Safety automatically encodes this information. You can 
also click Encode to open the coding dictionary dialog.

Coded Indication This field is populated with the encoded term when the user enters 
data in the reported indication field and tabs out.

Encode (Indication) Opens the MedDRA Browser with the term already populated from the 
Coded Indication field.

Note: To view the complete MEDDRA hierarchy for the encoded term, 
click the Encoding Status icon

Add Adds a new Indication row.

Note: Only two indications are visible at a time

Delete Click this button to delete the selected Indication row.

Up Allows the user to move an indication up.

Down Allows the user to move an indication down.
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The following table lists and describes the fields in the Quality Control window.

Field/Control Name Description

Quality Control 
Safety Date

Enter the Quality Control department reference number for the 
analysis.

Quality Control Sent 
Date

Enter the sent date.

Quality Control 
Cross Reference

Enter the Quality Control department reference number for the 
analysis.

Date Returned Enter the date returned.

Global ID Enter the global number.

Quantity Enter the quantity.

# CID Number Enter the Control Identification Number.

PCID Number Enter the Product Control Identification Number.

Lot Number Enter the lot number. If the Lot Number entered is incorrect, a Lot 
Number Lookup dialog is displayed, that allows you to enter select 
from the existing lot numbers.

Complaint 
Categories Date

Enter a date for complaint categories.

Complaint 
Categories Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Analysis Categories 
Date

Enter a date for analysis categories.

Analysis Categories 
Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Analysis Summary 
Date

Enter a date for an analysis summary.

Analysis Summary 
Text

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Quality Control 
Result Date

Enter the date the result of the analysis was received by the Quality 
Control department.

Quality Control 
Result

Enter a text explanation as necessary. Use the zoom icon to open the 
zoom notes and view or edit the text.

Quality Control 
Comment

Enter any comment relating to the analysis.
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5.1.4.4.7 Vaccine Information Section  You can enter vaccine information and enter the 
appropriate information in the Vaccine Information section. The following is an 
illustration of the section.

Vaccine Information Fields and Field Descriptions
The following table lists and describes the fields in the Vaccine Information section.

5.1.4.4.8 Product Details Section  This section is the same for the Product Details section 
under all the tabs - in the Drugs tab, Device tab, and the Vaccine tab. 

See the The Product Details Section for details about this section.

5.1.4.4.9  Vaccine Administration   The following is an illustration of the Vaccine 
Administration form.

Field/Control Name Description

Start Date/Time Enter the vaccination date. Enter a partial date if the full date is not 
available.

Dose Number Enter the vaccine dose number.

Dose Enter the vaccine dose.

Units Select the dose unit. The Administrator can adjust this list.

Dose Description Enter a description of the vaccine dose.

Patient Route of 
Administration

Enter the route of administration or a short code for the route of 
administration. The system automatically decodes your entry. The 
Administrator can adjust this list.

Parent Route of 
Administration

Enter the route of administration or a short code for the route of 
administration. The system automatically decodes your entry. The 
Administrator can adjust this list.

Package ID Enter the package ID.

Batch / Lot # Enter the batch and/or lot number(s).

Expiration Date Enter the expiration date. Enter a partial date or no date if the full date 
is not available.

Block 10 If this box is checked, the Start Date in this Dosage record and the time 
from the leftmost CDD vaccine will be printed in the VAERS Form 
Block 10 as Date of Vaccination.

Block 14 If this box is checked, this Dosage record will be printed in the VAERS 
Form Block 14.

Anatomical Location Select the anatomical location of the vaccination. The Administrator can 
adjust this list.



Case Form Functions

Case Form 5-56

To enter vaccine administration information:

1. Enter the relevant vaccination information items in the form.

The following table lists and describes the fields in the Vaccine Administration form.

Field/Control Name Description

Best Doctor / Health Care Professional Information

Title Enter the health care professional's name title, if applicable.

First Name Enter the first name of the health care professional.

Middle Name Enter the middle name of the health care professional.

Last Name Enter the last name of the health care professional.

Suffix Enter the health care professional’s name suffix, if applicable.

Phone Enter the telephone number of the health care professional.

Email Address Enter the email address of the health care professional.

Person Completing 
Form Relationship to 
Patient

Select an appropriate item from the list.

For VAERS Form-1 
Use Only 

Administered By Enter the name of the person who administered the vaccine.

Resp. Physician Enter the name of the physician responsible for the patient.

County Enter the county where the patient was vaccinated.

State Enter the state where the patient was vaccinated.

CDC/FDA VAERS # Enter the verification number.

Purchased With Select the most appropriate item from the list to describe how the 
vaccine was purchased.

Illness at time of 
Vaccination

Enter the illness, if known.

Reported Previously Select an appropriate item from the list.

Required ER Visit Select this check box if the event required a visit to the emergency room 
or doctor.

Vaccine Facility 
Information

Facility Name Enter the name of the facility where the vaccine was administered.

Address 1 Enter line 1 of the address of the facility.

Address 2 Enter line 2 of the address of the facility.
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5.1.4.4.10  Prior Adverse Events   The following is an illustration of the Vaccine Prior 
Adverse Events form.

To enter prior adverse events information
1. Enter the relevant vaccination information items in the form.

2. Click OK to save the entered prior vaccination adverse event information.

The following table lists and describes the fields in the Vaccine Prior Adverse Events 
form.

5.1.4.4.11 Vaccine History Section  The following is an illustration of the Vaccine History 
section of the screen.

Vaccine History Fields and Field Descriptions
The following table lists and describes the fields in the Vaccine History section.

Country Enter the country of the facility where the responsible physician works.

Postal Code Enter the postal code of the facility.

City Enter the city of the facility where the responsible physician works.

Phone Enter the telephone number of the facility.

State Enter the state of the facility.

Fax Enter the fax number of the facility.

Facility Type Enter the facility type where the patient was vaccinated.

Facility Military Flag Select Yes or No indicate whether or not the vaccination facility was a 
Military facility.

Field/Control Name Description

Patient Select whether the details refer to the patient or to a sibling.

Vaccine Enter the name of the vaccine.

Dose # Enter the dose number of the vaccine.

Age Enter the patient's age at onset of the event.

Age Units Select the appropriate age unit from the list.

Adverse Events Enter a term that describes the adverse event. Click the Encode button 
to encode the term.

Field/Control Name Description

Date Enter the date of vaccination. Enter a partial date if the full date is not 
available.

Field/Control Name Description
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5.1.5 Events Tab
The Events tab enables you to enter or view details for adverse events associated with 
a case. The following is an illustration of the Events tab.

5.1.5.1 General Usage Information
When using the Events tab, be aware of the following:

– You can change the listedness for a drug at the individual level.

– This limitation also applies to the Medical Review and Local Labeling dialogs.

■ The field labels for the Event Assessment tab are updated and configured on the 
Argus Console.

■ When you modify the Event outcome on the Events Tab, and the event outcome 
and case outcome do not match, the system displays the following message:

Route of Admin Enter the route of administration or a short code for the route of 
administration. The system automatically decodes your entry. The 
Administrator can adjust this list.

Vaccine Enter the name of the vaccine.

Generic Name Enter the generic name of the vaccine.

Anatomical Location Select the anatomical location of the vaccination. The Administrator can 
adjust this list.

Dose # Enter the vaccine dose number.

Manufacturer Enter the vaccine manufacturer or select a manufacturer. The 
Administrator can adjust this list.

Dose Enter the vaccine dose.

Units Select the dose unit. The Administrator can adjust this list.

Batch & Lot # Enter the batch and/or lot number(s).

Block 14 If this box is checked, this Vaccine History will be printed in the VAERS 
Form Block 14.

Add Adds a new Indication row.

Note: Only two indications are visible at a time.

Delete Click this button to delete the selected Indication row.

Field/Control Name Description
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Case Outcome may no longer match events.

■ If the Death Seriousness criteria on the Event tab are unchecked, the event 
outcome reverts to empty and is not set to fatal.

■ On the Death Details screen, the Autopsy Results field defaults to blank instead 
of No. If the value is incorrectly set, the system sets it to null during the upgrade.

■ On the Event Assessment tab, the system displays the Notes icon beside the event 
term if the preferred term has associated notes on the datasheet.

■ If the datasheet does not have notes for the preferred term, the system does not 
display the Notes icon.

■ This is also true for the Medical Summary and the Local Labeling dialog

■ When you click the Notes icon, the system displays the notes in read-only mode.

■ If Allow User to Add Non-Current MedDRA Terms for is configured to Case 
where Country of Incidence (COI) is other than Japan, the existing application 
behavior is maintained as:

a. For COI other than Japan: The user can choose a MedDRA LLT term for which 
LLT (J) is non-current, that is, based on English currency.

b. For COI as Japan: Existing application behavior is retained, and if an E or J user 
tries to add a LLT with Non-current LLT(J), the application displays an error 
message.

c. The application indicates the Non-current LLT (J) term with icon indicator on 
the English side of the Case Form similar to the way it indicates Non-current LLT 
(J) on the Japan side of the Case Form for both English and Japan users.

If the Allow User to Add Non-Current MedDRA Terms for is configured to Case 
irrespective of Country of Incidence, the existing application behavior is 
modified as:

a. Irrespective of COI of the case, both E and J users can add a LLT to the case for 
which LLT (J) is non-current, that is, based on English currency. 

b. Also, there is an indicator on both sides (English and J) to indicate the 
Non-current LLT (J) term similar to the way it indicates a Non-current LLT (J) on 
the Japan side of the Case form for both English and J users.

■ The MedDRA LLT term selection behavior across the Case Form (not limited to the 
list mentioned below) is governed based on the profile switch value configured in 
the Allow User to Add Non-Current MedDRA Terms for and On change of LLT 
Term Sync English and Japan LLTs, irrespective of the currency.

– Book-in -> Description as Reported

– Case Form -> Patient -> Lab Data -> Test Name

– Case Form -> Patient -> Other Relevant History -> 
Verbatim/Indication/Reaction

– Case Form -> Patient Tab -> Patient Sub Tab -> Death Details -> Cause of 
Death To be Coded

– Case Form -> Patient Tab -> Patient Sub Tab -> Death Details -> Autopsy 
Results To be Coded

– Case Form -> Parent -> Other Relevant History -> 
Verbatim/Indication/Reaction

– Case Form -> Products -> Product Indication -> Reported Indication 
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– Case Form -> Product-> Vaccine -> Prior Adverse Event -> Adverse Events 

– Case Form -> Event -> Description to be Coded 

– Case Form -> Event -> Event Death Details -> Description as Reported 

– Case Form -> Analysis Tab -> Company Diagnosis Syndrome

– Coding Review -> Prior Adverse Event -> Adverse Events

– Coding Review -> Event Information -> Description to be Coded

■ The system populates the To be coded value on the MedDRA popup dialog box 
when you click the green checkbox for the MedDRA hierarchy. This applies to the 
following area where the MedDRA dialog box appears.

– Patient Tab: Other Relevant History: Description

– Patient Tab: Other Relevant History: Reaction

– Patient Tab: Other Relevant History: Indication

– Patient Tab: lab Tests

– Product Tab: Product Indications

– Event Tab: Event Coding

– Analysis Tab: Company Diagnosis Syndrome

– Console: Business Configuration: Products: Datasheets

– Console Business Configuration: Products: Product Indications

– Console: Codelists: Lab Tests

– Console: Codelists: Always Serious Term List

■ The Event to Exclude from Report Field enables you to identify information not to 
include in a PMDA expedited report.

– The default for this check box is unchecked.

– When this check box is checked, you are required to enter a justification for 
this action in the Reason to Exclude from Report dialog box.

– After you enter the justification, the system places a symbol to the right of the 
field.

– You must have at least one event in a report. If you try to exclude all events 
from the report, the system presents the following message: "All the events are 
excluded from reports. If you want to report, at least one event is necessary. 
Proceed?" 

– The system does not retrieve events that are excluded from a report as part of 
CSPSR (Clinical Study Periodic Safety Report) unless it has been configured to 
include them in such a report.

The following is an illustration of the MedDRA dialog box.
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When you click the Recalculate button, the system does not recalculate listedness 
where the Event Assessment Listedness already has a case justification (generated 
automatically or manually overwritten).

5.1.5.1.1 Field Properties for Help Text/Default Labels  The following table describes the 
field properties for the Help Text/Default Labels.

Field Calculations
The following table describes the calculations the system uses for each field.

Default Field Label Default Help Text

Onset from First Dose This date is defined as the earliest regimen start date to 
Onset and is completed automatically.

The Date calculation is based on the Case Form 
Calculation for Inclusive or Exclusive

Onset from Last Dose This date is defined as the latest regimen stop date to 
Onset and is completed automatically.

The Date calculation is based on the Case Form 
Calculation for Inclusive or Exclusive.

Total Dose to Event The system calculates this value based on daily dose 
and duration.

Units The system provides this value based on the dosage 
units entered.

Action Taken Select the appropriate term from the drop-down list 
(e.g., Dose Increased, Withdrawn, etc.). The 
Administrator may adjust the values in this list.

Other The value can only be entered when the Action Taken is 
"Other."

Dechallenge Results Select the appropriate option.

Rechallenge Results Select the appropriate option.

Event occurred as consequence of Select the appropriate option.

Term Select the appropriate option.

Most Important Diagnosis? Select the appropriate option.

Event more specific/severe than PT? Select the appropriate option.



Case Form Functions

Case Form 5-62

5.1.5.2 Event
The Event information tab enables you to encode adverse events, record the criteria for 
the seriousness of each event, and display the results of automated assessments to 
determine whether events are listed in data sheets. It also lists the licenses for the data 
sheets. The Event information tab includes the following sections:

■ Event Information

■ Event Coding

■ Seriousness Criteria

■ Nature of Event

■ Details

5.1.5.2.1 Event Information Section  The Event Information section enables you to enter 
information about the event information including diagnosis, patient history, intensity, 
and so forth. 

Event Information Fields and Field Descriptions
The following table lists and describes the fields in the Event Information section.

Field Calculation

Total Dosage The sum of all Total Regimen Dosages.

First Dose to Onset The system calculates this value based on the first dose stop date and 
the event onset date, if present.

If any regimen start date is null, the system sets the First Dose to Onset 
is to null.

The system does not automatically use partial date entries for the 
Regimen Start and Stop Date/Time fields to calculate First Dose to 
Onset.

The user can overwrite this field.

Last Dose to Onset The system calculates this value based on the last dose stop date and 
the even onset date, if present.

If the regimen start date is null, the system sets the Last Dose to Onset 
is to null.

The system does not automatically use partial date entries for regimen 
Start and Stop Date/Time fields to calculate the Last Dose to Onset.

The user can overwrite this field.
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Field/Control Name Description

Relationships Click the Relationships button to view the Diagnosis-Event 
Relationships dialog. This allows you to group symptoms and signs 
with diagnoses. This requires at least two events and a diagnosis.

Original Language Make the appropriate selection to indicate the original language the 
event was reported in.

Description as 
Reported

Enter the verbatim term used by the reporter, or patient, to describe the 
adverse event. As you type, the term is automatically copied under 
Description to be Coded. Verbatim English translations of foreign 
languages may also be entered here.

Diagnosis/ 
Symptoms

Make the appropriate selection to indicate whether the event is a 
diagnosis or symptoms.

Medical 
Confirmation by 
HCP

Make the appropriate selection to indicate whether the event is 
medically confirmed by a HCP. This drop-down has the values: Yes, 
No, and Blank.

Term Highlighted by 
Reporter

Make the appropriate selection to indicate whether the primary source 
reporting the event considered it a major concern or reason for 
reporting the case. If the information was not explicitly provided by the 
initial reporter the term should not be considered a highlighted term. 
The seriousness of the reaction/event should be based on the ICH E2A 
criteria.

Note: Selecting Yes does not mark this case as Serious automatically.

Description to be 
Coded

If necessary, the verbatim term can be modified in this field. For 
example, the original term may need to be split, or enhanced with an 
anatomical location. The Administrator can prevent manual encoding 
of the description. If automatic encoding is enabled, the term can be 
auto-encoded to the included term level.

Onset Date/Time Enter the date/time when the event started. Enter a partial date if the 
full date is not available.

Onset from Last Dose This field is calculated automatically from the event onset date and 
most recent stop date listed in the dosage regimen details of the suspect 
drug(s). You can also enter or modify the field manually. This field is 
removed if the dosage regimen is ongoing.

Stop Date/Time Enter the date/time when the event stopped.

Duration This field is calculated automatically from the event start and stop 
dates. You can also enter or modify the duration manually.

Onset Latency This field is calculated automatically from the earliest first dose date of 
the suspect drug(s) to onset date. You can also enter or modify the 
duration manually.

Note: Onset Latency = Onset Date - First Dose.

Receipt Date Enter the date on which information about this event was received by 
your company.

Patient Has Prior 
History?

Make the appropriate selection to indicate whether the patient has had 
a prior history or has suffered from the same event in the past.

Treatment Received? Select Yes, No, or Unknown.

Intensity Select the category of severity of the event. The Administrator can 
adjust this list.

Frequency Select the frequency of the event from the list. The Administrator can 
adjust this list.
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5.1.5.2.2 Understanding the Diagnosis-Event Relationship  Argus Safety allows you to 
group events in a case, and/or to associate them with particular diagnoses. These 
determinations can be made by your company or simply as reported to your company. 
This feature aids significantly in the interpretation and review of individual case 
reports. It is also useful in summary reports as it enables the reporting of diagnoses 
only, while retaining database records of individual event terms.

Click the Relationships button in the Event Information section of the Eventstab to 
open the Diagnosis-Event relationship dialog.

5.1.5.2.3 Associating a symptom with a diagnosis  Click the up or down arrows to 
associate a selected symptom with a diagnosis. In Argus Safety Web, select the 
symptom and click Move Up or Move Down.

Example:

Such Adverse Events (AE) might be entered into the database as follows:

This example demonstrates how defining a diagnosis-event relationship can clarify an 
adverse event report. Suppose an initial case report describes a patient suffering from 
"Somnolence," "Sore Throat," and "Fever."

AE #     Diagnosis AE Term (Associated AEs)

 1    Somnolence 

2    Sore Throat

 3    Fever

For reports on all events, they would appear on a CIOMS-I form as:

Outcome of Event Select the outcome of the event. The Administrator can adjust this list. 
If Fatal is selected, Death is selected in the list of seriousness criteria.

Note: If the Death check box is subsequently cleared, the outcome still 
remains fatal.

Country in which 
event occurred

Select the country in which event occurred.

Lack of Efficacy Check this check box, if applicable.

Progression of 
Disease

Select this check box, if appropriate.

Adverse Drug 
Withdrawal Reaction

Check this check box, if applicable.

Infection Check this check box, if an infection has occurred.

Emergency Room 
Visit

Check this check box, if applicable.

Physician Office Visit Check this check box, if applicable.

Note:  To use this feature, the case must contain at least two events 
and, at a minimum, one diagnosis. The events related to a diagnosis 
are listed on top in this dialog and the symptoms are indented with 
respect to the diagnoses. You can group events together and associate 
them with individual diagnoses.

Field/Control Name Description
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■ Somnolence [SEDATION]

■ Sore Throat [SORE THROAT NOS]

■ Fever [PYREXIA]

Suppose a follow-up report then supplies information that the patient also had 
neutropenia, and had been diagnosed as suffering from agranulocytosis (the cause of 
the sore throat and fever). The somnolence was considered to be co-incidental, and 
unrelated to any other adverse events.

Neutropenia and agranulocytosis would be entered onto the system, and a 
diagnosis-event relationship established as follows:

These events would appear on a CIOMS I form as:

■ AGRANULOCYTOSIS

■ [AGRANULOCYTOSIS]  ([SORE THROAT],

■ [PYREXIA NOS], [NEUTROPENIA])

■ Somnolence [SEDATION]

■ This immediately gives a clear clinical picture of the case.

5.1.5.2.4 Using the MedDRA Browser  The MedDRA application searches the term 
dictionary for a match at the Lower level term or at the Synonym level. If a match is 
found, the following fields are automatically populated: Term code, Preferred Term, 
Included Term, High Level Term, Group Term and Body System/SOC.

Click the icon to view the MedDRA Browser.

5.1.5.2.5 Configuring Regulatory Reporting Rules  The regulatory reporting rules can be 
configured to look at any type of criteria but are mainly configured to look at 
Seriousness, Listedness, Causality, and Outcome. Out of these, Listedness and 
Causality can be captured and controlled (using the event assessment section) down to 
an individual license basis.

This granularity allows individual license holders to override the normal listedness 
and causality assessment to control the need for submissions to their local regulatory 
authority. Each affiliate could either suppress the need for a report by demoting the 
criteria, or add the requirement for a report by promoting the listedness or causality.

This serves to promote the global reporting automation while maintaining the level of 
individual local affiliate control that is often needed.

AE # Diagnosis AE Term (Associated AEs)

1 Yes agranulocytosis

2 (sore throat)

3 (fever)

4 (neutropenia)

5 Somnolence

Note: To obtain an assessment of the adverse event, the product 
must be in the company's suspect product and the event must be 
encoded.
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5.1.5.3 Event Coding Section
The Event Coding section enables you to enter information about the event. The 
following is an illustration of the Event Coding section.

The following table lists and describes the fields in the Event Coding section.

5.1.5.4 Seriousness Criteria Section
The Seriousness Criteria section enables you to identify how serious the event was. 
For example, did the result in death or was it life threatening. The following is an 
illustration of the Seriousness Criteria section.

Seriousness Criteria Fields and Field Descriptions
The following table lists and describes the options in the Seriousness Criteria section.

Field/Control Name Description

Body System/SOC Displays the body system or System Organ Class. This item is 
automatically entered from the event dictionary that is used and it 
cannot be edited.

Lower Level Term Displays the ART code. If you have appropriate access rights, click 
Encode to view the associated coding dialog.

Preferred Term Displays the preferred term. This item is automatically entered from the 
event dictionary that is used and it cannot be edited.

Preferred Term Code Displays the preferred term code. This item is automatically entered 
from the event dictionary that is used and it cannot be edited.

High Level Term Displays the High Level Term when the MedDRA coding dictionary is 
used. This item is not displayed when event encoding is done using the 
WHO-ART dictionary. This field cannot be edited.

High Level Group 
Term

Displays the high-level group term when using the MedDRA coding 
dictionary. This field is not shown when coding with WHO-ART. This 
field cannot be edited.
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5.1.5.4.1 Entering Death Details  Use the following procedure to enter details about a 
death.

1. Select the Death check box under Seriousness Criteria.

2. The form for Event Death Details appears.

3. Enter information for the items in the form.

4. Click OK to save the entered Death Details.

The following table lists and describes the fields in the Event Death Details section.

5.1.5.4.2 Entering Hospitalization Details  Use the following procedure to fill out the 
Hospitalization Details form.

To complete the Hospitalization Details form
1. Select the Hospitalized check box under Seriousness Criteria.

2. The form for Hospitalization Details appears.

Field/Control Name Description

Death Displays the Death Details dialog

Note: If you un-check the Death option in the Seriousness Criteria, 
you are required to confirm the deletion of the death details.

Hospitalized Displays the Event Hospitalization dialog.

Medically Significant Select this check box to display the seriousness as medically significant.

Life-threatening Select this check box to display the seriousness as life-threatening.

Disability Select this check box to display the seriousness as a disability.

Intervention 
Required

Select this check box to display the seriousness as requiring 
intervention.

Congenital Anomaly Select this check box to display the seriousness as a congenital anomaly.

Other Select this check box to enter explanatory text. It is mandatory to enter 
text, specifying the Other Seriousness Criteria.

Field/Control Name Description

Death Date Enter the date of death. You can enter a partial date if the exact date is 
unavailable.

Autopsy Done? Make the appropriate selection.

Cause of Death Enter a term to describe the cause of death. Click Encode to display the 
associated encoding dialog.

Autopsy Results 
Available?

Make the appropriate selection.

Autopsy Results Enter Information about the autopsy results.

Note: When Seriousness criteria Death is unchecked, the system 
displays a message Do you wish to delete the Death Details?.On 
confirming, the Death date (NF or date) and Autopsy details are 
cleared .
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3. Enter information for the items in the form.

4. Click OK to save the entered Hospitalization Details.

The following tables lists and describes the fields in the Hospitalization Details form.

5.1.5.4.3 Nature of Event Section  The Nature of Event section enables you to identify the 
nature of the event from the drop-down list. You can add a maximum of 50 such 
Nature of Event rows.

Field/Control Name Description

Hospital Name Enter the hospital name associated where the adverse event occurred.

City Enter the city in which the hospital is located.

State Enter the state in which the hospital is located.

Hospitalization Start 
Date

Enter the first date of the patient's hospitalization associated with this 
adverse event. If the exact date is not available, you can enter a partial 
date in this field.

Hospitalization End 
Date

Enter the last date of the patient's hospitalization associated with this 
adverse event. If the exact date is not available, you can enter a partial 
date in this field.

Duration of 
Hospitalization 

This field is automatically calculated by the system, based on the start 
and end dates entered. This field is calculated using 24-hour 
increments. You can also manually enter the number of days the patient 
was hospitalized.

Event caused initial 
hospitalization

Select this check box if the event is associated with the initial 
hospitalization of the patient.

Event prolonged 
hospitalization

Select this check box if the event prolonged hospitalization.

Discharge summary 
available

Select this check box if a discharge summary is available.
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5.1.5.4.4 Details Section  This section enables you to enter notes related to the event. If 
Reported Causality is entered when the case is booked-in, the system automatically 
transfers it to this field. The following is an illustration of the Details section.

5.1.5.5 Event Assessment
The Event Assessment tab enables you to capture causality and listedness information 
for a case. All encoded events in the case are compared with the listed events for 
company products (agents) associated with the case. The following is an illustration of 
the Event Assessment tab.

Event Assessment Tab Fields and Field Descriptions
The following table lists and describes the fields on the Event Assessment tab.

Field/Control Name Description

Recalculate Refreshes the Event Assessment section with the newly entered data if 
new suspect products or events are entered, or the Event Relationship 
is modified.

Product This field is populated when events are entered in the Products tab and 
is displayed in the following format:

■ First Line - Product Name

■ Second Line - Generic Name

Causality as 
Reported/Source

This field provides the source of causality as reported such as 
Investigator, MAH, Healthcare Professional, and so on

Method This field provides the method used for causality determination.

Result This field indicates the result of the causality as reported.

Causality as 
Determined/Source

This field provides the source of causality as determined. 

Method This field provides the method used for As Determined Causality.

Result This field indicates the result of As Determined Causality.

Other Causality / 
Source

This field specifies the source of other causality.

Method This field provides the method used for other causality.

Result This field indicates the result of other causality.

Event This field is populated when events are encoded and are displayed in 
the following format:

■ First Line - Event PT (Verbatim)

■ Second Line - LLT
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5.1.5.5.1 Filtering in the Event Assessment Tab  The following table lists and describes 
how the system filters each field on the Event Assessment tab.

5.1.5.5.2 User Actions on the Event Assessment Tab  The following table list user actions 
and the results of those actions.

D/S Displays the Diagnosis/Symptom details by D or S in line with the 
Events.

Seriousness Severity 
Duration

Displays the Seriousness, Severity and the Duration of the Event.

Datasheet Displays the datasheet(s) for the agent.

License Displays the license(s) for the agent.

As Determined 
Listedness

Indicates whether the system found the event on the datasheet for this 
product.

Field/Control Name Description

Product The product filter drop down list contains all products listed in the 
event assessment. The user can filter on all the products which are 
present in the Event Assessment dialog.

Event Contains a drop down of values of distinct Event PT. The user can filter 
on all the products which are present in the Event Assessment dialog.

D/S Contains a drop down values of D for Diagnosis or S for Symptoms.

Datasheet Contains a drop down of values of distinct Datasheets.

Licenses Contains a drop down of values of distinct Countries of the Licenses.

Note:  Only the assessment rows that match the selected criteria 
display in the filtering results.

User Action Result

Click Datasheet 
column's icon

The system does the following:

■ Displays the license view

■ Displays the datasheet view

■ Displays the License column

■ Enables the icon for the License column

Click Product Name 
link

Displays the name for the selected product

Click Event 
Description link

Displays the Event Information for the selected event

Click License 
Description link

Displays the license description as defined in the License Configuration

Click Datasheet 
Description link

Displays the first 1000 terms in the datasheet. Click Print to view all the 
terms and click Export to export all the labeled terms to an Excel file in 
a single column with column header as Labeled Terms.

Field/Control Name Description
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5.1.5.6 Product-Event Details Tab
The Product-Event Details tab enables you to capture causality information for a case. 
The following is an illustration of the Product-Event Details tab.

Product-Event Details Tab Fields and Field Descriptions
The following table lists and describes the fields on the Product-Event Details tab.

Field/Control Name Description

Product This field is populated when events are entered in the Products tab and 
is displayed in the following format:

■ First Line - Product Name

■ Second Line - Generic Name

Causality as 
Reported/Source

This field provides the source of causality as reported such as 
Investigator, MAH, Healthcare Professional, and so on

Method This field provides the method used for causality determination.

Result This field indicates the result of the causality as reported.

Causality as 
Determined

This field is populated automatically, along with the information 
entered in the Reported Causality field.

Other Causality 
Source

This field defines the source of causality calculation.

Event This field is populated when events are encoded and are displayed in 
the following format:

■ First Line - Event PT (Verbatim)

■ Second Line - LLT

Most Important 
Diagnosis? 

Select Yes or No.

Event more 
specific/severe than 
PT?

Select Yes or No.

Onset from First 
Dose 

This date is defined as the earliest regimen start date to Onset, and is 
completed automatically.The Date calculation based on the Case Form 
Calculation for Inclusive or Exclusive.

Onset from Last Dose This date is defined as the latest regimen stop date to Onset, and is 
completed automatically.The Date calculation based on the Case Form 
Calculation for Inclusive or Exclusive.

Total Dose to Event This value is calculated automatically, based on daily dose and 
duration.

Units Units are provided automatically based on the dosage units entered.

Action Taken Select the appropriate term from the drop-down list.

Other This value can be entered only when the Action Taken is Other.

Dechallenge Results Select the appropriate option.

Rechallenge Results Select the appropriate option.
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5.1.6 Analysis Tab
The Analysis tab enables you to generate or view a narrative description of the case, 
together with other notes. In addition, it also enables you to enter information required 
for generating the MedWatch 3500A, BfArM, and AFSSaPS reports.

The typical users of this tab are responsible for:

■ Making a medical assessment of the case

■ Approving the case for completeness and accuracy.

The following is an illustration of the Analysis tab.

5.1.6.1 Case Analysis Section
The Case Analysis section of the Case Analysis tab enables you to enter narrative 
information about the adverse event. The following is an illustration of the Case 
Analysis section.

Event Occurred as a 
Consequence of 

Select the appropriate option.

Term Select the appropriate option.

Field/Control Name Description
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Case Analysis Fields and Field Descriptions
The following table lists and describes the fields in the Case Analysis section of the 
Case Analysis tab.

5.1.6.2 Using Auto Narrative Templates
You can select an Auto Narrative template for the Narrative, Case Comment, 
Abbreviated Narrative, Company Comment, and Evaluation in light of similar events 
in the past.

To generate or add narrative templates
1. Click the button to view the Custom Auto Narrative Templates dialog.

2. Select the required Autonarrative from the list.

3. Click Append to append this Autonarrative to the existing narrative.

Field/Control Name Description

Narrative Click Generate to generate an auto narrative.

This feature is configured by the Administrator.

If you are not utilizing the auto narrative feature, enter the narrative 
here.

The narrative is printed on expedited reports.

Case Comment You can enter comments in this area. If you are not permitted to edit the 
auto narrative, you can use this field to provide additional details 
important to the interpretation of the case. Comments appear on certain 
expedited reports.

Abbreviated 
Narrative

Enter brief comments in this field. This item maps only to the PSUR 
report.

Local Evaluator 
Comment

Enter the comments provided by the local evaluator.

Company Comment Enter comments in this area. This information does not appear on 
expedited reports.

Evaluation in light of 
similar events in the 
past

Enter an evaluation comment that takes in to consideration similar 
events that have occurred in the past.
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4. Click Append if this is the first narrative being added to the text area.

5. Click Replace to replace the existing narrative with the selected narrative.

5.1.6.2.1 Viewing Differences in Case Narratives  The system enables you to view the 
differences in case comments from previously locked versions of the case. To view 
these differences, click the Show Difference button in the Case Comments section of 
the Analysis Tab.

When you choose to view the differences in the two narratives, the system does the 
following:

■ Displays the differences in red with a strike out and a yellow highlight.

■ Displays additions to the narrative in black with green highlights.

■ The Narrative is read-only and you cannot modify it.

■ Use the zoom dialog to adjust the font size.

■ The system displays the last revision number of the case and date and time stamp 
in the following format:

■ (Last revision # X as of YYYY MMMM)

where:

■ The system disables the button if there is no previously locked version of the case.

■ This function is also available on the Medical Review dialog.

5.1.6.3 Case Summary Section
The Case Summary section of the Case Analysis tab enables you to enter summary 
information about the adverse event. The following is an illustration of the Case 
Summary section.

Note:  You cannot modify the Autonarrative text if the 
Administrator has configured the system to prevent modification of 
the Autonarrative.

If an Autonarrative template has been configured in multiple 
languages, icons representing the languages display above the text 
area.

X Is the revision number of the last case

YYYY Is the date the case was locked

MMMM Is the time the case was locked in 24-hour format.
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Case Summary Section Fields and Field Descriptions
The following table lists and describes the fields in the Case Summary section of the 
Case Analysis tab.

5.1.6.4 Analysis Tab: MedWatch Info Tab
The MedWatch Info tab enables you to enter additional details required for the 
MedWatch 3500A Drug Report. The following is an illustration of the MedWatch Info 
tab.

Field/Control Name Description

Case Serious This list indicates whether the overall adverse event case is serious or 
non-serious. This assessment is automatically performed by the system 
from the Seriousness Criteria of the Events tab. If any of the 
Seriousness Criteria was selected for any event in the Event tab, Yes is 
selected automatically in the list. No is selected if the Seriousness 
Criteria is cleared for all events in the Events tab. You can modify the 
selection after entering a justification, if you have the access rights to do 
so.

Serious Notes A justification for overriding the system determination will be 
displayed in the Notes area. A green dot will appear adjacent to the 
Notes area. Click the green dot to revert to the automatic calculation for 
seriousness or to view the overriding notes.

Company Agent 
Causal

The system automatically determines this value from the As 
Determined causality in the Event Assessment section. This field is 
displayed as Yes if the As Determined causality is Yes and vice versa. If 
the As Determined causality is Unknown, this field will be Yes.

Case Causal Notes A justification for overriding the system determination is displayed in 
the Notes area. A green dot is displayed next to the Notes area. Click 
the green dot to revert to the automatic calculation for seriousness or to 
view the overriding notes.

Listedness 
Determination

The value for this field is calculated from the Event Assessment section 
in the Events tab. If any row there shows Unlisted under the Listed 
column, this value is set to unlisted.

Listedness 
Determination Notes

A justification for overriding the system determination is displayed in 
the Notes area. A green dot appears adjacent to the Notes area. Click 
the green dot to revert to the automatic calculation for seriousness or to 
view the overriding notes.

Case Outcome The value for this field is also calculated from the Events tab. If the 
outcome for any event is Fatal, the case outcome is set to Fatal. If the 
case outcome is changed here, that change is not made to the event 
outcome in the Events tab.

Company 
Diagnosis/Syndrome

The company diagnosis or syndrome is entered in this field.

Notes A justification for overriding the system determination is displayed in 
the Notes area. A green dot is displayed adjacent to the Notes area. 
Click the green dot to revert to the automatic calculation for seriousness 
or to view the overriding notes.



Case Form Functions

Case Form 5-76

MedWatch Info Tab Fields and Field Descriptions
The following table lists and describes the fields on the MedWatch Info tab. Be aware 
that the values in the Form section column refer to specific sections of the MedWatch 
3500A Drug Report form.

Form Section Field Description

B1. Adverse Event / 
Product Problem

Select the applicable check boxes.

Select Adverse Event when a product is suspected to have caused an 
adverse outcome in a patient.

Select Product Problem when the defect or malfunction in the product 
could lead to a death or serious injury. Select both check boxes if a 
malfunction or product problem caused a death or serious injury.

C9. Suspect 
Medications (NDC#)

Enter the National Drug Code if you have selected the Product Problem 
check box.

F1. User Facility or 
Importer

Indicate whether this report is from a user facility or an importer. You 
can suppress printing of Block F of the MedWatch 3500A report by 
selecting Suppress Block F Printing.

F2. UF/Dist report 
number

Consider UF / 
Importer data from

Enter the complete number of the report exactly as entered in the upper 
right corner of the front screen.

Select User Facility or Importer information from Case Form of from 
Reporting Destination.

F3. User facility or 
Importer Name

 Address1/Address 
2/City / State/ 
Country/Postal code

Enter the full name and address of the user facility or distributor 
reporting site.

F4. Contact person

Sal/First 
Name/MI/Last 
Name

Enter the full name of the medical device reporting (MDR) contact 
person. This is the person who is designated as the device user 
facility/distributor contact for this requirement. The FDA will conduct 
its MDR correspondence with this individual. The contact person may 
or may not be an employee of the facility. However, the facility and its 
responsible officials will remain the parties ultimately responsible for 
compliance with MDR reporting requirements.

F5. Phone number Enter the phone number of the medical device reporting (MDR) contact 
person.
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5.1.6.4.1 Guidelines to Selecting G3 Report Source Checkboxes  The following table 
provides information about the conditions that govern when a specific check box 
should be selected.

F6. Date aware of 
event

Enter the date that the user facility's medical personnel or the 
distributor became aware that the device may have caused or 
contributed to the reported event.

F10. FDA codes 
Patient

FDA Device Codes

Click the first row and column of the FDA Patient and Device Codes 
section and then click Select. You can enter up to six FDA Patient 
Codes. If the entered code is not present in the FDA Codes list, it is 
erased.

F11. Report sent to 
FDA

Select this check box if a report has been sent to the FDA. If you select it, 
enter the date when the report was sent to FDA.

F12. Location where 
event occurred

Select the location of the actual occurrence of the event.

F13. Report sent to 
mfr?

Select this check box if a report has been sent to the manufacturer. If 
you select it, enter the date when the report is sent to manufacturer.

G3. Report Source Select the Report Source check boxes as applicable, to match all report 
sources specified with the Reporter Type.

See the following guidelines for selecting the check boxes.

G5. PLA# Pre-1938 / 
OTC Product

Enter the PLA number.

If the product pre-dates 1938, select Pre-1938.

If the product is an over-the-counter product, select OTC product.

If this condition is true
Select the following check 
box

Country of Incidence is not USA. Foreign

Report Case type is configured to contain cases from 
Literature.

Literature

Report Case Type is configured to contain cases from Clinical 
Trials.

Study

Any reporter with Health Professional set to Yes Health Professional

Any Reporter Type is selected as Company Representative. Company Representative

Any Reporter (Primary or Other) exists in a case with a 
Reporter Type of Other, If the selected Report Type is a 
Regulatory Authority (text value) within the Argus Case, the 
Other check box should be checked and the text Regulatory 
Authority should be entered in the text box.

Other

Any Reporter Type is selected as Consumer AND none of the 
reporters is identified as Health Care Professional.

Consumer

Note: The User Facility and Distributor check boxes must be checked 
manually.

Enter the appropriate text if you have selected Other as a report 
source.

Form Section Field Description
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5.1.6.5 Analysis Tab: BfArM Info Tab
Use the BfArM Info tab to enter information required for the BfArm Report. The 
following is an illustration of the BfArM Info tab.

To enter data for the BfArM report
1. Open the BfArM Info tab.

2. Select the choices that apply to the patient from the items in the form.

3. If you do not know if a particular condition applies for the patient, select Unk.

5.1.6.6 Analysis Tab: AFSSaPS Info Tab
Use the AFSSaPS Info tab to enter the imputability assessment information for the 
suspect product along with the Adverse Events. The following is an illustration of the 
AFSSaPS Info tab.

AFSSaPS Info Tab Fields and Field Descriptions
The following table lists and describes the fields on the AFSSaPS Info tab.

Note: If any of the relevant items are entered in the Current Medical 
Status form in the Patient tab, the system automatically enters them 
here. If you change any of those items in the BfArM Info tab, the 
system will not enter the data in the Patient tab.
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5.1.7 Activities Tab
The Activities tab presents detailed information about the contact log, routing 
comments, action items, and Case Lock/Closure.

The following is an illustration of the Activities tab.

5.1.7.1 Activities Tab: Contact Log Section
The Contact Log section of the Activities tab enables you to:

Track correspondence related to individual cases

Field/Control Name Description

Event Displays included terms for all events.

Product Enter the suspect product. You cannot enter a concomitant 
product.

Chronology Select a Chronology code. The fixed set of values is C0, C1, C2, 
and C3. Click the icon to select the Time to onset, 
Readministration and Drug Stopped Values.

The user's selection auto-calculates the Chronology for the 
Product - Event combination.

Semiology Select a Semiology code. The fixed set of values is S1, S2, and 
S3.

Click the icon to select the Semiology Outcome, 
Complementary Test, and Other Explanation.

The user's selection auto-calculates the Semiology for the 
Product - Event combination.

Bibliography Select a Bibliography code. The fixed set of values is B0, B1, B2, 
and B3.

Imputability Imputability Calculation:

~ Select from one or more of the following checkboxes:

■ Poursuite de l'étude sans modification du protocole

■ Poursuite de l'étude avec amendement au protocole

■ Arrêt de l'étude

■ Arrêt du développement du produit

■ Autres

The text box after Autres supports fifty characters. If the 
Autres checkbox is not checked, the field is disabled.

You can click Copy to Local Evaluator Comment to copy 
imputability values to the Local Evaluator Comment field and 
place the imputability text-equivalent at the beginning of the 
text that currently exists in the field. Copy to Local Evaluator 
Comment is visible only if the language for the "Local 
Evaluator Comment" field is French.

Future Actions Enter a text description for future actions.
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Display scheduled letters

The following is an illustration of the Contact Log section of the Activities tab.

The following table lists the different icons that appear for letters:

Contact Log Fields and Field Descriptions
When using the Contact Log section, be aware of the following:

The number displayed in parenthesis in the header of each section - Contact Log, 
Action Item, Routing Comments, Case Lock/Archive - displays the total number of 
entities within the section.

You can choose to view All Action Items or only Open Action Items, which display 
all the Open Action items within the case. By default, All Action Items are displayed.

You can sort Action Items by clicking on the column headers.

The system remembers the sort order on for the duration of the case.

The following table lists and describes the fields in the Contact Log section of the 
Activities tab.

Icon Description

Letter envelope icon 
with a Blue Arrow to 
the right 

Clicking on the email button opens a message editor.

Double Overlapping 
Letter Envelope Icon

Indicates Letter scheduled awaiting to be sent. 

Letter Envelope icon 
with a Red 
Exclamation Mark

Indicates that the letter is overdue (Date Open > System Date)

Letter Envelope icon 
with a Green 
Exclamation Mark

Indicates mail success status.

Field/Control Name Description

Date The date is automatically inserted by the system when a letter is 
scheduled or generated through the Letters menu. You can enter the 
date on which the letter is manually scheduled or generated. 

Click the letter icon to open the Letter Preview dialog. This allows you 
to view a letter or to modify it if it has not been sent already.

Code Select from a list of values to set the contact code for this entry. The 
Administrator can adjust the information in this list.

e-mail button Click to send an e-mail message.

Description Enter a brief explanation for the letter, for example, "Initial Letter," or 
the details of a phone conversation.

New Letter button Click this button to generate a new letter.
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5.1.7.1.1 Generating Letters  You can generate letters from the Contact Log section. 
When generating letters, be aware of the following:

■ The placeholders for the original letter template can be replaced by information 
that is specific to the current case.

■ A letter is only added to a search if the Correspondent check box is checked.

■ The Administrator can configure the system to generate letters automatically and 
to schedule them for a specific number of days after receiving details of an adverse 
event. For example, the system might schedule an Initial Response Letter to be 
sent the day after an adverse event is received. Auto letter scheduling is triggered 
when a case is initially saved.

■ Letters cannot be auto-generated unless the "Date" [contact log date] is reached, to 
ensure that the latest information for the case has been updated to the letter.

■ If the Primary Reporter is marked as a correspondence contact, the system sends 
Auto-scheduled letters are sent to the Primary Reporter. Otherwise, the letter is 
sent to the first correspondence contact.

■ Auto-scheduled letters appear in the Contact Log section of the Case Form. You 
can view or print them by double clicking the letter icon. You can also edit letters 
that have not been sent. The system does not automatically send letters. You must 
send or remove letters manually.

■ In addition to auto-scheduling letter, you can also configure auto action items, 
which prompt you to follow-up with a correspondent after a letter has been 
scheduled and sent. Auto action item scheduling is triggered once the sent date 
has been entered for a letter. Auto action items appear in the Action Items section 
on the Case Form and in the Action Items tab of the Worklist.

■ The system uses the following naming convention to when saving letters in the 
Uploaded letters folder:

XXXX_YYYY.RTF

where:

■ The system replaces all special characters in the case number with an underscore ( 
_ ) character.

■ The CFG_PLACEHOLDER SQL limit is 4000 characters rather than 1000.

Group/User Select a group responsible for the Contact item. From the list below, 
select a user from the selected group who will be responsible for the 
action. The Contact Item will appear in the Worklist for selected user. If 
"Any" is chosen as the group, the Action Item appears in all the users' 
Worklist. The Administrator can adjust the information in these lists.

Date Sent The date is automatically inserted when a letter is sent through the 
letter menu. You can also manually enter the date the letter was sent. If 
this field is completed, the letter will become read-only.

XXXX Is the current case number

YYYY Is the current letter numbering format (i.e., date and time the letter was 
generated)

Field/Control Name Description
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To create an RTF document with placeholders, you need to configure it through Argus 
Console > Code List > Letter Configuration. The details of this configuration are 
available in the Argus Console Guide under the Configuring letter (RTF) templates 
section.

The following image displays the meaning/status of various letter icons:

Use the following procedure to generate a letter:

To generate a letter
1. Go to Contact Log in the Activities tab and click New Letter.

2. The Custom Letter Templates dialog opens.

3. Select the required letter template from the list and click OK to open the letter in a 
separate window.
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4. Make the necessary changes to the letter text.

5. Select File-->Save to save the changes.

6. If you modified the letter, select Yes.

This attaches the letter to the Case Form by browsing to the location where you 
saved the changes.

7. After saving the letter, the system displays it in the Contact Log section of the 
Activities tab.

8. The system creates an action item for following-up on this letter in the Action 
Items section of the Activities tab.

5.1.7.1.2 Scheduling Action Items for Letters  When specifying or changing the Date Sent 
field in a letter, you can schedule an action item if you wish to do so.

■ If an action item is not specified, the field is blank.

■ Any Action Item can be updated on the screen immediately after a case has been 
saved.

■ Unless the Action Item has already been marked as completed, each time the Date 
Sent field is changed for a letter, the corresponding action item (if one exists) is 
also updated with a new Due Date of Date Sent of the Letter and the number of 
days specified for the Action in the Letter configuration

5.1.7.1.3 Opening a Message Editor  To open a message editor
1. Click the letter icon to open the message editor.

2. The system opens the message editor.

The following table lists and describes the fields in the dialog box
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5.1.7.2 Activities Tab: Action Items Section
The Action Items section enables you to view or enter details of action items for the 
case and to assign responsibilities for actions. The following is an illustration of the 
Action Items section.

5.1.7.2.1 Action Items Fields and Field Descriptions  The following lists and describes the 
fields in the Action Items section.

Field/Control Name Description

To Displays the e-mail address specified for the Primary Reporter in the 
Case Form.

You can edit this field.

From Displays the email address specified in the Return Email Address in 
Argus Console>Code Lists>Letter Configuration. You can edit this field 
also.

Subject Displays the Case Number and the Description of the Contact log.

You can edit this field.

Send Enables you to send the e-mail to the intended recipient.

Field/Control Name Description

Date Open Enter the date the action item was created. Open action items appear in 
the Worklist of the user who is responsible for the action item. They 
also appear in the Open Action Items Report.

Code Select an Action Item code from the drop-down list. This will display 
the description of the selected Action Item Code. The Administrator 
can adjust this list.

Description Selecting an Action Item code automatically enters information into this 
field. The text can be modified as required. The Administrator can 
adjust this list.

Group/User Select a group responsible for the Action Item from the given 
drop-down list. From the drop-down list below this, select a user from 
the selected group who will be responsible for the action. The Action 
Item will appear in the Worklist for the selected user. If "Any" is chosen 
as the group, the Action Item appears in all the users' Worklist. The 
Administrator can adjust these lists.

Due Enter the date on which the action item is to be completed.

Completed Enter the date on which the action item was completed. A red border 
indicates a completed action item while a green border indicates an 
incomplete action item. 

Sent in Letter Identifies that the Query Type Action item has been sent as a part of the 
Letters. Displays only for those Action Items that are configured as 
"Query Action" in Console ' Action Type code list.
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5.1.7.3 Activities Tab: Routing Comments Section
The Routing Comments section displays workflow routing information and 
comments for the case. It also contains a read-only sub-section on Case 
Locking/Closure. The following is an illustration of the Routing Comments section.

Routing Comments Fields and Field Descriptions
The following table lists and describes the fields in the Routing Comments section.

5.1.7.3.1 Routing Cases  If the case meets the routing rules specified by the 
Administrator, you can use the Case Routing dialog box to route a case to the next 
workflow state. When using the Routing Forward Cases function, be aware of the 
following:

■ Non-Enterprise Workflow managers cannot view all the Workflow States below 
the line if the Workflow States are assigned to Sites in the Workflow Configuration.

■ Only Enterprise Workflow managers have access to all sites for routing cases 
ahead in the Workflow.

■ If the Workflow state does not have defined site, all workflow managers can see it.

To route a case
1. Click Route in the Activities tab of the Case Form to open the Case Routing 

dialog box.

2. From the Route to Next State drop-down list, select the state to which you would 
like to route the case.

If only one workflow state can be selected for the Next Route state, that state can 
be selected by default in the Route to Next State field.

3. From the Route to User drop-down list, select the user or user group to route the 
case to.

4. Enter the routing comments in the Comments field.

OR

Click Select to select a comment from a list of pre-defined routing justifications.

Field/Control Name Description

Date Displays the date the case was routed to a new workflow state. This 
field is automatically generated when a case is routed.

User Displays the name of the user who routed the case. This field is 
automatically generated when case is routed.

Comment Displays the routing comment.

Route button Routes the cases.

Return button Returns the case to the previous state.
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Routing Comments Log and Case Print
Local Lock/Unlock details are displayed as part of the Routing Comments log in Case 
Form > Activities tab.

It displays the Date of local lock/unlock, User who performed the local lock/unlock 
similar to the existing global lock functionality. The text "Case Locally Locked for JP" 
or "Case Locally Unlocked for JP" is populated before the user added comments in the 
Local Lock screen, corresponding to the Local lock or unlock action. Note "JP" is the 
standard A2 country code for the country Japan defined in the Argus Console > 
Countries code list.

When a case is globally/locally locked or globally/locally unlocked at the same time, 
only one entry is added to the Routing Comments log.

The text "Case Globally and Locally Locked for JP" is added for single lock operation.

The text "Case Globally and Locally Locked for JP" is added for sngle unlock 
operation.

The system records the corresponding routing comments described above even in 
scenarios where the system user (e.g., AGservice) performed the local lock/unlock 
action.

To select text from the pre-define list of routing justifications
1. Click on the Select button in the Case Routing dialog to open the Routing 

Justification dialog box.

2. Select the required justification from the justification list displayed under Select a 
standard justification for this field. The system highlights the selected row.

3. Click OK.

4. The system closes the Routing Justification dialog box and displays the selected 
justification text in the Comments field in the Case Routing dialog box.

5. Click OK to route the case.

5.1.7.3.2 Returning Cases  If necessary, you can return a case to its previous workflow 
state.

To return a case to its previous workflow state
1. Open the case.

2. Click the Return button in the Activities tab of the Case Form.

3. When the system opens the Case Routing dialog box, enter your password in the 
Password field.

4. From the Route to User drop-down list, select the user or group the case needs to 
be returned to.

5. Enter any routing comments in the Comments field.

6. Click OK to return the case to its previous workflow state.

Note: The system displays disabled users in the user drop-down list 
in alphabetical order with an asterisk (*) at the end. You can view the 
total number of times the case has been routed in the header section, 
excluding the blank rows.
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5.1.7.4 Activities Tab: Case Lock/Close Section
The Case Lock/Close section enables you to lock a case, unlock a locked case, and 
formally close a case. You must lock the case before you can generate a report. The 
following is an illustration of the Case Lock/Close section on the Activities tab.

When closing a case, be aware of the following:

■ If the Auto-schedule Later checkbox for expedited reports is checked and you try 
to archive a case, the system displays the following message:

Case xxxx cannot be closed while Auto Schedule Later is checked. Please uncheck 
the option for the Auto Schedule Later option on the Regulatory Reports tab or 
wait for the Report Scheduling to complete before attempting to archive the case.

■ The system displays this same message when you close single or multiple cases 
from the New/Open dialog on the Worklist.

Case Lock/Close Fields and Field Descriptions
The following table lists and describes the fields in the Case Lock/Close section of the 
Activities tab.

Field/Control Name Description

Case Status Enables you to unlock, lock, or close a case after entering the 
appropriate user information.

■ Unlock -- Enables you to unlock a case if you have the appropriate 
permissions. To unlock a case, enter the password you use to log 
on to Argus Safety.

■ Lock -- Enables you to lock a case if you have the appropriate 
permissions. The current date will be used for the lock date. To 
lock the case, enter the password you use to log on to Argus Safety 
in the Case Locking dialog box.

■ Close -- Enables you to close a case if you have the appropriate 
permissions. To close the case, enter the password you use to log 
on to Argus Safety in the Case Closure dialog box. 

Note: Auto-archiving a case is not allowed if any local or global 
reports are pending for generation. If a user tries to close a case for 
which Local Reports have not yet been submitted (through this 
Case Status field here), the application will display a message that 
the case cannot be closed due to reports needing submission.
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Local Locking
When a user clicks on the Local Lock icon on a case that has been Global Locked but 
is pending Local Lock for Japan, the system displays a pop-up dialog to validate the 
user who attempts to perform the local lock on the case.

Enter the password and notes to perform the local lock on the case.

When a user clicks the Local Lock icon on a case that has already been Local Locked 
for Japan, the system checks that the common profile switch "Enable Local Unlocking" 
for the current enterprise is set to "Yes". If this option is set to "No", it displays a 
message that the "Local Unlocking feature is not enabled".

If the option is set to Yes, first check if the case has any Local Japan report, that are 
pending generation, and displays a warning message. 

If there are no Local Japan report that are pending generation, the system prompts the 
users with Case Local Unlock dialog on whether they want to proceed with Local 
Unlock.

On clicking Yes for Local Unlock, the system validates the user again.

After the user has been validated, the system stops any local Japan report that is 
pending generation from being generated and enables all the Local Fields for editing.

The following table lists the different lock statuses in the application and their 
meanings/descriptions:

Closure Date Date on which the case was locked or closed. If a locked case is being 
viewed by a user, any other user who tries to access the same case will 
have read-only access to the case.

■ Cases should be closed only after all action items for the case are 
complete, all expedited regulatory reports have been submitted, 
and all the expected follow-up information has been received. If a 
closed case that is closed requires modification, the case must be 
re-opened by using the password.

■ A case may be either locked or closed, but not both. A locked case 
will be moved from the locked state to the closed state without 
having to unlock first.

■ Note: Case closure should not be confused with closing the Case 
Form. Closing of the Case Form refers to removing the current 
Case Form from the screen.

Lock or Closed By Displays the name of the user who locked or closed the case.

Notes Displays relevant information about the case lock or closure.

Lock Status with Icon Description

Global Locked Denotes a locked case that does not have local reporting needs.

Global Unlocked Denotes an unlocked case that does not have local reporting 
needs or where the Local PRPT case is both globally and locally 
unlocked.

Field/Control Name Description
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5.1.7.4.1 Locking a Case  To lock a case:

1. In the Case Lock/Close section of the Activities tab, click Lock.

2. The system opens the Case Locking dialog box.

3. Enter your Argus Safety password in the Password field.

4. Enter any notes in the Notes field.

5. Click OK.

6. The system displays the locking notes in the Notes field of the Case Lock/Close.

After a case has been globally locked and when a local user (an Argus J user) opens 
that case, the application allows the local user to enter local data, as follows:

All the local fields remain editable for the Argus J user.

All the existing case form fields and tabs that remain editable after global lock retain 
the same behavior (irrespective of English or local users).

Any operation that update the global value such as Re-arrange, Add, Delete, Up / 
Down buttons, Relationships, Copy Japanese to English button, Lab data import is not 
allowed, retaining the existing behavior on lock. One exception to this is Case 
Classification field - the Add and Delete buttons shall remain available.

The Copy English to Japanese buttons allow the user to copy information from English 
to Japanese data entry. Note that no global values shall be updated with copy action.

On global lock, all the qualifying reporting rules will be executed as follows:

All the qualifying Global (i.e., non-Japan) and Japan Local reports will be scheduled.

The Global (i.e., non-Japan) reports shall be generated/transmitted as per the existing 
functionality.

However, the Japan Local reports cannot be generated before local lock is performed.

Global Locked and Local 
Locked 

Denotes a Local PRPT case that is locked at both global and local 
levels for all local countries for the case.

Global Locked and 
Pending Local Lock 

Denotes a Local PRPT case that is locked global but pending 
local lock for any local country for the case.

Note:  To unlock a case from the Locked/Archived state, select the 
Unlocked value from the Case Status drop-down list. This will 
display the Archived Case or Case Lock dialog. The dialog box 
requires you to specify your password and the reason for unlocking 
the case. The case is unlocked/archived after you enter this 
information.

Lock Status with Icon Description
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One Step Global and Local Lock
In some scenarios, when a Japanese user enters a domestic case, both the local data 
entry as well as English translation may happen before the global lock, which would 
necessitate the Global and Local Lock be done in a single step by the Japanese user. 

In order to support this scenario and allow the Argus J user to perform the Global 
Lock and Local Lock at the same time, the system has been enhanced as follows:

When a local user (Argus J user in this release) performs a global lock, the system shall 
display the existing Case Locking dialog but enhanced with an option to perform 
Local lock additionally for a Local PRPT case. Note that this functionality shall be 
applicable for global case locking done from any place via the application’s UI 
including Case Form, E2B, Incoming Review, etc. Note this is not applicable to LAM as 
this feature is applicable only to the Argus J user type.

This checkbox appears only for a Local PRPT case, when the user has Allow Local 
Locking configuration enabled under Argus Console > Access Management > Users.

When the user clicks OK on this screen to perform Global Lock and if the Local Lock 
option is checked, the system shall be enhanced to perform both the global and the 
local lock for the case.

The following table lists the different lock statuses in the application and their 
meanings/descriptions:

5.1.7.4.2 Unlocking a Case  Use the following procedure to unlock a case.

To unlock a case
1. In the Case Lock/Close section, select Unlocked from the Case Status drop-down 

list.

2. When the system opens the Locked Case dialog box:

1. Type your password in the Password field.

2. Type any relevant information in the Notes field.

3. Click OK.

3. When the system opens the Case Unlock dialog box, click one of the following:

■ Significant F/U

■ Non-significant F/U

■ Other

When a user performs global unlock for a case, the system shall check if the case has 
local or global reports in pending generation state (i.e. "scheduled" and "new data 

Lock Status Description

Global Locked Denotes a locked case that does not have local reporting needs.

Global Unlocked Denotes an unlocked case that does not have local reporting 
needs or where the Local PRPT case is both globally and locally 
unlocked.

Global Locked and Local 
Locked

Denotes a Local PRPT case that is locked at both global and local 
levels for all local countries for the case.

Global Locked and 
Pending Local Lock

Denotes a Local PRPT case that is locked global but pending 
local lock for any local country for the case.
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available" states as identified by the configured SQL explained below) or pending lock 
(for Local PRPT case), as explained below:

The checks for reports pending generation are applicable only when DLP_
EXPEDITED_E2B_REPORTS is set to 0 (i.e., DLP is not enabled for Expedited 
Reporting).

The system checks the value returned by running the SQL (if any) configured in the 
existing common profile switch "SQL to prevent case unlock when reports are pending 
generation" under Case Processing (introduced in release 7031).  If the value returned 
is 0 or no SQL has been configured, the system shall allow users to global unlock the 
case without any of the other checks.

If the value returned is greater than 0, the system behaves as follows:

If the Value of Allow forced unlock (Global and Local) is No and the Report status 
(Global or Local) is Pending (i.e. the configured SQL returned a value > 0), the case is 
not unlocked and an error message is shown.

If the Value of Allow forced unlock (Global and Local) is Yes and the Report status 
(Global or Local) is Pending (i.e. the configured SQL returned a value > 0), a warning 
message is displayed. The case is unlocked using the existing "Locked Case" dialog if 
the user selects "Yes" on the warning message.

If the Value of Allow forced unlock (Global and Local) is N/A and the Report status 
(Global or Local) is Generated /Submitted (i.e., the  value from SQL check returned 0 
or no SQL has been configured), the case is unlocked, as per its existing functionality.

This switch functions independent of the "Allow Local Lock" privilege and "Enable 
Local unlocking" privileges. So, for example a local user that does not have "Allow 
Local Lock" privilege but has "Allow forced unlock (Global and Local)" privilege 
would still be able to globally and locally unlock the case on Global unlock.

When a user performs a global unlock for a case that has pending local lock (for a 
Local PRPT case), a warning message is displayed.

When a user performs global unlock for a case that has pending local lock (for a Local 
PRPT case):

If the value of Allow Global Unlock on Pending Local Lock is set to Yes, a warning 
message is displayed. If the user selects No, the case shall NOT be unlocked. If the 
user selected Yes, further checks on reports explained above are implemented.

If the value of Allow Global Unlock on Pending Local Lock is set to No, the case shall 
NOT be unlocked and an error message is displayed.

If the case has both local lock pending and reports scheduled, the pending local lock 
check shall take precedence over the pending report generation check.

This functionality is applicable for case unlocking done from any place via the 
application's UI including Case Form, LAM, E2B, Incoming Review, etc.

This feature is NOT applicable to End of Study Unblinding (EOSU).

Local Report icon in Screens
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5.1.7.4.3 Setting the Focus for a Follow-up Event  After unlocking a case, the system sets 
the focus for significant/non-significant follow-up events as follows:

1. When you click the Significant F/U button on the Case Unlock dialog, the system 
automatically displays the case General tab, checks the Significant check box for 
both drugs and devices (if enabled by the profile switch), and sets the focus on the 
Follow-up Received Date.

Screen: Argus > Case Actions > Open > (Select a Case) > General Tab > General 
Information Section > Follow-ups sub-section (middle of screen).

■ The system checks to determine whether the Significant check box is checked.

■ The system sets the focus on the Follow-up Received Date.

2. When a case is unlocked and you select the Non-Significant F/U button from the 
case unlock pop-up dialog, the system automatically displays the case General tab 
and sets focus on the Follow-up Received Date.

Argus > Case Actions > Open > (Select a Case) > General Tab > General 
Information Section > Follow-ups sub-section (middle of screen)

■ The Significant check box is not checked.

■ Focus is on the Follow-up-Received Date.

■ You can add multiple follow-ups.

Argus > Case Actions > Open > (Select a Case) > General Tab > General 
Information Section > Follow-ups sub-section (middle of screen)

– If you add a single follow-up, the Add button remains available for the 
user to add additional follow-ups.

– Currently, the Add button disappears after the user adds a single 
follow-up. The user must save, close and reopen the case before he/she 
can add an additional follow-up.



Case Form Functions

Case Form 5-93

■ A hyperlink in the follow-ups section enables you to open the link in a 
different dialog box.

5.1.8 Additional Information Tab
The Additional Information tab enables you to attach notes and other items to the 
case. For example, you could attach a fax message that came in as part of the case and 
needs to be scanned and attached or an electronic file received by e-mail. It also 
enables you to set up cross-references to other cases such as links between cases 
referring to mothers and children. The total number of attachments and references 
attached to a case display in the header.

The following is an illustration of the Additional Information tab.

When using the Additional Information tab, be aware of the following:

■ The system shrinks the main widow up to 60% and opens the attachments from 
the Notes and Attachments dialog in a new browser window.

■ The system opens any hyperlinks that appear on the Additional Info tab in a new 
Internet Explorer window if the selected reference is HTTP/URL Reference.

■ When you click the hyperlink and a reference case is present, the system opens a 
case number irrespective of the selected reference type when you clicked the 
hyperlink.

■ If no sites are defined for the attachments classification, the system permits all 
users to view the attachments on the Additional Info tab.

■ The system only permits users who belong to the site defined on the attachment 
classifications to view the attachments.

■ The system filters the attachment classifications based on the sites a user has 
permission to access.

■ The Case Form/Case Listing reports printout hides the row.

■ The system permits Workflow Enterprise to view all attachments across all sites

5.1.8.1 Additional Info Tab Fields and Field Descriptions
The following table lists and describes the fields on the Additional Info tab.
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Field/Control Name Description

Notes and Attachments

Notes and 
Attachments

This section of Additional Info tab provides an option to sort on the 
column headers (similar to Activities tab’s Action Items sorting feature) 
to sort the records based on the fields in Notes and Attachment section.

Classification Select a classification that describes the attachment. The Administrator 
can adjust this list.

Refer to the Oracle Argus Interchange User’s Guide for details about 
Attachment Classification usage in sending attachments in electronic 
reports.

Date The current date is automatically entered in this field. You can also 
enter a date manually.

Incl. Reg. Sub Select this checkbox to merge PDF attachments within the case form. 
The Incl. Reg. checkbox identifies the attachments to be included as an 
appendix to the Expedited Reports. On selecting this checkbox, the 
Expedited Reports - CIOMS I, CIOMS I (Local), US FDA MedWatch 
3500 Drug and 3500 A Device print an appendix page before each 
attachment. This is added to the case, and marked as Inc. Reg. Sub 
checked.

Note: The checkbox is available only if a PDF is selected as an 
attachment.

Literature Reference Select the Literature that is related to the attachment. Attachments that 
have Literature reference are transmitted as in-line attachments for the 
data element C.4.r.2 in E2B(R3) report.

Keywords Enter keywords related to the case or click Select.

Description Enter a description of the attachment.

Attach File Inserts a file attachment into the case. Maximum file size is 4 GB. 

Add Inserts a row for an additional attachment.

Delete Deletes the selected row.

Attach Documentum 
Link

This option is visible only if Documentum is available.

Click Searching for Documentum to search for and attach 
Documentum.

References Type Select a reference type from the list, for example, a parent-child link. 
The Administrator can adjust this list.

ID # Enter the case number of the case that is to be referenced.

Note: Click Select to search for the case that is to be referenced. You can 
also use this field to record the reference number for external cases.

Notes Notes can be entered here for reference.

Select Opens the Case Selection dialog for the selected ID.

Add Inserts a row for an additional attachment.

Field Description

Classification Select a classification that describes the attachment. The 
Administrator can adjust this list.

Refer to the Oracle Argus Interchange User’s Guide for details 
about Attachment Classification usage in sending attachments in 
electronic reports.
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■ It is possible to send different Case Form attachments to different agencies, based 
on the 'Attachment classification' specified to the Receiving Agency in Reporting 
Destination Codelist in Argus Console. Refer to the Argus Console Guide for 
details.

■ After the records in Notes and Attachments are sorted, if the following options are 
invoked without closing the case, sort order is respected in these modules (similar 
to Activities 'Action Items sorting feature):

– Case Form Print

– Medical Review

– Copied Case

5.1.8.2 Searching for Documentum Links

To search for Documentum links
1. Click the Attach Documentum Link button to open the Documentum Lookup 

screen.

2. Enter the desired search criteria as per Type Name, Attribute Name and Search 
String, and click Search.

3. Select the desired link from the row displaying the search results.

4. Click Select to select the link from the list.

5.1.8.3 Attaching Files to a Case
You can attach from 1 to 99 files to a case.

5.1.8.3.1 To attach files to a case  In the Notes and Attachments section of the 
Additional Info tab, click Attach File to open the Attachment dialog box.

1. Click Browse to locate a file attachment.

2. Select the file and click OK.

5.1.8.4 Entering Keywords
You can associate keywords with a case in the Notes and Attachments section.

To attach keywords to a case
1. Go to the Notes and Attachments section and click Select.

Keywords On clicking this column header for the first time, records are 
sorted in the ascending order (alphabetically) of the "Keywords".

Date On clicking this column header for the first time, records are 
sorted in the ascending order (chronologically) of the "Date".

Description On clicking this column header for the first time, records are 
sorted in the ascending order (alphabetically) of the 
"Description".

Note: To view an attachment, click the icon associated with the 
attachment.

Field Description
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2. When the system opens the Attachment Keywords dialog box:

■ Select a keyword from the Select a keyword to add to the list drop-down list.

■ The system displays the selected keywords in the Keywords field.

3. Click OK

5.1.8.5 Attaching References to a Case

To add a reference to a case
1. Locate the References section and click Select.

2. When the system opens the Case Search Criteria dialog box, enter the appropriate 
search parameters and click Search.

3. When the system displays the search results in the Total Number of Rows section, 
select the desired search criteria from the list and click Select to view details about 
the selected case.

5.1.9 Regulatory Reports Tab
The Regulatory Reports tab enables you to:

■ View all scheduled reports

■ Schedule new reports

When a new case is created, there are no reports associated with it. As data is entered 
and the case is saved, the regulatory report scheduling algorithm determines which 
reports, if any, will be required for that case.

The reports determined to be necessary appear in the Regulatory Reports tab. You can 
manually schedule reports via the Reports menu or by clicking the Regulatory Reports 
Tab. You can also add comments to the existing reports. The comment section can also 
be updated to enter the notes for the report even after the report has been submitted.

The following is an illustration of the Regulatory Reports tab.

5.1.9.1 General Usage Information
When using the Regulatory Reports tab, be aware of the following:

■ The case submission date must be on or after the initial receipt date for the case. If 
the submission date is before the initial receipt date, the system displays the 
following message:
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Please enter the Submitted Date greater than the Initial Receipt Date of the Case

■ The system displays the time component for the date generated on the Case 
Form|Regulatory Reports tab using the IE offset of the client machine for the 
display.

■ The system displays the time component for the date generated on the Report 
Details using the IE offset of the client machine for the display.

■ When you manually schedule an expedited report, the system places the word, 
Manual, in the Notes field along with the current notes information.

■ When you manually schedule a report, the system enables you to check "Blind 
Product Study" on the Schedule New Expedited Report dialog box to blind the 
study products if they are in the case.

5.1.9.2 Regulatory Report Tab Fields and Field Descriptions
The following table lists and describes the fields on the Regulatory Reports tab.

Field/Control Name Description

Status The notification log provides a list of reports which have been 
scheduled, generated, or submitted. The following report status are 
available indicated by the icons in the regulatory reports tab:

■ Report has been routed and approved by a user.

■ Report has been routed and disapproved by a user.

■ Report has been scheduled but not saved.

■ Report has been scheduled and saved.

■ Report has been scheduled and generated.

■ Report has been scheduled/generated and it is past its due date of 
submission.

■ Report has been scheduled/generated and submitted.

■ Report has been marked as submission not required by a user.

Seq Displays the sequence (Initial, Follow-up, etc.)

Destination Displays regulatory authority to which the report is to be submitted.

Report Type Displays the type of regulatory report like US IND Summary, BfARM 
Form 643, etc.

License Type Displays license information.

License # Displays the license number.

Generated Displays the date when the regulatory report was generated (if 
applicable). The system date on which it is generated is used as the 
default value.

Local Comment Displays a local comment, if it exists.

Submitted Displays the date the regulatory report was submitted (if applicable). 
The system date on which it is generated is used as the default value. 
This date does not initially appear on the Case Form when submitted. It 
is displayed when the case is re-opened.

Notes Displays notes entered when the report was created.

Due Displays the date the regulatory report is due for submission to the 
regulatory authority (if applicable). This field is auto-calculated based 
on the initial receipt date or on the basis of the most recent significant 
follow-up date. It can also be specified manually by entering the date in 
the Due Date section.
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5.1.9.3 Grouping Regulatory Reports
You can group reports by selecting the appropriate grouping structure from the 
Organized by drop-down list. You can group reports as follows:

■ Report Type/Submit Category/Reporting Destination

■ Report Type/Reporting Destination

■ Report Type/Reporting Group

The numbers in parentheses next to each folder indicate the number of reports in the 
folder.

The following are definitions of the terms used in the reporting structure.

■ Report Type -- Can be either Expedited or Periodic reports. The system generates 
a folder for each type.

■ Reporting Destination contains all defined code list items for Reporting 
Destinations that have at least one report scheduled within the case.

If no reports are scheduled for a defined reporting destination, no folder will be 
created for this destination. All the folders which are the reporting destinations under 
each folder are sorted alphabetically.

■ Pending Reports -- Reports that have not been submitted or are marked as 
non-submitted.

■ Submitted Reports --All submitted reports.

■ Marked as Non-Submit --Reports that have not been submitted.

■ Reporting Group -- Contains all user groups assigned to the scheduled expedited 
or scheduled in the case

5.1.9.3.1 Grouping by Report Type/Submit Category/Reporting Destination  The Expedited 
folder contains the following:

■ Pending Reports by Destination

■ Submitted Reports by Destination

Responsible Displays the name of the user responsible for the report.

Auto Schedule 
button

Initiates Auto-Scheduling of expedited reports according to the 
configuration for this feature, for example, Always, Significant, Manual, 
or None.

Schedule Local 
Reports Only

Allows you to schedule only local reports.

Auto Schedule 
Device button

Schedules regulatory reports, using the Device rules.

Schedule New Report 
button

Schedules a new expedited report.

Auto Schedule Later This item appears if the system is configured for auto-schedule of 
expedited reports using Argus Safety Service. Select this check box 
when the system is about to run the auto-scheduling against this case 
after the case is locked.

Auto Schedule 
Device Later

Select this check box to run the auto-scheduling for only devices.

Field/Control Name Description
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■ Non-Submitted Reports by Destination

The Periodic folder contains single case report forms (MedWatch, VAERS or CIOMS) 
that were generated as part of a Periodic Report.

■ Pending Reports by Destination

■ Submitted Reports by Destination

■ Non-Submitted Reports by Destination

5.1.9.3.2 Grouping by Report Type/Reporting Destination  The Expedited folder contains a 
sub-folder for reporting destinations that have at least one scheduled report.

The Periodic folder contains the single case report form (MedWatch, VAERS or 
CIOMS) generated as part of a Periodic Report are listed in the Periodic section. If no 
report was generated, the system does not create sub-folders.

5.1.9.3.3 Grouping by Report Type/Reporting Group  The Expedited and Periodic folders 
contain sub-folders for each group that has generated a report. If a group has not 
generated a report, the system does not create a sub-folder.
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6Case Actions

This chapter discusses the actions that can be performed on the existing cases.

6.1 Working with Cases
This section provides information about actions that can be performed on existing 
cases. It includes discussions of the following:

■ Finding and Opening Existing Cases

■ Creating a New Case

■ Processing a Case

■ Closing a Case

■ Saving a Case

■ Copying a Case

■ Performing a Medical Review

■ Performing a Coding Review

■ Printing Cases

■ Printing Medical Summaries

■ Deleting a Case

■ Revising a Case

6.1.1 Finding and Opening Existing Cases
You can find and open a case from the Case Open form shown in the following 
illustration.

To find and open an existing case
1. Select Case Actions --> Open to view the Case Open form.

2. Enter or select the appropriate search criteria in the form fields and click Search.

3. When the system displays the search results, locate the appropriate case in the list.

4. Click the link associated with the Case ID.

5. The system opens the Case Form for the selected case.

6. You can now review the case details and enter further information in the Case 
Form.



Working with Cases

Case Actions 6-2

6.1.1.1 General Usage Information
When using the Case Open dialog box, be aware of the following:

■ You can print all the cases in the current view from the Case Actions|Open 
dialog.

■ If you open a case that is assigned to another user in Edit mode, case assignment is 
not changed and the case remains with the user to whom it was initially assigned. 
However, if you open an unassigned case in Edit mode, the case is now 
automatically assigned to the user who has opened the case in Edit mode from any 
module of Argus Safety.

■ If you search for a case that has been deleted, the system displays the following 
message:

’The case number being searched has been deleted from the system. Please 
undelete the case from the Utilities | Undelete option for further processing.’

■ This message appears across the application where you use the case number to 
search for a case as follows:

– Worklist -- All dialogs

– Last Accessed Cases from the Menu

– Person Argus Status

■ Case Search while adding the Case as a reference

– If a blinded user views the case information from the Case Summary, the 
system displays the Blind name instead of the Study Drug name in the 
product information.

– When you view the case details, the system displays the same folder structure 
on the Regulatory Reports tab. This enables you to view the expedited and 
periodic in an organized tree structure.

6.1.1.2 Case Open Form Fields and Field Descriptions
The following table lists and describes the fields on the Case Open form.

Note: You can open the 10 most recently-accessed cases without 
going through the preceding process. These cases appear under Active 
Cases.

Field/Control Description

Search For Select the criteria by which the case must be searched for and enter an 
appropriate search item, if applicable.

Note: You can search for cases based on multiple study identifiers. The 
option, "Pri/Stdy/Othr/Cntr/Rptr/Pat" supports entry of Project ID, 
Study ID, Other ID, Center ID, Reporter ID, and Patient ID values 
separated by the "/" (forward slash) character. Any or all fields may be 
present.
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6.1.1.3 Search Results Contents
The Search Results under Total Number of Rows display a list of cases as specified in 
the Search Criteria (Default Criteria is Date Range of Last 30 days). The previous 
search results are displayed if a search was performed by the user during the same 
session without logging out.

The following table lists and describes the Search Results columns and contents.

6.1.1.4 Sharing a Case Series
You can share a case series from:

■ Argus to Argus Insight

■ Argus Insight to Argus

Full Search Select this check box, if necessary.

Full search is best explained with an example. If the full search option is 
not used and the item that is entered under Search for is "AB", then a 
string such as "ABCESS" will match "AB", but a string such as "LABOR" 
will not. If the full search option is used, both these items will match 
"AB". Also, items whose first few letters sound similar (like "TIM" and 
"TIN") will also appear in the search results.

Product Family Select the Product Family that the case belongs to, if applicable.

Date Range Select a relevant Date Range, if applicable.

Tip: To enter a customized date range, select Custom Date Range from 
the list.

■ Enter an appropriate date range in the custom date range dialog and 
click OK.

■ Select the Follow-up radio button to search on Follow-up Dates, 
including the Significant and Non-Significant Follow-ups.

Advanced 
Condition

Select an advanced condition for the case, if applicable.

Note: Click AC to create a new advanced condition.

Result from Argus 
Insight

Enables you to create a search result with the same cases as the Active 
Case Series in Argus Insight.

Search Click Search to display the list of cases that match the search criteria.

Column Description

Total Number of 
Rows

Displays the total number of results found to match the search criteria.

■ Displaying Rows. The number of rows being displays.

■ Page Size. The number of rows that display on each page.

■ <<  >>. Click to scroll through the search results.

Lock State Displays the Lock Status - whether the case is locked or unlocked.

Click the icon displaying the lock status for more information.

Case # Displays the unique Case Number of each case. Click the case number 
link to open the case.

Date Displays the date when the case was opened.

Product Displays the Product related to the case.

State Displays the State that the case belongs to.

Field/Control Description
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To share a case series from Argus to Argus Insight
1. Click the [Argus Insight] option to automatically activate the same case series in 

the search result.

2. Argus Insight automatically makes the same case series active that is present in 
the search result of the Case Search dialog in Argus.

To share a case series from Argus Insight to Argus
Click the Result from Argus Insight button in Case Search to create a search result 
with the same cases as the Active Case Series in Argus Insight.

Be aware of the following:

■ If there are no cases in the Active Case Series in Argus Insight or no Active Case 
Series exists, the system generates an "empty" search result.

■ If there are cases in the Argus Insight Case series that no longer exist in Argus, 
they are excluded from the case series in Argus.

■ You can also make the Case Search dialog case series active from within Argus 
Insight through the Case Series menu option Make Active from Argus in Argus 
Insight.

■ A case is excluded from the case series, if a case series from Argus contains cases 
that are not present in the data mart.

6.1.2 Processing a Case
When your company receives initial case information you enter this information on 
the Initial Case Entry form. After entering this information, it must be verified, or 
checked for duplicates (possibly by another user) to ensure that duplicate information 
is not entered in the database. Once the information is verified, you can book in the 
case or enter additional case data.

The following is an illustration of the Initial Case Entry form.

Note: : If Argus Insight is already open, the system replaces the 
active case series in Argus Insight with cases from Argus.
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6.1.2.1 Initial Case Entry Fields and Field Descriptions
The following table lists and describes the fields in the Initial Case Entry form.

Field Description

Initial Receipt Date Enter the date on which your company became aware of the case. The 
Receipt Date cannot be entered as a partial date.

Central Receipt 
Date

Enter the date on which this information was received by Central Safety.

Country of 
Incidence

Enter the country where the adverse event occurred. You can select the 
appropriate country from the list.

Note: This may or may not be the reporter's or the patient's country of 
residence.

Report Type Select the item that best describes the type of report. This determines the 
fields that are made available for entering case information.

Note: The report type also impacts the duplicate search. For example, 
selecting Sponsored Trial makes the Study ID and Protocol ID fields 
available. The Administrator can adjust the information in this list.

Project ID Enter the Project ID of the case.

Study ID This item is applicable to clinical trial cases only. Enter the study ID. Click 
Select to choose the study ID from the Clinical Trial Selection dialog.

Center ID This item is applicable to clinical trial cases only. Click Select to choose the 
Center ID from the Clinical Trial Selection dialog.

Initial Justification The values of this field are configurable through the standard Argus 
Justifications dialog. This field is reflected in the General tab of the Case 
Form and is also available for duplicate searching for cases.

Click the green dot to view and select justifications from the Argus 
Justification dialog.

Product Name Enter the name of the product associated with the case. If the adverse 
event(s) are associated with more than one product, each additional 
product can be added from the Case Form.

Note: Enter the most suspect product here. Click Select to search for a 
product from the Trade Name Product Lookup dialog. Several items are 
automatically entered on the Case Form based on the product selected 
here.
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6.1.2.2 Booking in Cases and Entering Initial Case Information
From the Initial Case Entry form, you can decide to book-in a case before entering 
further case information in the Case Form.

Generic Name This field can be used to enter the generic name of the product. This field 
will be automatically entered when a product is selected from the Trade 
Name Product Lookup dialog.

Description as 
Reported

Enter a brief verbatim description from the reporter that describes the 
event that is most clinically important in the case. The icon denotes that 
the event is encoded. Click the icon to populate the MedDRA hierarchy 
dialog.

Onset Date/Time Enter the date/time for the onset of adverse event symptoms.

Sal. First Name 
Middle Name Last 
Name

Enter the reporter's salutation, first name, middle name and last name.

Suffix Enter the reporter's name suffix, if applicable.

Country Enter the reporter's country.

State/Province Enter the reporter's state/province or county.

Postal Code Enter the postal code or zip code.

Intermediary Enter the type of intermediary for the case, if applicable.

Patient Name or 
Initials

Enter the patient's name or initials. The system can search for cases on 
initials, first name, and last name.

Pat. ID Enter the patient's ID.

Date of Birth Enter the patient's Date of Birth (dd-MON-yyyy).

Note: When entering the month, enter 1 for JAN, 2 for FEB, 3 for MAR and 
so on.

Age Enter the patient's age. When searching for duplicates, the system will 
retrieve all ages that begin with the number that was entered for the 
search. For example, searching for "5," will retrieve patients aged 5, and 50 
through 59.

Units Enter the age units (days, months, or years).

Gender Select the patient's gender from the list. The Administrator can adjust the 
information in this list.

ID Enter the value to search for a Reporter Reference number, Case Reference, 
and Case number.

Keyword Enter a keyword when searching for duplicates. Keywords are only used 
for searching for cases.

Journal and/or 
Title

These items are applicable to literature cases only. Click Select to choose a 
journal and/or title from the Literature Reference dialog. The 
Administrator can adjust this list.

Full Search (Like 
Soundex)

Check the Full Search (Like, Soundex) check box to perform a full search, 
including Soundex search for cases.

Tip: Soundex enables you to search for cases with similar phonetics.

Field Description
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To enter initial case information
1. Select Case Actions --> New to open the Initial Case Entry form.

2. Enter preliminary case information in the form.

3. Click Search to determine whether information related to this case has already 
been entered.

4. A list of cases that match the criteria you entered on the form is displayed. Inspect 
the search results for a duplicate case.

5. If a duplicate case does not appear, click Continue in the Initial Case Entry form to 
display the BookIn and Attachments and References sections.

6. Enter the relevant information in sections like Causality, Seriousness, Attachments 
and References.

■ Under Reported Causality, select the reporter's assessment of causality. The 
causality relationship is the causal relationship between the clinically most 
important event and the suspect drug that is entered in the Initial Case Entry 
form.

■ For Seriousness Criteria, select the appropriate check boxes to indicate the 
seriousness of the case, as appropriate.

Note: You can configure the number of cases that display in the 
Bookin dialog in the Page Size drop-down list. By default, 100 cases 
appear on the page. You can choose to display up to 2000 cases on a 
single page.

Note: Fields displayed with a red flag are required fields and must 
contain a value.

Note: : If a duplicate case exists, open the case to enter further 
information (if any) related to the existing case. Click the link 
associated with the case 

Note:

■ Select only the criteria that applies to the clinically most important 
adverse event.

■ If you select the Death check box, you can enter the death details 
from the dialog that automatically appears. If you select the 
Hospitalized check box, you can enter hospitalization details from 
the dialog that automatically opens.

■ Either a seriousness criterion or a non-serious criterion must be 
entered before a case can be booked in.

■ When a Duplicate Search is performed, the system will remember 
the results until the user logs out of the system or performs a 
duplicate search again. When the Bookin screen is opened, the 
search results from the last search are displayed again.
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7. If the case is not serious, select the appropriate check box under Case is 
Non-Serious. The Non Serious Section of the Initial Case Entry dialog is 
differentiated by a | between the Serious criteria and the Non Serious Criteria.

8. Click Add to add an attachment

9. Select File Attachment or URL Reference, as appropriate.

To insert a file attachment
1. Select File Attachment from the list and click Browse.

2. Click the New Case from Image button - is the first button (from left) in the Quick 
Launch bar. This button opens the Windows Open dialog, which helps you to 
browse to the default location from where the file(s) can be attached.

To insert a URL Reference
1. To insert a URL Reference, select URL Reference from the list.

2. Enter the URL after "http://".

To search for and insert a document
1. Select Documentum Link and click Add.

2. The Document Lookup dialog is displayed.

3. You can search for a document from the database by specifying a search criterion 
in this dialog.

4. Click BookIn.

5. If the Administrator has configured the system for automatic numbering of cases, 
the automatically assigned case number opens. If the numbering of cases is 
manual, you can enter the appropriate case number.

Note: This location is configured can be configured by the 
administrator in Argus Console under System Configuration > 
Common Profile Switches > Case Processing.

Note: Once you click the Bookin button, it is hidden from the screen. 
The button is enabled only if the Save operation fails or when the case 
is booked in successfully. Mandatory fields are denoted by an orange 
border across the field in the Bookin dialog.

Note:

■ When a case is booked in, the case may be assigned to a specific 
user and it will be given a particular state, depending on the 
configuration set up by the Administrator.

■ The case can not be booked in without these fields populated: 
Product, Event, Receipt Date, Report Type, Country of Incidence 
and Seriousness.

■ These are noted by an orange border across the field label and 
identified by an orange flag to indicate that these are required 
fields.
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6.1.2.3 Checking for Duplicates

To check for duplicates
1. Check whether the case information that is being entered in the Initial Case Entry 

form has been entered previously (possibly by another user).

2. Enter the information related to the case in the Initial Case Entry form.

3. Select the Receipt Range Limits radio button to check for duplicates based on the 
dates entered in the form. Click Search. A list of cases that match the criteria 
entered in the form opens.

4. Inspect the list to determine if any case contains duplicate information.

6.1.2.4 Understanding Receipt Range Limits
The following table provides information about using Receipt Ranges.

6.1.3 Closing a Case
This section provides information about how to close a case. Once a case is closed, you 
can do the following:

Tip: When you book-in a case, a dialog that prompts you to open the 
newly created case is displayed.

Click Yes to open the case.

Field Description

No date 90 days before System Date and 2 days after System Date.

Full Onset Date 10 days before Onset date and 90 days after Onset Date.

Full Initial Receipt 
Date

60 days before Initial Receipt Date and 60 days after Initial Receipt Date.

Note: This default date range for searching on Initial Receipt Date can be 
disabled by un-checking the Receipt Range Limits radio button on the 
Initial Case Entry dialog.

Partial Onset Date Based on the Full Date Range - if only the year is entered, the date range 
becomes: 10 days before the end of the previous year and 90 days after end 
of the year.

Partial Initial 
Receipt Date

Based on Full Date Range - if only a year is entered, the date range 
becomes: 60 days before end of previous year and 60 days after the end of 
the year.

Note:

■ If an Initial Receipt Date is not entered but an Event Onset Date 
has been entered, the search will default to look for cases with 
Initial Receipt Dates 10 days before and 90 days after the event 
onset date. This feature can also be disabled directly on the dialog 
by un-checking the Receipt Range Limits check box. If you do not 
check anything, the default date range is 90 days before and 2 
days after the current date.

■ The Duplicate Search permits you to sort in ascending or 
descending order in the duplicate search results. You can also use 
wild card searches on all text fields in the BookIn dialog.
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■ You can view a closed case in the Case Form in read-only mode.

■ View reports generated for the case

■ Preview new drafts

■ View report details

■ View drafts of reports that haven't been generated

You cannot create expedited reports for cases that have been formally closed. For that 
reason, you cannot close a case that has pending scheduled reports.

To close a case
1. Select Case Actions --> Close.

2. When the system opens the Save Case dialog box:

Click Yes to save and close the case

OR

Click No to close the case without saving it.

After you close a case, the system does the following:

1. Opens the next active case, if you have active cases that you are working on. If 
there are no active cases, the system displays the default Worklist.

2. Displays the Personal Argus Status if the default Worklist option is <None>.

6.1.4 Saving a Case
This menu option enables you to save a case.

To save a case
1. Click the Case Number of the case you want to save.

2. When the system opens the Case Form, select Case Actions --> Save.

3. When the system opens the Case Form Saving dialog box, click OK.

6.1.5 Copying a Case
Argus enables you to save all or part of a case and stores the copy in the database as a 
separate case. When copying cases, be aware of the following:

■ Clicking the case reference in any copied case opens the original case.

■ You can select specific sections of the case to copy.

■ If your system is configured for manual case numbering, the system prompts you 
to enter a new Case ID. Otherwise, the system automatically assigns a new Case 
ID. The following is an illustration of the Case ID Number dialog box.

To copy a case
1. Select Case Actions --> Copy.

2. When the system opens the Case Copy -- Webpage dialog box, enter the number 
of copies you want to make and click Yes to copy the case.

3. When the system displays the Case Copy dialog box, click the appropriate check 
boxes to select the portions of the case you want to copy
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OR

Click Select All to copy the entire case.

4. Click Copy.

5. The system saves and opens a copy of the case with a new case number and 
presents a message. Click OK.

6.1.6 Using the Medical Review Function
Use the Medical Review function to quickly and efficiently add important information 
to a case. The Medical Review form has three (3) tabs as follows:

■ Medical Review Tab

■ Temporal View Tab

■ Action Items/Addl Info Tab

To access Medical Review
1. Select Case Actions --> Medical Review.

2. The system opens the Medical Review form.

3. Click on the appropriate tab.

Note: Depending on whether the system is configured for automatic 
case numbering, the system either generates a case ID or enables you 
to enter the case ID for this case.

Null flavor data is copied along with Case Form data on Case Copy.
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6.1.6.1 Common Actions
The following table lists and describes the actions you can perform from all Medical 
Review tabs.

6.1.6.2 Using the Medical Review Tab
The Medical Review tab has three sections as shown in the following illustration:

■ Case Narrative

■ Case Assessment

■ Event Assessment

Field Description

View Draft Select a report from the drop-down list and click View Draft to generate a 
draft version of the report based on the open case.

Note: This report form type is saved as a default and the next time the user 
opens the Medical Review for another case, this is defaulted to the Report 
Form selected previously.

The Draft report does not display all the changes made to the Case until 
the case has been saved in the database.

Zoom/Unzoom Click the zoom icon to view the selected dialog on a much bigger scale.

Click Un-Zoom icon to revert back to the earlier view.

Return Case Click Return Case to open the return route dialog and save the 
information.

Forward Case Click Forward Case to open the forward route dialog and save the 
information.

When the case has been routed and the form is closed, you cannot route 
from the case form Activities tab till the case has been closed and 
re-opened.

Save and Close Click Save and Close to save and close the case.

Cancel Click Cancel to exit without making any changes.
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The system displays the user-defined fields in the Medical Review dialog box, if they 
have been enabled on the Case Form Analysis tab. If they have not been enabled, they 
do not display on the tab.

Enter information in the Case Narrative, Case Assessment and Event Assessment 
sections.

6.1.6.2.1 About the Case Narrative Section  The Case Narrative section is fixed and cannot 
be changed. However, you can choose from the drop-down options associate with the 
fields to view any of the other narrative fields. The system saves the view as a default 
and uses it when you open the Medical Review for another case.

The following is an illustration of the Case Narrative section.

Note:

■ An (S) is displayed for Serious events.

■ An (F) is displayed for Fatal events.

■ An (LT) is displayed for Life Threatening events.

■ An (H) is displayed for Hospitalized events.
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6.1.6.2.2 About the Case Assessment Section  The Case Assessment section enables you 
to provide information about case details. The following is an illustration of the Case 
Assessment section.

Select whether the case is serious or not from the Case Serious drop-down list. In a 
similar manner, select relevant information about Company Agent Causal, Listedness, 
and Case Outcome from the drop-down lists.

6.1.6.2.3 About the Event Assessment Section  The Event Assessment section allows you 
to understand more about the events. The following is an illustration of the Event 
Assessment section.

Event Assessment Fields and Field Descriptions
The following table lists and describes the fields in the Event Assessment section.

Filtering in the Event Assessment Section
The following table describes how the each field of the Event Assessment section is 
filtered:

Field Description

Product This field is populated when events are entered in the Products tab and is 
displayed in the following format:

■ First Line - Product Name

■ Second Line - Generic Name

Causality as 
Reported/

Causality as 
Determined

Event PT 
/Description/LLT

Causality as Reported -- Indicates the degree of reported causality.

Causality as Determined -- This field is populated with information 
entered in the Reported Causality field.

Event PT/Description/LLT -- This field is populated when events are 
entered in the Events tab and displays in the following format:

■ First Line - Event PT

■ Second Line - Verbatim

■ Third Line - LLT

D/S Displays the Diagnosis/Symptom details by D or S in line with the 
Events.

Seriousness 
Severity Duration

Display the Seriousness, Severity and the Duration of the Event.

Data Sheet Displays the data sheets for the agent.

License Displays the licenses for the agent.

As Determined 
Listedness

Indicates whether the system found the event on the datasheet for this 
product.
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User Actions within Event Assessment
The following table lists user actions and their result.

Attaching Cases from the Medical Review Screen
Notes and Attachments and Contact Log sections appear on the Case Form Additional 
Info tab to the Medical Review screen as follows:

■ The new functions appear on the Action Items/Addl Info tab.

■ The performance of the Medical Review dialog remains the same while initially 
loading the dialog.

■ The system displays user-defined fields in the Medical Review dialog box if they 
have been enabled on the Case Form Analysis tab.

6.1.6.3 Using Temporal View Tab
Click Temporal View tab to view a read-only version of the case before routing. The 
following is an illustration of the Temporal View tab.

Field Description

Product The product filter drop down list contains all products listed in the event 
assessment. The user can filter on all the products which are present in 
the Event Assessment dialog.

Event Contains a drop-down of values of distinct Event PT. The user can filter 
on all the products which are present in the Event Assessment dialog.

Diagnosis Contains a drop-down list of values of D for Diagnosis or S for 
Symptoms.

Data Sheet Contains a drop-down of values of distinct data sheets. All the blank data 
sheets display as a single row of <Unspecified>.

Licenses Contains a drop-down of values of distinct Countries of the Licenses. All 
the Licenses which are not associated to a data sheet displays under 
<Unspecified> or are aligned with the data sheet view.

Note: Only the assessment rows that match the selected criteria are 
displayed in the filtering results.

User Action Result

Click Datasheet 
column's "plus" 
icon

Displays the license and data sheet views and displays the License 
Column and enable the "-" for the License Column.

Click Product 
Name

Displays the Product Information dialog for the selected product

Click Event 
Description

Displays the Event Information dialog for the selected event

Click License 
Description

Displays the Product Information as defined in the License Configuration.

Click Datasheet 
Description

Displays all the configured terms in the data sheet.



Working with Cases

Case Actions 6-16

The information displayed in the Temporal View tab is taken from the information 
entered in the Case Form section. Click the following links for information about each 
section on the Temporal View tab.

6.1.6.3.1 About the Summary Section  The Summary section provides read-only 
summary information about the case.

The following table lists and describes each field in the Summary section.

Field Description

First Suspect 
Product

Displays the name of the primary suspect product.

Generic Name Displays the generic name of the primary suspect product.

Coded Indication Displays information about the product indication.

Gender Displays the gender of the patient.

Age Displays the age of the patient.

Report Type Displays the report type.

Reporter Type Displays the type of reporter reporting the event.

Company 
Diagnosis/Syndro
me

Displays the company diagnosis.
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6.1.6.3.2 About the Display Options Section  The Display Options section enables you to 
select information to view in the Event Assessment section of the form. The following 
is an illustration of the Display Options section.

The following table lists each check box and describes the information that displays in 
the Event Assessment section.

6.1.6.3.3 About the Event Assessment Section  The Event Assessment section provides 
summary information about the adverse event.

The following table lists and describes the information in the Event Assessment 
section.

Case Serious Displays whether the case is serious or not.

Company Agent 
Causal

Displays the case causality status.

Field Description

Suspect Products Select the check box to view Suspect Products in the Event Assessment 
Section.

Non-Suspect 
Products

Select the check box to view Non-Suspect Products in the Event 
Assessment Section.

Patient History Select the check box to view Patient History in the Event Assessment 
Section.

Patient Lab Data Select the check box to view Patient Lab Data in the Event Assessment 
Section.

Relevant Tests Select the check box to view Relevant Tests in the Event Assessment 
Section.

Events - All 
Events, Serious 
Events Only

Select the check box as required to view All Events/Serious Events Only 
in the Event Assessment Section.

Field Description

ID Denotes the type of event. For example, HOSP means Hospitalized.

Info Click the Info icon (i) to view details about the selected entity.

Item Displays the item name.

Field Description
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The system opens a unique dialog box for the event you have chosen to view. 

View Death Information
The system presents death information in the following dialog box.

View Event Information
The system presents event information in the following dialog box.

View Hospitalization Information
The system presents hospitalization information in the following dialog box.

View Patient History
The system presents patient history information in the following dialog box.

View Product Information
The system presents product information in the Temporal Information Product dialog 
box.

6.1.6.3.4 About the Relevant Tests Section  The Relevant Tests section provides 
information about any tests that were performed.

The following lists and describes

6.1.6.4 Using the Action Items/Additional Info Tab
The Action Items/Additional Info tab enables you to enter contact log information, 
information about action items, and notes and attachments. The tab has three sections 
as shown in the following illustration. The sections are:

■ Contact Log

■ Action Items

■ Notes and Attachments

Start Displays the date from when the event assessment began.

Stop Displays the last date of the event assessment.

Duration Displays the duration of the event assessment.

Field Description

Relevant Tests Displays information about any relevant tests, if any.

Zoom/Unzoom Click the Zoom icon to view the report on a bigger scale.

Click the Unzoom icon to revert to the earlier view.

Flag Icon This icon displays the language text that is supported.

Notes Icon Click this icon to view/enter notes.

Field Description
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6.1.6.4.1 About the Contact Log Section  The Contact Log section enables you to track 
correspondence about an adverse event. The following is an illustration of the Contact 
Log section.

Contact Log Fields and Field Descriptions
When using the Contact Log section, be aware of the following:

■ The number displayed in parentheses in the header of each section - Contact Log, 
Action Item, Routing Comments, Case Lock/Archive - displays the total number 
of entities within the section.

■ You can choose to view All Action Items or only Open Action Items, which 
display all the Open Action items within the case. By default, All Action Items are 
displayed.

■ You can sort Action Items by clicking on the column headers.

■ The system remembers the sort order on for the duration of the case.

The following table lists and describes the fields in the Contact Log section of the 
Activities tab.
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6.1.6.4.2 Generating Letters  You can generate letters from the Contact Log section. 
When generating letters, be aware of the following:

■ The placeholders for the original letter template can be replaced by information 
that is specific to the current case.

■ A letter is only added to a search if the Correspondent check box is checked.

■ The Administrator can configure the system to generate letters automatically and 
to schedule them for a specific number of days after receiving details of an adverse 
event. For example, the system might schedule an Initial Response Letter to be 
sent the day after an adverse event is received. Auto letter scheduling is triggered 
when a case is initially saved.

■ Letters cannot be auto-generated unless the "Date" [contact log date] is reached, to 
ensure that the latest information for the case has been updated to the letter.

■ If the Primary Reporter is marked as a correspondence contact, the system sends 
Auto-scheduled letters are sent to the Primary Reporter. Otherwise, the letter is 
sent to the first correspondence contact.

■ Auto-scheduled letters appear in the Contact Log section of the Case Form. You 
can view or print them by double clicking the letter icon. You can also edit letters 
that have not been sent. The system does not automatically send letters. You must 
send or remove letters manually.

■ In addition to auto-scheduling letter, you can also configure auto action items, 
which prompt you to follow-up with a correspondent after a letter has been 
scheduled and sent. Auto action item scheduling is triggered once the sent date 
has been entered for a letter. Auto action items appear in the Action Items section 
on the Case Form and in the Action Items tab of the Worklist.

Use the following procedure to generate a letter.

To generate a letter
1. Go to Contact Log in the Activities tab and click New Letter.

Field Description

Date The date the letter was generated and sent. The following icons may be 
present:

Click the letter icon to open the Letter Preview dialog. This allows you to 
view a letter or to modify it if it has not been sent already.

Date Sent The date is automatically inserted when a letter is sent through the letter 
menu. You can also manually enter the date the letter was sent. If this 
field is completed, the letter will become read-only.

Code The contact code for this entry. The Administrator can adjust the 
information in this list.

Click this e-mail button to open a message editor.

Description Enter a brief explanation for the letter, for example, "Initial Letter," or the 
details of a phone conversation.

New Letter Click this button to generate a new letter

Group/User Select a group responsible for the Contact item. From the list below, select 
a user from the selected group who will be responsible for the action.

The Contact Item will appear in the Worklist for selected user. If "Any" is 
chosen as the group, the Action Item appears in all the users' Worklist. 
The Administrator can adjust the information in these lists.
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2. The Custom Letter Templates dialog opens.

3. Select the required letter template from the list and click OK to open the letter in a 
separate window.

4. Make the necessary changes to the letter text.

5. Select File-->Save to save the changes.

6. If you modified the letter, select Yes.

This attaches the letter to the Case Form by browsing to the location where you 
saved the changes.

7. After saving the letter, the system displays it in the Contact Log section of the 
Activities tab.

8. The system creates an action item for following-up on this letter in the Action 
Items section of the Activities tab.

6.1.6.4.3 Scheduling Action Items for Letters  When specifying or changing the Date Sent 
field in a letter, you can schedule an action item if you wish to do so.

■ If an action item is not specified, the field is blank.

■ Any Action Item can be updated on the screen immediately after a case has been 
saved.

■ Unless the Action Item has already been marked as completed, each time the Date 
Sent field is changed for a letter, the corresponding action item (if one exists) is 
also updated with a new Due Date of Date Sent of the Letter and the number of 
days specified for the Action in the Letter configuration

6.1.6.4.4 Opening a Message Editor  To open a message editor

Click to open the message editor.

The following table lists and describes the fields in the dialog box

6.1.6.4.5 About the Action Items Section  The Action Items section enables you to enter 
action items and their related information. The following is an illustration of the 
Action Items section.

Field Description

To Displays the e-mail address specified for the Primary Reporter in the 
Case Form.

You can edit this field.

From Displays the e-mail address specified in the Return E-mail Address in 
Argus Console>Code Lists>Letter Configuration. You can edit this field 
also.

Subject Displays the Case Number and the Description of the Contact log.

You can edit this field.

Send Enables you to send the e-mail to the intended recipient.
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The following tables lists and describes the fields in the Action Items section.

6.1.6.4.6 About the Notes and Attachments Section  The Notes and Attachments section 
enables you to view notes and attachments associated with a case. The following is an 
illustration of the Notes and Attachments section.

6.1.7 Using the Coding Review Function
The Coding tab provides a single entry point for viewing and coding several kinds of 
information. The following is an illustration of the coding tab.

Field Description

Date Open Enter the date the action item was created. Open action items appear in 
the Worklist of the user who is responsible for the action item. They also 
appear in the Open Action Items Report.

Due Enter the date on which the action item is to be completed.

Completed Enter the date on which the action item was actually completed.

Code Select an Action Item code from the drop-down list. This will display the 
description of the selected Action Item Code. The Administrator can 
adjust this list.

Description Selecting an Action Item code automatically enters information into this 
field. The text can be modified as required. The Administrator can adjust 
this list.

Group/User Select a group responsible for the Action Item from the given drop-down 
list. From the drop-down list below this, select a user from the selected 
group who will be responsible for the action. The Action Item will appear 
in the Worklist for the selected user. If "Any" is chosen as the group, the 
Action Item appears in all the users' Worklist. The Administrator can 
adjust these lists.
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6.1.7.1 General Information
The following is an illustration of the General Information section of the Coding tab.

The following table lists and describes the fields in the General Information section.

6.1.7.2 Product Information
The following is an illustration of the Product Information section of the Coding tab.

The following table lists and describes the fields in the Product Information section.

Field Description

Report Type Identifies the type of case.

Study Info Displays study information about of the case.

Patient Info Identifies the patient's age & gender.

Literature Info Displays information about the Primary Literature of the case.
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6.1.7.3 Event Information
The following is an illustration of the Event Information section of the Coding tab.

The following table lists and describes the fields in the Event Information section.

6.1.7.4 Death Information
The following is an illustration of the Death Information section on the Coding tab.

The following table lists and describes the fields in the Death Information section.

6.1.7.5 Patient Information
The following is an illustration of the Patient Information section on the Coding tab.

The following table lists and describes the fields in the Patient Information section.

Field Description

Product Name Displays the product name.

Dosage Form Displays the configured formulation for the drug.

Strength / Unit Displays the configured Concentration and Units for the drug.

Indication Verbatim Identifies the indication associated with the product.

IND Coded (LLT) Displays the Coded PT with LLT in parenthesis.

Field Description

Event verbatim Event name as reported.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Seriousness Displays the Event Seriousness for the Event.

Severity Displays the Event Intensity for the Event.

Duration Displays the Event Duration for the Event.

Field Description

Cause of Death Displays the coded or un-coded event verbatim for cause of death.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.
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6.1.7.6 Lab Data
The following is an illustration of the Lab Data section on the Coding tab.

The following table lists and describes the fields in the Lab Data section.

6.1.7.7 Parent Information
The following is an illustration of the Parent Information section on the Coding tab.

The following table lists and describes the fields in the Parent Information section.

Field Description

Patient -- Other Relevant 
history: Condition Type

Displays the condition type of the patient's previous history.

Patient -- Other Relevant 
history: Verbatim Coded 
(Description)

Displays the condition of the patient's previous history.

Coded PT (LLT) Displays the Coded PT with LLT in parentheses.

Patient -- Other Relevant 
history: Condition Type if 
equal to Historical Drug

Displays the condition type of the patient's previous history.

Patient -- Other Relevant 
history: Verbatim Coded 
(Description)

Displays the condition of the patient's previous history.

Coded PT (LLT) Displays the Coded PT with LLT in parentheses.

Indication Verbatim Displays the Indication Verbatim for the Historical Drug.

Indication Coded PT (LLT) Displays the Coded PT with LLT in parentheses.

Reaction Verbatim Displays the Reaction Verbatim for the Historical Drug.

Reaction Coded PT (LLT) Displays the Coded PT with LLT in parentheses.

Field Description

Test Name Displays the Lab Data Verbatim for the Lab Data.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Results / Units Displays the entered Results and Units for the Lab Data.

Normal High / 
Low

Displays the configured Normal High and Low with Units for the Lab 
Data.



Working with Cases

Case Actions 6-26

6.1.7.8 Case Analysis
The following is an illustration of the Case Analysis section of the Coding tab.

The following table lists and describes the fields in the Case Analysis section.

6.1.7.9 Common Buttons Available in Coding Review
The Cosing Review screen comprises some common buttons.

The following table lists and describes these buttons present in this section.

Field Description

Condition Type Displays the condition type of the Parent previous history.

Verbatim Coded Displays the condition of the Parent previous history.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Indication Verbatim Displays the Indication Verbatim for the Historical Drug.

Indication Coded PT 
(LLT)

Displays the Coded PT with LLT in parenthesis.

Reaction Verbatim Displays the Reaction Verbatim for the Historical Drug.

Reaction Coded PT 
(LLT)

Displays the Coded PT with LLT in parenthesis.

Field Description

Company Diagnosis 
/ Syndrome 
Verbatim

Displays coded or un-coded event term for diagnosis or syndrome that 
the company ascribes to the case.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Field Description

Print Allows you to print the entries displayed on the screen.

Return Case Allows you to return the case displayed on the screen.

Forward Case Allows you to forward the case displayed on the screen.

Draft Report Provides access to the Draft Reports including Medical 
Summary Report. You cannot access to Medical Review 
Summary Report, if you do not have access to the Medical 
Review dialog.

Code Opens the Code dialog box.
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6.1.8 Using the Action Item Tab
The Action Item tab enables you to view and track action items for a case. The 
following is an illustration of the Action Item tab.

Click the following link for information about the fields and controls on the Action 
Items tab.

6.1.8.1 Action Item Fields and Field Descriptions
The following lists and describes the fields and controls on the Action Item tab.

Save and Close Allows you to close the case after saving it.

Cancel Allows you to exit the case without saving it.

Field Description

Show Enables you to show all action items (open and closed) or show on the 
open action items.

Add Enables you to add a new action item

Delete Enables you to delete an action item.

Up Enables you to move to the previous action item in the list

Down Enables you to move to the next action item in the list.

Date Open Enter the date the action item was created. Open action items appear in 
the Worklist of the user who is responsible for the action item. They also 
appear in the Open Action Items Report.

Date Due Enter the date the action item is due to be completed.

Completed Enter the date the action item was actually completed.

Code Select an Action Item code from the drop-down list. This will display the 
description of the selected Action Item Code. The Administrator can 
adjust this list.

Description Selecting an Action Item code automatically enters information into this 
field. The text can be modified as required. The Administrator can adjust 
this list.

Group Print Select a group responsible for the Action Item from the given drop-down 
list. From the drop-down list below this, select a user from the selected 
group who will be responsible for the action. The Action Item will appear 
in the Worklist for the selected user. If "Any" is chosen as the group, the 
Action Item appears in all the users' Worklist. The Administrator can 
adjust these lists.

User Select the user responsible for handling the action item.

Field Description
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6.1.9 Using the Print Function
The Print function enables you to print the following:

■ Case Form

■ Medical Summary

You access each of these print functions from the Case Actions menu. The following is 
an illustration of the Print Case dialog box.

Accessing Print Case Form Functions
Use the following procedure to access the Print Case Form functions.

To access print Case Form functions
1. Open a case

2. Select Case Actions --> Print --> Case Form.

3. The system opens the Print Cases tabbed dialog box.

6.1.9.1 Accessing Print Medical Summary Functions
Use the following procedure to access the Print Medical Summary function.

1. Open a case.

2. Select Case Actions --> Print --> Medical Summary.

3. The system opens the Medical Summary Report.

Print Enables you to print a list of action items

Field Description
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6.1.10 Printing a Case
The Print Case tabbed dialog box enables you to:

■ Print a case form or any of its sections (Print tab)

■ View and print letters associated with the case (Letters tab)

■ View and print attachments associated with a case (Attachments tab)

■ Transmit case information (Transmit tab)

The following is an illustration the tabbed Print Case dialog box.

Click the following links for information about using the Print Case dialog box and 
printing cases, letters, and attachments and transmitting cases.

6.1.10.1 Printing a Case
The Print tab contains a check box for each section of the Case Form. You can print any 
or all of the sections on the Case form. However, the system only prints the sections 
you select. When printing a Case Form, be aware of the following:

■ Select the Include Multiple Text checkbox, to print multiple language text

■ Click the Blind Study Product checkbox to blind product information for study 
cases

The following is an illustration of the Print tab.
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To print sections of the case form
1. Click the check box for each section of the Case Form you want to print

OR

Click Select All to select all the sections of the Case Form.

2. Click Print to print the case.

6.1.10.2 Viewing and Printing Letters
The Letters tab enables you to view and print completed letters.

To view and print a letter
1. Click the letter description link to display the letter.

2. When the system opens the letter, click Print to print it.

6.1.10.3 Viewing and Printing Attachments
The Attachments tab enables you to view and/or print case attachments. The system 
prints date/time information:

■ As footers on all printouts (except letters).

■ In the following format: dd-mmm-yyyy hh24: mm: ss.

Note: If the printed cases do not appear to be formatted correctly, 
adjust your printer settings.
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To print case attachments
1. Click the attachment description link to display the attachment.

2. When the system opens the letter, click Print to print it.

6.1.10.4 Transmitting a Case
The Transmit tab enables you to transmit a case electronically.

To transmit a case
1. Select the recipient from the Available Recipients list.

2. Select the transmission method from the Method list.

3. Enter any comments under Comments.

4. Click Transmit.

6.1.11 Printing a Medical Summary
The Print Medical Summary function enables you to print the medical summaries for 
a case. The following is an illustration of the Medical Summary Report.
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To print the Medical Summary
1. Open a case.

2. Select Case Actions --> Print --> Medical Summary.

3. The system opens the Medical Summary Report.

4. Select File - Print in the PDF to take a printout of the medical summary.

6.1.12 Deleting a Case
When you delete a case, you can no longer access it from the application. However, the 
system does not remove the case information from the database. Before the system 
permits you to delete a case, you must provide a justification. The following is an 
illustration of the delete justification dialog box.

To delete a case
1. Select Delete --> Case Actions.

2. When the system opens the Action Justification dialog box, do one of the 
following: Enter the justification manually in the Please enter a justification for 
performing this action field

OR

Select a pre-defined justification from the Select a standard justification field.

3. Type your Argus login password in the Password field.

4. Click OK.
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Action Justification Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Action Justification dialog box.

6.1.13 Viewing Case Revisions
The Case Revisions feature enables you to view the Revisions made to cases. You can 
track the revision where follow-up information appended to the case. The follow-up 
designations are as follows:

■ (S) F/U -- Indicates that significant follow- up information is attached to the case.

■ (NS) F/U -- Indicates that the follow-up information attached to the case is not 
significant.

The following is an illustration of the Case Details dialog box.

To view case revisions
1. Open a case.

2. Select Case Actions --> Case Revisions.

The system opens the Argus Safety Case Details dialog box. The dialog box 
provides the following information for the current case:

■ Scheduled Reports

■ Submitted Reports

■ Case Revisions

3. Select the desired report from this list.

4. The system displays the Audit Log Details screen containing a list of all revisions.

Field Description

Please enter a justification 
for performing this action

Enter the text that justifies the need to delete a case.

Password Enter your password

Select a standard 
justification for this field

Contains standard, pre-configured descriptions of justifications 
for deletion.

Spell Check Checks the entered/selected text for any grammatical errors.

OK Saves the justification entered/selected for case deletion.

Cancel Exits out of this dialog without saving any justification.



Working with Cases

Case Actions 6-34

■ Revision History dialog of Case Actions | Case Revisions displays the Lock icon 
for the revisions in which the case is in locked state.

■ Unlock icon is displayed for the revisions where the case is in unlocked state.

■ Archive icon is displayed for the revisions where the case is in archived state.
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7Advanced Conditions

This chapter provides information about Advanced Conditions, a powerful search tool 
that enables you to build complex queries for retrieving system data. 

7.1 Advanced Conditions
You can create complex or non-standard queries in the Advanced Conditions dialog 
box where you can define field-level search criteria. Detailed knowledge of the 
database schema is not required.

Click the Advanced Conditions button to begin creating advanced conditions to open 
the Advanced Conditions dialog box.

From the Advanced Condition dialog box, you can save and retrieve sets of search 
criteria (advanced conditions) and add, edit, or delete them. Access rights and 
permissions can be assigned to individual advanced conditions. You can execute and 
modify rights to one or more groups on a per-advanced condition basis.

When using Advanced Conditions, be aware of the following:

Note: Note: Only users with execute rights for an advanced 
condition, can view the advanced condition in the drop-down list in 
the Case Open dialog.
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■ By default, the Advanced Conditions drop-down list enables you to view only the 
New, None, and already selected Advanced Conditions.

■ Select New or None from the drop-down list and click the AC button to create a 
new advanced condition.

7.1.1 About the Advanced Condition Screen
You can choose and rename a query set on the Advanced Condition screen. However, 
the rename function is restricted to users who have permission to modify the 
advanced condition. When you open an advanced condition or query set, the system 
places the current query name in the Name field. The following is an illustration of the 
Advanced Condition screen.

When using the Advanced Condition screen:

■ You must click Save to record changes to the advanced condition name.

■ The system disables the Save button until you enter an advanced condition name 
in the Name field.

■ If you fail to enter a name before saving, the system displays the following 
message: ’Please enter the Advanced Condition name before saving’.

■ When you click Save, the system saves the query set with the new name and 
description.

■ When you click Save, the system refreshes the Query Set drop-down list.

■ You can import an XLS, XLSX or TXT file with one column containing case 
numbers as shown in the following illustration.
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■ If you attempt to upload a file format other than XLS, XLSX, or TXT, the system 
displays the following message:

Only XLS or Text Files are supported for Importing cases as a Hit List.

■ When you upload a text file, each line in the file is considered a complete case 
number.

■ When you click Import, the system enables you to browse to the file.

■ If a case is missing (cannot be found), the system displays the following message:

Case Number: XXXX is not found

■ If a case has been deleted, the system displays the following message:

Case Number: XXXX is deleted.

■ If there are multiple missing or unfound cases, the system displays all of them in 
the message dialog box.

■ If the same case has been entered multiple times; the system ignores it after it 
imports it.

■ The system can import 1000 cases/60 seconds for the Hit List.

■ After the system creates the Hit List, the user clicks Store Hit List. This system 
saves the advanced condition and stores the hit list so you can retrieve it for later 
use.

■ When you click Hit List, the system displays the cases in the hit list, and all other 
data and options, on the Case Open screen for further processing

■ When you click Export on the Hit List, the system exports the data in CSV format.

7.1.1.1 Filtering for Existing Advanced Conditions
Use the following procedure to filter for existing advanced conditions.
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To filter for existing advanced conditions
1. Go to Case Actions > Open and open the Case Open page.

2. Click the Lookup icon next to the Advanced Condition drop-down list, to open 
the Advanced Conditions Lookup dialog box.

3. Select one of the following options from the drop-down list under Filter

■ Contains - Enables you to filter for advanced conditions that contain the 
entered criteria.

■ Starts With - Enables you to filter for all advanced conditions that start with 
the entered criteria.

4. Enter the search criteria for the advanced conditions in the text box, as applicable.

5. Click Filter to display the advanced conditions matching the specified filtering 
criteria.

6. Select the appropriate advanced condition from the list.

7. Execute any of the actions below, as applicable:

■ Click OK to list the selected advanced condition in the Advanced Conditions 
drop-down list.

■ Click AC to display the details for the selected advanced condition in the 
Advanced Conditions dialog.

■ Click Cancel to close the Advanced Condition Lookup dialog without saving 
changes.

■ Select a previously selected advanced condition from the drop-down list to 
apply the search criteria for that condition.

7.1.1.2 Viewing Results from Existing Advanced Conditions
Use the following procedure to view the results of existing advanced conditions.

To view the results of an existing advanced condition.
1. Select an Advanced Condition from the Advanced Conditions drop-down list.

2. Click Search.

3. The system displays the cases matching the criteria specified in the selected 
Advanced Condition.
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4. The system displays a list of matching cases is displayed in the Total Number of 
Rows section.

7.1.2 Working with Advanced Conditions
This section provides information about how to create and user Advanced Conditions.

7.1.2.1 Creating, Viewing or Modifying Advanced Conditions
Use the following procedure the create, view, or modify an advanced condition.

To create an advanced condition
1. Select New from the Advanced Conditions drop-down list

OR

Click the Advanced Conditions icon. 

2. When the system opens the Confirmation dialog box:

Click Yes to create a new advanced condition query set

OR

Click No to create a new advanced condition by associating logical operators (like 
AND, OR) with items from the Case Form.

3. If you select No, the system opens an Advanced Condition Set dialog box.

7.1.2.2 About the Advanced Condition Set Dialog Box
The Advanced Condition Set dialog enables you to search for those entities under the 
Properties tree-list, which are from either the case data or from the code list. 
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The dialog box has two buttons that provide this functionality:

■ From Code List -- If you select this option, the Value drop-down list displays a list 
of all values configured in the Code List

■ From Case Data -- If you select this option, the Value drop-down list displays only 
the values actually in the cases.

■ These radio buttons display only if the selected entity belongs to a code list. Select 
the relevant entity and one of the radio buttons, as applicable to search the entity 
based on the code list or case data, as specified.

■ The Product name field can contain up to 70 characters for searching.

■ In the Suspect Product Name, Product Name 2/Study Cases, Company Product, 
Study Drug, and Primary Suspect Drug sections, you select the product from the 
company product browser instead of the drop-down values by clicking the select 
button in the Read Only text field.

■ When you click the select button, the system transfers the Product Name to the UI 
to enable you to search on the selected product.

■ Select a property type from the Properties tree list.

7.1.2.3 Additional Information about Properties
The items available in the folders in the Properties list represent Case Form fields you 
can use to perform the search in the advanced conditions. 
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Be aware of the following:

■ You can auto-populate an Advanced Condition by right-clicking a field in the 
Properties section to enable a field-to-field comparison.

■ When you select a Property for which terms can be encoded, the system enables 
the Select button. You can use the MedDRA Browser to select (possibly) multiple 
terms for the property. Refer to Using the MedDRA Browser for Advanced 
Conditions for further details.

■ The system enables an SMQ icon when you select SMQ-related properties from the 
Properties tree-list. Click this icon to view the SMQ Info dialog. It contains details 
about the selected SMQ.

■ In the Conditions list, select a condition that must apply to the item selected 
above.

Available conditions are:

1. In the Value field, enter the value that applies to the property or select an 
appropriate value from the list.

2. If the created condition created is to be linked with another condition, select the 
appropriate logical operator from the list adjoining Value.

3. Click Add to add the newly created condition to the advanced condition.

■ equal to

■ contains

■ less than

■ greater than

■ not equal to

■ greater than or equal to

■ less than or equal to

■ exists

■ missing

■ does not contain

■ begins with
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4. Repeat steps 3 through 8 to add more conditions to the advanced condition.

5. After entering each of the conditions required for the advanced condition, click 
Save.

6. Enter a name for the advanced condition and click OK.

7.1.2.4 Sharing Advanced Conditions
The system provides the option of share advanced conditions with other users. To 
enable other users to use the advanced condition, click the Share with other users.

When sharing advanced conditions with other users, be aware of the following:

■ If an Advanced Condition is not shared with other users, the Advanced Condition 
does not appear in the Advanced Condition list for any user except the 
Administrator and the user who created it.

■ If the Advanced Condition is shared, all users in the system can view the 
advanced condition, but cannot modify it.

■ You cannot stop sharing an Advanced Condition, if the Advanced Condition is in 
use in the system.

7.1.2.5 Using Advanced Conditions
You can use Advanced Conditions from the Case Selection dialog. Use the following 
procedure to do so.

To use advanced conditions
1. Select Case Actions --> Open.

2. Depending on how the criteria is to be used, you can do the following:

■ Use a set of previously saved criteria

■ Select the appropriate set of criteria from the Advanced Condition list.

■ Select the set of criteria from the Advanced list and click the adjoining 
Advanced Condition icon.

■ Add a new condition to a set of criteria

■ Create a new advanced condition by associating logical operators (like AND, 
OR) with items from the Case Form

Tip: You can use the AND and OR logical operators to link an 
existing condition to a new condition.

■ If you are using the AND operator to link two conditions, both 
conditions must be TRUE for the advanced condition to be TRUE. 
In all other cases, the advanced condition evaluates to FALSE. 

■ If you are using the OR operator to link two conditions, the 
advanced condition is TRUE if either or both conditions are 
TRUE. The advanced condition evaluates to FALSE if both 
conditions are FALSE.

Tip: To enter a customized Date Range:

1. Select Custom Date Range from the list.

2. Enter an appropriate date range in the custom date range dialog.

3. Click OK.
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7.1.2.6 Creating an Advanced Condition Query Set
Use the following procedure to create a Query Set of Advanced Conditions.

To create a Query Set of Advanced Conditions:
1. Select New from the Advanced Conditions drop-down list or click the Advanced 

Conditions icon.

2. A dialog that prompts for the creation of an advanced condition query set opens.

3. Click Yes to create a set of advanced conditions by linking together those 
advanced conditions that have been defined previously.

4. The Advanced Condition Set dialog appears. In this dialog, previously-created 
advanced conditions can be linked together using set operators like UNION, 
MINUS, and INTERSECT.

5. Click Add to add an advanced condition to the query set. A new row opens in the 
advanced condition selection area. In this row, select an appropriate advanced 
condition from the Advanced Condition list.

6. Select an appropriate set operator from the Set Operator list. This set operator will 
link this advanced condition to the next advanced condition.

7. To add the next advanced condition to the query set, click Add.

8. Repeat steps 5 through 7 for each advanced condition that must be entered in the 
query set.

8. When each of the advanced conditions for the query set is entered, click Save.

9. Enter a name for the advanced condition and click OK.

7.1.2.6.1 Renaming Query Sets  You can rename a query set from the Advanced 
Condition Set screen. However, only users with the appropriate permissions can 
modify a query set. When the user opens an advanced condition or query set, the 
system places the current query name in the Name field. The following is an 

Tip: To modify, open, or delete advanced conditions, click Open in 
the Advanced Conditions dialog. A list of all the advanced conditions 
will be displayed. In this list, select the appropriate advanced 
condition and click Open to open or modify it, or Delete to delete it.

To view or modify the SQL statement associated with an advanced 
condition, click Show SQL. Make the required modifications to the 
SQL statement, if necessary.

Note: If the required advanced condition is not already present in 
the list, it can be created by selecting (New) from the list. If an existing 
advanced condition requires modification, select it and click Edit. The 
advanced condition can be edited by a user only if it was created by 
that user.

Note: To view or modify the SQL statement associated with an 
advanced condition, click Show SQL. Make the required modifications 
to the SQL statement, if necessary.
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illustration of the Advanced Condition Set screen.When renaming a query set, be 
aware of the following:

■ Click Save to update the changes to the query set name.

■ The system disables the Save button until you enter an advanced condition name 
in the Name field.

■ When you click Save, the system saves the query set with the new name and 
description.

■ When you click Save, the system refreshes the Query Set drop-down list.

■ If you fail to enter a query set name before clicking Save, the system displays the 
following message:

■ Please enter Advanced Condition Query Set Name before saving.

■ If you rename the query set and attempt to close the Advanced Condition Set 
window without clicking Save, the system displays the following error message:

■ You have made changes to the existing item. If you press OK, changes made will 
be lost.

■ When you click New, the system clears all values from the Name, Description, 
and Query Set fields.

7.1.2.7 Using the Hit List Tab
The Hit List tab enables you to search for cases that match the query set criteria for the 
advanced condition.

To search for cases
1. Click Find Now in the Hit List tab of the Advanced Conditions dialog.

2. This system runs a search based on the selected query set criteria and displays a 
list of cases (if any) that satisfy the advanced condition query set.

The following table show the operations you can perform in the Hit List tab.
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To... Do the following

Manually add an existing case to the hit 
list

Click Add and enter the Case ID in the text box

Remove a case from the hit list Click Delete

Save the hit list result for future use Click Store Hit List

Retrieve results of the saved hit list Click Retrieve Hit List

Save the hit list as a text file Click Export

View SQL for Query Click Show SQL

Run a Query Click Find
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8Worklist

This chapter describes the Worklist tab and the information that it displays.

8.1 About Worklist
The Administrator may have configured your user account so that the Worklist 
displays each time you log on to the system. Place the cursor over Worklist in the 
menu bar to view the available options.

8.1.1 General Usage Information
The worklist displays the following information:

■ New cases created in the system

■ Cases that are currently open

■ To Do items like letters, reports, and other action items

■ Transmission status of reports

■ All bulk printed reports

When using the worklist, be aware of the following

■ The Worklist dialogs have filtering options on all elements in each worklist as 
follows:

– New/Open

– Bulk Print

– Reports

– Action Items

– Bulk Transmit

– Bulk Transmit ICSR Messages

– Bulk Transmit ICSR Reports

– Coding Status

– Coding Action Items

– Contact/Letters

– Letters

■ You can filter on any element by clicking the Filter icon to display the filtering 
row.
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■ The system now provides a type ahead feature to enable you to filter on any 
text/date element.

■ You can minimize the filtering options by clicking the minimize icon. 

■ The paper clip icon identifies the maximize icon.

■ You can perform a Like search. In other words, if you search for "Cure," the system 
returns all elements starting with "Cure."

■ You can perform a wildcard search. In other words, if you search for "Cure" the 
system returns all elements containing "Cure."

■ The user can click the Search button to filter for reports in the reports list.

■ These filtering options are available from worklist-specific views and when 
performing case or reports drill down searches from the Dashboards.

■ The system saves all user preferences, including filtering options and filter views, 
for future use.

■ The Days Open fields on the WL|New and Open have a drop-down list with 
values of <7, 7-15, >15, and the Worklist Reports has values of 7, 15

■ The Assigned To filtering element has been removed from the Worklist New and 
Open dialogs in the MAIN filtering criteria

■ All the worklist dialogs have a refresh icon beside the View option. This enables 
you to refresh worklist dialogs that use the preference saved in the worklist 
elements.

■ All the worklist dialogs have a minimize button to minimize the filtering options. 
This increases the number of rows that display in the list.

8.1.2 Worklist Filtering
The Worklist Filtering options enable you to search for a specific case. The Filter 
contains editable fields that enable you to either select from a list of values or perform 
a Wild card search. This feature applies to all the Worklist Filters across all worklist 
items.

The Worklist filter in each Worklist entity contains the following filtering options:

■ View Individual

■ View Group and

■ View All

The default filter is Case Number. This enables you to enter a Case Number to search 
for results matching a specified case number.

8.1.3 Worklist Options
The following worklist options are available to you.

■ New and Open

■ Action Items

■ Coding Action Items

■ Contacts

■ Reports
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■ Bulk Transmit

■ Bulk Print

■ Coding Review

■ Bulk Transmit ICSR

■ Local Labeling

■ Coding Status

■ Letters

8.1.3.1 New and Open
This section discusses the features provided by the Worklist - New and Open menu 
items.

■ When you select New, the system displays new worklist items that have been 
assigned but not yet accepted. You can also see unassigned cases.

■ When you select Open, the system displays all cases that have been assigned and 
accepted.

To view the Worklist - New or Open page
1. Select Worklist --> New or Worklist --> Open

2. When the system opens the Worklist - New or Worklist - Open screen, enter 

8.1.3.1.1 General Usage Information  When using the New/Open Worklist screen, be 
aware of the following:

■ The New/Open Worklist displays the Workflow Group and the Workflow State 
currently associated with the case.

■ The Workflow Group is available in the Worklist New and Open printouts.

■ You can sort on this field.

■ The lock icon identifies cases that are locked.

■ The Initial Date field has been renamed Receipt Date and enables you to view the 
date the case was first received. The new name displays on the UI and on the 
Printout.

■ The system allows multiple assignments of cases for Workflow/Enterprise 
Managers only on the Worklist New/Open dialogs.

■ The system displays the user name to enable you to select a User for reassignment.

■ If the user has cases open, the system skips those cases.

■ The system tracks updates in the audit log.

■ When the user selects this option, the selected cases have the same user as 
modified by the user.

8.1.3.1.2 Search Case  The following is an illustration of the Search Case section.

Tip: The same fields are displayed in the Worklist - Open screen 
also.

Field Description
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8.1.3.1.3 Filtering Functions  The Filter function enables you to search for entities that 
are only in the worklist. The following is an illustration of the options available in the 
Filter drop-down list.

The following table describes the options available in the Filter drop-down list.

8.1.3.1.4 Total Number of Rows  The following is an illustration of the Total Number of 
Rows section

Filter Performs searches for worklist items on the basis of the 
filtering criteria selected here.

Value Enables the user to select the desired Value as the search 
criterion.

Search Button Enables the user to open the selected or entered case ID.

Group Membership Enables the user to select the type of Group Membership.

Case Owner Enables the user to select the Case Owner.

Assigned To Enables the user to select who the case has been assigned to.

Only view locked Cases 
requiring Follow-up

Select this checkbox to view only those locked cases that 
require follow-up.

View Individual Enables the user to view individual items assigned to this 
group.

View Group Allows the user to view all items assigned to this user group.

View All Allows administrator and workflow manager to see all items 
in the system.

Option Description

Case Number Filters on Case Number.

Workflow State Displays only those workflow states that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Product Displays only those products that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Event Preferred Term Displays only those Event PTs that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Event as Reported Displays the name of the event as reported.

Case Report Type Displays only those Report Types that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Product Group Displays product groups where the Primary Suspect Drug occurs.

Note: The Assigned To option is not available if the user selects 
Individual radio button option from View.
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The following table describes the contents in the columns in the Total Number of 
Rows section.

Field Description

Priority Displays the Priority of the Case.

Lock Status Enables the user to view the Locked state of the case by the icon. If the 
locked icon is present, it indicates that the case is locked and vice versa.

Note: The lock icon is also displayed if the Case Status is Initial or 
Follow up. If the case is Follow-up, additionally, the Follow up number is 
also displayed.

For example: Initial or F / U: 1.

The icon (displayed in the lock state column) in the Worklist - New, 
Open and Reports screens denotes a SUSAR (Suspected Unexpected 
Serious Adverse Reaction) case.

Lock State Header Options

Click the Lock State header row. A pop-up appears listing the following 
sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

Receipt Date If the option "Display Initial Receipt Date always" is configured, the 
Initial Received date of the case is displayed in the Receipt Date column 
on the Worklist screen.

If the option "Display Initial Receipt Date or the latest Follow-up Receipt 
Date" is chosen, and if follow-up entry exists, the latest F/UP Received 
Date regardless of significant or not is displayed in the Receipt Date 
column on Worklist screen. If follow-up do not exist, then the Initial 
Received date of the case is displayed in the Receipt Date column on 
Worklist screen.

Aware Date Displays the Aware Date of the case.

Note: Aware date is the latest significant follow up which is received in 
the case or the Initial Receipt Date if there are no Significant follow ups 
present in the case.

Days Open Displays the number of days that have elapsed between the Initial 
Receipt Date or latest significant Follow-up Receipt Date (if it exists) and 
the current system date (database server).

Days Remaining Displays the number of days that are remaining, as configured in the 
Administration module for Case Processing.
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Case Number Displays the Case Number.

Note: Click the case number to open the case.

Workflow Status Displays the current workflow status of the case.

Product Name Displays the first suspect product in question.

Generic Name Displays the generic name of the suspect product in question.

Event PT Displays the Primary Event and Verbatim, as reported.

Event Verbatim Displays the Event Verbatim, as reported, in the format Primary Event 
(Verbatim as Reported).

S/U/R Displays the Case Level Assessments:

■ S denotes Serious (Y/N)

■ U denotes Unlisted (Y/N)

■ R denotes Causality (Y/N)

Note:

■ Unknown is treated as a "?"

■ When the user clicks the SUR link, the Case Summary gets 
displayed.

F, LT or H ■ F denotes a Fatal (F) case

■ LT denotes Life Threatening (LT)

■ H denotes Hospitalized (H)

Note:

If any of the above are present together, then Fatal takes precedence 
followed by LT followed by H. If the case is neither of the above, No is 
displayed.

Case Type Displays report type information.

Study ID Displays the Study ID of the study cases.

Note: If Study ID is not present, this field is blank.

Reporter Type Displays the Reporter type for the Primary Reporter in the case.

Note: If Reporter ID is not present, this field is blank.

Country Displays the Country of the incident.

Assigned To Displays the current owner or "Unassigned" user to the case.

Owner Displays the Owner of the case.

By default, the first user to accept a case after book-in becomes the "Case 
Owner". The Case Owner has the access right to assign the cases that he 
owns to another user. Though a Case Owner cannot be reassigned 
automatically after the initial assignment, he can be reassigned manually 
by a Workflow manager.

Note: If Owner is not present, this field is blank.

Print List Button Allows the user to print the current worklist for reference.

Note: You can open a case in read-only mode without creating a case 
lock. Use Open in Read-Only to open the case in read-only mode. You 
cannot save a case in a Read-Only mode.

Field Description
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The Worklist>New and Worklist>Open also display a status beside Priority, 
indicating that the time remaining has exceeded the allocated time.

8.1.3.1.5 Routing Details  This section enables you to enter case routing details.

8.1.4 Workflow Options
The Worklist pages have some common options for your use. To see a list of these 
options, right-click the icon Lock State icon to display an option menu.

8.1.4.1 Worklist User Options
The following tables lists the different user options and where they are available

Option Description
Option available 
under Worklist

Open Read Only Opens the selected case in 
read-only mode.

New, Open

Accept Case Allows the user to accept the case 
and assign a user name as 
responsible for that case. A case 
marked with their name as 
responsible moves the case from 
the user's New tab to their Open 
tab.

New

View Case Opens the case. Action Items

Accept Action Item This option is displayed to users 
who have access to Worklist > 
Action Items.

On clicking this option, the 
username of the current user is 
populated in the Assigned To 
column under Case Form > 
Activities tab > Action Items > 
Worklist > Action Item list.

The user who accepted the action 
item can see it under the assigned 
action item in Dashboard > 
Personal Argus Status.

Action Items
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Assign Action Item

This option is displayed only to 
Workflow Managers, and is 
displayed in the context menu.

On selecting this option, a 
drop-down list (of all active users) 
is displayed in the Assigned To 
field for the selected row, with 
(Unassigned) as the default value. 
On selecting a user from this 
drop-down list, the assigned user 
is populated in the Assigned To 
column under Case Form > 
Activities tab > Action Items > 
Worklist > Action Item list.

The user who accepted the action 
item can see it under the assigned 
action item in Dashboard > 
Personal Argus Status.

Action Items

Case Summary Displays the Summary dialog to 
allow the user to view a summary 
of the case form data.

Action Items, 
Open, Reports

Adjust Priority Allows the workflow manager to 
modify the priority level of the 
case.

New, Open

Close Multiple Cases Enables the user to close multiple 
cases.

New, Open

Adjust Assignment Enables the user to adjust 
assignment.

New, Open

Close Case Enables the user to close the case. New, Open

Adjust Case Owner Enables the (re-)assignment of a 
Case Owner by a Workflow 
Manager.

New, Open

View Report Allows users to open the report. Reports

Report Details Allows users to open the report 
details.

Reports

View Multiple Reports Allows users to open multiple 
reports.

Reports

Accept Report Allows the user to accept the 
unassigned report.

Reports

Approve Report This option is enabled only if the 
report is in the Generated state. 
Select this option to automatically 
open the Routing tab of the Report 
Details pop-up window, with the 
Comment field active waiting for 
user input.

Reports

Local Labeling Allows the user to open the local 
labeling for the case that the 
expedited report belongs to, 
showing all the non-assessed local 
labeling rows.

Reports

Option Description
Option available 
under Worklist
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8.1.5 Worklist Action Items
This section discusses the features on the Worklist - Action Items.

To view the Worklist -- Action Items page

1. Select Action Items from Worklist.

2. When the system opens the Action Items screen, enter the information in the fields 
as necessary.

8.1.5.1 General Usage Information
The Worklist Action Items displays the entire description of the Action item selected in 
the Description field on the dialog. Be aware of the following:

Mark for Non-Submission Allows the user to mark the report 
required for Non-Submission. The 
report details dialog is displayed 
with focus to the Submission tab.

Reports

Mark Multiple for Non-Submission Allows the user to also mark 
Multiple reports for 
Non-Submission. The notes and 
date entered are also reflected in all 
the reports.

Reports

Mark Multiple for Approval Allows the user to also mark 
multiple reports for approval.

Reports

Close Action Item Allows the user to close the 
highlighted action item.

Note: Only the Owner of the action 
item can view this option, not all 
the users.

Action Items

Assign Multiple Cases Allows the user to make 
assignments for multiple cases.

Open

Print Allows the user to print a case 
form from the New and Open 
worklist tabs.

New, Open

Print Multiple Cases Allows the user to print a case 
form from the New and Open 
worklist tabs.

New, Open

Medical Review Allows the user to view the 
Medical Review dialog (if he has 
the access rights to view it).

New, Open, 
Reports

Print Medical Summary Allows the user to view the 
Medical Summary Report (if he has 
the access rights to view it).

Reports

Coding Review Allows the user to view the Coding 
Review dialog if the user belongs 
to a group with access rights to 
Coding Review (if he has the 
access rights to view it).

New, Open

Route Multiple Cases Allows the user to route multiple 
cases to the selected workflow 
state.

New, Open

Option Description
Option available 
under Worklist
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■ The system displays the Action Item Code with the Description of the Action Item.

■ You can filter or sort the groups assigned to the Action Items.

■ The Product Name and Study ID have been combined into a single column.

■ The printout prints the new columns.

■ Worklist > Coding Action Items displays the entire description of the action item 
selected in the Description field on the dialog.

8.1.5.2 Query Management
The system generates open Query Action Items based on the advanced conditions 
rules for the action item type.

■ When the user saves the case or clicks the Generate Query icon on the Quick 
Launch toolbar, the system creates an open action item based on the profile switch.

■ The assigned group is defined in the code list. If there is no defined group, the 
default group is Unassigned.

■ The Due date for the action item is the System Date + the Due Date (in days) as 
defined in the code list.

■ The Open Date is the system date on the day the Query is created for the case.

When you click Generate Queries icon, the system generates the Action Item 
queries. These queries are based on the rules define for the Action Item types in 
Code List Maintenance where the Advance Condition satisfies the case criteria.

This item displays on the Quick Launch Toolbar when the case it open.

Short cut key: CTRL+ALT+X

When you save or click Generate Query, the system evaluates all open query 
action types.

If, after the system schedules the action item query, unresolved queries are resolved or 
there are queries that do not meet the criteria of the Advance Conditions, the system 
closes the action item and uses the system date as the close date.

If there are open query action Items, the system does not create new action items with 
the same name when the system tries to resolve the open queries list in the case form.

8.1.5.3 Query Action Items
When querying action items, be aware of the following:

■ The Worklist|Action Items enables you to query only query action items by 
selecting View Query Action Items.

■ The Worklist|Action Items enables you to filter only overdue action items by 
clicking Overdue Action Items. The Worklist displays the Action Items where the 
action item due date is before today's date (system date).

■ By default, the system displays all types of action items to the user.

■ The system allows all open query type action items to be populated in a Letter 
template by adding the following place holder [OPEN_QUERY]. This populates 
the open queries letter template content as configured in the code list when the 
letter is being generated by the user in a separate line for each open query in the 
following format.
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Example:

■ Please provide Reporter Name (Adv. Cond is Reporter name is null)

■ Please provide Physician's address (Adv. Cond is Reporter address is null)

■ Please provide Physician's phone number (Adv. Cond is Reporter phone number 
is null)

■ If the case is saved and the Reporter Name exists, the system creates two Action 
items.

■ The following is an example of a generated letter:

8.1.5.4 Search Case
The following is an illustration of the Search Case section.

Attribute Tool Tip Example

Query Name Name of Query to be included in 
the letter template.

QUERY_Preg_LMP (must begin with 
"QUERY_")

Query Condition Advanced condition. If the 
condition is true, then insert text 
into the generated letter.

Patient is pregnant and date LMP 
missing (Advanced Condition)

Query Letter Text Text to be inserted in generated 
letter if Query Condition is True. If 
Query Condition is no true, the no 
query item is created.

Please provide the Date of Last 
Menstrual Period (LMP) for the 
patient.

Query Item Text Text to be display on the list of 
open queries

Patient missing Date of LMP.
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The following table lists and describes the fields and controls in the section.

8.1.5.5 Filter Function
The Filter function enables you to search for entities in the worklist. The following 
tables describes the options available in the Filter drop-down list.

8.1.5.5.1 Total Number of Rows  The following is an illustration of the Total Number of 
Rows section.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here

Value Enables the user to select the Value as the search criterion

Search Button Enables the user to open the selected or entered case ID.

View Individual Enables the user to view individual items assigned to this user.

Group Membership Enables the user to view the group membership.

View Group Enables the user to view all items assigned to this user group.

View All Enables administrator and workflow manager to see all items in the 
system.

View Query Action 
Items

Enables you to query only query action items.

Overdue Action 
Items

Displays the Action Items where the action item due date is before 
today's date (system date). 

Option Description

Case Number Displays the Case Number

Workflow State Displays only those workflow states that occur in the given work, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Product Displays only those products that occur in the given work, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Event Preferred Term Displays only those Event PTs that occur in the given work, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Event as Reported Displays the Event as Reported

Case Report Type Displays only those Report Types that occur in the given work, 
considering other filter elements such as Case Owner, Assigned to, 
etc.

Note: The Assigned To option is not available if you select the 
Individual radio button option from View.
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The following table describes the contents of each column in the Total Number of 
Rows section.

8.1.6 Coding Action Items
This section discusses the features provided on the Worklist - Coding Action Items 
page.

To view the Worklist - Coding Action Items page
1. Select Worklist --> Coding Action Items.

2. When the system opens the Coding Action Items page, enter the information in 
the fields as necessary.

8.1.6.1 Search Case
The following is an illustration of the Search Case section.

Column Description

Case Number Displays the Case Number.

Note: Click the case number to open the case.

S/U/R Displays the Case Level Assessments:

■ S denotes Serious (Y/N)

■ U denotes Unlisted (Y/N)

■ R denotes Causality (Y/N)

Note:  Unknown is treated as a "?". When the user clicks the SUR link, the 
Case Summary is displayed.

Description Displays the description of the Action Item in question.

Date Open Displays the date the action item was opened.

Date Due Displays the due date.

Days Open Displays the number of days for which the action item has been open.

Assigned To Displays the current owner or "Unassigned" user for the case

Print List Button Allows the user to print the current worklist for reference.
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The following table lists and describes the fields in the Search Case section.

8.1.6.2 Filter Functions
The Filter functionality performs searches on entities present in the worklist only. The 
following table lists and describes the options available in the Filter list.

8.1.6.3 Total Number of Rows
The following is an illustration of the Total Number of Rows section.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here

Value Select a value as a search criteria

Assigned To Searches on the basis of who the case has been assigned to.

View Individual View only individual items assigned to this user group.

View Group View all items assigned to this user group.

View All Enables administrator and workflow manager to see all items in the 
system.

Option Description

All Does not filter on any cases in the work list, excluding other filter 
elements that are specified, e.g. Case owner, etc.

Case Number Displays the Case Number

Workflow State Displays only those workflow states that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Product Displays only those products that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Event Preferred 
Term

Displays only those Event PTs that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Event as Reported Displays the name of the event as reported

Case Report Type Displays only those Report Types that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to.

Note: The Assigned To option is not available if the user selects 
Individual radio button option from View.
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The following table describes the headers within Total Number of Rows:

8.1.7 Contacts
This section discusses the features provided on the Worklist - Contacts and Letters 
page.

To view the Worklist -- Contacts and Letters page
1. Select Worklist --> Contacts and Letters.

2. When the system opens the Worklist - Contacts and Letters screen, enter the 
information in the fields as necessary.

8.1.7.1 Search Case
The following is an illustration of the Search Case section of the Worklist -- Contacts 
screen.

The following table lists and describes the fields in the Search Case section.

Field Description

Case Number Displays the Case Number.

Note: Click the case number to open the case.

S/U/R Displays the Case Level Assessments:

■ S denotes Serious (Y/N)

■ U denotes Unlisted (Y/N)

■ R denotes Causality (Y/N)

Note:

■ Unknown is treated as a "?"

■ When the user clicks the SUR link, the Case Summary gets displayed.

Description Displays the description of the Action Item in question.

Date Open Displays the date the action item was opened.

Date Due Displays the due date.

Days Open Displays the number of days for which the action item has been open.

Assigned To Displays the current owner or "Unassigned" user to the case

Print List Button Allows the user to print the current worklist for reference.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here

Value Selects the Value as the search criterion

Select Button Opens the selected or entered case ID.
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8.1.7.1.1 Filter Functions  The Filter function enables you to search for entities in the 
worklist. The following table below describes the options available in the Filter 
drop-down list.

8.1.7.1.2 Total Number of Rows  The following is an illustration of the Total Number of 
Rows section.

The following table describes the columns in Total Number of Rows:

Assigned To Selects the user to whom the case has been assigned.

View Individual View individual items assigned to this user group.

View Group View all items assigned to this user group.

View All Enables the administrator and workflow manager to see all items in the 
system.

Option Description

Case Number Displays the case number.

Note: The Assigned To option is not available if the user selects 
Individual radio button option from View.

Field Description

Case Number Displays the Case Number.

Note: Click the case number to open the case.

Study ID Allows the user to view the Study ID present in the case.

Description Displays the description of the Action Item in question.

Product Name Allows the user to view the Product Name of the Primary Suspect Drug.

Aware Date Displays the Aware Date of the Case. Aware date is the latest significant 
follow up which is received in the case or the Initial Receipt Date if there 
are no Significant follow ups present in the case.

Date Due Displays the due date.

Days Open Displays the number of days for which the action item has been open.

Assigned To Displays the current owner or "Unassigned" user to the case.

Print List Button Allows the user to print the current worklist for reference.

Field Description
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8.1.8 Reports
This section discusses the features available from Worklist - Reports page.

To view the Worklist Reports page
1. Select Worklist --> Reports.

2. When the system opens the Worklist - Reports screen, enter the appropriate 
information as necessary.

8.1.8.1 Search Case
The following is an illustration of the Search Case section of the page.

The following table lists and describes the fields in the Search Case section.

8.1.8.2 Filter Function
The Filter function enables you to search for entities in the worklist. The following 
tables describes the options available from the Filter drop-down list.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here.

Value Selects the Value as the search criteria.

Search Button Opens the selected or entered case ID.

Assigned To Selects the person to whom the case is assigned.

View Individual Enables the administrator and workflow manager to see individual items 
in the system.

View Group View all items assigned to this user group.

View All Enables the administrator and workflow manager to see all items in the 
system.

Option Description

Case Number Displays the Case Number.

Reporting 
Destination

Displays the report destination (agency) for which the report is 
scheduled.

Product Displays only those products that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Event Preferred 
Term

Displays only those Event PTs that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Report Status Displays the status of the report as Approved, Generated or Scheduled.

Case Report Type Displays only those Report Types that occur in the given worklist, 
considering other filter elements such as Case Owner, Assigned to, etc.

Report Form Displays the description of the report.
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8.1.8.2.1 General Usage Information  When using filtering, be aware of the following:

■ The filter options have a Study ID element that enables the user to filter cases 
within the list (not deleted).

■ This option is a type ahead that enables users to enter values for studies defined in 
the configuration.

■ The type ahead feature limits the users to 25 items in the drop-down list.

■ When the user selects type ahead values, the system performs a like search.

■ The filter options have a Reporting Group element that enables the user to filter 
cases in the list.

■ This option is a type ahead that enables users to enter values for Reporting 
Groups defined for the reports in the worklist.

■ The type ahead limits the users to 25 items in the drop-down list.

■ When the user selects type ahead values, the system performs a like search.

■ The filtering elements have the Product and Reporting destinations removed from 
the list.

■ The user can mark multiple reports for approval by selecting the Mark Multiple for 
Approval option.

■ The user can view the Medical Summary report for all users who have permission 
to print the Medical Summary report.

■ The system displays the Report Details dialog and permits the user to enter the 
approval notes that are applied to all selected reports. The system skips any 
reports selected by the user that have the following statuses:

– Scheduled

– Disapproved

– Approved

■ The system hides the reports fields from the report details dialog and does not 
permit the user to access or modify any other tabs.

■ The system hides the Route button to prevent users from modifying the Report 
Status.

■ Workflow Enterprise users can access View and can modify the report details for 
all reports for all cases across multiple sites in their lists.

8.1.8.2.2 Filtering Reports by Report Destination  When filtering by report destination, be 
aware of the following:

■ You can click the magnifying glass icon to filter reports by report destination. The 
system displays the standard lookup dialog.

Due Date Enter a due date.

Note: The Assigned To option is not available if the user selects 
Individual radio button option from View.

Option Description
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■ The Report Destination filter multi-selection screen list contains the names of all 
agencies as configured in the Argus Regulatory Authority CodeList.

■ The system displays only the report rows that match the authority/agency you 
selected.

8.1.8.2.3 Filtering Reports by Product Family  When filtering reports by product family, be 
aware of the following:

■ You can click the magnifying glass icon to filter reports by product family. The 
system displays the standard lookup dialog.

■ The Product Family filter multi-selection screen contains a list of all product 
family names as configured in the Argus Products Code List.

■ The system displays only the report rows that match the product you selected.

8.1.8.2.4 Filtering Reports by Country of Incidence  When filtering reports by country of 
incidence, be aware of the following:

■ You can click the magnifying glass icon to filter reports by country of Incidence. 
The system displays the standard lookup dialog.

■ The Country of Incidence filter multi-selection screen contains a list of all 
available countries.

■ The system displays only the report rows that match the country of incidence you 
selected.

8.1.8.3 Total Number of Rows
The following is an illustration of the Total Number of Rows section.

The following table lists and describes the columns in the Total Number of Rows 
section.

Field Description

Selected Allows the user to select the report.



About Worklist

Worklist 8-20

Lock State Allows the user to view the Locked state of the case by the icon. If the 
locked icon is present, it indicates that the case is locked and vice versa.

Note: The lock icon is also displayed if the Case Status is Initial or 
Follow up. If the case is Follow-up, additionally, the Follow up number 
is also displayed.

E.g. Initial or F / U: 1.

The icon displayed in the lock state column, in the Worklist - New, 
Open and Reports screens denotes a SUSAR (Suspected Unexpected 
Serious Adverse Reaction) case.

Lock State Header Options

Click the Lock State header row. A pop-up appears listing the following 
sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

Status Displays the report status. Click the link displaying the report status to 
view the Report Details. Refer to the About the Report Details Dialog 
Box section for descriptions of each tab.

Case Number Displays the Case Number.

Note: Click the case number to open the case.

Country of Incidence Displays the Country of incidence.

Report Type Displays the Case Report Type.

Suspect Product Displays the Trade name for which the report has been scheduled. A "+" 
displayed at the end of a Product Name indicates that more than one 
Suspect Company Products exist.

A Device Name is also displayed for those Reports which were 
scheduled for the Device.

Diagnosis Displays the Primary Event Diagnoses PT

Event Verbatim Displays the event verbatim (verbatim as reported) of the Primary 
Event.

S/U/R Displays the Case Level Assessments:

■ S indicates Serious (Y/N)

■ U indicates Unlisted (Y/N)

■ R indicates Causality (Y/N)

Note:  Unknown is treated as a "?".  When the user clicks the SUR link, 
the Case Summary gets displayed.

F or LT Indicates whether a case is fatal or life threatening as follows:

■ F identifies a Fatal (F) case

■ LT identifies a Life Threatening (LT)

Note: If any of the above are present together, then Fatal takes 
precedence followed by LT.  If the case is neither of the above, No is 
displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form Displays the description of the report. Click the link to view the DRAFT 
Report PDF.

Field Description
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The following table lists and describes the options available under Lock State.

Destination Displays the report destination (agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Displays if the report is Initial or Follow-up.

If it is a Follow-up, the follow-up number is printed.

Due Date Displays the date the report is due.

Days Past Due Displays the number of days the report is past due date.

Days Open Displays the number of days since the report has been open.

Date Scheduled Displays the Scheduled Date of the report.

Assigned Displays the name of the individual to whom the case has been 
assigned.

Downgrade Displays Yes if the report is a downgrade report.

Print List Button Allows the user to print the current worklist for reference.

Option Description

View Report Enables the user to view the report as a PDF.

Report Details Enables the user to view the report details.

Accept Report Enables the user to accept the report.

Approve Report Enables the user to approve the report.

Adjust Assignment Enables the user to adjust assignment for the selected report.

Medical Review Enables the user to view the Medical Review of the case.

Print Medical 
Summary

Enables the user to print the medical summary of the case.

Case Summary Enables the user to view the case summary of the case.

Local Labeling Enables the user to view the local labeling dialog.

■ This option is available only if the user has access to Local Labeling 
within the groups to which the user belongs to.

■ The Local Labeling can also be viewed by clicking the local labeling 
icon that is displayed next to S/U/R.

Mark for 
Non-Submission

Enables the user to mark the report for non-submission.

Mark for 
Submission

Enables the user to mark the report for submission.

View Multiple 
Reports

Enables the user to view multiple reports as a PDF.

Mark Multiple for 
Non-Submission

Enables the user to mark multiple reports for non-submission.

Mark Multiple for 
Submission

Enables the user to mark multiple reports for submission.

Mark Multiple for 
Approval

Enables the user to mark multiple reports for approval.

Field Description
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8.1.9 Bulk Transmit
The Bulk Transmit function lists the status for all transmission events against your 
assigned cases.

8.1.9.1 To view the Bulk Transmit page
1. Select Worklist --> Bulk Transmit.

2. When the system opens the Bulk Transmit screen, enter the appropriate 
information as necessary.

8.1.9.2 General Usage Information

Search Case Section
The following is an illustration of the Search Case section.

The following tables lists and describes the fields and controls in the Search Case 
section.

8.1.9.2.1 Filter Function  The Filter function enables you to search for entities in the 
worklist. The following table describes the options available from the Filter 
drop-down list.

8.1.9.2.2 Total Number of Rows  The following is an illustration of the Total Number of 
Rows section.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria 
selected here

Value Enables the user to select the Value as the search criterion

Search Button Enables the user to open the selected or entered case ID.

View Individual Enable users to view individual items assigned to this user group

View Group Enable the user to view all items assigned to this user group.

View All Enable administrator and workflow manager to see all items in the 
system.

Option Description

Case Number Displays the case number

Reporting 
Destination

Displays the report destination (agency) for which the report is 
scheduled.

Report Form Displays the report form

Report Status Displays the report status
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The following table below describes the columns in Total Number of Rows section

8.1.9.2.3 User Options  The following table describes the user options.

Field Description

Case Number Displays the Case Number. Click the Case Number to view the case 
details.

Report Form Displays the Description of the report

Click the link to view the DRAFT Report PDF.

Fax Number Displays the fax number of the report recipient

Recipient Name Displays the name of the report recipient

Recipient Company Displays the name of the company of the report recipient

Date Created Displays the date on which the report was created.

Date Sent Displays the date on which the report was transmitted to the recipient.

# of Pages Displays the number of pages in the report

Attempts Displays the number of attempts made to transmit the report. If you are 
using Right Fax, the value of this field is displayed as 0 even if the Right 
Fax had attempted it multiple times. This is an unsupported feature in 
Right Fax.

Sender Displays the name of the sender of the report

Lock State Displays the lock status of the report.

Email Address Allows the user to enter the email address.

Due Date Displays the due date for the report.

Sender Agency 
Name

Displays the name of the agency that has generated the report

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the Report Status to view the Report Details. Refer to the About the 
Report Details Dialog Box section for descriptions of each tab.

Print List Button Allows the user to print the current worklist for reference.

Option Description

View Transmission Displays the report in a PDF format.



About Worklist

Worklist 8-24

8.1.9.2.4 Routing Details  The following is an illustration of the Routing Details section. 
Enter routing details in this text box.

8.1.10 Bulk Print
The Bulk Print function displays a separate list for all Bulk Print events against 
reports.

To view the Bulk Print page
1. Select Worklist --> Bulk Print

2. When the system opens the Bulk Print page, enter the appropriate information.

8.1.10.1 General Usage Information

Search Case Section
The following is and illustration of the Search Case section.

The following table lists and describes the fields and controls in the Search Case 
section.

Mark report as 
Submitted

Marks the report for the selected row as submitted.

Note: This option is displayed to only those users who have the access 
rights to mark a report as submitted.

Remove 
transmission

Failed transmissions can be removed using this option as it removes the 
transmission log entry from the list. 

Note: A report whose status is pending cannot be transmitted.

Re-transmit This options allows reports to be re-generated and re-transmitted if report 
generation had failed earlier. For failure in other stages of report 
transmission, this option performs only retransmission.

Submit Multiple 
Reports

Multiple reports that are selected from the list can be marked as 
submitted simultaneously.

Re-transmit 
Multiple

The status of multiple reports that are selected from the list can be 
changed to "pending," and those reports can be re-transmitted.

Remove Multiple 
Transmissions

Transmission of multiple reports that are selected from the list can be 
removed.

Note: Reports that appear in the Bulk Transmission section or the 
Bulk Print section do not display in the Reports section of the 
Worklist.

Field Description

Option Description
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8.1.10.1.1 Filter Function  The Filter function enables you to search for entities in the 
worklist. The following table below describes the options available from the Filter 
drop-down list.

8.1.10.1.2 Total Number of Rows Section  The following is an illustration of the Total 
Number of Rows section.

The following table below describes the columns in Total Number of Rows:

Filter Performs searches for worklist items on the 
basis of the filtering criteria selected here.

Value Enables the user to select the Value as the 
search criterion.

Search Button Enables the user to search.

View Individual Enables the user to view individual items 
assigned to this user group.

View Group Allows the user to view all items assigned to 
this user group.

View All Allows administrator and workflow manager 
to see all items in the system.

Option Description

Case Number Displays the case number

Reporting 
Destination

Displays the report destination (agency) for which the report is 
scheduled.

Report Form Displays the report form

Report Status Displays the report status

Field Description

Case Number Displays the Case Number. Click the Case Number to view the case 
details.

Report Form Displays the Description of the report

Click the link to view the DRAFT Report PDF.

Agency Name Displays the name of the agency that has generated the report

Printer Name Displays the name of the printer.

Date Created Displays the date on which the report was created.

Date Sent Displays the date on which the report was transmitted to the recipient.
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8.1.10.1.3 Bulk Print User Options  Click the icon associated with each report to view 
available user options. The following table describes the Bulk Print user options.

8.1.10.1.4 Routing Details Section  The following is an illustration of the Routing Details 
section. Enter routing details in this text box.

8.1.11 Bulk ICSR Transmit
The Bulk ICSR Transmit function displays only those ICSR Reports that are awaiting 
submission (not in submitted state) when transmitted from "Bulk Report By Form" to 
the Trading partner.

This menu option is not displayed if Interchange is not licensed or if you do not have 
access to open worklist screens based on existing File Menu Access rights in the Group 
Configuration.

The Bulk ICSR Transmit page has two (2) tabs as follows:

■ Reports -- Displays the status of individual ICSR Reports that are in the process of 
being transmitted.

Lock State Displays the lock status of the report.

Due Date Displays the due date for the report.

Sender Displays the name of the sender of the report

Report Status Displays the Report Status.

Click the Report Status to view the Report Details.

Print List Button Allows the user to print the current worklist for reference.

Option Description

View Report Displays the report in a PDF format.

Mark report as 
Submitted

Marks the report for the selected row as submitted.

Note: This option is displayed to only those users who have the access 
rights to mark a report as submitted.

Remove Print Job Removes the print job entry from the list.

Note: A report whose status is pending cannot be printed.

Re-print This option is displayed if the selected row has a status of failure or 
success. Select this option to change the status back to pending and the 
re-print the report.

Submit Multiple 
Reports

Multiple reports that are selected from the list can be marked as 
submitted simultaneously.

Re-print Multiple The status of multiple reports that are selected from the list can be 
changed to "pending," and those reports can be re-transmitted.

Remove Multiple 
Print Jobs

Print jobs of multiple reports that are selected from the list can be 
removed.

Note: The reports appearing in the Bulk Transmission section or the 
Bulk Print section are not displayed in the Reports section of the 
Worklist.

Field Description
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■ Messages -- Displays the status of ESM Messages which may contain multiple 
reports.

To view the Bulk ICSR Transmit page
1. Select Worklist --> Bulk ICSR Transmit.

2. When the system opens Bulk ICSR Transmit page, entered the appropriate 
information as necessary.

8.1.11.1 General Usage Information

8.1.11.1.1 Reports Tab  The following is an illustration of the Reports tab.

Click the relevant links for information about the sections and user options on the 
Reports tab.

Search Criteria Section
The following is an illustration of the Search Criteria section.

The following table lists and describes the fields in the Search Criteria section.

Field Description

Report Select the type of report from the drop-down list, as applicable.

Select E2B, eVAERS or eMDR from the list to view the transmission 
status of the report.

Case # Displays the Case Number.

Click the Case Number to view the report.

Message Type Select a pre-defined message type.This field is set to ichicsr and is 
disabled if report is set as eMDR or eVAERS 
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8.1.11.1.2 Total Number of Rows Section  The following is an illustration of the Total 
Number of Rows section.

The following table describes the columns in the Total Number of Rows section.

Periodic Report This field is enabled for message type that are marked as "Periodic" in 
Message type codelist.

This field is disabled for eVAERS and eMDR.

Start Date Enter the start date.

End Date Enter the end date.

Range Select a date range.

Search button Triggers search based on the search criteria.

Only show 
transmissions that 
have reached a 
failure state

Enable this checkbox to search for only those transmissions that have a 
failed status.

Show all 
transmissions 
(submitted and 
unsubmitted) 
having a error ACK

When this checkbox is checked by the user during the Search action, the 
system brings back any ICSR report that has received an error ACK 
(acknowledgement), irrespective of whether it has been marked as 
submitted or not.

Note: When this checkbox is checked, the checkbox "Only show 
transmissions that have reached a failure state" is automatically is 
unchecked.

View Individual Displays all items assigned only to the individual user.

View Group Allows the user to view all items assigned to this user group.

View All Allows administrator and workflow manager to see all items in the 
system.

Stage Legend Shows the status (through colors) corresponding to each stage.

Field Description

Action Displays the icon containing the available user actions.

Tip: Click on the case lock status (unlocked, locked or archived) for 
further options.

Case Number Displays the Case Number. Click the Case Number to view the case 
details.

Submitted Date Displays the date when the report was submitted.

Case Status Displays the current workflow of the state

Field Description
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8.1.11.1.3 Reports Tab User Options  Click the Action icon with each report to view the 
available user options. The following table below describes the available options.

Reporting 
Destination

Displays the name of the Reporting Destination

Date Created Displays the date on which the report was created.

Date Transmitted Displays the date when the report was transmitted.

Local Company 
Name

Displays the name of the local company that has sent the report.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the Report Status to view the Report Details.

Message Type Displays the ICSR message type for the transmission

Transmit Denotes Processing Report

EDI In Denotes EDI In

EDI Out Denotes EDI Out

MDN Rec. Denotes MDN Received

ACK Rec. Denotes Acknowledgement Received

Status Details Contains the details of the latest failure / success message for the 
selected row.

Print Prints the row selected by the user

Print List Button Allows the user to print the current worklist for reference.

Option Description

View Report Details 
(Read only)

Opens the existing Report Details dialog in read-only mode.

View ICSR Report 
(ICSR Viewer for 
the report)

Opens the existing ICSR Viewer report.

ICSR Transmission 
History 
(Transmission 
History for the 
selected report)

Opens the new Transmission History screen

Remove 
Transmission

Removes the transmission log entry from the list.

Note: A report whose status is pending cannot be transmitted.

Re-Transmit This option is displayed if the selected row has a status of failure or 
success. Select this option to change the status back to pending and the 
re-fax the report.

Remove Multiple 
Transmissions

Removes transmission of multiple reports that are selected from the list.

Re-Transmit 
Multiple Reports

The status of multiple reports that are selected from the list can be 
changed to "pending," and those reports can be re-transmitted.

Submit Multiple 
Reports

Multiple reports that are selected from the list can be marked as 
submitted simultaneously.

Field Description
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8.1.11.1.4 Messages Tab  The following is an illustration of the Messages tab.

8.1.11.1.5 Search Criteria Section  The following is an illustration of the Search Criteria 
section on the Message tab.

Remove 
Transmission

Failed transmissions can be removed using this option as it removes the 
transmission log entry from the list. 

Note: A report whose status is pending cannot be transmitted.

Re-Transmit This options allows reports to be re-generated and re-transmitted if 
report generation had failed earlier.

For failure in other stages of report transmission, this option performs 
only retransmission.

Note: If the ICSR report in a result set row was already submitted, 
the system does not display the following pop-up menus:

a. Remove Transmission

b. Re-Transmit

c. Mark as Submitted

d. Remove Multiple Transmissions

e. Re-Transmit Multiple

f. Submit Multiple Reports

g. ICSR Transmission History

For the same record above, the system, however, keeps the View 
Report Details and View ICSR Report menus enabled.

Option Description
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The following table lists and describes the fields and controls in the Search Criteria 
section.

8.1.11.1.6 Total Number of Rows Section  The following is an illustration of the Total 
Number of Rows section.

The following table below describes the column in the Total Number of Rows section.

Field Description

Report Select  E2B or eVAERS or eMDR from the drop-down list to view the 
transmission status of these reports.

Agency Trading 
Partners

Enter the agency or trading partner.

Transmit Date 
Range From

Select the transmit date range.

Range Select a range to auto populate the Start Date and End Date.

Note: The Range option is cleared if the Start Date or End Date is 
changed.

Message # Range Select the message range.

Search button Triggers search based on the search criteria.

Stage Legend Shows the status (through colors) corresponding to each stage.

Field Description

Reports Displays the number of reports.

Action Displays the icon containing the available user actions.

Trading Partner Displays the name of the agency or the trading partner.

EDI Receive Receipt Displays the EDI Receipt status.

Local Msg # Displays the Local Message Number.

Remote Msg # Displays the Remote Message Number.

File Name Displays the File Name.

Transmit to EDI Displays the Transmit to EDI Status.

EDI Tracking ID Displays the EDI Tracking ID.

EDI Transmit Date Displays the EDI Transmit Date.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the Report Status to view the Report Details.
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8.1.11.1.7 Message Tab User Options  Click the Action icon associated with each report to 
view the available user options. The following tables lists and describes the available 
user options.

8.1.12 Local Labeling
When using worklist local labeling, be aware of the following:

■ Filtering by Product Family

Click the magnifying glass icon to filter the search results by product family.

You can filter products in the Event Assessment dialog based on the selected product 
families.

On filtering, the system displays only the assessment rows matching the selected 
product families.

■ Events Assessment can show all listedness values. By default it shows listedness 
only for core datasheets and for those countries the user has permission to access.

■ The filter options have a Study ID element and a Case Number (not a type ahead) 
added to filter cases in the list.

– This option is a type ahead field that enables you to enter values for studies 
defined in the configuration.

– The type ahead limits the number of values in the drop-down list to 25.

– When you select type ahead values, the system performs a like search.

■ Sorting

Search results can be sorted by case number and product name.

EDI In Denotes EDI In.

EDI Out Denotes EDI Out.

MDN Rec. Denotes MDN Received.

ACK Rec. Denotes Acknowledgement Received.

Status Detail Contains the details of the latest failure / success message for the 
selected row.

Print button Prints the row selected by the user.

Print List button Allows the user to print the current worklist for reference.

Option Description

ICSR Transmission History (Transmission 
History for the selected report)

Opens the new Transmission History screen

View Acknowledgement (Read only) Displays the Acknowledgment report.

Note: This menu option is not displayed if ACK 
has not been received for message.

View Reports Opens the Bulk Transmit ICSR in the report view 
for all the reports in the message.

View xml acknowledgement Displays business level acknowledgement

Field Description
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■ Printing --You can print the current view of the Worklist as defined by the filtering 
and sorting criteria.

■ Saving

The system remembers the filtering and sorting selections for a particular session.

The system displays the default settings on the Worklist - Local Labeling for a new 
user session.

■ The system displays the total number of rows in the Search header section (e.g., 20 
cases of a possible 450 with 0 cases being processed.)

■ You can configure the number of cases to display on the Page Size drop-down list 
in the Search dialog (based on the profile settings for paging as a read only value).

■ The system displays the number of cases currently in view and automatically 
updates the range based on the page size specified in the Search dialog (read 
only). For example, if you select 100, the system divides the displays rows into 
groups of 100 cases.

■ You can go directly to a range of cases from the Displaying Rows drop down list.

■ You can scroll through the Search results page-by-page, as defined by the Page 
Size drop-down list.

■ You can filter search results by Product:

– The product Filter drop down list contains all products listed in the event 
assessment.

– The system enables you to filter on the Products in the Event Assessment 
dialog.

– By default, the system displays all the products with the <ALL> option.

– When filtering, the system displays only the assessment rows for the product 
you selected.

■ Events assessment can show all listedness values. By default, it shows listedness 
only for the core datasheets and countries you have permission to access.

■ Event

– The Event Filter contains a drop down values of distinct Event PT.

– The system enables you to filter on the events in the Event Assessment dialog.

– By default, the system displays all events with the <ALL> option.

– When filtering, the system displays only the assessment rows that match the 
product you selected.

■ Diagnosis -- The Diagnosis Filter contains a drop-down list with the following 
values:

– D (Diagnosis)

– S (Symptoms)

– In the Events Assessment dialog, you can filter on either the diagnosis or the 
symptom.

■ By default, the system displays all events with the <ALL> option.

■ When filtering, the system displays only the assessment rows that match the 
product you selected.
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■ Datasheets

– The Datasheets drop-down contains a list of distinct datasheets.

– You can filter on the datasheets in the Event Assessment dialog.

– By default, the system displays all datasheets with the <ALL> option.

– When filtering, the system displays only the assessment rows for the product 
you selected.

– All the blank datasheets display as a single row of Unspecified.

– When you click the Datasheet hyperlink, the system displays the datasheet 
notes.

■ Licenses

– The Licenses drop-down contains a list of distinct countries for the licenses.

– In the Event Assessment dialog, you can filter on licenses.

– By default, the system displays all licenses with the <ALL> option.

– When filtering, the system displays only the assessment rows that match the 
product you selected.

– All licenses not associated with a datasheet display under Unspecified and 
are aligned with the datasheet view.

– When you click the Licenses hyperlink, the system displays the license 
references.

– You can print the current Search view as defined by the filtering and sorting 
criteria.

■ The Process button triggers all the applicable rules (both global and local) for the 
country/license type for the licenses that are assessed through this screen.

■ If there were no local reports configured in the system (that is, if there is no data in 
the Local Reports Configuration table), all the reports triggered above are 
generated.

■ If there were local reports configured in the system (that is, if there is data in the 
Local Reports Configuration table), all the reports triggered above for a case that 
has Local Lock pending for the country of those licenses assessed above are in 
scheduled state and are generated on subsequent local lock.

■ For more information about Local Labeling, see the LAM User Guide for Worklist - 
Local Labeling requirements.

8.1.13 Coding Status
Coding Status enables you to perform the following functions:

■ Coding Status View

■ Single Case Coding / Recoding

■ Bulk Coding / Recoding

■ Coding Status Reports

Configured users can select Coding Status through the Worklist menu. The following 
is an illustration of the Coding Status screen.
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8.1.13.1 Search Conditions Section
The following is an illustration of the Search Conditions section.

The following table lists and describes the fields and controls in the Search Conditions 
section.

8.1.13.2 Total Number of Rows Section
The following is an illustration of the Total Number of Rows section.

The following table lists and describes the columns in the Total Number of Rows 
section.

Field Description

Search For Select the criteria by which the case must be searched for and 
enter an appropriate search item, if applicable.

Note: You can search for cases based on multiple study 
identifiers. The option, "Prj/Othr/Stdy/Rptr/Pat" supports 
entry of Project ID, Study ID, Other ID, Center ID, Reporter ID, 
and Patient ID values separated by the "/" (forward slash) 
character.

Any or all fields may be present.

Full Search Select this checkbox, if necessary.

Full search is best explained with an example. If the full search 
option is not used and the item that is entered under Search for is 
"AB", then a string such as "ABCESS" will match "AB", but a 
string such as "LABOR" will not. If the full search option is used, 
both these items will match "AB". Also, items whose first few 
letters sound similar (like "TIM" and "TIN") will also appear in 
the search results.

Product Family Select the Product Family that the case belongs to, if applicable.

Date Range Select a relevant Date Range, if applicable.

Tip: To enter a customized date range, select Custom Date 
Range from the list.

Enter an appropriate date range in the custom date range dialog 
and click OK.

Advanced Select an advanced condition for the case, if applicable.

Note: Click AC to create a new advanced condition.

Search Displays the list of cases that match the entered search criteria

Field Description

Case Lock icon Depicts the lock or unlock status of the case.
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8.1.13.3 Coding Status Icons
The following table lists and describes the icons used to identify the coding status.

8.1.14 Letters
The Letters function enables you to search for letters associated with a case.

To access the Worklist - Letters page
1. Select Worklist --> Letters.

2. When the system opens the Worklist - Letters page, enter the appropriate 
information.

8.1.14.1 Search Case Section
The following is an illustration of the Search Case section.

Case Number Displays the case number. Click the link to view the case form.

Aware Date Displays the Aware Date for the case.

Seriousness 
Criteria

Displays the Case level Seriousness Criteria. In case the case has any Fatal 
or Life Threatening event, it is displayed as such.

Workflow State Displays the Workflow State of the case

Aging (Days) If all code-able items of the case are coded completely, Aging is displayed 
as the Number of days from the Initial Receipt Date to the date when 
latest item of the case was coded.

If any code-able item of the case is not coded, Aging is displayed as the 
Number of days from the Initial Receipt Date to the system date 
(Database Server).

Coding State If all the events / products are encoded, the coding state is denoted with 
a green check mark.

If the case has even a single code-able item as not coded, the coding state 
is shown as a red cross mark.

Icon Description

Displays that the verbatim text has not yet been coded.

Displays that the verbatim text has been successfully coded.

Is displayed if the verbatim text has been submitted to Central Coding, 
but no result has been returned to Argus yet.

Is displayed if the term was submitted to Central Coding for coding and 
returned a status of error either from Central Coding or Argus.

Field Description
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The following table lists and describes the fields and controls in this section.

8.1.14.2 Total Number of Rows Section
The following is an illustration of the Total Number of Rows section.

The following table below describes the columns in the section.

8.1.15 Intake
The Intake function enables you to view a list of incoming attachments in Worklist 
View where you can select an attachment for creating a case.

To access the Worklist - Intake page
1. Select Worklist --> Intake.

2. When the system opens the Worklist - Intake page, enter the appropriate 
information.

8.1.15.1 Pending Tab
The following is an illustration of the Pending tab.

Field Description

Current Letter Select the current letter from this list

Date Range Allows the user to select a date range from which cases may be selected. 
The selection made from the Date Range drop-down list automatically 
populates the From and To fields.

Show only those 
cases with no 
previous 
notifications

Allows the user to filter the case list search to only those cases that have 
not had any correspondence letters sent.

Advanced 
Condition

Select an Advanced Condition from the list

AC Creates a query for an Advanced Condition

Search button Displays the results matching the search criteria

Field Description

Action Displays the Action icon

Case ID Displays the Case ID. Click the Case ID to view the case details.

Date Displays the date

Reporter Displays the reporter name

Last Notification Displays the last notification date
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Users other than Workflow Managers can now reject case from Intake Worklist.

The following table lists and describes the fields and controls in this section.

Field Description

Priority Allows the user to view the priority of the case.

Initial Date Allows the user to view the initial receipt date of the case.

Intake Date Allows the user to view the date of case intake.

Product Name Allows the user to view the first suspect Product in question.

Generic Name Allows the user to view the generic name of the suspect product in 
question.

Event PT Allows the user to view the Primary Event and Verbatim as Reported.

Event Verbatim The following format is used:

Primary Event (Verbatim as Reported)

S/U/R Allows the user to view case-level assessments

F, LT or H Allows the user to view Fatal, Life-Threatening or Hospitalized cases.

Case Type Allows the user to view report type information. 

Study ID Allows the user to view the Study ID of the study cases.

Reporter Type Allows the user to view the Reporter type for the Primary Reporter in 
the case.

Country Allows the user to view the Country of incident.

Assigned To Allows for the current owner or "Unassigned" user to be assigned to the 
case.

Group Allows for the current group owner or "Unassigned" group to be 
assigned to the case.

Central Site/LAM 
Site

Allows the user to view the current Site (Argus or Affiliate) of the Case - 
If there are no Sites defined then ALL users can access the case 
attachment.

Attachment Name Allows the user to view the attachment which is associated to the case.

Classification Allows the user to view the attachment classifications which is 
associated to the case.

Description Allows the user to view the attachment description which is associated 
to the case.

Create Case Allows the user to create a case.

Reject Case Allows the user to reject the case.
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8.1.15.2 Rejected Tab
The following is an illustration of the Rejected tab.

The following table below describes the columns in the section.

Print List Allows the user to print the case.

Field Description

Priority Allows the user to view the priority of the case.

Initial Date Allows the user to view the initial receipt date of the case.

Intake Date Allows the user to view the date of case intake.

Product Name Allows the user to view the first suspect Product in question.

Generic Name Allows the user to view the generic name of the suspect product in 
question.

Event PT Allows the user to view the Primary Event and Verbatim as Reported.

Event Verbatim The following format is used:

Primary Event (Verbatim as Reported)

S/U/R Allows the user to view case-level assessments

F, LT or H Allows the user to view Fatal, Life-Threatening or Hospitalized cases.

Case Type Allows the user to view report type information. 

Study ID Allows the user to view the Study ID of the study cases.

Reporter Type Allows the user to view the Reporter type for the Primary Reporter in 
the case.

Country Allows the user to view the Country of incident.

Assigned To Allows for the current owner or "Unassigned" user to be assigned to the 
case.

Group Allows for the current group owner or "Unassigned" group to be 
assigned to the case.

Central Site/LAM 
Site

Allows the user to view the current Site (Argus or Affiliate) of the Case - 
If there are no Sites defined then ALL users can have access to the case 
attachment.

Attachment Name Allows the user to view the attachment which is associated to the case.

Classification Allows the user to view the attachment classifications which is 
associated to the case.

Field Description
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Description Allows the user to view the attachment description which is associated 
to the case.

Rejected Date Allows the user to view the date when the case was rejected.

Rejected By Allows the user to view the user who rejected the case.

Create Case Allows the user to create a case.

Reject Case Allows the user to reject the case.

Print List Allows the user to print the case.

Field Description
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9MedDRA Browser

This chapter describes the MedDRA (Medical Dictionary for Regulatory Activities) 
browser which is used to encode diseases, symptoms, signs, and so forth. In Argus 
Safety, using such a dictionary provides consistency when assigning terms for adverse 
events. 

9.1 MedDRA Browser Functionality
When loading the new MedDRA dictionary, the system selects the default MedDRA 
browser.

The following is an illustration of the MedDRA Browser screen.

To view the MedDRA Browser
1. Select Utilities --> MedDRA Browser.

The system opens the MedDRA Browser screen.

9.1.1 Using the MedDRA Browser
Your Argus Safety Administrator may have configured the system to use the MedDRA 
Browser for encoding events or indications.
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If this is the case, the MedDRA Browser dialog opens when you click the Encode 
button. The dialog can also be invoked while creating Advanced Conditions or by 
going to Utilities > MedDRA Browser.

■ A new checkbox has been added in MedDRA browser "Include Non-current 
terms" as shown in the screenshot below. This is unchecked by default.

■ This checkbox is enabled only when MedDRA Browser is used for searching on 
local MedDRA dictionaries.

■ When MedDRA Browser opens up to perform further searches on MedDRA Web 
Service, then this checkbox is unchecked and disabled.

■ When user searches for a term by marking "Include Non-current terms" checkbox, 
the system retrieves the matching Non-current terms along with the Current 
terms.

■ The Non current LLT terms are displayed preceded with an asterisk (*) symbol 
separated by a space, in the search results grid as well as bottom section which 
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displayed the selected term details. On clicking on non current term, the system 
displays its PT, HLT, HLGT, and SOC terms. Note that existing application logic to 
determine non-currency of a term is either based on English or Japanese currency 
of the term in different scenarios. Hence, the asterisk (*) symbol is dislplayed 
appropriate.

– If MedDRA J is not configured, then only English currency is used.

– If MedDRA J is configured and MedDRA Browser is opened from a Japanese 
base language screen, then only Japanese currency is used.

– If MedDRA J is configured, MedDRA Browser is opened from an English base 
language screen (for English as well as Argus J user), and Country of 
Incidence is Japan, then English as well as Japanese currency is used.

– If MedDRA J is configured, MedDRA Browser is opened from an English base 
language screen (for English as well as Argus J user), and Country of 
Incidence is not Japan, then only English currency is used.

■ On selecting a noncurrent term in the MedDRA browser by clicking 'Select' button, 
the  following message is displayed:

Selected term is a non-current term in the MedDRA dictionary. Please select a 
current term.

■ The MedDRA Browser print PDF also display the asterisk (*) symbol in front of 
the non-current LLT.

■ The MedDRA Browser print PDF display the footnote as follows in the Print PDF 
report:

*  Non-current MedDRA term

9.1.1.1 MedDRA Browser Dialog Fields and Field Descriptions
The following table lists and describes the fields in the MedDRA Browser dialog box.

Field Description

Coded Version Shows the version of the dictionary under which this event was 
originally encoded.
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9.1.1.2 MedDRA Searches and Search Results
Use the following procedure to search for terms.

Execute these steps to search for terms:
1. Enter the required term in one of the five levels of encoding.

Terminology Allows you to select the version of the dictionary in which you wish to 
encode this event.

Full Search If you select this check box, the search text you enter will be matched 
within each word of the terms. If this check box is cleared, the system 
will only return the terms that begin with the text you entered.

Special Category You can select a special category in the MedDRA dictionary from this list 
in order to display the terms related to that category.

Clear Clears all entries in the dialog.

Search All Levels You can enter text in this field and press ENTER in order to search for the 
text across all of the five levels of the dictionary.

SOC column System Organ Class. You can enter text in this field to search for the term 
in this particular level.

HLGT column High Level Group Term. You can enter text in this field to search for the 
term in this particular level.

HLT column High Level Term. You can enter text in this field to search for the term in 
this particular level.

PT column Preferred Term. You can enter text in this field to search for the term in 
this particular level.

LLT column Low Level Term. You can enter text in this field to search for the term in 
this particular level.

Synonyms This level can list company-specific synonyms for LLT terms.

Print Creates a report of the information that is currently on the dialog. This 
report will be in PDF format.

Select Click this button to enter the terms that have been selected into the 
encoding.

Save Click this button to save the query. This button is enabled only on 
selection of the PT term(s).

Export This button is enabled in two scenarios - when MedDRA is opened from:

i) Argus Console > Business Configuration > Products and Licenses > 
Product Family > Datasheet

or, from:

ii) Argus Console > Code Lists > Argus > Event Group

MedDRA terms are selected at any level of the MedDRA hierarchy.

On clicking this button, a dialog is displayed, that allows you to select the 
file type - .csv / .xls / .xlsx file.
On specifying the file type, the selected PT terms are then exported in the 
Export file. in the <PT terms> format.

Cancel Click this button to close the dialog without making any changes.

Field Description
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2. You can enter as little information as necessary in order to get a broader set of 
results. Alternatively, you can enter the term under Search All Levels to search for 
the term across all levels.

3. Select the Full Search check box, if necessary.

Full search is best explained with an example: If the full search option is not used 
and the item that is entered under Search for is "AB", then a string such as 
"ABCESS" will match "AB", but a string such as "LABOR" will not. If the full search 
option is used, both these items will match "AB."

4. Press ENTER. A list of search results opens.

9.1.1.2.1 About Search Results  When using search results, be aware of the following:

■ You can click the Select button to transfer the selected terms to the Case Form or 
the Advanced Conditions dialog, depending on where the browser was invoked 
from. The button only becomes available after terms at all levels have been 
selected.

■ If you double-click an LLT term, a Term Details dialog appear. The dialog displays 
the following details about the term:

– Indicate if the term is current or non-current

– MedDRA code for the highlighted term

– Primary SOC code and term

– Secondary SOC code(s) and term(s), if applicable

– Dictionary identifier

■ When you select a term in a particular column, the other columns will be filled-in 
with the appropriate terms that correspond to the selected term.

■ The Primary SOC Path is highlighted by using bold text for the path.

■ To perform a synonym search, select an LLT among the search results. A synonym 
for the LLT will appear in the Synonyms column. When you select a synonym, the 
LLTs for that synonym will appear in the Synonyms column.

9.1.1.2.2 Using the MedDRA Browser for Advanced Conditions  When you select a field for 
which the terms can be encoded in the Advanced Conditions dialog, the Select button 
appears.

Click this button to view the MedDRA Browser dialog. You can search and select the 
required terms from the MedDRA browser. These terms are automatically transferred 
to the Advanced Conditions dialog.

9.1.2 Non-Current Terms Search within MedDRA Browser
A new checkbox called Include Non-current Terms has been added in the MedDRA 
browser to allow users to expand their search results on local MedDRA dictionaries to 
non-current terms as well. The Non-Current LLT terms in the search results are 
displayed, preceded with an asterisk (*) symbol for identification. These are allowed 
only for search results and not allowed to be selected or applied in the application.

9.1.3 MedDRA Recoding
The MedDRA recoding tool displays the following options for each case with the 
existing data elements after the case number in the XLS export or tab delimited file:



MedDRA Browser Functionality

MedDRA Browser 9-6

■ Current Workflow State.

■ Current Workflow Group.

■ If Excel is the output format and the number of record returned is more than 60K, 
the system splits the record set into multiple worksheets of 64K each.

■ These options are available for the end user logs.

■ The SOC/HLGT/HLT/PT/LLT and Synonym columns in the MedDRA schema 
and the MedDRA table have been expanded to 250 characters to conform to the 
ICH guidelines.

■ The MedDRA Recoding Tool is configurable as per customer requirements.

The following table lists the tables that support MedDRA Recoding and their locations 
in the Argus application.

9.1.3.1 MedDRA Recoding Logic
The following logic is used during the MedDRA recoding:

1. Get the Lower Level Term (LLT).

2. Check LLT_Code column in the MEDDRA_PREF_TERM_LLT table to see if LLT is 
not current (LLT_CURRENCY = N).

Decisions:

■  If LLT cannot be found in MEDDRA_PREF_TERM_LLT then record as 
exception to be noted in LOG file.

■ If LLT is not current then get PT_CODE from MEDDRA_PREF_TERM_LLT 
and use as LLT (Each PT exists as LLT also - always).

■  If LLT is current then keep LLT as it is.

3. If a current LLT can be found in previous step then continue with next step else go 
to 1 and select next set of Terms.

Argus Database Table Location in Argus

CASE_PAT_HIST Argus Safety > Case Form > Patients Tab > Parent Section > 
Other Relevant History

CASE_EVENT Argus Safety > Case Form > Events Tab > Event Information

CASE_PROD_INDICATIONS Argus Safety > Case Form > Products > Products Indication

CASE_ASSESS Argus Safety > Case Form > Events Tab > Event Assessment 
> Event PT (Description)/LLT

CASE_DEATH_DETAILS Argus Safety > Case Form > Events Tab > Seriousness Criteria 
> Death Details > Cause of Death & Autopsy Details

CASE_LAB_DATA Argus Safety > Case Form > Patient Tab > Lab Data

LM_ALWAYS_SERIOUS_
TERM 

Argus Console > Code Lists > Always Serious Term List 

LM_LABELED_TERM Argus Console > Business Configuration > Products and 
Licenses > Datasheet

LM_PRODUCT Argus Console > Business Configuration > Products and 
Licenses > Primary Indication

LM_LAB_TEST_TYPES Argus Console > Code Lists > Lab Test Type
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4. Based on the LLT, get the Preferred Term (PT_CODE) from MEDDRA_PREF_
TERM_LLT. Get the rest of the hierarchy from MEDDRA_MD_HIERARCHY, 
based on PT_CODE and PRIMARY_SOC_FG = 'Y'.

5. Match all the 5 levels of Code and Description and update the data, if required.

6. Populate the following columns:

■ DICT_ID = Current MedDRA Dictionary ID, present under Case Form 
Configuration.

■ CODE_STATUS = 1 (displaying that this set of terms has been encoded).

9.1.3.2 Recode MedDRA terms at the Enterprise level
For multi-tenant environment, the MedDRA Re-Code Tool allows recoding of 
MedDRA terms at the Enterprise level.

■ The MedDRA recoding tool displays an additional multi-select list of all active 
Enterprises.  This lists all  active Enterprise Short Names in alphabetical order.

■ New Schema Owner is no longer required. As per the recoding logic, cases are also 
re-coded to the MedDRA version that is configured in Console.
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■ Displays a note below the Existing MedDRA Version to Re-Code list - "Note - 
Cases will be re-coded to the MedDRA version configured in Console for the 
respective Enterprises."

■ The MedDRA recoding tool  only re-codes the items that match the selected 
Enterprises and values selected in  the"Existing MedDRA Version to Re-Code" list.

■ The log file  specifies the Enterprise Short Name with every log record that is 
processed for a particular Enterprise.
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10Reports: Compliance and Aggregate
Reports

This chapter contains detailed information about Argus reports and how to create and 
use them.

10.1 Reports
Several different kinds of reports are available in Argus. You can access them from the 
Reports menu. When using reports, be aware of the following:

■ The system prints a DRAFT watermark across the entire page starting from the 
bottom left to top right for the following on all pages:

– ALL Expedited reports including E2B CIOMS and MedWatch on the ICSR 
Viewer

– ALL Periodic Reports including Expedited reports part of the Periodic and 
Aggregate reports part of Periodic

■ If you select Internal or a value for Other text for PSUR/CTPR reports, the system 
prints "Internal" or the other text value as the watermark on the PDF reports that 
include the expedited reports that are part of the periodic for all pages.

■ The Bulk Reporting screen has a Study ID filter option that enables you to filter 
cases in the list.

■ When using the Study ID filter, be aware of the following:

– The Study ID is a type ahead field the system enables you to enter the study 
ID values defined for cases.

– There can be a maximum of 25 items on the drop-down list.

– When you select values from the drop-down list, the system performs a like 
search.

■ The system prints the user-defined summaries in the order they are listed in the 
Periodic report.

This chapter discusses these reports in detail and also about the reports in the 
following categories. The following is a list of all available Argus reports.
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10.1.1 Compliance Reports
This section lists the different Compliance Reports in Argus and discusses about each 
of them in detail.

Place the cursor over the Compliance option in the Reports tab to go to any of the 
Compliance Reports.

10.1.1.1 About Expedited Reports
Expedited Reports provide access to the list of previously scheduled or generated but 
not submitted expedited reports.

Apart from viewing these reports, you can also schedule a new expedited report from 
this dialog.

Depending on the regulations set forth by the Regulatory Authorities, expedited 
reports might need to be submitted for the adverse events pertaining to your 
company's products.

You can generate several different kinds of expedited reports as follows:

■ CIOMS-I Form (English)

■ CIOMS-I Local Form (English)

■ CERFA 65-0040 (French)

■ CERFA 65-0044 (French)

■ Compliance Reports

■ Expedited Reports

■ Periodic Reports

■ Submitted Reports

■ Aggregate Reports

■ Case Data Analysis 
Reports

■ CIOMS II Line Listing 
Reports

■ Case Listing Reports

■ Memorized Reports

■ Periodic Reports

■ Clinical Trial Periodic 
Reports

■ ICH PSUR Reports

■ US IND Periodic Reports

■ US NDA Periodic Reports

■ Bulk Reporting

■ Incoming ICSR Reports

■ Processed ICSR Reports

■ Report Mapping
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■ MHLW Clinical (Japanese)

■ MHLW Spontaneous (Japanese)

■ US FDA MedWatch Form 3500A (English)

■ US FDA MedWatch Form 3500A (English) Drug Only

■ MHRA Clinical (English)

■ MHRA Spontaneous (English)

■ US FDA VAERS Form (English)

■ EU EMEA Clinical Form (English)

■ EU EMEA Spontaneous Form (English)

■ EU Device Vigilance Initial Form (English)

■ EU Device Vigilance Final Form (English)

■ German BfArM form 643 / PEI Form (German) French CERFA (French)

■ Spain Clinical

■ Spain Spontaneous

■ Canadian Device Form

■ Canadian Expedited Form

■ eMDR

■ E2B

■ eVAERS

10.1.1.1.1 General Usage Information  When using Expedited Reports, be aware of the 
following:

■ The following expedited report forms do not print a follow up number when the 
user selects DRAFT on the Regulatory Reports tab or when he/she selects the 
Quick Launch Draft option:

■ US FDA MedWatch Drug/Device

■ US FDA VAERS

■ CIOMS I/CIOMS I (Local)

■ French CERFA

■ Spanish Spontaneous/Clinical

■ The system enables you to print draft expedited reports from the Batch Print or 
Create Reports without printing DRAFT on the reports from the Case Open or the 
Reports | Compliance | Expedited Reports dialog.

■ When you select the Draft option, the system enables you to print a DRAFT 
watermark on the expedited reports.

■ If you do not enter a value, the system does not print a watermark on the 
expedited reports.

■ You can enter a maximum of 10 characters in the text field.

10.1.1.1.2 Storing Expedited Reports in Documentum  Argus Safety lets you store your 
Expedited Reports in Documentum.
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■ Mark an Expedited Report as submitted from within Argus. to insert the report 
into the Documentum system as a PDF.

■ If the report is to be transmitted via fax or email, Argus Safety Service marks the 
report as a successful submission in Documentum only after the fax or email 
transmission has succeeded.

10.1.1.1.3 Understanding Follow-up Reports  Follow-up reports are created when 
significant follow-up information is entered for the case. This is indicated by entering 
follow-up information in the General Information section of the General tab and 
when one of the following two things happens:

■ Data for a case changes

■ Update information for a case has been entered

■ Depending on the configuration set up by the Administrator, the system analyzes 
the scheduled reports prior to the data changes to see if they are still required.

■ If the system determines that they are not required, the report status is marked as 
"Downgrade". New reports are automatically scheduled, if required.

■ If the system determines the report is still needed and needs to be updated, one of 
two functions can take place depending on the configuration done by the 
Administrator:

– The system overwrites the report

– The system schedules a new report in addition to the old report

■ If the system has been configured to overwrite the existing report, the report status 
becomes "New Data Available."

■ In the Worklist, the status for this report shows "New Data Available" for this 
report. When you re-generate the report, you can select whether or not you would 
like to re-generate the report with the new data.

■ If the system is configured to create a follow-up report, the previous report 
remains in its current state and a new report is scheduled with the status of 
"Scheduled."

■ If a report has been previously submitted, this report is never deleted under any 
configuration.

10.1.1.1.4 Viewing a Summary of Expedited Regulatory Reports  The following table below 
describes how to view a summary of Expedited Regulatory Reports:

To.. Do..

View the regulatory reports for a 
particular case (scheduled, generated and 
submitted)

Open the Regulatory Reports tab of the Case 
Form.

View all scheduled, generated, and 
approved reports, as well as other 
outstanding action items

Select Reports from the Worklist menu.

View a list of all scheduled, generated, and 
approved reports

Select Compliance | Expedited from the Reports 
menu.

View all the submitted reports in the 
system

Select Compliance |Submitted from the Reports 
menu.
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10.1.1.1.5 User Options  Several common features are available in the Expedited 
Reports section. These include:

■ Lock State Header Options

■ Lock Icons

■ Lock Icon Options

Lock State Header Options
Click the Lock State header row to sort on the following category of cases. A pop-up 
appears listing the following sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

Click on the required option to sort cases based on the selected case categorization.

Lock Icons
The following table describes the meaning of each icon when attached to a case.

Lock Icon Options
Click the lock icon to view the list of options described in the following table:

Note: The icon displayed in the lock state column in the Reports-> 
Compliance - Expedited and Submitted screens denotes a SUSAR 
(Suspected Unexpected Serious Adverse Reaction) case. 

Icon... Identifies...

A case marked for a Periodic ICSR submission.

A locked case.

An unlocked case

A SUSAR (Suspected Unexpected Serious Adverse Reaction) case.

Field Description

View Report Displays the details of the selected report.

Report Details Displays specific information about the report as entered in the 
Regulatory Reports section.

Note: The information displayed in the fields of the Report Details 
dialog is fetched from the data entered in the Regulatory Reports 
section of Case Form. Refer to the About the Report Details Dialog Box 
section for descriptions of each tab.
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10.1.1.1.6 Scheduling Reports  Use the following procedure to schedule reports.

1. Open the case for which the report has to be scheduled.

2. When the system displays the Case Form for the selected case, select Regulatory 
Reports --> Schedule New Reports.

3. When the system opens the Schedule New Expedited Report dialog box, enter the 
appropriate information in the fields in the dialog box.

4. Click OK to schedule the report.

5. Save the case to save the report.

Schedule New Expedited Reports Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Schedule New Expedited 
Report dialog box.

Case Summary Displays the Case Summary dialog

Remove Report Deletes the report from the case on being asked for a justification.

Mark for 
Non-Submission

Displays the Submission tab in the Report Details dialog.

Select No for Mark for Non-Submission and enter the reason for the 
non-submission.

Remove Multiple 
Reports

Deletes multiple reports from the case on being asked a justification.

Mark Multiple for 
Non-Submission

Displays the Submission tab in the Report Details dialog. Select No for 
Mark Multiple for Non-Submission and enter the reason for the 
non-submission. This is applied to all selected reports.

Field Description

Product Select the relevant company product from the list. All company 
products associated with the particular case appear in the list.

Note: The items appearing in the drop-down list are listed in the 
following format:

Trade Name, Product Name, Formulation, Concentration and 
Indication.

Field Description
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License # Select the appropriate license.

Note: The items appearing in this drop-down list are listed in the 
following format:

Country of License, License Type and License Number.

‘License #’ drop-down list in the manual report scheduling 
dialog format now displays other alternate values if License # 
value is not available for a license. 

The below-mentioned preference order is followed to display an 
appropriate value for License # as part of the license selection 
display value format:

1. If License # is not available and Clinical Compound Number 
is available, then the License # drop-down list will display:

<License Authorization Country> (<License Type>) 
<Clinical Compound Number>

2. If License # as well as Clinical Compound Number is not 
available, then For English Users: it will display - <License 
Authorization Country> (<License Type>) <Trade Name 
from Console>.

Destination Select the regulatory authority for which the report is to be 
scheduled.

Form Select the type of the report that is to be created.

Message Type Select the Message Type from the drop-down list.

Aware Date This drop-down list is only populated and enabled after a license 
has been selected. The Aware Dates are displayed in descending 
order of the Current Aware Date.

Note: If an Aware Date is appended with ’(A)’ in the drop-down 
list, it is used to denote the aware date of an Amendment.

The list of the aware dates is determined based on the license 
type selected in the following two groups:

i. Drug/Vaccine - follow-up dates that are marked significant

ii. Device - follow-up dates that are marked as "device" 
significant

If the system is configured to not have separate significant 
indication for Drug and Device, only the standard 
(Drug/Vaccine) significant follow-up dates are considered.

The resulting expedited report Due Date is based on the selected 
Aware Date and the duration of the Due Date section.

Note: The selected Aware Date has no impact on the Actual Due 
Date if the user specifies an absolute Due Date. For instance, 
selecting a date in the Due Date field causes the report to be due 
on the specified date, regardless of the selected Aware Date.

Protect Confidentiality of 
Patient and Reporter

Select this check box if identifying information about the patient 
and the reporter must not appear on the report.

The system also displays ’MSK’ null flavor in the eVAERS report 
when this checkbox is checked.  MSK is populated only when the 
data element contains some data and is not null.

Notes Enter any relevant notes in this field.

Blind Study Product Check this checkbox to select a blind study product.

Group Select the group that will be responsible for the report.

Cover Letter Select a cover letter for the report, if relevant.

Field Description
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The following are the functionality changes for the New Expedited Reports dialog box 
(J Specific):

■ Downgrade Report is scheduled manually using the New Expedited Report 
Scheduling User Interface.

■ When you click OK with the Downgrade Reporting Schedule, the Justification 
window is displayed to log the reason of the downgrading.

■ The Schedule New Expedited Report Window has a drop-down list in the top 
section. The content of the drop-down list has New Report and Non-Reportable 
Follow up Report options.

■ When the Downgrade Report is scheduled, J.8 is transmitted as Does Not Apply.

Auto-scheduling Reports
Use the following procedure to schedule reports automatically:

1. Open the case for which the report has to be scheduled.

2. Select Regulatory Reports > Auto Schedule or Auto Schedule Device.

3. Reports that qualify as per Reporting Rules defined in Console are populated. If a 
report was manually scheduled or automatically scheduled for the same reporting 
Destination, system schedules Follow-up report else a Initial report based on 
product license type and status of previously scheduled report.

Follow-up scheduling for eVAERS
Use the following procedure to execute follow-up schedule for eVAERS reports:

1. If the case was previously submitted to a Reporting Destination in VAERS PDF 
format, and if the same reporting destination is configured for sending eVAERS 
report, then:

■ The system schedules an Initial Report by populating the Initial column in the 
Case Form under Regulatory Reports > Seq column.

■ If any Follow-up reports are scheduled in the same destination at a later point 
of time, the system schedules a follow-up report by populating the 
Follow-up<###> in the Case Form under Regulatory Reports > Seq column.

■ The system uses Case Number (as printed in the Manufacturer Control 
Number - that is listed in Box 24 - of the previously submitted VAERS report) 
in data elements C.1.1. and C.1.8.1.

2. If a reporting destination is configured for eVAERS and VAERS reports and if the 
previous report was sent in eVAERS format, and if the subsequent report is 
scheduled in VAERS PDF format to the same destination, then:

■ The system schedules an Initial Report by populating the Initial column in the 
Case Form under Regulatory Reports > Seq column.

■ If any Follow-up reports are scheduled in the same destination at a later point 
of time, the system schedules a follow-up report by populating the 
Follow-up<###> in the Case Form under Regulatory Reports > Seq column.

Due Date Specify the due date of the report by selecting the number of 
days after which it will be due, or by specifying the exact date.

Field Description
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■ The system does NOT use (C.1.1) from the previously submitted VAERS 
report, as the Manufacturer Control Number of the VAERS report.

10.1.1.1.7 Generating Reports  You can generate a report using either of the following 
procedures.

Method 1: Generating a Report
1. Verify that the relevant case has been locked and the required report has been 

scheduled.

2. Open the selected case to display its associated Case Form.

3. Open the report from the Regulatory Reports tab of the Case Form.

4. When the system opens the Regulatory Reports details for the selected case, locate 
the relevant report and click the Final link to generate the report.

5. The system generates the selected report.

Method 2: Generating a Report
1. Verify that the relevant case has been locked and the required report has been 

scheduled.

2. Select Case Actions --> Open to view the Case Open form.

3. Click Search to view cases matching the search criteria.

4. When the system displays the search results, click the Lock State icon and select 
Case Details.

5. When the system opens the Argus Safety Case Details dialog, open the 
Scheduled Regulatory Reports folder and select the relevant regulatory report.

6. The system automatically generates the report.

Note: ■To preview a report in draft mode, click the DRAFT link for 
the report in the Case Form.

■ You do not need to lock the case to preview a report in draft 
mode.

■ If you have access rights to view or print blinded information, you 
are prompted to select whether you would like to view a blinded 
or unblinded version of the report. If your access rights disallow 
you from viewing or printing unblinded information, you can 
view only a blinded version of the expedited report. The 
following items are not displayed when viewing a blinded version 
of the expedited report:

■ Clinical Treatment Given (Study Drug field)

■ Study Drug Formulation and Concentration

■ Study Drug Dose, Daily Dose and Route

■ Study Drug Batch/Lot # and Expiration Date

■ If the case is locked you can generate the report from the Worklist 
| Reports, Reports | Bulk Reporting and Reports | Compliance | 
Expedited screens.
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10.1.1.1.8 Approving Reports  Use the following procedure to approve reports.

1. Open the case associated with the report that needs to be approved.

2. When the system opens the Case Form, click the Regulatory Reports tab to 
displays the case details.

3. Click the icon associated with the report you wish to approve and select View 
Report Details.

4. When the system opens the Report Details dialog, click the Routing tab.

5. When the system opens the Routing tab, select Approved from the State 
drop-down list and click Route.

6. When the system opens a dialog box, enter the required information and click OK 
to approve the report.

10.1.1.1.9 Creating Unscheduled Expedited Reports  Use the following procedure to create 
unscheduled expedited reports.

1. Select Reports --> Expedited --> Compliance.

Expedited Reports Dialog Box Fields and Fields Descriptions

Note: Refer to Report Routing to understand how you can route a 
report to another state.

Field Description

Selected Click the checkbox to select the report.

Lock State Displays if the case is locked or un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Note: Click the link displaying the status to view the report details.

Case Number Displays the Case Number.

Note: Click the link displaying the Case Number to open the selected 
case.

Country of Incidence Displays the Country of Incidence for the selected case.

Report Type Displays the Report Type of the selected case.

Suspect Product Displays the Trade Name for which the report has been scheduled. A 
(+) displayed at the end of the Product Name denotes that more than 
one Suspect Company Product exists.

For Reports which were scheduled for the Device, the Device name gets 
displayed.

Diagnosis Displays the Primary Event Diagnoses PT

Event Verbatim Displays the (verbatim as reported) of the Primary Event.

S/U/R Displays the Case Level Assessments

■ S - Serious (Y/N)

■ U - Unlisted (Y/N)

■ R - Causality (Y/N)

■ Unknown is displayed by a "-"

Click the SUR link to view the Case Summary.
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2. Click Batch Print or Create Report and search for the case for which the expedited 
report has to be scheduled.

3. When the system displays the search results, select the locked cases for which the 
expedited report is to be scheduled.

4. Click Batch.

5. When the system opens the Batch Print or Create Reports dialog box, enter the 
appropriate information and click OK.

6. The system generates the unscheduled expedited report.

Batch Print or Create Reports Fields and Field Descriptions
The following table lists and describes the Batch Print fields.

F / LT Denotes Fatal / Life Threatening

If the case is both F and LT, only F is displayed.

If the case is neither F nor LT, No is displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form Displays the Description of the report.

Click the link to view the DRAFT Report PDF.

Destination Displays the Report Destination (Agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Displays the status whether it is Initial or Follow-up.

If it is Follow-up, the follow-up number is also displayed.

Due Date Displays the due date. This date is based on the previously submitted 
report for the MedWatch Reports under the G7 Section for 5, 7, 10, 15 
and 30 Days.

Days Past Due Displays the number of days the report is past due date.

Downgrade Displays Yes if the report is a Downgrade Report.

View All Allows the administrator and workflow manager to see all items in the 
system.

View Group Allows the user to view all items assigned to this user group.

Individual Allows the user to view all items assigned to him.

Print List Button Allows the user to print the current Expedited Reports List for 
referencing the current view of the Expedited Reports List.

Batch Print Allows the user to batch schedule Expedited Reports for Locked or 
Unlocked Cases.

Field Description

Reporting 
Destination

Displays the different reporting destinations.

Report Form Displays the report form types.

License Type Select the license type as investigational or marketed or any type of 
license.

Field Description
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10.1.1.1.10 Creating Batch Reports  You can use the Batch Reports function to schedule 
and generate reports for multiple cases. Before using this function, verify that no cases 
or reports are open.

Use the following procedure to create batch reports.

1. Select Expedited Reports from the Reports - Compliance menu.

2. When the system opens the Expedited Reports dialog box, click Batch Print or 
Create Report.

Expedited Reports Dialog Box Fields and Field Description
The following table lists and describes the fields in the Expedited Reports dialog box.

Message Type Select the message type from the drop-down list

Format Enables you to print reports As Draft or As Final.

■ The Print As Final option is available only if all the selected cases 
are locked.

■ If Print As Final is selected, then the option Save with case, mark 
as submitted is also available as a checkbox option.

■ Click the options Print As Final and Save with case, mark as 
submitted to generate final Regulatory Reports and create a 
submission record with each case identical to the current 
functionality.

■ Click the options combination of Print As Final only (and not Save 
with case, mark as submitted) to generate final Regulatory Reports 
without creating a submission record with each case.

■ If the report is associated with a blinded study, select the Blind 
study product check box.

Destination Click the Printer check box to print the report

Protect 
Confidentiality of 
Reporter and Patient

Click this check box to hide the Reporter and Patient information on the 
expedited reports.

The system also displays ’MSK’ null flavor in the eVAERS report when 
this checkbox is checked. MSK is populated only when the data 
element contains some data and is not null.

Scheduling ■ If Run Now is selected, all the selected reports run against all 
selected cases and a PDF is generated.

■ The Run Now option is visible only when a MedWatch, MedWatch 
Drug, CIOMS, or VAERS form is selected on the Batch Expedited 
Report screen.

■ 2Select Run at and enter the appropriate date and time when the 
generation of reports should occur.

■ Note that if you select an unlocked case, the report gets printed in 
draft form only and is not saved.

Field Description

Selected Click the check box to select the report.

Lock State Displays if the case is locked or un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Note: Click the link displaying the status to view the report details.

Field Description
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1. When the system opens the Expedited Reports dialog box, search for the cases for 
which the expedited report needs to be scheduled.

Case Number Displays the Case Number.

Note: Click the link displaying the Case Number to open the selected 
case.

Country of Incidence Displays the Country of Incidence for the selected case.

Report Type Displays the Report Type of the selected case.

Suspect Product Displays the Trade Name for which the report has been scheduled. A 
(+) displayed at the end of the Product Name denotes that more than 
one Suspect Company Product exists.

For Reports which were scheduled for the Device, the Device name gets 
displayed.

Diagnosis Displays the Primary Event Diagnoses PT

Event Verbatim Displays the (verbatim as reported) of the Primary Event.

S/U/R Displays the Case Level Assessments

■ S - Serious (Y/N)

■ U - Unlisted (Y/N)

■ R - Causality (Y/N)

■ Unknown is displayed by a "?"

Click the SUR link to view the Case Summary.

F / LT Denotes Fatal / Life Threatening

If the case is both F and LT, only F is displayed.

If the case is neither F nor LT, No is displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form Displays the Description of the report

Click the link to view the DRAFT Report PDF.

Destination Displays the Report Destination (Agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Displays the status whether it is Initial or Follow-up

If it is Follow-up, the follow-up number is also displayed.

Due Date Displays the due date.

Days Past Due Displays the number of days the report is past due date.

Downgrade Displays Yes if the report is a Downgrade Report.

View All Allows the administrator and workflow manager to see all items in the 
system.

View Group Allows the user to view all items assigned to this user group.

Individual Allows the user to view all items assigned to him.

Print List Button Allows the user to print the current Expedited Reports List for 
referencing the current view of the Expedited Reports List.

Batch Print Allows the user to batch schedule Expedited Reports for Locked or 
Unlocked Cases.

Field Description
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2. When the system displays the search results, select the appropriate cases and click 
Batch.

3. When the system opens the Batch Print or Create Reports dialog box, enter the 
appropriate information in the fields and click OK

The Expedited Batch Printing dialog supports printing Batch CIOMS, Medwatch, and 
VAERS on Argus Web locally.

Batch Print or Create Reports Dialog Box Fields and Field Descriptions
The following tables lists and describes the fields in the Batch Print or Create Reports 
dialog box.

Field Description

Reporting 
Destination

Displays the different reporting destinations.

Report Form Displays the report form types.

License Type Select the license type as investigational or marketed or any type of 
license.

Message Type Select the message type from the drop-down list

Format Enables you to print reports As Draft or As Final.

■ The Print As Final option is available only if all the selected cases 
are locked.

■ If Print As Final is selected, then the option Save with case, mark 
as submitted is also available as a checkbox option.

■ Click the options Print As Final and Save with case, mark as 
submitted to generate final Regulatory Reports and create a 
submission record with each case identical to the current 
functionality.

■ Click the options combination of Print As Final only (and not Save 
with case, mark as submitted) to generate final Regulatory Reports 
without creating a submission record with each case.

■ If the report is associated with a blinded study, select the Blind 
study product check box.

Destination Click the Printer check box to print the report

Protect 
Confidentiality of 
Reporter and Patient

Click this check box to hide the Reporter and Patient information on the 
expedited reports. The system also displays ’MSK’ null flavor in the 
eVAERS report when this checkbox is checked. MSK is populated only 
when the data element contains some data and is not null.
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10.1.1.1.11 Expedited Reporting Rules Algorithm  The expedited reporting rules algorithm 
affects the following:

■ Suppression of Duplicate Reports

■ Blinded/Forced Distribution

■ Letter Placeholder for the IND Cover Letter

Suppression of Duplicate Reports
You can suppress duplicate expedited reports to be scheduled at the reporting 
destination level, according to the following criteria:

■ The Suppress Duplicate Reports option only applies to drug reports. It does not 
apply to device reports.

■ This option does not reduce the number of reporting rules the system evaluates. 
However, it does prevent the system from scheduling and generating expedited 
reports that match the duplication criteria.

■ When you select Suppress Duplicate Reports, the system uses the following 
attributes to determine whether the reports are duplicates of other reports:

– Report Form

– Reporting Destination

– Aware Date

■ If two or more duplicate reports have different due dates (regardless of license 
type), the system schedules the report with the earliest due date.

Blinded/Forced Distribution
The system enables you to configure the Blinding Study option for products in the 
case.

■ When the user selects this checkbox, the system blinds the study products for the 
report being sent to the reporting destination in a manner similar to the Bulk 
Reporting dialog option.

■ If the user selects either of the Blind Study product options (Reporting Rules or 
Bulk Reporting), the system blinds the study product information on the report 
form.

■ The system blinds only active blinded studies. It does not blind the following case 
reports even if the Blind Study product is selected

– Open Label Studies

Scheduling 1. If Run Now is selected, all the selected reports run against all 
selected cases and a PDF is generated.

The Run Now option is visible only when a MedWatch, MedWatch 
Drug, CIOMS, or VAERS form is selected on the Batch Expedited 
Report screen.

Note: If you select an unlocked case, the report gets printed in draft 
form only and is not saved.

2. Select Run at and enter the appropriate date and time when the 
generation of reports should occur.

Field Description
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– Study is eligible for unblinding - If the Study is Unblinding checkbox is not 
kept as unchecked in study configuration, the user will be able to see the 
complete case data even if he/she has protection enabled.

■ In cases where expedited reports are due, the system permits the user to 
force-distribute the reports based on user-defined reporting rules, even if case 
processing is incomplete.

■ When the user selects the Force Distribution rule, the following occurs:

■ If a case encounters a rule where a report is due is locked, the system schedules the 
report based on the rule and does the following:

– Generates the report on the due date.

– Dynamically replaces the current case comment with the force distribution 
case comment.

– Transmits the report based on the preferences defined by the reporting 
destinations.

– Displays the status in the Worklist Bulk Transmit/Transmit ICSR dialogs.

■ The AG Service Force Reporting process for expedited reports completes the 
process by:

– Checking the reports required for force distribution

– Locks the case (if it's not already locked)

– Generates the reports and makes sure it is ready for transmission

■ The system adds case comments to the following reports:

– CIOMS I

– CIOMS I (Local)

– Spanish Spontaneous

– Clinical Forms

■ If a user has a case open, the system skips the case until the user releases the case.

■ After transmitting the reports (sent to the WL Status dialogs), the system does the 
following:

– Unlocks the case

– Uses the justification of the unlock as the case comment (as defined in the 
Profile switch)

– Determines whether there are any unsubmitted reports and, if there are 
unsubmitted reports, sends the current forced distribute reports to the Bulk 
Reporting queue for transmission.

■ The system puts the following in the Notes field of the report:

– Auto-scheduled; Forced Distributed: (EU) 15 day EMEA Mkt; Cure All

– During the time the case is locked and reports are being generated, the system 
does not allow the user to edit the case. The system displays the following 
message:

– The case is in use by XXXX user

where:

– XXXX is the name of the AG Service user executing the report scheduling.
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■ The notes for the Case Locking/Unlocking are the same as those defined as the 
common profile value for the Forces Distribution option; System is the user.

Letter Placeholder for the IND Cover Letter
Be aware of the following:

■ You can define a placeholder for the IND_SIMILAR_EVENTS table. The system 
uses data from this table to populate the Case Number, Protocol Number, Subject 
ID, and Adverse Event terms for previously submitted cases reporting the same 
events.

■ If the placeholder is used in a letter template, the system prints the information 
shown in the following table.

where:

AER# is the case number when an Investigational IND MedWatch was previously 
submitted and included the same Related Event Term as the current case.

Protocol Number is the Project ID for the case in (a).

Subject ID is the Patient ID for the case in (a).

Adverse Event Terms(s) are the Related Events for the licensed product in case(a).

If no reports were submitted, the system prints None Submitted instead of the 
table.

The placeholder only prints this information when it is used in the cover letter for 
the Regulatory Report. The system uses the license associated with the scheduled 
report to track other cases where the same product license was previously 
submitted for the same events in the current case.

10.1.1.2 About Periodic Reports
This section discusses the different fields and features available in Periodic Reports.

The Periodic Reports screen comprises two tabs: Periodic Report tab, and Background 
Periodic Report Status tab.

10.1.1.2.1 General Usage Information  When using periodic reports, be aware of the 
following:

■ You can filter cases in the following period reports based on the Case 
Locked/Archived date:

■ NDA

■ IND

■ PSUR

Adverse Event Report 
No. (AER#)

Protocol Number Subject ID Number Adverse Event 
Term(s)

CASE001 CUREALL P101 Verbatim[PT]
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■ CTPR

■ When you select the Case Locked/Archived date, the system limits the cases based 
on whether the case has been locked or archived within the specified time frame.

■ The locked date is the lock date for the current case.

■ If there is significant FU in the reporting time frame, the system considers the case 
a follow-up case in the group options of the PSUR/CTPR reports.

■ If you specify the time frame for the case locked/archived date, the system 
disables the following:

– Include Follow-up

– Exclude Follow-up

– Include Summary of Unlocked Cases

– Include Unlocked Cases

■ For the 15 day report section of the NDA Reports, the system uses the timestamp 
to determine whether there are further follow-up or downgraded cases in that 
date range.

10.1.1.2.2 Periodic Report Features  The following table lists and describes the data that 
appear in the columns on the Periodic Reports screen:

10.1.1.2.3 User Options  Common features on the Period Reports page. Click the icon 
associated with each report to view the following options:

Field Description

View All Enables the user to view all available periodic reports.

Trade Name Displays the Trade Name.

Destination Displays the name of the Destination.

Description Displays the report name. Click this to open the selected report in PDF 
format.

Due Date Displays the Due Date.

Status Opens the Report Details dialog for the selected report.

Print List Allows the user to print the current Periodic Reporting for referencing the 
current view of the Periodic Reporting.

Option Description

View Report Opens the Individual Periodic Report selected by the user.

Report Details Displays specific information about the report as entered in the 
Regulatory Reports section.

Note: The information displayed in the fields of the Report Details 
dialog is fetched from the data entered in the Regulatory Reports 
section of Case Form.
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10.1.1.2.4 About the Report Details Dialog Box  The Report Details dialog box includes 
several tabs.

General Tab
The General tab displays the general information about the report. The information on 
this tab cannot be modified.

The application behavior for Report Details Dialogue has been updated such that, for 
the PMDA E2B Reports when the Ack is received with A.1.6=01 and B.1.8=02 
application dispalys an Orange tick rather than Green Tick after successfully loading 
the Ack. 

The following table lists and describes the fields on the General tab.

10.1.1.2.5 Scheduling Tab  The Scheduling tab displays a reason for scheduling this 
report. It also shows the date on which the report was scheduled.

Field Description

Agency Displays the Reporting Destination for which the report is scheduled.

Responsibility Displays the User Group to which the report is assigned.

Date Generated Displays the date when the report was generated.

Date Submitted Displays the date when the report was submitted.

Report Type Displays the Expedited Report Form of the report.

Language Displays the language in which the report has been made.

Date Due Displays the date when the report is due.

Date Transmitted Displays the date when the report was transmitted.

Case Nullification 
Date

Displays the date when the case was nullified.

Case Nullification 
Reason

Displays the reason entered when a case is logically deleted in Argus.
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The following table lists and describes the fields on the Scheduling tab.

10.1.1.2.6 Routing Tab  The Routing tab displays the routing history of the report. To 
route the report, click Route.

The following table lists and describes the fields on the Routing tab.

Field Description

Scheduled On Displays the date when the report was scheduled.

Scheduled By Displays the name of the person who schedule the report.

Case Revision Displays the case revision number.

Case Number Displays the case number.

Reason for 
Scheduling

Displays the reason for scheduling the report.

Note: All fields in this tab are auto-populated as per records entered 
in Argus.

Field Description

Current State Displays the current state of the report.

State Displays the state of the report. This button is enabled when you click the 
Route button.
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10.1.1.2.7 Submission Tab  The Submission tab enables you to specify whether 
submission is required and enter a reason for not submitting the report.

The following table lists and describes the fields on the Submission tab.

10.1.1.2.8 Comment Tab  The Comment tab enables you to enter a local comment that 
prints out on that specific report when generated. Each report has its own Local 
Comment section.

Date Time Displays the date and time of the report routing.

Group Displays the group of the report. This button is enabled when you click 
the Route button.

Reports Displays the type of report it is.

User Displays the state of the report. This button is enabled when you click the 
Route button.

Comments Displays routing comments entered before routing the report.

Field Description

Submission 
Required

Enables you to select if this report is not required to be submitted to the 
regulatory authority.

Determined On Displays the date when the report was considered not required to be 
submitted.

Determined By Displays the name of the user who decided the report was not required to 
be submitted.

Reason for 
Non-Submission

Click Select to select the reason for non-submission.

Field Description
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The following describes the Local Comment field on the Report Details tab.

Transmission Tab
To transmit a report

1. Click the icon associated with a report and select the Transmission tab from 
Report Details.

2. When the system opens the Report Details The Report Details dialog opens.

3. This dialog displays the status of reports that have been transmitted to different 
recipients.

The following table lists the fields that comprise the Report Details dialog.

Field Description

Local Comment Enables you to enter any remarks about the report.

Field Description

Report Form Displays the name and type of report being transmitted.

Agency Name Displays the agency name for the report.

Fax Number / 
Recipient Name

Displays the Fax Number or name of the recipient of the report.

Recipient Company Displays the name of the company that is receiving the report.

Date Created Displays the date when the report was created.
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4. Click OK or Cancel to approve the transmission or discard any changes, 
respectively.

5. Click the Transmit button to transmit a report. The Transmit to Recipients dialog 
is displayed.

6. Select the recipients of the report, as applicable from the Available Recipients list.

7. Select the method of transmission from Method, as applicable.

8. Enter remarks in Comments.

9. Click Transmit.

10. The selected report is transmitted to the specified recipients.

10.1.1.2.9 Background Periodic Report Status  The Background Periodic Report Status tab 
is displayed for users who have been configured by the Argus Safety administrator in 
Argus Console, under Access Management > Groups > Menu > Reports > Periodic 
Reports.

The following table displays a description of the Background Periodic Report Status 
tab:

Date Sent Displays the date when the report was sent.

# of Pages Displays the number of pages present in the report.

Attempts Displays the number of attempts in transmitting the report.

Sender Displays the sender of the report.

Status Displays the transmission status of the report.

Field Description
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Field Description

Report Name Displays the name of the report, as entered in the Report Configuration 
screen.

Report Type Displays the type of the report, such as NDA, PSUR, CTPR, etc.

Start Date Displays the date and time when the report generation started. 

For English users, it is displayed in DD-MMM-YYYY HH:MM:SS (GMT 
offset) format.

For Japanese users, it is displayed in YYYY/MM/DD 00:00 (GMT offset) 
format.

Username Displays the username of the user who initiated the report.
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10.1.1.3 Creating Unscheduled Periodic Reports

To create Unscheduled Periodic Reports:
1. Click the Create Unscheduled Report button

2. The system opens Periodic Reports dialog box that provides a list of configured 
reports of the following types:

■ PSUR - Containing ICH PSUR Line Listing Reports

■ IND - Containing US IND Periodic Reports

■ NDA - Containing US NDA Periodic Reports

■ CTPR - Containing CT Periodic Reports

3. Click the (+) icon against the desired category to view all the reports within that 
category.

Status Displays the current status of report generation in the form of hyperlinks, 
with the options listed below:

Executing

Error

Pending

Generated

On clicking the Generated status, the Periodic Report is displayed.

On selecting any status other than Generated, the Background Periodic 
Report Execution Status dialog is displayed, as shown below:

This dialog displays the different stages of Periodic Report status. A grey 
tick mark is denotes Pending state, a Green tick mark denotes Completed 
State, and a Red cross mark denotes an Error.

Refresh Allows you to refresh the screen.

Print List Allows you to print the entries in Background Periodic Report Status for 
reference of the current view.

Context Menu > 
View Report

This option is displayed in the context menu only when ’PDF/CSV/RTF 
Report Creation’ is ’Generated’. On clicking View Report, the selected 
report is displayed.

Remove Report Allows you to remove a selected report. Reports can be selected from the 
AG Service Report Status screen and can be removed by clicking this 
Remove Report context menu option. On selecting this option, a 
Justification for the removal must be provided, after which the report is 
removed.

Field Description
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4. Select the report you wish to create from this list and click Select.

5. When the system opens the Report Batch Printing dialog, select Run Now or Run 
at, as appropriate.

6. In the Email field, enter the email ID of the user to whom the periodic report 
should be e-mailed, once completed. By default, this field lists the email address (if 
configured) of the current user.

7. Select what you want printed on the report: Final, Draft, Internal, or enter Other 
information.

8. Run Using allows users to select between Argus Native Periodic report and BI 
Publisher.

9. Report Form Type allows users to select the Report Templates and these options 
are dependent on the value selected in Run Using. If Run Using is selected as 
Argus Native, the Report Form Type dropdown displays PBRER and PSUR. The 
option selected from this drop-down list is used as Report Form Type for 
follow-up algorithm.

10. The options displayed in the Report Form Type are configurable through the 
flexible codelist Report Template.

11. Click OK.

12. The system generates the periodic report.

10.1.1.4 About Submitted Reports
This section provides information about how to submit and view reports.

The following table lists and describes the icons that appear on the Submitted Reports 
page.

10.1.1.4.1 Submitting Reports  Before you can mark a report as submitted, the report 
must first be approved.

Use the following procedure the submit an approved report.

Note: If you select Run Now, specify PDF, RTF, or CSV from the 
drop-down menu for the report output option to generate the PSUR or 
CTPR report in the selected format.

If you select Run at, specify the date/time to schedule the PSUR 
report to be generated by Argus Safety Service. This enables only 
Final and disables all other Print As options.

Field Description

View Report Enables you to view the report.

Report Details Enables you to view the report details.

Mark as Unsubmitted Enables you to change the status of the report from Submitted to 
Generated. No nullification report is generated on selecting this option.

Schedule 
Nullification

This option is enabled for ICSR reports only. This option enables users 
to schedule a new ICSR nullification report against the original report. 
The nullification reports scheduled by selecting this option are not 
generated and transmitted automatically.
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1. Open the case for which the report has to be approved.

2. Open the Regulatory Reports tab in the Case Form.

3. When the system opens the Regulatory Reports details for the selected case, click 
the icon associated with the report you wish to approve.

4. Select View Report Details.

5. Select Submitted from the State list in the Routing tab and click Route.

6. When the system opens a dialog box, enter the required details and click OK.

7. The report is approved.

Viewing Submitted Reports
Use the following procedure to view submitted reports.

1. Select the Reports --> Compliance --> Submitted Reports.

2. When the system opens the Submitted Reports page, enter the appropriate search 
criteria and click Search.

3. The system displays the Search Results.

Submitted Reports Fields and Field Descriptions
The following table lists and describes the search fields on the Submitted Reports 
page.

Note: The Case Nullification Date is the date when the case is 
deleted, the Case Nullification Reason is the comment entered when 
the case is logically deleted in Argus.

Note: A user who has "Workflow Manager" rights can undo the 
submission of a report, if necessary.

Field Description

Destination Select one or more Reporting Destination(s).

Report Form Select one or more Report Form(s).

Submission Date 
Range

Specify a specific date range from the drop-down list.

Tip: To specify your own dates use the To and From dates.

License Type Select the License type.

Note: Only reports that have been scheduled based on the selected license 
type will be displayed.

Case ID Enter the specific case number.

Tip: Use wild cards such as 2007% to search for cases starting with 2007.

Include these 
Reports

Select the required report type or case status to be displayed.

Product Select the product as required. The reports scheduled for these products 
will be displayed.
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10.1.1.4.2 Submitted Reports Search Results  The following table lists and describes the 
contents of the columns in the Submitted Reports Search Results.

10.1.1.4.3 Unsubmitting Reports  Cases that are archived while unsubmitting reports can 
be reopened from the Archived Case dialog.

Use the following procedure to unsubmit such cases.

1. Enter the password and notes required in the Archived Case dialog box.

2. When the system opens the Report Unsubmit dialog box, enter the reason for 
unsubmitting the report and click OK.

3. The system unsubmits the report.

10.1.1.4.4 Lock State Header Options  Click the Lock State header row. A pop-up appears 
listing the following sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

Field Description

Status Displays the status of the report.

Case ID Displays the Case Number for the report.

Revision Date Displays the date when the last revision was made.

Destination Displays the destination of the report (agency name).

Time Frame (I/F-u) Displays the whether the report was initial or follow-up.

Product Displays the first suspect product for the case on which the report is 
based (expedited reports).

License Type Displays the license type of the report.

Primary Event Displays the first event term for the case on which the report is based 
(expedited reports).

Reason for 
Scheduling

Displays the reason provided for scheduling the report.

Report Form Displays the type of report scheduled (form) and initial/follow-up status 
(e.g. "Initial Report" or "Follow-up #3").

Submitted Date Displays the report's submission date.

Case Del. Date Displays the date when the case was deleted.

Blind Study 
Product

Enables you to mark the study product as blinded.

Print All Submitted 
Reports

Enables you to print all the submitted reports.

Export Enables you to export the report.

Print List Enables you to print the report as a PDF.

Tip: The icon (displayed in the lock state column) in the Reports-> 
Compliance - Expedited and Submitted screens denotes a SUSAR 
case.
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10.1.2 Aggregate Reports
Argus Safety has powerful system reporting capabilities that enable you to monitor 
the following:

■ Product safety profiles

■ Case progress

■ Company productivity during the case handling process

This section provides information about the Argus Aggregate Reports.

To view an aggregate report
Select Reports --> Aggregate Reports --> <Report Type>. 

10.1.2.1 General Usage Information
When using Aggregate reports, be aware of the following:

■ The date and time printed on the following reports are the date and time the query 
is executed for case qualification. They are not the date/time the query was 
completed and the report obtained Web Server.

■ Case Listing Report

■ Case Data Analysis Report

■ The system converts the following elements that display in the case form as actual 
text on the Case Listing and CIOMS II Line Listing reports:

■ Duration of Administration

■ Time Between First Dose/Primary Event

■ Time between Last Dose/Primary Event

■ Another field has been added to the Regulatory Reports section for the report 
follow up number. The system prints the report follow-up number on the 
expedited reports in the following format:

F/U# X

where:

X is the report follow-up number.

■ For an initial report, the system prints initial in the column.

■ If there are no reports for the case in the Case Listing/CIOMS II Line Listing, the 
column is left blank.

■ This option is available on the CIOMS II Line Listing/Case Listing reports.

■ The system uses the IE offset of the client workstation to print the date and time 
component for all system-calculated fields on the Case Listing/CIOMS II Line 
Listing reports for the following fields

Table Name Column Name Local IE Adjustment

case_master close_date Yes

case_master date_locked Yes

case_routing route_date Yes

cmn_reg_reports date_approved Yes
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■ You can filter cases in the following aggregate reports based on the lock/archived 
date:

■ Case Listing

■ Case Data Analysis

■ CIOMS II Line Listing

■ When you select Case Locked/Archived date, the system limits the cases based on 
whether the case is locked/archived within the specified time frame.

■ The lock date is considered the locked date.

■ If you select the Case Patient or Reporter Information in the Case Listing or 
CIOMS II Line Listing reports and the Protect Confidentiality field is checked for 
the patient or reporter Information, the system does not print the relevant patient 
or reporter Information selected in the Case Listing or CIOMS II Line Listing 
report.

■ If you do not have permission to view the reporter or patient information, the 
corresponding reporter or patient elements selected on the Case Listing or CIOMS 
II Line Listing report are blank.

If the report doesn't have cases that meet the criteria, the system prints the PDF with a 
"No data found" message.

10.1.2.2 Using the System Reports Library
You can access the System Reports Library from Reports --> Aggregate Reports --> 
System Reports Library.

When using the System Reports Library, be aware of the following:

■ The user can use the following fields to query all memorized reports:

– Report Name (type ahead)

– Description (type ahead)

– Report Type (type ahead)

– Case Data Analysis

– CIOM II Line Listing

– Case Listing

■ Author (type ahead)

■ Last Modified

– Date (date text box)

– Upgrade populates this with System Date

cmn_reg_reports DATE_GENERATED Yes

cmn_reg_reports date_scheduled No

cmn_reg_reports date_submission_determined Yes

cmn_reg_reports date_submitted Yes

cmn_reg_reports date_xmt Yes

rpt_routing route_date Yes
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■ Avail. for Periodic (text box)

– Blank

– Yes

– No

■ Shared (text box)

– Blank

– Yes

– No

■ The user can enter wildcards in Name and Description fields.

■ The following are in Search and Navigation bar:

– Displaying Records Drop-down list (standard functionality)

– Page Size Drop-down list (standard functionality)

– Back Button (page back standard functionality)

– Forward Button (page forward standard functionality)

– Search Button (executes the search with any entered criteria)

– Clear Button (clears the search drop-downs or text boxes)

■ The system displays the following columns on the screen:

– Report Name - The report name given by the user.

– Description - A description of the report as defined by the user.

– Report Type - The report type.

– Author - The name of the author of the report.

– Last Modified - The date the report was last modified. This is the system date.

– Avail. for Periodic - Indicates whether the report is available for Periodic 
reports

– Shared (See System Rule below)

■ The system displays the following buttons on the page:

– Copy

– Delete

– Open

– Execute (standard functionality)

– Export

– Transmit

■ When the user clicks the Filter icon, he/she can filter on any element.

– The system provides the type ahead feature to enable the users to filter on any 
text element.

– When the user clicks X, the system closes the filtering options.

– When the user specifies filtering criteria, the filter icon changes to the paper 
clip icon to indicate that filtering criteria has been specified.
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– The system permits the user to conduct a like search, For example, if user 
searches for "Cure" the system returns all elements beginning with Cure.

– The system permits the user to conduct wildcard searches. For example, if the 
user searches for "%Cure," the system returns all elements containing Cure.

– When the user clicks Search, the system filters reports in the report list.

■ The system saves all user preferences for future use.

■ The following fields word wrap, but do not scroll:

– Report Name

– Description (200 Characters)

■ If a record in a row is available for periodic reporting, the system places a Yes in 
the Avail. for Periodic column; otherwise the system displays No in the column.

– The user must select the available for periodic reporting option when he/she 
creates the report.

■ If the system report is shared, the system places a Yes in the Shared column; 
otherwise it displays No in the column.

– The user must set the report creation or modification options when he/she 
creates the report.

■ The user can click the column heading to sort the column in ascending or 
descending order.

– Report Name is the default sort column and is sorted in ascending order.

– Ascending (A to Z, 1&emdash;10, etc.) is the default sort order.

– A sorted column has an up or down arrow to indicate whether the column is 
sorted in ascending or descending order.

■ When the user clicks Copy, the system displays a copy of the report in the 
appropriate popup. The system displays the Case Data Analysis Report, the CIOM 
II Line Listing Report, or the Case Listing Report.

– The system names the copy of the report Copy of xxxxxx

where:

The system displays the following columns on the screen:

xxxxxx is the name of the report the system is copying.

If there are too many characters in the report name, the system truncates the 
name.

■ When the user clicks Delete, the system displays the following message:

Are you sure you want to delete?

– If the user clicks Yes, the system deletes the selected row.

– If the user clicks No, the pop-up window closes and nothing changes.

– If the report is in use, the system displays the following message:

The report which is selected is being used and cannot be deleted.

■ When the user clicks Open, the systems displays the appropriate Report pop-up 
box:

– If the user has not selected a row, the system disables the Open button.
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– The system determines the appropriate dialog box based on the report type.

* If the user selects a Case Data Analysis report, the system displays the 
Case Data Analysis popup.

* If the user selects a CIOMS II Line Listing report, the system displays the 
CIOM II Line Listing popup.

* If the user selects a Case Listing report, the system displays the Case 
Listing popup.

– If the selected report is in use, the system displays the following:

The report which is selected is being used by XXXX and cannot be modified.

where:

XXX is the full user name of the person using the report.

■ When the user clicks Execute, the system generates the selected reports.

– If the user has not selected a row, the system disables the Execute button.

– The system creates and displays the report in PDF format just as it does when 
the user clicks OK on the individual report pages.

■ When the user clicks Export, the system generates the selected report and starts 
the export process (i.e., CSV file download).

– If the user has not selected a row, the system disables the Export button.

■ If the user clicks Transmits, the system generates the selected report and starts the 
transmit process.

– The system displays the Recipient popup.

– If the user has not selected a row, the system disables the Transmit button.

■ The Memorize button in the System Report dialog enables the user to enter the 
memorize details in the report configuration options.

– If the user fails to enter the Name in the memorize section, the system disables 
the Memorize button.

* Case Listing

* CIOMS II Line Listing

* Case Data Analysis

10.1.2.3 About Case Data Analysis Reports
The Case Data Analysis Report enables you to view quantities of cases over time in a 
Cross-Tabular Fashion. Use the following procedure to create a Case Data Analysis 
report. The following is an illustration of a Case Data Analysis Report.
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10.1.2.3.1 Creating a Case Data Analysis Report  Use the following procedure to create a 
Case Data Analysis report.

To create a Case Data Analysis Report
1. Select Reports --> Aggregate Reports --> Case Data Analysis.

2. In the Case Data Analysis Report view, select the information that must appear in 
the report.

3. In Row1, select the field the system uses to group cases by row.

4. In Column1, select the data the system uses to group cases by column.

5. In Row2, select the field by which each Row1 item will be categorized.

6. In Column2, select the field by which each Column1 item will be categorized.

7. Select a product family to which the report applies, if appropriate.

8. In Selection for Row1, select the value for row 1 by which the report must be 
restricted.

9. Specify an advanced condition, as appropriate.

10. Select Report Number of Cases or Report Number of Events, depending on the 
number of cases or the number of events to be entered in the report.

11. If you select Report Number of Events, you can specify the kind of events (serious 
listed, non-serious listed, serious non-listed, or non- serious non-listed) that will 
appear in the report.

12. Select whether only the top few items should be displayed and enter the number 
of items that should be displayed.

13. Select the Show  % of Total check box to specify the percentage in each cell in the 
report.

14. Select the Blinded check box to hide blinded information in the report.
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15. Select the Use Case Search Results checkbox to limit the Case Data Analysis only 
to the cases present in the Case Search dialog.

16. Specify a date range for the cases that will appear in the report.

17. In Report Type, select whether the report is to be printed in text (data) format or in 
graphical (chart) format.

If you select Chart, you can specify the kind of chart (bar graph, line chart, etc.) 
that will be used to display the information.

18. Enter a title for the report.

10.1.2.3.2 Memorizing the Criteria Specified for a Particular Report.  To memorize the 
criteria for a specific report
1. Click Memorize to open the Memorized Report dialog box.

2. Click Save.

10.1.2.3.3 Saving, Deleting, or Canceling a Report  Use the following procedure to save, 
delete, or cancel a report, as applicable.

To save, delete or cancel the report, as applicable
1. Click OK in the Case Data Analysis screen to generate the report in PDF format.

2. To export a report in CSV format, click Export.

3. To transmit a report using Argus Safety Service, click Transmit.

4. To delete a report, click Delete.

10.1.2.4 About CIOMS II Line Listing Reports
The CIOMS II line listing report is a common format desired by Drug Safety 
professionals for reviewing cases. Create this report from the CIOM II Line Listing 
dialog box shown in the following illustration.

10.1.2.4.1 Creating a CIOMS II Line Listing Report  Use the following procedure to create a 
CIOMS II Line Listing report.
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To create the CIOMS II Line Listing report
1. Select CIOMS II Line Listing from Reports -->Aggregate Reports --> CIOMS II 

Line Listing.

2. On the CIOMS II Line Listing Criteria tab, select information for the header, footer, 
product family, advanced condition (if any), cases to include, and date.

3. Select either the Case Creation Date or Case Receipt Date radio button and 
specify a date range to run the report. 

4. In the Line Listing tab, add or remove the appropriate fields.

5. In the Grouping tab, add or remove elements, insert a page break and change the 
sort order (if desired).

6. Click Memorize to open the Memorized Report dialog box.

7. Save, Delete or Cancel the report, as applicable.

8. Click OK in the CIOMS II Line Listing screen to generate the report in PDF 
format.

9. Click Export to export a report in CSV format.

10. Click Transmit, to use Argus Safety Service to transmit a report.

10.1.2.5 About Case Listing Reports
The Case Listing Report enables you to filter cases based on Case Initial Receipt Date 
and Case Creation Date. You can select multiple entities from the List of available 
fields using the CTRL+CLICK functionality. The following is an illustration of the Case 
Listing dialog box.

Note: If you perform a search and return a list of cases to the Case 
Search screen, the Use Case Search Results is visible. Checking this 
box will disable all selection criteria with the exception of "Include 
Unlocked Cases". For example, the Advanced Condition and Date 
Range will be disabled.
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Creating a Case Listing Report
Execute the steps below to create a Case Listing report:

1. Select Reports --> Aggregate Reports --> Case Listing.

2. When the system opens the in the Case Listing Reports view select the 
information to appear on the report.

3. Select the fields that are to appear in the report from the Available Fields list.

4. Click Add. Repeat this process for each field that must appear in the report.

5. Use Move Up and Move Down to arrange the fields in the Selected Fields list.

6. Select the Blinded checkbox to hide blinded information in the report.

7. Specify an Advanced Condition, if appropriate.

8. Specify a date range for the cases to be displayed in the report.

9. If you select the Include in Header check box, the selected date range is displayed 
on the report.

10. Under Sorting Order, select the fields by which the cases will be sorted. The first 
field allows you to create a list that is sorted with respect to that particular field. 
Groups of cases that are identical with respect to the first field can be sorted by 
specifying the second field.

11. Enter the title of the report.

12. Click Memorize to memorize the criteria specified for a particular report. The 
Memorized Report dialog appears.

13. Save, Delete or Cancel the report, as applicable.

Note: You cannot sort the cases by fields that do not appear on the 
report.
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14. Click OK in the Case Listing Reports screen to generate the report. The report will 
be generated in PDF format.

15. To export a report in CSV format, click Export.

16. To transmit a report using Argus Safety Service, click Transmit.

10.1.2.6 About System Reports Library
The System Reports Library / Memorized Reports enables you to recall a memorized 
Case Listing, CIOMS II Line Listing or Case Data Analysis Report criteria. You can 
save (memorize) search criteria and reuse these criteria when generating future 
reports. 

The Memorized Reports dialog displays current user reports as well as reports that 
are shared by all users. Use the following procedure to create Memorized Report.

To create a Memorized report
1. Select Reports --> Aggregate Reports --> System Reports Library to open the 

Memorized Report dialog box.

2. Select a memorized report and click Open.

3. Click the Share this report with other users check box to make the report criteria 
available to all users. Previously memorized reports appear in the Your 
Memorized Reports list.

4. Click Delete to delete a selected memorized report.

5. Select the Make available for use Periodic Reports check box to use this report in 
periodic reports like PSUR, CTPR, IND, and NDA.

10.1.2.6.1 General Usage Information  When using the System (Memorized) Reports, be 
aware of the following.

■ The following Line Listing Available fields functionality boxes have been 
updated:

– Reports > Aggregate Reports > CIOMS II Line Listing, (Line Listing tab) to 
allow select fields.

– Reports > Aggregate Reports > Case Listing to allow the user to select fields.

– Reports > Aggregate Reports > Case Data Analysis.

■ A tree view, similar to the advanced condition tree view, has been created for the 
available fields. The fields are the same as those currently displayed and the field 
text box is read-only.

■ If you select a field from the tree view and adds it to the Selected Fields list, the 
system removes the field from the Available Fields list.

■ If the you try to add the field again, the system displays a message and displays 
the name of the selected field inside brackets ( [ ] ). If you wish to remove the 
selected field, click Yes.

Note: A shared report can only be deleted by the Administrator or 
the user who created it.
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11Reports: Periodic Reports

This chapter contains detailed information about Argus periodic reports and how to 
create and use them.

11.1 Periodic Report Types
This section lists the different Periodic Reports in Argus and discusses about each of 
them in detail. Place the cursor over the Periodic Reports option in the Reports tab to 
go to any of the Periodic Reports.

You can create four kinds of periodic reports:

■ Clinical Trial Periodic Reports

■ ICH PSUR Reports

■ US IND Periodic Reports

■ US NDA Periodic Reports

11.1.1 Initial and Follow-up Cases in Periodic Reports
A case is categorized as follow-up only if it has been previously submitted to the same 
regulatory agency, report form type and configured product/licenses or study, 
otherwise it is considered initial.

11.1.2 Storing Periodic Reports in Documentum
Argus Safety enables you store your Periodic Reports in Documentum.

When you approve an expedited report from within Argus, the system exports the 
report as a PDF file and saves it in the Documentum database by Argus Safety Service. 
From this point, you can perform document reviews within the Documentum system.

When the report is ready to be submitted, mark the report as submitted from within 
Argus. Argus Safety Service updates the status of the report within Documentum to 
Submitted.

If the report is to be transmitted via fax or email, Argus Safety Service marks the report 
as a successful submission in Documentum only after the fax or email transmission 
has succeeded.

11.1.3 Viewing a Summary of Periodic Regulatory Reports
You can select any of the following options in viewing the summary of a periodic 
regulatory report:
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■ To view the regulatory reports for a particular case (scheduled, generated, and 
submitted), open the Regulatory Reports tab of the Case Form.

■ To view all scheduled, generated, and approved reports, as well as other 
outstanding action items assigned to you or your user group, select Reports in the 
Worklist menu.

■ To view a list of all scheduled, generated, and approved periodic reports, select 
Periodic Reports from the Reports | Compliance menu.

11.1.4 Using the Library Page
The periodic reports have a library page for the following reports:

■ PSUR

■ CTPR

■ IND

■ NDA

The following table lists and describes the fields on the Library Page:

When using the Library Page be aware of the following:

■ The system places the total number of records displayed on the library page in the 
Total Number of Row (x) read-only field in the Report header.

■ The user can select the number of cases to display from the Page Size drop-down 
list.

■ The page size drop-down list contains the following values:

Field/Control Name Purpose

Category Enables the user to view the report Category.

Sub Category Enables the user to view the report Sub Category.

Report Name Enables the user to view the name of the Periodic Report

Inclusion Start Date/Stop Date Enables the user to view the report start and stop dates as 
defined in the configuration.

Author Created Enables the user to view the name of the author who created 
the report.

Author Modified Enables the user to view the name of the author who last 
modified the report.

Date Created Enables the user to view the date the report was created.

Date Modified Enables the user to view the date the report was last 
modified.

Justification Enables the user to view the justification for updating the 
report.

The system displays the standard Justifications dialog that 
contains the lasts justification entered by the user.

Search When the user clicks Search, the system initiates the search 
operation. When the system displays the search results, the 
user can enter search parameters in various fields and click 
Search to narrow the search results.

Clear Enables the user to clear user-entered data from the fields
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– 50

– 100 (default)

– 250

– 500

– 1000

– 2000

■ The system displays the number of reports currently in view and the system 
automatically updates the range based on the selected page size. For example, if 
the user selects a page size of 100, the system displays reports in groups of 100.

■ The user can go directly to a range of cases from the Displaying Rows drop-down 
option.

■ The user can scroll through the reports page-by-page in increments as defined in 
the Page Size drop-down list.

■ The user can sort on all columns in the Reports view by clicking the column 
header. The system displays an up arrow or a down arrow depending on whether 
the column is sorted in ascending (A-Z, 1-10, etc.) or descending order (Z-A, 10-1, 
etc.).

■ Initially, the reports are sorted by Category.

■ The default sort order is ascending.

■ When you click the Filter icon, the system displays the filtering row to enable you 
to filter on any element.

■ The type ahead feature enables you to filter on any element except Draft/Final.

■ Click the appropriate icon to minimize the filtering options.

■ Click the X to close the filtering options.

■ If filtering criteria is defined, the system displays the filtering elements icon to 
indicate that filtering elements exist.

■ If filtering criteria is not defined, the system displays the no filtering elements icon 
to indicate that no filtering elements are defined.

■ The system enables you to perform a like search. For example, if the user searches 
for Cure, the system returns all elements that start with Cure.

■ The system enables you to perform wildcard searches. For example, if the user 
searches for %Cure, the system returns all elements that contain Cure.

■ When you click Clear, the system clears the filtering criteria from the fields.

■ Clicking the filter icon enables you to filter for reports in the list of reports.

■ The system saves all user preferences for future use. If the user has already entered 
filter elements, the system displays the filter details for the last search when it 
displays the dialog.

11.1.5 About CTPR: Clinical Trial Periodic Reports
The Clinical Trial Periodic Reports (CTPR) are created to report the IND Annual 
reports and EU Clinical Trial Directive line listing reports to FDA.
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To create Clinical Trial Periodic Reports
1. Select Reports --> Periodic --> CTPR (Clinical Trial Periodic Reports) to open a list 

of CTPR Reports.

2. To create a new report from an existing report in the list, click Copy or Modify.

3. Click New Report to create an entirely new report. The Clinical Trial Periodic 
Reports dialog opens.

4. Enter an appropriate name for the report under Report Name.

5. Use the tabs in this dialog to configure the CTPR.

11.1.5.1 General Usage Information
When using the CTPR, be aware of the following:

■ The system enables you to group cases as per the options provided in the 
drop-down list. Example: by Product Name or by Drug Regimen Frequency:

■ Product Name

– This option enables you to group the Product Name - Formulation - 
Concentration with Units when the elements are separate with a hyphen ( - ).

– If an element is missing, the system does not print the hyphen ( - ).

– The system groups the cases based on the primary drug in the report.

■ Dosage Regimen Frequency

– This option enables you to group the frequency of the primary dosage 
regimen for the primary drug in the report.

– The system prints Frequency: followed by the frequency as defined above.

■ You can select datasheets for specific report types similar to the CTPR Report for 
the Inclusion criteria. If you select any rows in the inclusion criteria, the system 
disables the Datasheet selection dialog.

■ Report Type.This portion lists the report types (configured in Code List | Report 
Type) the report will be run against (LM_REPORT_TYPE). The user must select a 
report type so the system knows to save the criteria row.
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■ Serious Criteria.This enables you to specify the seriousness of the cases for the 
selected report type as follows:

– Serious: Case Level or Primary Event is Serious.

– Non-Serious: Case Level or Primary Event is Non-Serious.

– If you select both Serious and Non-Serious, the system ignores the criteria.

– Fatal: At least one event has a Fatal event outcome.

– Non-Fatal: No events have a Fatal event outcome.

– If you select both Fatal and Non-Fatal, the system ignores the criteria.

■ Listedness.

– When using the case level assessment, the system does not consider the 
datasheet. Cases appear in the CTPR if the case level assessment matches the 
selected criteria.

– When using the primary event assessment in conjunction with a datasheet, the 
system uses only the As Determined listedness for the primary event when 
determining whether a case should be included in the CTPR report.

– If both Listed and Unlisted are selected, the system ignores the criteria and 
includes all listedness values (including Unknown).

■ Datasheet.This enables you to specify which Datasheet to use when looking for 
Listedness (LM_DATASHEET). The system uses the datasheet criterion only when 
you select the primary event assessment as the CMN_PROFILE assessment.

■ When you select the <ALL> datasheet option, the listedness for the primary event 
on at least one datasheet must match the selected criteria.

■ Related/Non-Related.

– When using case level assessment, cases appear in the CTPR when the case 
level causality matches the selected criteria.

– When using the Primary Event assessment, cases appear only if the causality 
for the primary event as reported or as determined matches the selected 
criteria.

– When using the All Events assessment, cases appear if any case events with as 
reported or as determined causality match the selected criteria.

– If you select both Related and Non-Related, the system ignores the 
related/non-related criteria.

■ HCP/Non-HCP. To have a case included in the CTPR, you must identify at least 
one case reporter as a HCP or Non-HCP. If this is being used in conjunction with 
the Primary Reporter Only checkbox, the system evaluates only the primary 
reporter for this criterion.

■ Primary Reporter Only. This enables the system to perform the HCP/Non-HCP 
check against only the primary reporter. This updates the entire configuration 
whether checked or unchecked.

■ You can copy an existing template by clicking the Create from Template button on 
the CTPR reports list.

■ When you click Create from Template, the system displays the Create from 
Template dialog.
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■ You can choose the CTPR Group Name (as configured in the Product Name 
configuration) from a type ahead field.

■ When you enter the CTPR Group Name in the Select CTPR Group Name field 
and the From and To dates in the Create from Template dialog and click OK the 
system does the following:

– Saves the CTPR Configuration with the new dates.

– Replaces the products in the list of selected products with all products as 
defined for the selected CTPR name.

– Replaces the periodic report name in the newly configured periodic reports 
with a new name in the following format:

XXXX: YYYY to ZZZZ

where:

XXXX is the selected CTPR Name.

YYYY is the From Date entered by the user.

ZZZZ is the To Date entered by the user.

– Replaces the date ranges for the From and To date fields only for the Periodic 
Report.

– Bases the remaining configuration, including the security permissions, on the 
selected CTPR template.

■ When you enter the CTPR Group Name in the Select CTPR Group Name field 
and the From and To dates in the Create from Template dialog and click Print and 
Save, the system does the following:

– Saves the CTPR Configuration with the new dates.

– Replaces the products in the list of selected products with all products as 
defined for the selected CTPR name.

– Replaces the periodic report name in the newly configured periodic reports 
with a new name in the following format:

XXXX: YYYY to ZZZZ

where:

XXXX is the selected CTPR Name.

YYYY is the From Date entered by the user.

ZZZZ is the To Date entered by the user.

– Replaces the date ranges for the from and to date fields only for the Periodic 
Report.

– Calls the Report Batch Printing dialog.

– Bases the remaining configuration, including the security permissions, on the 
selected CTPR template.

11.1.5.2 Common Tab Fields
The Report Name, Report Category and Report Sub-Category fields are common to 
all tabs of the Reports.

The following table below describes these fields:
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11.1.5.2.1 Subject of Report Tab  The Subject of Report tab is used to configure the 
report header and to specify the agency, products, etc. for which the CTPR is 
applicable.

The following table lists and describes the fields on this tab.

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the 
Reports menu.

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.
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Field Description

Available Reporting 
Destination

Displays the list of configured Regulatory Agencies. Select an agency 
from the list displayed in Reporting Destination and click Add to add 
the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click 
them.

Likewise, select an agency from the Selected Destination list and click 
Remove to remove it from the selected destination.

Primary Agency Select the primary agency for the report.

Note: When you submit a Periodic report, it goes to the selected 
Primary Agency.

Selected Reporting 
Destination

Displays the list of agencies where the report is being sent. Select an 
agency from the list displayed in Reporting Destination and click Add 
to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click 
them.

Likewise, select an agency from the Selected Destination list and click 
Remove to prevent it from being sent to the selected destination.

Report # Enter a report number for this report

Report Title Enter a report title for this report

Ingredient Automatically displays the "Ingredient" as provided in the Subject of 
Report dialog.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

Trade Name Automatically displays the "Trade Name(s)". Multiple trade names are 
also displayed together, separated by commas.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

International Birth 
Date

Automatically displays the earliest license awarded date, when a user 
selects an Ingredient and a Product.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

Report Footer Enter the footer for the report

Print all 
configuration criteria 
on separate cover 
page

Mark this box to print out the configuration of this report when the 
report is printed. This is only available when PDF option is selected 
during printing.

Print page numbers 
on reports

When checked, this option enables the user to print page numbers on a 
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

■ The "Include Periodic Page Numbering" option in the CTPR 
Summary Tabulations CIOMS Report section is inactive and 
grayed out.

■ The "User Periodic Numbering on the report" option on CTPR 
Summary Tabulations FDA CTPR support section is grayed out 
and inactive.

■ The "Additional Separate Page Numbering for UD Summaries" 
option on the CTPR UD Summaries tab is grayed out and inactive.

■ The system removes all existing report page numbering and the 
option to check page number check boxes on the report 
configuration tabs are grayed out and inactive.
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11.1.5.2.2 Product Selection Tab  The Product Selection tab enables you to select the 
products included in the CTPR report.

The following table lists and describes the fields on the Product Selection tab.

Allow access to 
report cases through 
Case Series

When the report is run as final, it creates a Hit List, which can be 
retrieved from other areas of the application where advanced 
conditions can be selected. Click this checkbox to report cases through 
the Hit List.

Field Description

Available Ingredients Displays the list containing the Ingredients used for the product 
configuration. Select an ingredient from the list displayed in Available 
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered 
ingredient within the Available list of Ingredients.

Selected Ingredients Displays the list of ingredients selected from the Available Ingredients 
list.

Available Countries This list is auto-populated and displays only the countries with a 
license containing the ingredient selected from the Available 
Ingredients list.

Selected Countries Displays the countries selected from the Available Countries list.

Indication This list contains the Indication configured for the product containing 
the ingredients in the Available Ingredients section. The selections 
made from this list get displayed in the Available Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Field Description
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11.1.5.2.3 License/Study Tab  The License/Study tab is used to configure the report 
header and to specify the agency, products, etc. for which the CTPR will be applicable.

The following tables lists and describes the fields on the License/Study tab.

11.1.5.2.4 Inclusion Criteria Tab  The Inclusion Criteria tab allows you to select search 
parameters for inclusion of cases in a periodic report.

Formulation This list contains the Formulation configured for the product 
containing the ingredients in the Available Ingredients section. The 
selections made from this list get displayed in the Selected Products 
section.

Note: You can select multiple Formulations from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Field Description

Available Licenses Contains licenses that use the ingredient selected in the Ingredient 
field. This field is automatically populated when an ingredient has been 
selected.

Selected Licenses Displays the licenses selected from the Available Licenses list by 
clicking Add/Add All. You can select Licenses that are related to 
different ingredients for a report.

Available Studies Contains studies that use the ingredient selected in the Ingredient field. 
This field is automatically populated when an ingredient has been 
selected.

Selected Studies Displays the studies selected in the Available Studies list by clicking 
Add/Add All. You can select studies that are related to different 
ingredients for a report.

Field Description
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The top section of the dialog allows you to specify the type of cases that will be 
included in the periodic report.

The following table lists and describes the fields on the Inclusion Criteria tab.

Field Description

Case Creation Date Allows you to specify a range of cases by the date when the case was 
created.

Case Receipt Date Allows you to specify a range of cases by the initial receipt date.

Note: The Date Range is only available when an unscheduled CTPR is 
being created. You must specify only one date range out of Case 
Creation Date and Case Receipt Date.

Case 
Locked/Archived 
Date

Allows you to specify the date when the case was locked/archived.

Use Current Version Allows you to use the latest revision to populate the data within the 
selected reports.

Use DLP Version Allows you to use the case data of the version as of the specified DLP 
Version.

Age Groups Allows you to include or exclude cases based on the patient's age 
group. Select all the age group categories that apply.

Restrict Cases to 
countries where 
studies are active

References study configuration to determine if the case was submitted 
during the dates the study was active.

Note: This option is available only if a study is selected from the 
Available Studies section in the License/Study tab.

It should not be used for Centrally approved products (CAP), which 
only have an EU license.
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11.1.5.2.5 Using the DLP Version  DLP primarily uses two processes:

■ Next Case Revision

■ Last Case Revision

DLP Options
Be aware of the following DLP Options.

■ Last Completed Version -- This option always uses the case version with the last 
lock that existed prior to the DLP or "As of reporting" date. This option does not 
enable data cleaning

Note: DLP saves only the last revision when multiple saves are performed in the 
same job session.

Advanced Condition Allows you to specify an advanced condition that must be satisfied by 
each case that is included in the report. Ensure that the advanced 
condition or the advanced condition query set that is specified here 
does not contradict any other criteria specified in the dialog.

Datasheet for 
Listedness

Select the Datasheet to look against for Listedness when running the 
report.

Note: Select the ALL datasheet to use the most conservative listedness 
for the primary event, or the Case Listedness for the tabulation.

Use Assessment in 
Cases

When selected, the CTPR Report will use the Case Event Assessment 
when performing datasheet listedness calculations.

Re-assess cases 
against datasheet in 
effect at the 
beginning

When selected, the CTPR will re-assess the cases in the line listing 
based on the Active Datasheet on or before the Start Date of the 
Reporting period.

Re-assess cases 
against datasheet in 
effect at end

When selected, the CTPR will re-assess the case in the line listing based 
on the Active Datasheets on or closest to the end date of the CTPR 
Reporting end date range without exceeding that date.

Reference Type 
(Clinical Reference 
Data Element)

Select the reference type to be displayed on the Main Listing if Clinical 
Study Reference is selected as a Data Element in the Available Data 
Elements section of the Line Listing tab.

Expeditable Only This option is enabled only when an agency has been specified on the 
Subject of Report tab. Check this option to include only those cases 
that have submitted expedited reports to the specified Primary Agency.

Exclude Follow-up 
cases

Follow-up cases are cases with a significant follow-up in the Clinical 
Trial reporting period where the initial receipt date is in a prior period. 
Check this option to exclude follow-up cases from appearing on the 
Clinical Trial report.

Include Unlocked 
Cases

Check this option to allow cases that have not been locked for reporting 
to appear on the report.

Use Datasheet 
Assessment for UDF 
Tabulations

Allows you to select datasheet for a report to make UDF tabulations.If 
no datasheet is selected, the most conservative listedness is chosen, i.e. 
Unlisted followed by Listed.

Add Cases not 
included in previous 
reporting period

Allows you to add cases which were not included in the previous 
reporting period.

You can enter the start date of the period in the Start Date field.

Field Description
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■ Next Completed Version -- This option uses the current case lock or the next 
following case lock if the case version was initiated prior to the DLP or the "As of 
reporting" date with two exceptions:

– If there is no case lock for the current version that was received prior to the 
DLP, the last (current) case revision is used.

– If there is a case version after the case lock that was created for the purpose of 
data cleaning, it is to be used instead of the first locked case revision.

– If there are multiple contiguous case versions following the first case lock for 
the purpose of data cleaning, the last case data cleaning version is used.

11.1.5.2.6 Dates for Using DLP/"As of reporting" Function  You can perform DLP queries for 
the following:

■ Receipt Date -- date entered by the user during case creation

■ Initial / Follow up Receipt Date

■ Safety / Safety Follow up Receipt Date

■ System Date (Case Creation Date) - date the case was physically entered

11.1.5.2.7 As of Reporting Function  The as of reporting function returns the same case 
version results as the DLP Options, with the only difference that the date depends on 
the "as of date" instead of a DLP date.

11.1.5.2.8 Availability of DLP/As of query functionality  The DLP / as of query functionality 
is available in the following application modules:

■ Periodic Reports

– PSUR including all User defined Tabulations and expedited reports within the 
Periodic Report

– CTPR including all User defined Tabulations and expedited reports within the 
Periodic Report

– IND including all User defined Tabulations

– NDA including all User defined Tabulations and expedited reports within the 
Periodic Report

■ System Reports

– CIOMS II Line Listing

– CDA Reports

– Case Listing Reports

11.1.5.2.9 Line Listing Tab  The Line Listing tab contains the following fields and 
sections:

Note: The Data Cleaning option is only available with the DLP 
option Use Next Completed Version (Includes Data Cleaning).
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11.1.5.2.10 Available Data Elements  A number of optional fields are available in the 
Available Data Elements frame. Select the check box associated with a data element to 
add the data element to the report. Be aware of the following:

■ By default, the system print s unavailable fields on the report, and they cannot be 
changed.

■ Required data elements are printed as columns in the report. The optional data 
elements are printed as separate rows below the column data for each case.

Refer to the following table for a list of data elements on this tab.

Field Description

Include Line Listing Allows you to select whether you want the Line Listing Data Elements 
printed with the CTPR Report.

Blind Line Listing 
and Summary 
Tabulations

Hides the selected listings from being displayed

Data Element Notes

As Determined Causality Optional.

As Determined Listedness Optional.

As Reported Causality Optional.

Case Abbreviated Narrative Required and multi-language available.

Case Classifications Multiple classifications are displayed in separate 
lines.

Case Central Safety Date Optional.

Case Comment Text Optional.
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Case Initial Receipt Date Optional.

Case Listedness Optional.

Case Narrative Optional.

Case Number Required.

Case Outcome Required.

Case Report Type Required.

Case Seriousness? Optional.

Clinical EUDRACT # Number Optional.

Clinical Study Reference Optional.

Company Agent Causality Optional. Displays event causality from product 
name. Multiple causalities are displayed in separate 
lines.

Country of Incidence Required.

Death Cause Optional. Multi-language available.

Death cause as reported Optional

Death Cause HLGT Optional.

Death Cause HLT Optional.

Death Cause LLT Optional.

Death Cause SOC Optional.

Dosage Regimen Batch/Lot # Optional.

Dosage Regimen Daily Dose Required.

Dosage Regimen Duration Required.

Dosage Regimen Frequency Required.

Dosage Regimen Route of 
Administration

Required.

Dosage Regimen Start Date/Time Required. For the selected product the report is 
based on. List for all dose regimens.

Drug Dechallenge? Required.

Product Indication Optional. For the selected product the report is 
based on.

Product Indication HLGT Optional. For the selected product the report is 
based on.

Product Indication HLT Optional. For the selected product the report is 
based on.

Product Indication LLT Optional. For the selected product the report is 
based on.

Product Indication SOC Optional. For the selected product the report is 
based on.

Drug Rechallenge? Optional.

Event Description as Reported Required.

Event Onset Date/Time Required.

Data Element Notes
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11.1.5.2.11 Selected Data Elements  This section lists the selected elements and enables 
you to arrange the order in which these are to be printed. Click the Up or Down 
buttons to arrange the listed elements above or below in order of priority.

Options

Event Preferred Term Required.

Lab Data - Tabular Optional.

Literature Author Optional.

Literature Journal Optional.

Literature Pages Optional.

Literature Title Optional.

Literature Volume Optional.

Literature Year Optional.

Literature reference Optional.

Outcome of Event Optional.

Patient Age Required.

Patient Gender Required.

Patient Initials Optional.

Patient Relevant History Optional. Multi-language.

Patient Subject # Optional.

Product Name Optional. Displays "product name (generic name) 
product type, formulation, concentration unit" "daily 
dose," "dose dose_freq, route"

Product Name Report Inclusion Optional. Prints the Products that were part of the 
CTPR Report for the case.

Displays "product name (generic name) product 
type, formulation, concentration unit" "daily dose," 
"dose dose_freq, route"

Report Comment Optional.

Study ID Optional.

Study Other ID Optional.

Study ID Protocol # Optional.

Field Description

MedDRA Hierarchy 
from 
Cases/Dictionary

Select Cases to populate the data from the case data. Select Dictionary 
to populate the data from the MedDRA dictionary.

Print Only the Term 
(Preferred Term or 
Lower Level Term)

Prints only the event Preferred Term (PT) or event Lower Level Term 
(LLT) as per the selected radio button. Select the PT option to print only 
the preferred term and not the verbatim description.

Print Dose Text in 
place of regimen dose

Prints the dosage and frequency information from Dose Description 
field instead of Regimen Dose.

Data Element Notes
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11.1.5.2.12 Grouping Tab  Refer to the following table for a description of items in the 
Grouping tab.

Indicate if case was 
expedited previously

This checkbox is selected if a primary agency has been selected in the 
Subject of Report tab. Cases for which an expedited report was 
previously submitted to the selected authority are marked with an 
asterisk.

English Language Provides the option to print the descriptions in English.

Local Language Allows a user to specify which Local language for a multi-language 
field is to be printed i.e. the Abbreviated Narrative field.

Print event info 
(Serious, Un-listed, 
Related) as Column

Select this check box to print the Seriousness, Listedness and Causality 
under the Event Verbatim column.

Note: Events having listedness of "Unknown" are considered 
"Unlisted." If only diagnoses are assessed for event assessment, the 
events which are associated with a Diagnosis but have been marked 
with Diagnosis as "Np" display " - " for both listedness and causality.

List cases only once, 
under the primary 
event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event

List cases under all 
events, details under 
the primary event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event, while non-primary events are listed 
under their respective event hierarchy with a reference to the primary 
event body system. Therefore, use this option when grouping on Main 
Line Listing is by the Event Body System.

Print Product 
Indication for the 
product selected in 
the report

Select this option to print Product Indication for the product selected in 
the report.

Field Description
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11.1.5.2.13 Summary Tabulations Tab  The Summary Tabulations tab enables you to 
specify which summary tabulations/Listings will appear along with the line listing.

The following table lists and describes the fields on the tab.

Field Description

Available Groupings Allows a user to group cases together from the given list. Select the 
desired groupings from the list and click Add to move the grouping to 
the Selected Groupings list. Up to 10 grouping options can be selected.

Selected Groupings Lists the added groupings made available from the Available 
Groupings list, and reports the groups in the order they were selected.

Ascending Select this check box to sort the selected entities in ascending order.

Page Break Select this check box to start the cases from a new page, while also 
keeping the sorting together for every selected page break.

Available Sortings Allows a user to sort cases together from the given list. Select the 
desired sortings from the list and click Add to move the sorting to the 
Selected Sortings list.

Selected Sortings Allows a user to further sort cases without a total count for each sorted 
item. Up to 3 levels of sorting can be selected from the Available 
Sortings list.

Field Description

Include Index of 
Cases in CTPR

Create an index page of case numbers, for all cases included in the 
CTPR.
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Include Summary of 
Cases Missing 
Assessments

This option creates a sub-report of cases missing one of the following 
items:

■ Seriousness

■ Case Causality

■ Case Listedness

■ Case Outcome

■ Event Causality

■ Event Listedness

Click this checkbox to create one or both of the following sub reports:

Cases Missing Assessments - This sub-report displays cases that have 
been included in the CTPR line listing, but one or more of the following 
have not been assessed:

■ Case Seriousness

■ Case Causality

■ Case Listedness

■ Case Outcome

■ Event Causality

■ Event Listedness

Cases Not Included in Report - This sub-report displays cases that 
have not been included in the CTPR line listing as a result of missing 
one or more of the following items:

■ Lock Status

■ Safety Date

■ Uncoded Event

■ Causality

Count of Cases per 
Report Type

This option prints a Sub Report that counts the number of cases versus 
the Report Type, based on the cases within the CTPR.

The Cases per Report Type can be either of the following:

Count Cases with Initial Expedited Reports: Counts cases with initial 
Expedited report.

Count of cases with "Follow-up" Expedited report: Counts cases with 
Follow-up Expedited report.

Total Count of "Initial" Cases in the Report: Counts any (serious - 
non-serious) cases received during the reporting period.

Total Count of "Follow-up" Cases in the Report: Counts any (serious - 
non-serious) follow-up cases entered during the reporting period.

Cumulative Count: Count of cases received from the start of the trial.

Event Count per 
Study Drug

Creates a sub-report with Event count per Study Drug based on the 
selected causality. 2 configurations are possible as to allow for a count 
of related events vs. non-related events.

All Study Drugs in 
Single table

Suppresses '0' current columns (with their cumulative) and print 
everything in a single cross tab.

Grouped by Study 
Drug

Prints a cross tab report for every product. Prints the cumulative totals 
even if the current period has no events.

Field Description
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CIOMS Reports

Cumulative Summary

Event Type to 
Include

Prints SUSAR events on the CTPR Report based on the option selected 
from the drop-down list:

■ Separate counts of SUSAR and non-SUSAR events

Prints SUSAR and non-SUSAR events listed separately. SUSAR 
events are marked with an asterisk

■ Combined count of SUSAR and non-SUSAR event

Prints SUSARs. Normal events are grouped into one (current 
functionality)

■ Only count SUSAR events

Prints Only SUSARs i.e. non-SUSARs would not be printed

Title Enables you to select a title.

Include Line Listing 
Tabulation

Select this checkbox to view a pre-defined summary tabulation of 
Report type, Seriousness and Listedness of all cases in the CTPR.

Include Initial Cases Select this checkbox to include initial cases in the CTPR tabulation.

Include Follow-up 
Cases

Select this checkbox to include follow-up cases in the CTPR tabulation.

Include Summary of 
Unlocked Cases

Enables you to print the list of Case Numbers that are included in the 
Periodic Reports but are not locked.

Additional Expedited 
Report Forms 
(CIOMS/MedWatch/
VAERS)

Allows you to print CIOMS/MedWatch/AERS forms (as per selection) 
for its respective regulatory agency (as selection), for all cases in the 
report. It also provides an option to have (or not have) a watermark in 
the forms.

Field Description

Print CIOMS reports 
for serious/unlisted 
cases

Allows a user to print CIOMS I forms for all Serious/Unlisted (Case 
Level) cases appearing in the CTPR.

Note: CIOMS contain Internal or Other text printed on them when the 
CTPR is printed using the Internal or Other option.

Include Periodic 
Numbering on the 
CIOMS reports

Numbers the requested CIOMS I with a periodic format. (i.e. A-1-1 of 2, 
A-1-2 of 2, A-2-1 of 1, A-3-1 of 1 etc.). The index is modified to also 
contain the Periodic paging of each CIOMS report.

Field Description
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FDA CTPR Support

Field Description

Include Cumulative 
Summary

Select the checkbox to create a sub-report count of events, grouped by 
Product and Body System (SOC) and sorted by Preferred Term. The 
sub-report contains a previous date range count of events (comparative 
date range), a current date range count (current CTPR date range) and a 
cumulative count (all dates) of events assessed against the product(s) of 
the CTPR and matching the inclusion criteria.

Comparative Date 
Range

Allows a user to specify the previous date range as a comparison date 
for the events counted, and therefore should not overlap with the 
current date range specified on the CTPR inclusion criteria tab.

Serious Select this check box to include only serious events.

Unlisted Select this check box to include only unlisted events selected in the 
Datasheet on the "Inclusion Criteria Tab." If no datasheet is selected, 
then any Unlisted license is included.

Related Select this check box to include only those events that are assessed as 
Related or Causal.

Diagnosis Select this radio button to include only those events that are marked as 
diagnosis "Yes" and are without any symptoms associated with 
diagnosis.

Diagnosis & 
Symptoms

Select this option to include all events in the sub-report.

Separate Diagnosis & 
Symptoms

Select this option to include all SUSAR events in the CTPR Report.

Field Description

FDA CTPR Support Section

Include Adverse Event 
Summary

Select this option to generate a sub-report of events from the 
line listing. This sub report is grouped by Body System and 
Preferred Term.

Note: This section can be used if the company has obtained 
an FDA waiver to submit a CTPR instead of an NDA report.
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11.1.5.2.14 Single Case Submission Support  

Causality Select the desired causality from the list.

Ignore - Counts events regardless of causality assessment.

Causal - Counts events where the causality is considered 
reportable in the Causality Category configuration in List 
Maintenance.

Not Causal - Counts events where the causality is considered 
non-reportable in the Causality Category configuration in 
List Maintenance.

As Determined - Counts events where 'As Determined' 
causality meets the above selected causality criteria.

As Reported - Counts events where 'As Reported' causality 
meets the above selected causality criteria.

Both - Counts events where both 'As Reported' and 'As 
Determined' causality meet the above causality criteria.

Either - Counts events where either the "As Reported" or "As 
Determined" causality meets the causality criteria.

Only Cases with HCP Reporter Select this check box to include events for only those cases 
that feature an HCP reporter

Diagnosis Select this radio button to ensure that only events marked as 
diagnosis are counted.

Diagnosis & Symptoms Select this option to ensure that all events are counted in the 
sub-report.

Separate Diagnosis & 
Symptoms

Select this option to include all SUSAR events in the CTR 
Report.

Domestic Consumer Report Enables you to select domestic consumer report.

Print Unsubmitted This option allows a user to print MedWatch or VAERS forms 
for U.S. cases. The following types of cases will be excluded:

■ Foreign Cases (Country of Incidence not equal to U.S.)

■ Clinical Trial Cases (Case Report type in list maintenance 
has "this type includes cases from clinical trials" 
checked.)

■ Literature Cases (Case Report type in list maintenance 
has "this type include case from literature" checked.)

■ Cases with submitted expedited reports to the Agency 
selected in the CTPR.

Exclude Reports that are 
Non-Serious and Listed

Allows a user to suppress MedWatch or VAERS forms from 
printing for Non-Serious listed cases where all events are 
non-serious and listed for the datasheet specified.

Use Periodic numbering on the 
Reports

Numbers the requested forms with a periodic format. (i.e. 
Periodic Page 1 - 1, Periodic Page 1 - 2, Periodic Page 2 - 1, 
Periodic Page 2 - 2, etc.) An index with the Case Number is 
also included.

Field Description
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11.1.5.2.15 UD Summaries Tab  The UD Summaries tab allows you to specify which 
summary listings will appear along with the line listing.

Field Description

Single Case Submission Support Section

Generate Periodic ICSR 
Submissions for any cases in this 
Periodic Report that does not have 
at least one scheduled single-case 
report during the reporting period 
to the following Reporting 
Destination(s): Modify

Select this check box to generate the ICSR Reports only for 
the cases, where a Periodic ICSR Report for the message 
type chosen, does not exist.

Select one or more trading partners from the list box.

Important: Any case that does not have an expedited or 
single case periodic submission to a trading partner, must 
have an ICSR report scheduled as a part of the Periodic 
submission.

Click Modify to select a different Reporting Destination.

Schedule these single-case 
Periodic Reports to the following 
Reporting Destination

Select a single-destination trading partner for Periodic 
Reports from the drop-down list box.

Using the Message Type Select the required message type from the drop-down list 
box

Field Description

Include these summary 
tabulations/listings based on the 
set of cases presented in the line 
listing

Allows you to select from pre-configured summary 
tabulations/listings based on Case Data Analysis, Case 
listing or CIOMS II line listing reports. These tabulations 
are based only on the data included in the line listing. 
Select the Exclude Follow-up Cases check box to filter 
out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected 
on the Inclusion criteria tab, this option is ignored and 
follow-up cases are always filtered out.
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11.1.5.2.16 Scheduling Tab  The Scheduling tab allows you to specify details of how 
often the periodic report will be scheduled.

The following table lists and describes the fields on the Scheduling tab.

Include these summary tabulations 
based on all cases

Allows for additional sub-reports based on the 'Case 
Data Analysis' template, to be included as an output for 
the all cases in the database that meet the CTPR inclusion 
criterion for all dates.

Include these summary 
tabulations/listings based on the 
Date Range

This option allows for additional sub-reports based on 
Case Data Analysis, Case listing or CIOMS II line listing 
reports to be included as an output for the cases meeting 
the CTPR inclusion criterion for the Date Range specified 
when adding the sub-report.

The dates are based on either the "Case Creation Date" or 
the "Initial Receipt Date" as entered on the CTPR 
Inclusion Criteria tab. Click the checkbox to the right of 
the sub-report to ignore considering follow-up cases for 
the sub-report.

Identify SUSAR and Special Interest 
Events

Enables you to identify any SUSAR and special interest 
events.

Additional Separate Page 
Numbering for Summaries

Enables you to include additional separate page 
numbering for summaries.

Field Description

Start Date This is the International Birth Date for the CTPR product. This date is 
computed as the earliest Awarded date for any license of any type.

Recalculate Allows a user to recompute the International Birth Date of the CTPR 
Product. This date can be overwritten/manually entered, if needed.

Field Description
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11.1.5.2.17 Scheduling Frequency  

The following table lists and describes the fields in the Scheduling Frequency section.

11.1.5.2.18 Security Tab  The Security tab is used to configure the security level for the 
CTPR.

Report is due xx days 
after selected end 
date (creation or 
receipt date)

Enter the number of days when the report will be due after the end date 
specified for the scheduling period.

Automatically 
generate report xx 
days before/after 
selected end date at 
xx:xx

Allows a user to specify the timing of the automatic report generation, 
by specifying the number of days before/after the selected end date of 
the report.

Group Allows the user to select the group to which the automatically 
generated report is to be assigned

Field Description

Frequency Allows a user to specify the interval required for this scheduling 
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

Field Description
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The following table lists and describes the fields on the Security tab.

11.1.6 About ICH PSUR Reports
The Periodic Safety Update Reports (PSURs) are created on a periodic basis to enable 
regulatory authorities to monitor the safety of a marketed product. This information is 
used to view new data about the product acquired from appropriate sources. It helps 
relate this data to the patient exposure and also indicates whether changes should be 
made to the product information in order to optimize the use of the product. 
Requirements on the due date of periodic reports may differ for different regulatory 
authorities.

Field Description

Share this Report 
with Other Users

Click this check box to share this report with other users. Specify the 
privileges to be granted to groups by adding the group name from the 
Users Groups list to either the "Execute" or "Modify and Execute" list. A 
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the CTPR report template. 
Click Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared CTPR 
report template.

Modify & Execute The groups listed here have read, execute and modify access to the 
shared CTPR report template.
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To create Periodic Safety Update Reports (PSURs)
1. Select Reports --> Periodic --> ICH PSUR Reports. A list of PSUR Reports opens 

in the right frame.

2. Click Copy or Modify to create a new reports from an existing report.

OR

Click New Report to create an entirely new report.

3. When the system opens the ICH PSUR Line Listing Reports dialog box, enter an 
appropriate report name in the Report Name field.

4. Use the tabs to configure the PSUR.

11.1.6.1 General Usage Information
You can group cases for the PSUR Report by Product Name and Dosage Regimen 
Frequency as follows:

■ Product Name

■ This option enables you to group the Product Name - Formulation - Concentration 
concatenated with Units separated by a hyphen ( -).

■ If any elements are missing, the system does not print the hyphen ( -).

■ The groups the cases based on the Primary Drug in the report.

■ Dosage Regimen Frequency

– This option enables you to group the frequency of the primary dosage 
regimen for the primary drug in the report.

– The system prints Frequency: followed by the frequency as defined.

■ You can copy an existing template by clicking the Create from Template button.

■ When you click Create from Template, the system displays the Create from 
Template dialog.

■ You can choose the PSUR Group Name (as configured in the Product Name 
configuration) from a type ahead field.
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■ When you enter the PSUR Group Name in the Select PSUR Group Name field 
and the From and To dates in the Create from Template dialog, and click OK the 
system does the following:

– Saves the PSUR Configuration with the new dates.

– Replaces the products in the list of selected products with all products as 
defined for the selected PSUR name.

– Replaces the periodic report name in the newly configured periodic reports 
with a new name in the following format:

XXXX: YYYY to ZZZZ

where:

XXXX is the selected PSUR Name.

YYYY is the From Date entered by the user.

ZZZZ is the To Date entered by the user.

– Replaces the From and To date ranges only for the periodic report.

– Bases the remaining configuration, including the security permissions, on the 
selected PSUR template.

■ When you enter the PSUR Group Name in the Select PSUR Group Name field 
and the From and To dates in the Create from Template dialog and click Print and 
Save, the system does the following:

– Saves the PSUR Configuration with the new dates.

– Replaces the products in the list of selected products with all products as 
defined for the selected PSUR name.

– Replaces the periodic report name in the newly configured periodic reports 
with a new name in the following format:

XXXX: YYYY to ZZZZ

where:

XXXX is the selected PSUR Name.

YYYY is the From Date entered by the user.

ZZZZ is the To Date entered by the user.

– Replaces the From and To date ranges only for the Periodic Report.

– Calls the Report Batch Printing dialog.

– Bases the remaining configuration, including the security permissions, on the 
selected PSUR template.

11.1.6.2 Common Tab Fields
The Report Name, Report Category and Report Sub-Category fields are common to 
all tabs of the Reports.

The following table below describes these fields:

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the 
Reports menu.
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11.1.6.2.1 Subject of Report Tab  The Subject of Report tab is used to configure the 
report header and to specify the agency, products, etc. for which the PSUR will be 
applicable.

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.

Field Description

Primary Agency Select the Primary Agency.

Reporting 
Destination

Displays the list of agencies from where the report is being sent. Select 
an agency from the list displayed in Reporting Destination and click 
Add to add the report to the Selected Destination list.

You can select multiple agencies from the list of agencies such that the 
report can be submitted to multiple agencies at the same time.

Likewise, select a report from the Selected Destination list and click 
Remove to prevent it from being sent to the selected destination.

Field Description
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11.1.6.2.2 Product Selection Tab  Refer to the table below for a description of fields in the 
Product Selection tab.

Selected Destination Displays the list of agencies where the report is being sent. Select an 
agency from the list displayed in Reporting Destination and click Add 
to add the report to the Selected Destination list.

You can select multiple agencies from the list of agencies such that the 
report can be submitted to multiple agencies at the same time.

Likewise, select a report from the Selected Destination list and click 
Remove to prevent it from being sent to the selected destination.

Report # Enter a report number for this report.

Report Title Enter a report title for this report.

Ingredient Automatically displays the "Ingredient" as provided in the Subject of 
Report dialog.

Note: You can choose whether to view these field or not. Click the 
checkbox displayed with this field to hide or view it.

Trade Name Automatically displays the "Trade Name(s)" as provided in the Subject 
of Report dialog. Multiple trade names are also displayed together, 
separated by commas.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

International Birth 
Date

Automatically displays the earliest license awarded date, when a user 
selects an Ingredient and a Product.

Note: You can choose whether to view this field or not. Click the 
checkbox displayed with this field to hide or view it.

Report Footer Enter the footer for the report.

Print all 
configuration criteria 
on separate cover 
page

Mark this box to print out the configuration of this report when the 
report is printed. This is only available when PDF option is selected 
during printing.

Print page numbers 
on reports

When checked, this option enables the user to print page numbers on a 
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

■ The "Include Periodic Page Numbering on CIOMS reports" option 
on the PSUR Summary Tabulations CIOMS Reports section is 
grayed out and inactive.

■ The "Use Periodic Numbering on the reports" option in PSUR 
Summary Tabulations FDA PSUR section is grayed out and 
inactive.

■ The "Additional Separate Page Numbering for UD Summaries" in 
the PSUR UD Summaries tab is grayed out and inactive.

■ The system removes all existing report page numbering and the 
option to check page number check boxes on the report 
configuration tabs are grayed out and inactive.

Allow access to 
report cases through 
Hit List

When the report is run as final, it creates a Hit List, which can be 
retrieved from other areas of the application where advanced 
conditions can be selected. Click this checkbox to report cases through 
the Hit List.

Field Description
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Field Description

Available Ingredients Displays the list containing the Ingredients used for the product 
configuration. Select an ingredient from the list displayed in Available 
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered 
ingredient within the Available list of Ingredients.

Selected Ingredients Displays the list of ingredients selected from the Available Ingredients 
list.

Indication This list contains the Indication configured for the product containing 
the ingredients in the Available Ingredients section. The selections 
made from this list get displayed in the Available Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Formulation This list contains the Formulation configured for the product containing 
the ingredients in the Available Ingredients section. The selections 
made from this list get displayed in the Selected Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Available Products This list is automatically populated with the selections made in the 
Indication section.

Selected Products This list contains products selected by the user from the Available 
Products list. When a product is selected, the Trade Name field and 
International Birth Date fields are auto-populated with the license trade 
name ("formulation", "concentration") and earliest License Award Date 
for the product.
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11.1.6.2.3 Inclusion Criteria Tab  The Inclusion Criteria tab allows you to select search 
parameters for inclusion of cases in a periodic report. The top section of the dialog 
allows you to specify the type of cases that are to be included in the periodic report.

Click Add to add a criterion. Select appropriate items from the list of items that 
appear.

Field Description

Case Creation Date Allows you to specify a range of cases by the date when the case was 
created.

Case Receipt Date Allows you to specify a range of cases by the initial receipt date.

Case 
Locked/Archived 
Date

Allows you to specify the date when the case was locked/archived.

Use Current Version Allows you to use the latest revision to populate the data within the 
selected reports.

Use DLP Version Allows you to use the case data of the version as of the specified DLP 
Version.

Age Groups Allows you to include or exclude cases based on the patient's age 
group. Select Age Groups and then select all the age group categories 
that apply.

Use Assessments in 
Cases

When selected, the PSUR Report will use the Case Event Assessment 
when performing datasheet listedness calculations.

Re-assess cases 
against datasheet in 
effect at the 
beginning

When selected, the PSUR will re-assess the cases in the line listing 
based on the Active Datasheet on or before the Start Date of the 
Reporting period.

Re-assess cases 
against datasheet in 
effect at end

When selected, the PSUR will re-assess the case in the line listing based 
on the Active Datasheets on or closest to the end date of the PSUR 
Reporting end date range without exceeding that date.
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11.1.6.2.4 Inclusion Criteria  The following table describes the fields present in the 
Inclusion Criteria tab.

11.1.6.2.5 Line Listing Tab  The Line Listing tab contains the following fields and 
sections:

Expeditable Only This checkbox is available only when an agency is selected in the 
Subject of Report tab. If you select this check box, only the cases 
classified as submitted expedited reports to the specified agency are 
used.

Exclude Follow-up 
Cases

Filters out follow-up Reports from the PSUR Line Listing Report.

Include Unlocked 
Cases

Allows you to include unlocked cases in the periodic report.

Advanced Condition Allows you to specify an advanced condition that must be satisfied by 
each case that is included in the report. Ensure that the advanced 
condition or the advanced condition query set that is specified here 
does not contradict any other criteria specified in the dialog.

Use Datasheet 
Assessment for UDF 
Tabulations

Allows you to select datasheet for a report to make UDF tabulations.

If no datasheet is selected, the most conservative listedness is chosen, 
i.e. Unlisted followed by Listed.

Add Cases not 
included in previous 
reporting period

Allows you to add cases which were not included in the previous 
reporting period.

You can enter the start date of the period in the Start Date field.

Field Description

Dropdown list Select the appropriate report type from the drop-down list.

Datasheet This list allows you to specify which datasheet is to be checked to 
determine the listedness (listed or unlisted) of the case.

Serious / 
Non-Serious

If you select Serious and clear Non-serious, only cases having a 
"serious" event are included and vice-versa. If you select both Serious 
and Non-Serious the seriousness criteria is ignored.

Fatal / Non-Fatal Select Fatal when at least one event has an event outcome of 'Fatal". If 
not, select Non-Fatal. If you select both Fatal and Non-Fatal, both types 
of cases are included.

Listed / Unlisted Select Listed to view only Listedness values. If you select both Listed 
and Unlisted, all Listedness values (including Unknown) are included.

Related / 
Non-Related

Relatedness refers to the more conservative of reported or company 
causality. Select Related for any reportable causality type, and 
Non-Related for any non-reportable causality type.

HCP / Non-HCP HCP refers to cases that identify a Health Care Professional in the 
Reporter section within the General tab of the Case Form.

Primary Reporter 
Only

This check box displays whether the Primary Reporter has been 
selected to determine the HCP status.

Field Description
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11.1.6.2.6 Available Data Elements  The following illustration shows the optional fields 
under Available Data Elements.

■ Select the check box displayed against each data element to add it to the report.

■ The unavailable fields are printed on the report by default and cannot be changed.

■ Refer to the table below for a list of the data elements that are included in this tab.

■ The mandatory data elements are printed as columns in the report.

Field Description

Include Line Listing

Allows you to select whether you want the Line Listing Data Elements 
printed with the PSUR Report.

Data Element Notes

As Determined Causality Optional.

As Determined Listedness Optional.

As Reported Causality Optional.

Case Abbreviated Narrative Required and multi-language available.

Case Classifications Required. Multiple classifications are displayed in 
separate lines.

Case Central Safety Date Optional.

Case Comment Text Optional.

Case Initial Receipt Date Optional.

Case Listedness Optional.
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Case Narrative Optional.

Case Number Required.

Case Outcome Required.

Case Report Type Required.

Case Seriousness? Optional.

Company Agent Causality Displays event causality from product name. Multiple 
causalities are displayed in separate lines.

Country of Incidence Required.

Death Cause Multi-language available.

Death Cause HLGT Optional.

Death Cause HLT Optional.

Death Cause LLT Optional.

Death Cause SOC Optional.

Dosage Regimen Batch/Lot # Optional.

Dosage Regimen Daily Dose Optional.

Dosage Regimen Duration Optional.

Dosage Regimen Frequency Optional.

Dosage Regimen Route of 
Administration

Optional.

Dosage Regimen Start Date/Time Required. For the selected product the report is based 
on. List for all dose regimens.

Drug Dechallenge? Optional.

Drug Primary Indication Optional. For the selected product the report is based 
on.

Drug Primary Indication HLGT Optional. For the selected product the report is based 
on.

Drug Primary Indication HLT Optional. For the selected product the report is based 
on.

Drug Primary Indication LLT Optional. For the selected product the report is based 
on.

Drug Primary Indication SOC Optional. For the selected product the report is based 
on.

Drug Rechallenge? Optional.

Event Description as Reported Required.

Event Lack of Efficacy Optional.

Event Onset Date/Time Required.

Event Preferred Term Required.

Lab Data - Tabular Optional.

Literature Author Optional.

Literature Journal Optional.

Literature Pages Optional.

Data Element Notes
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11.1.6.2.7 Selected Data Elements  This section lists the selected elements and enables 
you to arrange the order in which these are to be printed.

Literature Title Optional.

Literature Volume Optional.

Literature Year Optional.

Indication Displays indication for product name.

Listedness Displays datasheet, product and listedness event 
preferred term

Literature reference Optional.

Outcome of Event Optional.

Patient Age Required.

Patient Gender Required.

Patient Initials Optional.

Patient Relevant History Multi-language.

Patient Subject # Optional.

Product Name Displays "product name (generic name) product type, 
formulation, concentration unit" "daily dose," "dose 
dose_freq, route"

Product Name Report Inclusion Prints the Products that were part of the CTPR Report 
for the case.

Displays "product name (generic name) product type, 
formulation, concentration unit" "daily dose," "dose 
dose_freq, route"

Report Comment Optional.

Reporter Reference Number Optional. If you select this value the report includes 
the reporter reference number as specified in the cases 
included in the Periodic report of All reporters within 
the case.

If the case does not have values, then label is not 
printed in the Line Listing for the report.

Reporter Type Optional.

Study Blinded Status Optional. The system enables you to exclude blinded 
cases from the inclusion criteria.

Study Center ID Optional.

Study Drug Optional.

Study ID Optional.

Study ID Protocol # Optional.

Data Element Notes
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Click the Up or Down buttons to arrange the listed elements above or below in order 
of priority.

Options

Field Description

MedDRA Hierarchy 
from 
Cases/Dictionary

Select Cases to populate the data from the case data. Select Dictionary 
to populate the data from the MedDRA dictionary.
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11.1.6.2.8 Grouping Tab  Refer to the following table for a description of items in the 
Grouping tab.

Print Only the Term 
(Preferred Term or 
Lower Level Term)

Prints only the event Preferred Term (PT) or event Lower Level Term 
(LLT) as per the selected radio button. Select the PT option to print only 
the preferred term and not the verbatim description.

Print Dose Text in 
place of regimen dose

Prints the dosage and frequency information from Dose Description 
field instead of Regimen Dose.

Indicate if case was 
expedited previously

This checkbox is selected if an agency has been selected in the Subject 
of Report tab. Cases for which an expedited report was previously 
submitted to the selected authority are marked with an asterisk and the 
date of submission appears in the line listing.

Any case that has been previously expedited to a selected agency, is 
listed in the list of Agencies in the Subject of Reports tab.

English Language Provides the option to print the descriptions in English

Local Language Allows a user to specify which Local language for a multi-language 
field is to be printed i.e. the Abbreviated Narrative field.

Print event info 
(Serious, Un-listed, 
Related) as Column

Select this checkbox to print the Seriousness, Listedness and Causality 
under the Event Verbatim column.

Note: Events having listedness of 'Unknown' are considered 'Unlisted'. 
If only diagnoses are assessed for event assessment, the events which 
are associated with a Diagnosis but have been marked with Diagnosis 
as 'No' display '-' for both listedness and causality.

List cases only once, 
under the primary 
event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event

List cases under all 
events, details under 
the primary event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event, while non-primary events are listed 
under their respective event hierarchy with a reference to the primary 
event body system. Therefore, use this option when grouping on Main 
Line Listing is by the Event Body System.

Print Product 
Indication for the 
Product selected in 
the Report

Enables you to print the product indication for the product selected in 
the report.

Field Description
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11.1.6.2.9 Summary Tabulations Tab  The Summary Tabulations tab enables you to 
specify which summary tabulations/listings will appear along with the line listing.The 
system enables you to separate the cumulative summary by seriousness, relatedness, 
and listedness. If you choose this option, the system separates the product event detail 
into the following categories: Serious/Non-Serious, Related/Non-Related, and 
Unlisted/Listed events.

Field Description

Available Groupings Allows a user to group cases together from the given list. Select the 
desired groupings from the list and click Add to move the grouping to 
the Selected Groupings list.

Selected Groupings Lists the added groupings, and reports the groups in the order they 
were selected. Up to 5 grouping options can be selected from the 
Available Groupings list.

Ascending Select this checkbox to sort the selected entities in ascending order

Page Break Select this checkbox to start the cases from a new page, while also 
keeping the sorting together for every selected page break.

Available Sortings Allows a user to sort cases together from the given list. Select the 
desired sortings from the list and click Add to move the sorting to the 
Selected Sortings list.

Selected Sortings Allows a user to further sort cases without a total count for each sorted 
item. Up to 3 sorting options can be selected from the Available 
Sortings list. This list is populated with the Mandatory Line Listing 
entities plus any optional data elements chosen for this configuration.
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It contains the following fields and sections:

Field Description

Include Index of 
Cases in PSUR

Create an index page of case numbers, for all cases included in the 
PSUR.
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11.1.6.3 CIOMS Reports

Include Summary of 
Cases Missing 
Assessments

This option creates a sub-report of cases missing one of the following 
items:

■ Seriousness

■ Case Causality

■ Case Listedness

■ Case Outcome

■ Event Causality

■ Event Listedness

Click this checkbox to create one or both of the following sub reports:

Cases Missing Assessments - This sub-report displays cases that have 
been included in the PSUR line listing, but one or more of the following 
have not been assessed:

■ Case Seriousness

■ Case Causality

■ Case Listedness

■ Case Outcome

■ Event Causality

■ Event Listedness

Cases Not Included in Report - This sub-report displays cases that 
have not been included in the PSUR line listing as a result of missing 
one or more of the following items:

■ Lock Status

■ Safety Date

■ Uncoded Event

■ Causality

Include Line Listing 
Tabulation

Select this check box to view a pre-defined summary tabulation of 
Report type, Seriousness and Listedness of all cases in the PSUR.

Include Initial Cases Select this checkbox to include initial cases in the PSUR tabulation.

Include Follow-up 
Cases

Select this checkbox to include follow-up cases in the PSUR tabulation.

Include Summary of 
Unlocked Cases

Enables you to print the list of Case Numbers that are included in the 
Periodic Reports but are not locked.

Additional Expedited 
Report Forms 
(CIOMS/MedWatch/
VAERS)

Allows you to print CIOMS/MedWatch/AERS forms (as per selection) 
for its respective regulatory agency (as selection), for all cases in the 
report. It also provides an option to have (or not have) a watermark in 
the forms.

Field Description
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11.1.6.3.1 PBRER Section 6.2 - Cumulative Summary Tabulations of SAEs from clinical trials  

11.1.6.3.2 PBRER Section 6.3 - Cumulative and Interval Summary Tabulations from 
Post-Marketing Data Sources  

Field Description

Print CIOMS reports 
for serious/unlisted 
cases

Allows a user to print CIOMS I forms for all Serious/Unlisted (Case 
Level) cases appearing in the PSUR.

Note: CIOMS contain Internal or Other text printed on them when the 
PSUR is printed using the Internal or Other option.

Include Periodic 
Numbering on the 
CIOMS reports

Numbers the requested CIOMS I with a periodic format. (i.e. A-1-1 of 2, 
A-1-2 of 2, A-2-1 of 1, A-3-1 of 1 etc.). The index is modified to also 
contain the Periodic paging of each CIOMS report.

Field Description

Include Section 6.2 Check this checkbox to include Section 6.2. By default, this is 
unchecked.

Cumulative Start Date Enter the cumulative start date in this field. This field users to 
specify the Start Date of the Cumulative date range. If not specified, 
the start date is picked from the date specified in the Inclusion 
Criteria. If specified, the application ensures that the date entered is 
a valid date, and is before the Start Date specified in the Inclusion 
Criteria.

Identify Study Cases 
using Report Type

Allows you to select the study cases that use report type from the 
multi-select list box. The values that are populated here, come from 
the Report Type codelist where the values display the ’This type 
includes cases from clinical trials’ as checked.

Search icon Click this icon to search for any advance conditions.

AC Click this button to select any existing advance conditions. This 
option is visible only when Include Section 6.2 is selected.

Group by Comparator If the Product Type attribute is present in the Study Configuration 
for the Product being evaluated, this option is displayed.  By 
default, this is unchecked. If this checkbox is selected, it displays 
sub columns based on Active Comparator names if Group by 
Comparator is selected. If Group by Comparator is not selected,  
the count is displayed under the name of the respective active 
comparator.
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Field Description

Include Section 6.3 Check this checkbox to include Section 6.3. By default, this is 
unchecked.

Cumulative Start Date Enter the cumulative start date in this field. This field users to 
specify the Start Date of the Cumulative date range. If not specified, 
the start date is picked from the date specified in the Inclusion 
Criteria. If specified, the application ensures that the date entered is 
a valid date, and is before the Start Date specified in the Inclusion 
Criteria.

Identify Spontaneous 
Cases using Report 
Type

Allows you to select the study cases that use report type from the 
multi-select list box. The values that are populated here, come from 
the Report Type codelist where the values display the ’This type 
includes cases from clinical trials’ as NOT checked. Only those 
values are included, where Display is set to Yes, in order to be 
consistent with the Report.

Identify 
Non-interventional 
Studies (UNION of 
rules below)

This is a mandatory field, comprising three new rules to identify 
Non-Interventional Studies: (Case Classification, Report Type, and 
Observe Study Type). These three new rules are displayed as 
checkboxes and have a section label called "Identify 
Non-interventional Studies (UNION of the rules below)". 

This field is mandatory, which means that at least one of the options 
must be selected if Include Section 6.3 is selected. 

Along with the three options, there is a multi-select list box for each 
that is populated with values from the respective codelist (given 
below) for the corresponding option that the user selected:

a. Case Classification is populated with values from "Case 
Classification" codelist.

b. Report Type is populated with values from "Report Type" 
codelist

c. Observe Study Type is populated with values from "Case 
Classification" codelist with ICSR code values that are not-null

All values are included in this list, irrespective of the Display field 
for Case  Classification and Observe Study Type codelists. Those 
values where Display for Report Type codelist is set to Yes, are also 
included.

A "+" sign is displayed as a label, next to these options to indicate 
that it is a UNION of selections. 
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11.1.6.3.3 Cumulative Summary  

11.1.6.3.4 FDA PSUR Support  

Field Description

Include Cumulative 
Summary

Select the check box to create a sub-report count of events, grouped by 
Product and Body System (SOC) and sorted by Preferred Term. The 
sub-report contains a previous date range count of events (comparative 
date range), a current date range count (current PSUR date range) and a 
cumulative count (all dates) of events assessed against the product(s) of 
the PSUR and matching the inclusion criteria.

Comparative Date 
Range

Allows a user to specify the previous date range as a comparison date 
for the events counted, and therefore should not overlap with the 
current date range specified on the PSUR inclusion criteria tab.

Serious Select this check box to include only serious events.

Unlisted Select this check box to include only unlisted events selected in the 
Datasheet on the "Inclusion Criteria Tab." If no datasheet is selected, 
then any Unlisted license is included.

Related Select this check box to include only those events that are assessed as 
Related or Causal.

Diagnosis Select this radio button to include only those events that are marked as 
diagnosis "Yes" and are without any symptoms associated with 
diagnosis.

Diagnosis & 
Symptoms

Select this radio button to include diagnosis and symptoms together in 
the sub-report.

Separate Diagnosis & 
Symptoms

Select this radio button to include diagnosis and symptoms separately 
in the sub-report. Selecting this option means that the case numbers are 
separated by Diagnosis and Symptoms respectively.

Field Description

FDA PSUR Support Section

Note: This section can be used if the company has obtained an FDA waiver to submit a PSUR 
instead of an NDA report.

Include Adverse Event Summary Select this option to generate a sub-report of events from 
the line listing. This sub report is grouped by Body System 
and Preferred Term.
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11.1.6.3.5 Single Case Submission Support  

Causality Select the desired causality from the list.

Ignore - Counts events regardless of causality assessment.

Causal - Counts events where the causality is considered 
reportable in the Causality Category configuration in List 
Maintenance.

Not Causal - Counts events where the causality is 
considered non-reportable in the Causality Category 
configuration in List Maintenance.

As Determined - Counts events where 'As Determined' 
causality meets the above selected causality criteria.

As Reported - Counts events where 'As Reported' causality 
meets the above selected causality criteria.

Both - Counts events where both 'As Reported' and 'As 
Determined' causality meet the above causality criteria.

Either - Counts events where either the 'As Reported' or 'As 
Determined' causality meets the causality criteria.

Only Cases with HCP Reporter Select this checkbox to include events for only those cases 
that feature an HCP reporter

Diagnosis Select this radio button to ensure that only events marked 
as diagnosis are counted.

Diagnosis & Symptoms Select this radio button to ensure that all events are counted 
in the sub-report.

Separate Diagnosis & Symptoms Select this radio button to include diagnosis and symptoms 
separately in the sub-report. Selecting this option means 
that the case numbers are separated by Diagnosis and 
Symptoms respectively.

Domestic Consumer Support Select this radio button to enable domestic consumer 
support.

Print Unsubmitted This option allows a user to print MedWatch or VAERS 
forms for U.S. cases

Exclude Reports that are 
Non-Serious and Listed

Allows a user to suppress MedWatch or VAERS forms from 
printing for Non-Serious listed cases where all events are 
non-serious and listed for the datasheet specified.

Use Periodic numbering on the 
Reports

Numbers the requested forms with a periodic format. (i.e. 
Periodic Page 1 - 1, Periodic Page 1 - 2, Periodic Page 2 - 1, 
Periodic Page 2 - 2, etc.) An index with the Case Number is 
also included.

Field Description

Single Case Submission Support Section

Field Description
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11.1.6.3.6 UD Summaries Tab  The UD Summaries tab allows you to specify which 
summary listings will appear along with the line listing.

The following lists and describes the fields on the UD Summaries tab.

Generate Periodic ICSR Submissions for 
any cases in this Periodic Report that does 
not have at least one scheduled single-case 
report during the reporting period to the 
following Reporting Destination(s): 
Modify

Select this checkbox to generate the ICSR Reports 
only for the cases, where a Periodic ICSR Report 
for the message type chosen, does not exist.

Select one or more trading partners from the list 
box.

Important: Any case that does not have an 
expedited or single case periodic submission to a 
trading partner, must have an ICSR report 
scheduled as a part of the Periodic submission.

Click Modify to select a different Reporting 
Destination.

Schedule these single-case Periodic 
Reports to the following Reporting 
Destination

Select a single-destination trading partner for 
Periodic Reports from the drop-down list box.

Using the Message Type Select the required message type from the 
drop-down list box

Field Description

Include these 
summary 
tabulations/listings 
based on the set of 
cases presented in the 
line listing

Allows you to select from pre-configured summary 
tabulations/listings. These tabulations are based only on the data 
included in the line listing. Selecting the Exclude Follow-up Cases 
check box filters out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected on the Inclusion 
criteria tab, this option is ignored and follow-up cases are always 
filtered out.

Field Description
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11.1.6.3.7 Scheduling Tab  The Scheduling tab enables you to specify details of how 
often the periodic report will be scheduled.

Include these 
summary tabulations 
based on all cases

Allows for additional sub-reports based on the 'Case Data Analysis' 
template, to be included as an output for the all cases in the database 
that meet the PSUR inclusion criterion for all dates.

Include these 
summary 
tabulations/listings 
based on the Date 
Range

This option allows for additional sub-reports based on Case Data 
Analysis, Case listing or CIOMS II line listing reports to be included as 
an output for the cases meeting the PSUR inclusion criterion for the 
Date Range specified when adding the sub-report.

The dates are based on either the "Case Creation Date" or the "Initial 
Receipt Date" as entered on the PSUR Inclusion Criteria tab. Click the 
checkbox to the right of the sub-report to ignore considering follow-up 
cases for the sub-report.

Identify SUSAR and 
Special Interest 
Events

Enables you to identify any SUSAR and special interest events.

Additional Separate 
Page Numbering for 
Summaries

Enables you to include additional separate page numbering for 
summaries.

Field Description

Start Date This is the International Birth Date for the PSUR product. This date is 
computed as the earliest Awarded date for any license of any type.

Recalculate Allows a user to recompute the International Birth Date of the PSUR 
Product. This date can be overwritten/manually entered, if needed.

Field Description
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11.1.6.3.8 Scheduling Frequency  

The following table lists and describes the fields in the Scheduling Frequency section.

11.1.6.3.9 Security Tab  The Security tab is used to configure the security level for the 
PSUR.

Report is due xx days 
after selected end 
date (creation or 
receipt date)

Enter the number of days when the report will be due after the end date 
specified for the scheduling period.

Automatically 
generate report xx 
days before/after 
selected end date at 
xx:xx

Allows a user to specify the timing of the automatic report generation, 
by specifying the number of days before/after the selected end date of 
the report.

Group Allows the user to select the group to which the automatically 
generated report is to be assigned

Field Description

Frequency Allows a user to specify the interval required for this scheduling 
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

Field Description
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11.1.6.3.10 Templates Tab  Refer to the Argus Dossier User Guide for a description of 
fields in the Templates tab.

Field Description

Share this Report 
with Other Users

Click this check box to share this report with other users. Specify the 
privileges to be granted to groups by adding the group name from the 
Users Groups list to either the "Execute" or "Modify and Execute" list. A 
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the PSUR report template. 
Click Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared PSUR 
report template.

Modify & Execute The groups listed here have read, execute and modify access to the 
shared PSUR report template.
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11.1.7 About US IND Periodic Reports
The system enables you to define an IND summary report. You can add a new report 
as well as copy, modify and delete existing reports.

Use the following procedure to create and IND Summary Report
1. Select Reports --> IND Reports to open IND Subject of Report view.

2. Click New Report.

OR

Select an existing report from the list and click Copy or Modify.
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3. When you click New Report, the IND Line Listing Reports dialog opens.

4. Enter an appropriate name for the report under Report Name.

5. Use the tabs in this dialog to configure the IND Report.

6. From each tab in the IND Summary Report, you can choose to Print all 
configuration criteria on separate cover pages (PDF Only).

11.1.7.1 Common Fields
The Report Name, Report Category and Report Sub-Category fields are common to 
all tabs of the Reports. The following table describes these fields.

11.1.7.1.1 Subject of Report Tab  The Subject of Report tab is used to configure the 
report header and to specify the agency, products, and other elements. Select multiple 
ingredients for a configured IND Report to view the multiple licenses to be selected for 
the report.

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the 
Reports menu.

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.
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Field Description

Primary Agency Select the Primary Agency.

Available Reporting 
Destinations

Displays the list of configured Regulatory Agencies. Select an 
agency from the list displayed in Reporting Destination and 
click Add to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you 
click them.

Selected Reporting 
Destinations

Displays the list of agencies where the report is being sent. 
Select an agency from the list displayed in Reporting 
Destination and click Add to add the report to the Selected 
Destination list.

Select multiple agencies by holding the CTRL key when you 
click them.

Likewise, select an agency from the Selected Destination list 
and click Remove to prevent it from being sent to the selected 
destination.

Company Name If a regulatory agency is selected in the Subject of Report tab, 
then the company name associated with the regulatory agency 
(this association is created by the Administrator) is 
automatically entered in this field.

Product Name This field is automatically filled as per the Ingredient field.

Note: Click the checkbox corresponding to this field to choose 
whether you want this field to appear on the report.

Approval This field is automatically filled with License numbers, 
separated by commas. This is an editable field.
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11.1.7.1.2 Product Selection Tab  Use the Product Selection tab to select product 
information to include in the report.

Award Date This field is populated with the earliest awarded 
Investigational License for US amongst the licenses selected. 
This field cannot be edited.

Note: Click the checkbox corresponding to this field to choose 
whether you want this field to appear on the report.

Print all configuration criteria 
on separate cover page

Click this checkbox to print out the configuration of this report 
when the report is printed. This is only available when the PDF 
option is selected during printing.

Print page numbers on 
reports

When checked, this option enables the user to print page 
numbers on a periodic report. This is the default for all report 
configurations.

If this checkbox is not checked, the following occur.

■ The "Additional Separate Page Numbering for UD 
Summaries" option on the IND Summaries Tabulation tab 
is grayed out and inactive.

■ The system removes all existing report page numbering

Allow access to report cases 
through Hit List

When the report is run as final, it creates a Hit List, which can 
be retrieved from other areas of the application where 
advanced conditions can be selected. Click this checkbox to 
report cases through the Hit List.

Field Description
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11.1.7.1.3 Inclusion Criteria Tab  The Inclusion Criteria tab allows you to select search 
parameters for inclusion of cases in a periodic report.

Field Description

Available Ingredients Displays the list containing the Ingredients used for the product 
configuration. Select an ingredient from the list displayed in Available 
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered 
ingredient within the Available list of Ingredients.

Selected Ingredients Displays the list of ingredients selected from the Available Ingredients 
list.

Indication This list contains a list of all the indications for the products containing 
the selected ingredient. The selections made from this list are displayed 
in the Available Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Formulation This list contains the Formulations configured for the product 
containing the selected ingredient and indication. The selections made 
from this list get displayed in the Selected Products section.

Note: You can select multiple Formulations from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Available Licenses This list is automatically populated with the licenses from the 
Indication section.

Selected Licenses This list contains licenses selected by the user from the Available 
Licenses list. When a product is selected, the Trade Name and 
International Birth Date fields are auto-populated with the license 
trade name ("formulation", "concentration") and earliest License Award 
Date for the product.
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11.1.7.1.4 Line Listing Tab  The following table describes the fields in the Line Listing 
tab.

Field Description

Case Creation Date Allows you to specify a range of cases by the date when the case was 
created.

Case Receipt Date Allows you to specify a range of cases by the initial receipt date.

Use Current Version Allows you to use the latest revision to populate the data within the 
selected reports.

Use DLP Version Allows you to use the case data of the version as of the specified DLP 
Version.

Age Groups Allows you to include or exclude cases based on the patient's age 
group. Select the Age Groups checkbox to activate the age groups and 
select all the age group categories that apply.

Options - 
Domestic/Foreign 
Cases

This option allows the user to include domestic and foreign cases 
within the periodic report. Select Domestic if Country of Incidence is 
USA and Foreign if Country of Incidence is not USA.

Expeditable Only This checkbox is available only when an agency is selected in the 
Subject of Report tab. If you select this check box, only the cases 
classified as submitted expedited reports to the primary agency are 
used.

Include Unlocked 
Cases

Allows you to include unlocked cases in the periodic report.

Advanced Condition Allows you to specify an advanced condition that must be satisfied by 
each case that is included in the report. Ensure that the advanced 
condition or the advanced condition query set that is specified here 
does not contradict any other criteria specified in the dialog.
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11.1.7.1.5 Summary Tabulations Tab  The Summary Tabulations tab enables you to 
specify which summary tabulations will appear along with the line listing.

Field Description

Report All Events Select this option to report all events.

Report only 
Diagnosis Events

Select this option to report only diagnosis events (only the diagnosis 
events that are either explicitly marked as diagnosis or are non-related 
symptoms).

List cases only once, 
under the primary 
event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event

List cases under all 
events, details under 
the primary event

Select this option to view the details of cases in the Main Line Listing 
only once under the Primary Event, while non-primary events are listed 
under their respective event hierarchy with a reference to the primary 
event body system. Therefore, use this option when grouping on Main 
Line Listing is by the Event Body System.

Create a Sub Report 
for Death Cases

Select this check box to separate death cases from the main IND listing. 
If the check box is checked, all death cases (Identified by any event 
marked as death in Seriousness Criteria or any event having a Event 
Outcome as Death) are filtered out from the IND Line Listing. All death 
case show up in a sub report, called "IND Line Listing (Death Cases)."

Field Description

Include these 
summary 
tabulations/listings 
based on the set of 
cases presented in the 
line listing

Allows you to select from pre-configured summary 
tabulations/listings. These tabulations are based only on the data 
included in the line listing. Select the Exclude Follow-up Cases check 
box to filter out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected on the Inclusion 
criteria tab, this option is ignored and follow-up cases are always 
filtered out.
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11.1.7.1.6 Scheduling Tab  The Scheduling tab allows you to specify details of how 
often the periodic report will be scheduled.

The following table lists and describes the fields on the Scheduling tab.

Include these 
summary tabulations 
based on all cases

Allows for additional sub-reports based on the 'Case Data Analysis' 
template, to be included as an output for the all cases in the database 
that meet the IND Report inclusion criterion for all dates.

Add Displays a list of memorized Case Data Analysis Reports that have 
been marked for availability in a periodic report.

Remove Click this button to remove a selected report.

Additional Separate 
Page Numbering for 
Summaries

Enables you to include additional separate page numbering for 
summaries.

Include Summary of 
Unlocked Cases

Enables you to print the list of Case Numbers that are included in the 
Periodic Reports but are not locked.

Field Description

Start Date This is the International Birth Date for the IND Report product. This 
date is computed as the earliest Awarded date for any license of any 
type.

Recalculate Allows a user to recompute the International Birth Date of the IND 
Report Product. This date can be overwritten/manually entered, if 
needed.

Report is due xx days 
after selected end 
date (creation or 
receipt date)

Enter the number of days when the report will be due after the end date 
specified for the scheduling period.

Field Description
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11.1.7.1.7 Scheduling Frequency  Description of fields in Scheduling Frequency:

11.1.7.1.8 Security Tab  The Security tab is used to configure the security level for the 
IND Reports.

Automatically 
generate report xx 
days before/after 
selected end date at 
xx:xx

Allows a user to specify the timing of the automatic report generation, 
by specifying the number of days before/after the selected end date of 
the report.

Group Allows the user to select the group to which the automatically 
generated report is to be assigned.

Field Description

Frequency Allows a user to specify the interval required for this scheduling 
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

Field Description
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The following table lists and describes the fields on the Security tab.

11.1.8 About NDA Periodic Reports
The NDA Periodic Reports enable you to define an NDA Periodic report. You can add 
a new report as well as copy, modify and delete existing reports.

Use the following procedure to create an NDA Periodic report

To create NDA Summary Reports:
1. Select Reports --> Periodic Reports --> NDA Reports to open the NDA Subject of 

Report view.

2. Click New Report to create an entirely new report,

OR

Select an existing report from the list and click Copy or Modify.

3. When you click New Report, the NDA Line Listing Reports dialog opens.

Field Description

Share this Report 
with Other Users

Click this check box to share this report with other users. Specify the 
privileges to be granted to groups by adding the group name from the 
Users Groups list to either the "Execute" or "Modify and Execute" list. A 
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the IND Report template. Click 
Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared IND 
Report template.

Modify & Execute The groups listed here have read, execute and modify access to the 
shared IND Report template.
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4. Enter an appropriate report name in the Report Name field

5. Use the tabs in this dialog to configure the NDA Report.

6. From each tab in the NDA Report, you can choose to Print all configuration 
criteria on separate cover pages (PDF Only).

11.1.8.1 General Usage Information
When using NDA Reports be aware of the following:

■ You can print an Index of Cases included in the NDA report.

■ If you select this option, the system lists the cases from the following sections once 
at the end of the configuration pages:

– Sequential List of cases

– Serious Listed Initial/Follow up

– Non Serious Listed Initial/Follow up

– Non Serious Unlisted Initial/Follow up

– 15 Day Submission

■ The page numbering for this sub-report continues from the configuration pages.

■ You can separate initial case events from follow-up case events in the Summary 
Tabulation tab of the NDA Report.

– If you select this option, the system counts events in the Initial section if the 
case is in the Serious Listed, Non-Serious Listed, or Non-Serious 
Listed/Unlisted sections.

– If you select this option, the system counts events in the Follow-up section if 
the case is in the Serious Listed or Non-Serious Listed/Unlisted follow-up 
sections of the NDA report.

– For the 15 Day events, if the case has not been previously reported in a NDA, 
the system counts it in the Initial section then the Follow-up section.

– If you select List cases once under the Primary Event System Organ Class 
(SOC), the system displays a footnote with an asterisk ( * ) printed across all 
the System Organ Classes on the report and the following statement: Primary 
Event System Organ Class.

■ If you select the Print FDA-3500A/VAERS form at the end option, the system 
prints the report sections in the following order:

■ Configuration (Including Case Indices (e.g. Sequential Case Listing, Listing by 
Seriousness/Listedness, Listing of Cases Missing Analysis)

– Line Listing

– Summary Tabulations

– MedWatch/VAERS reports at the end of the report

■ Page numbering for the MedWatches reports continue from the last page of the 
NDA report.

■ The configuration pages have been updated to reflect the updates made to the 
NDA Reports

■ The configuration pages are printed at the beginning of the NDA report.

■ By default, these are unchecked on all the existing configured reports.
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11.1.8.2 Common Fields
The Report Name, Report Category and Report Sub-Category fields are common to 
all tabs of the Reports. The following table describes these fields:

11.1.8.3 Subject of Report Tab
On the Subject of Report tab you can select multiple Ingredients for a configured 
NDA Report per allowable variations of product and license configuration and 
periodic reporting requirements for the FDA. Select multiple ingredients to view the 
multiple licenses to be selected for the report.

The following table describes the items in the Subject of Report tab.

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the 
Reports menu.

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.
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Field Description

Primary Agency Select the Primary Agency.

Available Reporting 
Destinations

Displays the list of configured Regulatory Agencies. Select an agency 
from the list displayed in Reporting Destination and click Add to add 
the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click 
them.

Selected Reporting 
Destinations

Displays the list of agencies where the report is being sent. Select an 
agency from the list displayed in Reporting Destination and click Add 
to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click 
them.

Likewise, select an agency from the Selected Destination list and click 
Remove to prevent it from being sent to the selected destination.

Company Name If a regulatory agency is selected, the company name associated with 
the regulatory agency (this association is created by the Administrator) 
is automatically entered in this field.

Ingredient This field is populated with ingredient selected in the Subject of 
Report tab.

Note: Click the checkbox corresponding to this field to choose whether 
you want this field to appear on the report.

Approval This field is automatically filled with License numbers, separated by 
commas. This is an editable field.

Trade Name Automatically displays the Trade Name.

Multiple trade names are also populated from license trade name 
(formulation, concentration) of selected licenses, separated by commas.

Note: Click the checkbox corresponding to this field to choose whether 
you want this field to appear on the report.

Award Date Automatically displays the earliest license awarded date, when a user 
selects an Ingredient and a Product.

Note: Click the checkbox corresponding to this field to choose whether 
you want this field to appear on the report.

Print all 
configuration criteria 
on separate cover 
page

Click this checkbox to print out the configuration of this report when 
the report is printed. This is only available when the PDF option is 
selected during printing.

Print page numbers 
on reports

When checked, this option enables the user to print page numbers on a 
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

■ The "Use Periodic Numbering on the reports" option in the NDA 
Line Listing tab is grayed out and inactive

■ The "Additional Separate Page Numbering for UD Summaries" in 
the NDA Summary Tabulations tab is grayed out and inactive.

■ The system removes all existing report page numbering and the 
option to check page number check boxes on the report 
configuration tabs are grayed out and inactive.

Allow access to 
report cases through 
Hit List

When the report is run as final, it creates a Hit List, which can be 
retrieved from other areas of the application where advanced 
conditions can be selected. Click this checkbox to report cases through 
the Hit List.
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11.1.8.4 Product Selection Tab
The Product Selection tab enables you to select product information to include on the 
report.

The following table lists and describes the fields on the tab.

Field Description

Available Ingredients Displays the list containing the Ingredients used for the product 
configuration. Select an ingredient from the list displayed in Available 
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered 
ingredient within the Available list of Ingredients.

Selected Ingredients Displays the list of ingredients selected from the Available Ingredients 
list.

Indication This list contains a list of all the indications for the products containing 
the selected ingredient. The selections made from this list are displayed 
in the Available Products section.

Note: You can select multiple Indications from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Formulation This list contains the Formulations configured for the product 
containing the selected ingredient and indication. The selections made 
from this list get displayed in the Selected Products section.

Note: You can select multiple Formulations from the list at a time by 
pressing the CTRL key and clicking the different Indication entities.

Available Licenses This list is automatically populated with the licenses from the 
Indication section.
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11.1.8.5 Inclusion Criteria Tab
The following table describes the items in the Inclusion Criteria tab.

Selected Licenses This list contains licenses selected by the user from the Available 
Licenses list. When a product is selected, the Trade Name and Award 
Date fields are auto-populated with the license trade name 
("formulation", "concentration") and earliest License Award Date for the 
product.

Field Description

Case Creation Date Allows you to specify a range of cases by the date when the case was 
created.

Case Receipt Date Allows you to specify a range of cases by the initial receipt date.

Use Current Version Allows you to use the latest revision to populate the data within the 
selected reports.

Use DLP Version Allows you to use the case data of the version as of the specified DLP 
Version.

Age Groups Allows you to include or exclude cases based on the patient's age 
group. Select the Age Groups checkbox to activate the age groups and 
select all the age group categories that apply.

Option (Applicable to 
Non-15-Day Selection 
Only)- 
Domestic/Foreign 
Cases

This option allows the user to include domestic and foreign cases 
within the periodic report. Select Domestic if Country of Incidence is 
USA and Foreign if Country of Incidence is not USA.

Field Description
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11.1.8.6 Line Listing Tab
The NDA report comprises of three tabs. The options for these tabs can be configured 
in the Line Listing tab.

The following tables lists and describes the fields on the tab.

Option (Applicable to 
Non-15-Day Selection 
Only)-

Exclude Literature 
Cases/Study Cases

This option allows the user to exclude Literature and Study Cases from 
being considered for the NDA Report. Select Exclude Literature Cases 
to exclude literature cases and select Exclude Study Cases to exclude 
study cases.

Advanced Condition Allows you to specify an advanced condition that must be satisfied by 
each case that is included in the report. Ensure that the advanced 
condition or the advanced condition query set that is specified here 
does not contradict any other criteria specified in the dialog.

Add Cases not 
Included in a 
previous reporting 
period Start Date

Enter the start date. This adds cases not included in a previous 
reporting period with the specified start date.

Include Unlocked 
Cases

Allows you to include unlocked cases in the periodic report.

Evaluate Primary 
Suspect Drug Only

Allows you to select only the Primary Suspect Drug.

Field Description

Tab 1: FDA - 
3500/VAERS Forms

Select this checkbox to generate the MedWatch 3500A (Drug) or VAERS 
reports which are serious listed or non-serious

Field Description
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Suppress printing of 
non-serious listed 
reports

Select this checkbox to prevent printing the non-serious listed reports 
but print their case numbers in the main NDA report indices

Note: Tab 1 of the NDA Line Listing report cannot be generated 
without Tab 2. However, Tab 2 can be generated without Tab 1

Tab 2: Index of 
Submitted Forms in 
Tab 1

Select this checkbox to generate an index of the forms from Tab 1 It 
prints all MedWatch/VAERS forms for the following cases:

■ Serious Listed

■ Non-Serious Unlisted

■ Non-Serious Listed

Note: Previously expedited 15-day reports that are Serious and 
Unlisted that have already been submitted to the FDA do not need to 
be re-submitted with this periodic report

Tab 3 Part 1: NDA 
Line Listing of 15 
Day Reports 
Submitted

Select this checkbox to generate a list of all serious unlisted expedited 
reports within the specified time period.

Note: The dates in these reports are in GMT.

TAB 3 Part 2: 
Tabulation by System 
Organ Class (SOC) of 
All Event Reports 
Submitted

Select this checkbox to generate a tabulation by System Organ Class 
(SOC) of all events reported during the specified time period. This 
includes the cases for which expedited reports were previously 
generated, as well as the cases that are submitted as part of the current 
report

TAB 3 Part 3: Cases 
sent to FDA under 
another NDA

Select this checkbox to print a list of all the serious unlisted events for 
which reports were submitted to the FDA previously

Note: If you select to print out the Tab 3 Part 3 section, the NDA report 
looks for other submissions (E2B, MW, MW Drug, VAERS, eVAERS, 
eMDR) to the same agency for the same case against other (not 
included in selection criteria for this report) marketed licenses. Any 
submission matching this criterion is listed on the Tab 3 Part 3 section 
of the NDA report. If there are multiple submissions against different 
licenses, then each one is listed. Each license is listed only once

Include Periodic 
Submissions

Select this checkbox to include all cases that have been sent under 
another NDA

Start Page Number Select the page number for the first page of the report

Listing Options These options for "List cases only once, under the primary event body 
system" and "List cases under all events body systems" only apply to 
the NDA Line Listing of Expedited Reports Submitted report

List cases only once, 
under the primary 
event System Organ 
Class

Select this option to list cases only once

List cases under all 
events System Organ 
Classes

Select this option to list cases under each SOC for each event

Include Summary of 
Cases Missing 
Assessments

Select this checkbox to include a Summary of Cases missing 
Assessments at the end of the report

Include Summary of 
Unlocked Cases

Select this option to include a summary of unlocked cases

Field Description
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11.1.8.7 Summary Tabulations Tab
The Summary Tabulations tab allows you to specify which summary tabulations will 
appear along with the line listing.

The following table lists and describes the fields on the tab.

Include Listing of 
Nullified 15-day 
Alert Cases 
Submitted During 
the Reporting Period

Any case that was deleted which has submitted report within the 
reporting period after an expedited submission was made to the FDA 
(primary agency) for the license specified in the NDA Periodic report, 
regardless of the report form used, e.g., it could be MedWatch or 
Expedited E2B (E2Bs with MESSAGETYPE tag value configured as 
“Expedited” in Message Type Code List) or eVAERS.

Use Periodic 
numbering on the 
Reports

Select this option to use periodic numbering on reports

Custom Case 
Summary Tabulation

Enter the Summary Report Title

Advanced Condition Select the Advanced Condition from the drop-down list

Field Description

Include these 
summary 
tabulations/listings 
based on the set of 
cases presented in the 
line listing

Allows you to select from pre-configured summary 
tabulations/listings. These tabulations are based only on the data 
included in the line listing. Select the Exclude Follow-up Cases check 
box to filter out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected on the 
Inclusion criteria tab, this option is ignored and follow-up cases are 
always filtered out.

Field Description
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11.1.8.8 Scheduling Tab
The Scheduling tab allows you to specify details of how often the periodic report will 
be scheduled.

The following table lists and describes the fields on the tab.

Include these 
summary tabulations 
based on all cases

Allows for additional sub-reports based on the 'Case Data Analysis' 
template, to be included as an output for the all cases in the database 
that meet the NDA Report inclusion criterion for all dates.

Add Displays a list of memorized Case Data Analysis Reports that have 
been marked for availability in a periodic report.

Remove Click this button to remove a selected report.

Additional Separate 
Page Numbering for 
Summaries

Enables you to include additional separate page numbering for 
summaries.

Case Count 
Summary Report

Enables you to print the list of Case Numbers that are included in the 
Periodic Reports but are not locked.

Field Description

Start Date This is the International Birth Date for the NDA Report product. This 
date is computed as the earliest Awarded date for any license of any 
type.

Recalculate Allows a user to recompute the International Birth Date of the NDA 
Report Product. This date can be overwritten/manually entered, if 
needed.

Field Description
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11.1.8.8.1 Scheduling Frequency  The following is an illustration of the Scheduling 
Frequency section.

The following table lists and describes the Scheduling Frequency fields.

11.1.8.9 Security Tab
The Security tab is used to configure the security level for the NDA Reports.

Report is due xx days 
after selected end 
date (creation or 
receipt date)

Enter the number of days when the report will be due after the end date 
specified for the scheduling period.

Automatically 
generate report xx 
days before/after 
selected end date at 
xx:xx

Allows a user to specify the timing of the automatic report generation, 
by specifying the number of days before/after the selected end date of 
the report.

Group Allows the user to select the group to which the automatically 
generated report is to be assigned.

Field Description

Frequency Allows a user to specify the interval required for this scheduling 
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

Field Description
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11.1.9 Bulk Reporting
Bulk Reporting enables you to print, transmit and/or submit reports in bulk.

1. Select Reports --> Bulk Reporting to view the Bulk Report screen.

2. The system displays the screen.

11.1.9.1 Bulk Reporting Filter Section
The Bulk Reporting Filter sections enables you to filter reports.

The following table lists and describes the fields in this section

Field Description

Share this Report 
with Other Users

Click this checkbox to share this report with other users. Specify the 
privileges to be granted to groups by adding the group name from the 
Users Groups list to either the 'Execute' or 'Modify and Execute' list. A 
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the NDA Report template. 
Click Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared NDA 
Report template.

Modify & Execute The groups listed here have read, execute and modify access to the 
shared NDA Report template.
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11.1.9.2 Total Number of Rows Section
The system displays the search results in the Total Number of Rows section.

***********************************************************************************************

The following table lists and describes the fields and columns in this section.

Field Description

Destination Select an Agency to filter reports by that particular agency. Only the 
agencies that have reports in the Scheduled, Approved and Generated 
states are displayed. Click Filter to select multiple agencies from the 
Reporting Destinations dialog. The previous filtering criteria is saved 
and retained when the user invokes this dialog. By default, all agencies 
are assumed.

Report Form Select any of the listed report forms to view reports belonging to the 
selected report form only.

Report Status Choose either Scheduled/Generated, Pending, Failed, or 
Printed/Transmitted from the drop-down list.

Print Regulatory 
Report

Prints the report as Draft or Final. The Draft option is disabled when 
the printing option is set to Transmit. Select Medical Summary to view 
the list of only medical summaries of distinct cases in a PDF.

Approved Reports 
Only

Filters reports for only approved reports.

View All Displays the bulk reports applicable to your filter selections.

Product Family Enter a Product family to view all cases where the scheduled reports 
belong to the searched Product family.

Study ID Filters reports on the basis of the Study ID.

Product Group Filters reports on the basis of the Product Group. If a value is selected 
in the Product Group filter, the Product Family dropdown values 
automatically narrow down to the product families which belong to the 
selected Product Group filter.

Specific Case # Searches a specific case. To do so, enter the Case Number of the case 
you wish to search and click the Retrieve button. This stores the agency 
selections last made.

Field Description

Selected Allows the user to select the report.

Lock State Displays the Case status of the case to depict if the case is locked or 
un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the status to view the report details.
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Case Number Displays the Case number.

Click the Case Number link to open the case.

Country of Incidence Displays the view Country of Incidence.

Report Type Displays the Case Report Type

Suspect Product Displays the Trade Name for which the report has been scheduled. If 
more than one Suspect Company Product exists for the case, an "(+)" is 
placed at the end of the product name.

For Reports which were scheduled for the Device, the Device name is 
displayed.

Diagnosis Displays the Primary Event Diagnoses PT

(Event Verbatim) Displays the (Verbatim as reported) of the Primary Event.

S/U/R ■ Displays the Case Level Assessments:

■ Serious (Y/N)

■ Unlisted (Y/N)

■ Causality (Y/N)

■ Unknown is treated as a "?"

■ The SUR link displays the Case Summary associated with the 
selected case.

F or LT Fatal / Life Threatening

■ If any of the events in the case are Fatal or Life Threatening F or LT 
is displayed.

■ If the case is both F and LT, only F is displayed.

■ If the case is neither F nor LT, only No is displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form 1. Displays the Description of the report

2. Click the Report form link to view the DRAFT Report as a PDF.

Destination Displays the report destination (agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Initial or Follow-up

If Follow-up, the follow-up number is printed

Due Date Displays the due date.

Days Past Due Displays the number of days the report is past due date.

Downgrade Allows the user to view if the report is downgrade.

Displays Yes if the report is a downgrade report else.

View All Allows administrator and workflow manager to see all items in the 
system.

Tip: The icon (displayed in the lock state) in the Reports-> Bulk 
Reporting screen denotes a SUSAR (Suspected Unexpected Serious 
Adverse Reaction) case.

Field Description
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11.1.9.3 Printing Options
Several printing options are available to you.

The following table lists and describes the available printing options

11.1.9.4 User Options
The following options are available to you.

■ Lock State Header Options

■ Lock State Icon Options

11.1.9.4.1 Lock State Header Options  To sort the cases based on the following case status, 
click the Lock State header row. A pop-up appears listing the following sorting 
options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

11.1.9.4.2 Lock State Icon Options  Click the Lock State icon to view the list of options. 
The following table describes these options:

Field Description

Blind Study Product Select this check box to print study cases with blinded information.

Mark as Submitted Select this check box to mark reports as Submitted when the 
transmission/e-mail has been sent.

A dialog is displayed is this check box is not selected. This dialog 
prompts you to confirm if the report is to marked as submitted or not.

Select Yes or No, as required. This selection is remembered for the next 
time when you print a report.

Print Medical 
Summary

Allows the user to print the Medical Summaries.

Print Allows you to choose the printer for the selected report from the Select 
Site Printer dialog.

Select the Site and Printer Name where you wish to print the report 
and click OK.

Print List Allows the user to print the current view of the Bulk Reporting.

Tip: The icon (displayed in the lock state) in the Reports-> Bulk 
Reporting screen denotes a SUSAR (Suspected Unexpected Serious 
Adverse Reaction) case.

Field Description

View Report Displays the Draft report.

Report Details Displays specific information about the report as entered in the 
Regulatory Reports section.

Case Summary Displays the Case Summary dialog

Remove Report Deletes the report from the case on being asked for a justification
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11.1.10 Initial and Follow-up Cases in Periodic Reports
A case is categorized as follow-up only if it has been previously submitted to the same 
regulatory agency, report form type and configured product/licenses or study. 
Otherwise, it is considered initial.

Mark for 
Non-Submission

Displays the Submission tab in the Report Details dialog.

Select No for Mark for Non-Submission and enter the reason for the 
non-submission.

Remove Multiple 
Reports

Deletes multiple reports from the case on being asked a justification.

Mark Multiple for 
Non-Submission

Deletes multiple reports from the case on being asked a justification. 
The notes and date entered for the selected report are applicable for all 
the reports selected for Non Submission.

Field Description
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12Reports: Bulk Reporting, ICSR Pending, and
Processed ICSR Reports

This chapter contains detailed information about the following reports:

Bulk Reporting

ICSR Pending Reports

Processed ICSR Reports

12.1 Bulk Reporting
Bulk Reporting enables you to print, transmit and/or submit reports in bulk.

Select Reports --> Bulk Reporting to view the Bulk Report screen shown in the 
following illustration.

12.1.1 Bulk Reporting Filter Section
The Bulk Reporting Filter sections enables you to filter reports.

The following table lists and describes the fields in this section

Field Description

Destination Select an Agency to filter reports by that particular agency. Only the 
agencies that have reports in the Scheduled, Approved and Generated 
states are displayed. Click Filter to select multiple agencies from the 
Reporting Destinations dialog. The previous filtering criteria is saved 
and retained when the user invokes this dialog. By default, all agencies 
are assumed.

Report Form Select any of the listed report forms to view reports belonging to the 
selected report form only.
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12.1.2 Total Number of Rows Section
The system displays the search results in the Total Number of Rows section.

The following table lists and describes the fields and columns in this section.

Report Status Choose either Generated Only or Scheduled/Generated, Pending, 
Failed, or Printed/Transmitted from the drop-down list.

If a user has configured the common profile switch "Allows Bulk 
Reporting screen to show Generated Reports Only" to "Bulk Reporting 
will allow filtering on generated reports only", the "Report Status" 
drop-down list displays "Generated Only" instead of 
"Scheduled/Generated".

On selecting "Generated Only", the Bulk Reporting screen displays only 
the reports that have been generated (Generated, Approved, 
Disapproved and New Data Available states).. 

However, if a user has configured the common profile switch "Allows 
Bulk Reporting to show Generated Reports Only" to "Bulk Reporting 
will allow filtering on both scheduled and generated reports", the 
"Report Status" drop-down list displays only the 
"Scheduled/Generated" value and not the "Generated Only" value.

If "Scheduled/Generated" is selected, the Bulk Reporting screen retains 
the existing behavior as it does today when this value is selected.

Print Regulatory 
Report

Prints the report as Draft or Final. The Draft option is disabled when 
the printing option is set to Transmit. Select Medical Summary to view 
the list of only medical summaries of distinct cases in a PDF.

Approved Reports 
Only

Filters reports for only approved reports.

View All Displays the bulk reports applicable to your filter selections.

Product Family Enter a Product family to view all cases where the scheduled reports 
belong to the searched Product family.

Specific Case # Searches a specific case. To do so, enter the Case Number of the case 
you wish to search and click the Retrieve button. This stores the agency 
selections last made.

Field Description

Selected Allows the user to select the report.

Lock State Displays the Case status of the case to depict if the case is locked or 
un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the status to view the report details.

Field Description
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Case Number Displays the Case number.

Click the Case Number link to open the case.

Country of Incidence Displays the view Country of Incidence.

Report Type Displays the Case Report Type

Suspect Product Displays the Trade Name for which the report has been scheduled. If 
more than one Suspect Company Product exists for the case, an "(+)" is 
placed at the end of the product name.

For Reports which were scheduled for the Device, the Device name is 
displayed.

Diagnosis Displays the Primary Event Diagnoses PT

(Event Verbatim) Displays the (Verbatim as reported) of the Primary Event.

S/U/R ■ Displays the Case Level Assessments:

■ Serious (Y/N)

■ Unlisted (Y/N)

■ Causality (Y/N)

■ Unknown is treated as a "?"

■ The SUR link displays the Case Summary associated with the 
selected case.

F or LT Fatal / Life Threatening

If any of the events in the case are Fatal or Life Threatening F or LT is 
displayed.

If the case is both F and LT, only F is displayed.

If the case is neither F nor LT, only No is displayed.

7/15 Displays 7  if the report is due within 7 days 

Displays 15 if the report is due in more than 7 days 

Report Form Displays the Description of the report

Click the Report form link to view the DRAFT Report as a PDF.

Destination Displays the report destination (agency) for which the report is 
scheduled.

Initial / Follow-up 
(#)

Initial or Follow-up

If Follow-up, the follow-up number is printed

Due Date Displays the due date.

Days Past Due Displays the number of days the report is past due date.

Downgrade Allows the user to view if the report is downgrade.

Displays Yes if the report is a downgrade report else.

View All Allows administrator and workflow manager to see all items in the 
system.

Tip: The icon   (displayed in the lock state) in the Reports-> Bulk 
Reporting screen denotes a SUSAR (Suspected Unexpected Serious 
Adverse Reaction) case.

Field Description
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12.1.3 Printing Options
Several printing options are available to you.

The following table lists and describes the available printing options:

12.1.3.1 Suppress Default Printer option in Select Site Printer dialog

While printing reports from the Reports > Bulk Reporting option, if a Site is not 
selected or left blank, the Default Printer is selected by default under the Printer 
Name drop-down list. 

If a particular Site is selected, the Default Printer option is not listed. By default, the 
<Select Printer> option is displayed as the first option. 

To print Bulk Reports for a particular site, the user can select one of the printers listed 
for that site from the Printer Name drop-down list and can perform further actions.

12.1.4 User Options
The following options are available to you.

■ Lock State Header Options

■ Lock State Icon Options

12.1.4.1 Lock State Header Options
To sort the cases based on the following case status, click the Lock State header row. A 
pop-up appears listing the following sorting options:

■ Lock State

■ SUSAR

■ Exp/Per

These options enable you to sort cases based on the case categorization.

Field Description

Blind Study Product Select this check box to print study cases with blinded information.

Mark as Submitted Select this check box to mark reports as Submitted when the 
transmission/e-mail has been sent.

A dialog is displayed is this check box is not selected. This dialog 
prompts you to confirm if the report is to marked as submitted or not.

Select Yes or No, as required. This selection is remembered for the next 
time when you print a report.

Print Medical 
Summary

Allows the user to print the Medical Summaries.

Print Allows you to choose the printer for the selected report from the Select 
Site Printer dialog. 

Select the Site and Printer Name where you wish to print the report 
and click OK.

Print List Allows the user to print the current view of the Bulk Reporting.

Tip: The icon   (displayed in the lock state) in the Reports-> Bulk 
Reporting screen denotes a SUSAR (Suspected Unexpected Serious 
Adverse Reaction) case.
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12.1.4.2 Lock State Icon Options
Click the Lock State icon to view the list of options.

The following table describes these options:

12.2 ICSR Pending Reports
The ICSR Pending Reports page enables you to:

■ View the ICSR reports sent by the agency or the trading partner

■ Process an incoming ICSR report.

You can do the following:

■ Check all the ICSR values of the reports sent and determine whether to accept or 
reject the reports

■ Provide a user password and acceptance notes/rejection reason and accept or 
reject an incoming ICSR report

Select Reports --> ICSR Pending Reports to view Incoming ICSR Reports screen.

12.2.1 Incoming ICSR Reports Fields
The following table describes the fields on the IncomingICSR Reports page.

Field Description

View Report Displays the Draft report.

Report Details Displays specific information about the report as entered in the 
Regulatory Reports section.

Case Summary Displays the Case Summary dialog.

Case Details Displays the Case Details screen. The tree structure of the case displays 
only the ’Reports’ node, with its existing features.

Medical Review Displays the Medical Review screen.

Remove Report Deletes the report from the case on being asked for a justification

Local Labeling Allows Local Labeling for the selected case.

Mark for 
Non-Submission

Displays the Submission tab in the Report Details dialog.

Select No for Mark for Non-Submission and enter the reason for the 
non-submission.

Remove Multiple 
Reports

Deletes multiple reports from the case on being asked a justification.

View Multiple 
Reports

Allows you to view multiple reports.

Field Description

Trading Partner Enter the trading partner. Click Filter to select an agency to filter by that 
particular Trading Partner. This allows you to select multiple agencies 
by clicking Add from the Select Reporting Destinations dialog.
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Product 
Name/Generic Name

Select Product Name or Generic Name, as applicable.

Click the Select button next to this text box.

On clicking the Select button, the system shows a pop-up screen that 
has a text box (2000 characters), a Search button, an OK button, and a 
Cancel button.

This pop up screen is called "Generic Name" or "Product Name" 
depending on the radio button selection in the Incoming ICSR Reports 
for which this popup was being invoked. This pop-up screen is titled 
"Product  Name" when invoked from the Processed ICSR Reports 
screen. The text box in the pop-up is auto-populated with text entered 
in product name or generic  name field on the corresponding invoking 
screen but allowing the user to update or type over it.

Besides this, when the user switches tabs between the Pending and 
Processed Sub Tabs, the system displays the default processing page 
icon to let the users know that system is still processing and switching 
is not completed.

The SQLs being run on the middle tier for the product and generic 
name queries have been optimized for performance. Further Indexes 
have been added on the tables to improve the performance.

Report Type Select the report type, as applicable.

Transmit Date Range Enter the range of the Transmit Date from the From and To fields. You 
can also select the range from the Range drop-down list.

Trading Partner Displays the name of the Trading Partner of the case.

Initial / F/U / Null The report version of the report

■ Initial: If the case received is an Initial Case.

■ Follow -up: If the case received is a Follow-up Case.

■ Nullification: If the case received is a Nullification Case.

World Wide Unique # The worldwide unique number of the received case.

Sender Case # Displays the case number of the sender.

Transmission Sent Displays when the transmission was sent.

MDN Sent Date Displays the date the MDN was sent.

Interchange 
Processed Date

Displays the date the interchange was processed.

Case Receipt Date Displays the date the case was received.

Country of Incidence Displays the country where the incident occurred.

Report Type Displays the report type of the case.

Imported Case # Displays the number of the imported case.

Product Name Displays the product name.

Generic Name Displays the generic name of the product.

Event PT Displays the Primary Event and Verbatim as Reported.

Event LLT Displays the Event LLT for the Event Information.

Is/Will be assigned 
to this site

Displays the site membership of the case.

Pat Initials Displays the initials of the patient.

Study ID/Pat. ID Displays the Study ID/ the ID of the patient in the case.

Field Description
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12.2.1.1 Button and Right-click Options
The following table describes the different buttons and right-click options available on 
Incoming ICSR Reports page.

Reporter Type Displays the primary reporter's Reporter Type.

Reporter Displays the first and last name of the Primary Reporter.

Button Description

ICSR Viewer Select this right-click option to launch the ICSR viewer. For details, refer 
to the ESM User Help.

Note: At the time of generating an ICSR report, some characters entered 
by the user in the case form may not be displayed the same in the ICSR 
report. For example, the ICSR report equivalent of the "&" character 
entered in the case form is &. Similarly, there are other such characters 
that are represented differently in the ICSR report. The table below 
contains the list of such characters and their equivalent representations 
in the ICSR report:

View Error/Warning 
Message

Select this right-click option to view all warning messages including 
M2 validation errors and Multiple ICSR Codes log.

Duplicate Search Select this right-click option to perform Duplicate Search for the case 
being imported with the case present in the system.

Accept ISCR Selects the incoming ICSR report

Execute these steps to accept an ICSR Case:

1. Click the Accept ICSR Case button. The Acceptance of Initial Report 
Confirmation dialog opens.

2. Enter your user password, date, and select a justification from the 
pre-defined list of justifications.

3. Click OK.

Reject ICSR Rejects the incoming ICSR report

Execute these steps to reject an ICSR Case:

1. Click the Reject ICSR Case button. The Rejection of Initial Report 
Confirmation dialog opens.

2. Enter your user password, date, and select a justification from the 
pre-defined list of justifications.

3. Click OK.

Reject ICSRs Enables you to reject multiple ICSRs by selecting the checkbox against 
each ICSR to that needs to be rejected. You can select the type of report 
to be followed up from the Follow Up Report Form screen.

This screen allows you to select a Follow-up Report format for a Report 
Form.

Select the desired option and click OK to print out the CIOMS or the 
MedWatch Report Form as a PDF report whilst importing the cases.

Field Description
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12.2.2 Pending Reports
When using ICSR Pending reports, be aware of the following:

■ The system uses the Oracle Text profile settings for the duplicate search in ICSR 
Pending configured in the Argus Schema Creation Tool.

■ The user can right click on the row and select the following:

Case Summary. This displays the Case Summary (current functionality)

Medical Summary. This displays the Medical Summary report, if the user has 
permission to access the Medical Review dialog.

Case Form Print. This launches the Case Form Print dialog to enable the user to print 
the case form in a new IE window.

12.2.3 Bulk Incoming ICSR Reports
The Bulk Incoming Reports dialog allows the user to import multiple ICSR reports 
that have been sent by the agency or trading partner.

Be aware of the following:

■ The reports that are imported can be a combination of Initial, Follow-up and 
Nullification reports.

■ The only pre-requisite for this dialogue is that Case numbering should be set to 
auto-numbering and not manually.

■ Bulk Incoming Reports does not prevent the duplicate cases to be loaded into the 
system.

To view Bulk Incoming Reports
1. Select multiple reports from the Incoming ICSR Reports screen and click Accept 

ICSRs.

2. The system opens the Bulk Incoming Reports screen.

The following table lists and describes the fields in the Bulk Incoming Reports dialog 
box.

Accept ICSRs Enables you to accept multiple ICSRs by selecting the checkbox against 
each ICSR to that needs to be accepted.

You can select the type of report to be followed up from the Follow Up 
Report Form screen.

This screen allows you to select a Follow-up Report format for a Report 
Form.

Select the desired option and click OK to print out the CIOMS or the 
MedWatch Report Form as a PDF report whilst importing the cases.

Field Description

Agency Name This drop down list contains unique trading partner from the ICSR 
reports have been received. You can select a particular agency/trading 
partner to filter the ICSR reports.

Button Description
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12.2.4 Duplicate Search
The Duplicate Search dialog for an ICSR report enables you to search for possible 
duplicate cases in the Argus Safety system. You can select different combinations of 
search criteria. When more than one criterion is selected, only cases that satisfy all 
criteria are listed. By default, only the fields that are present in the ICSR Report are 
checked for the Duplicate Search.

12.2.4.1 Duplicate Search Dialog Box Fields and Field Descriptions
The following table describes the fields present in the Duplicate Search dialog.

Product Name This drop down list contains unique suspect Product Names extracted 
from the received ICSR reports. Select a particular suspect product to 
filter the ICSR reports. If an Agency Name is selected, the Product 
Name list contains all suspect products belonging to that agency name.

Follow Up Output 
Format

This drop down list contains CIOMS-I, MedWatch and Case Form. You 
can print all ICSR reports in CIOMS-I, MedWatch or Case Form format 
only if the Follow Up checkbox has been selected.

Source Count Displays the total number of ICSR reports with breakdown in 'Initial' 
'Follow Up' and 'Nullification' category.

Report Type Displays the report type.

Selected Count Displays the number of ICSR selected by the user to load the ICSR 
reports in Argus Safety. Selected count can be changed by checking the 
'Initial' or 'Follow Up' or 'Nullification' checkbox.

Import Imports all the reports.

Note: For the Import process, if the system receives an ICSR report with 
the Medically Confirm field set to 1, the Primary reporter is marked as 
HCP.

Cancel Removes the Import ICSR reports window.
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Field Description

Agency The name of the primary agency.

Original Case 
Number

The original case number.

Message Number The message number of the case.

Product Name The product name that caused the adverse event.

Generic Name The generally known, popular name of the product.

Report Type The type of report.

Study ID The Study ID.

Receipt Date The date the report was received by Argus and saved in the system.

Center ID The ID of the center.

Sal. The salutation such as Mr. or Mrs.

Suffix The suffix, if applicable, that follows the name.

First Name The first name of the patient.

Last Name The last name of the patient.

Country of Incidence The country where the incident occurred.

Institution The institution where the incident occurred.

Institution ID The ID of the institution where the incident occurred.

State The state where the incident occurred.

Postal Code The postal code of the area where the incident occurred.

Patient Name The name of the patient.

Event Desc. A description of the adverse event.

Initials The initials of the patient.

Onset Date The date from when the first reaction or adverse event occurred.

Pat. ID The ID of the patient.

Age/Units The age of the patient.

Pat. DOB The date of birth of the patient.

Gender The gender of the patient.

Reference # National Regulatory Authority's Report Number, used as a Reference 
Number.

Journal The journal name related to the adverse event.

Nullification Reason The reason why the case was nullified.

Select All / Deselect 
All

Allows you to select (check) / deselect (uncheck) [respectively] all the 
checkboxes associated with the searched fields.

Accept Initial E2B as 
Follow-Up

Enables you to accept initial E2B as a follow-up

Search Finds results matching the specified search criteria.

ICSR Viewer Enables you to view the E2B report.

Accept E2B Case Enables you to accept an E2B case.

Reject E2B Case Enables you to reject an E2B case.
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12.2.4.2 Duplicate Search for Incoming Review
The Duplicate Search in Argus Central Incoming review enables you to search on 
Reference ID and Keyword field in Argus cases.

You can right-click against the Case Number for a listed case and use the following 
options:

View Warning Enables you to view warnings associated with the case.

View Differences Allows viewing differences between the current XML to be imported (a 
message that is not yet imported into the database), the current case 
data in the database, and if a case has been imported before, the last 
imported case.

Note: This button is available only for follow-up and nullification 
reports.

Case Number Displays the case number of the case matching the search criteria.

Pat. Initials Displays the initials of the patient in the case matching the search 
criteria.

Action Enables you to view the Case Summary dialog.

Project ID Displays the Project ID of the case matching the search criteria.

Study ID Displays the Study ID of the case matching the search criteria.

Date Displays the date of the case matching the search criteria.

Country Displays the country name of the case matching the search criteria.

Product Displays the product name involved with the case matching the search 
criteria.

Event Displays the event involved with the case matching the search criteria.

Report Type Displays the report type of the case matching the search criteria.

Reporter Displays the reporter involved with the case matching the search 
criteria.

Right-click Option Description

Case Form Print This option is displayed for only those users who belong to the group 
with access to Argus Console > Access Management > Groups > Menu 
> File > Print. This option allows you to print the case form report.

Case Summary This option is displayed for only those users who belong to the group 
with access to Argus Console > Access Management > Groups > Menu 
> File > Open Case Summary. This option allows you to open the 
summary report of the case.

Medical Summary This option is displayed for only those users who belong to the group 
with access to Argus Console > Access Management > Groups > Menu 
> File > Print. It displays the medical summary of the case.

Unlock/UnArchive 
Case

This option is displayed to allow users to re-open the archived and 
locked cases. On clicking this option, a Locked Case/Archived Case 
screen (as applicable) is displayed. You need to enter your password 
along with any remarks/notes and select a reason for your action to 
complete the unlocking/unarchiving of the case.

Note: This option is available only when the case is in locked/archived 
status, and if the user has privileges to lock/close the case, as per 
Console User Configuration > Case Form settings.

Field Description
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Be aware of the following:

■ The Reference ID field searches on the following fields in the Argus case:

– Additional Info | Case Reference ID

– Reporters | Reporter's Reference #

– Argus Case Number

■ By default, the system populates the Keyword field with the first value from the 
incoming affiliate event.

12.2.5 View Differences Report
The View Differences Report enables you to view differences between the current 
XML to be imported (a message that is not yet imported into the database), the current 
case data in the database, and if a case has been imported before, the last imported 
case.

Note: View Differences is available for follow-up reports only. This option is enabled 
only when an initial case or case number is selected in the duplicate search output 
section.

Click View Differences from the Duplicate Search screen to view the View Difference 
report. This displays the E2B Difference Report.

The following table describes the fields in the report.

Field Description

Trading Partner Allows you to view the Trading Partner name from whom the E2B 
report is received.

Note: The Lock/Archive icon displayed with this field denotes the 
status of the case.

DTD Version Allows you to view the DTD version of the follow-up E2B report.

Case Number Displays the original case number of the E2B report.

Follow Up # Displays the sequence number of the follow-up for the E2B report.

Total Number of 
Rows

Allows you to select the type of E2B Difference to view from: Current 
E2B vs. Current Case in Database

■ Current E2B vs. Last Imported E2B

■ Current Case in Database vs. Last Imported E2B

Import Select this check box to highlight import differences.

E2B Element Select this check box to highlight E2B differences.

Current E2B Select this check box to highlight differences in the current E2B.

Current Case in 
Database

Select this check box to highlight differences in the current case in the 
database.

Last Imported E2B Select this check box to highlight differences in the last imported E2B.

Accept Follow-up Allows you to update the corresponding fields for the selected E2B 
elements in the Argus case.

Reject Follow-up Does not update the corresponding fields for the selected E2B elements 
in the Argus case.

Print List Provides the difference report in a PDF format.
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12.2.5.1 Displaying Differences
The system displays the differences in the E2B reports as follows:

■ Addition -- New elements are highlighted in grey.

■ Deletion -- Deleted elements are highlighted in red.

■ Modification -- Modified elements are highlighted in yellow.

12.2.5.1.1 Accept Initial E2B Cases As Follow-Up  This option is enabled only when an 
initial case or case number is selected in the duplicate search output section.

1. Click this button to add an ICSR as a follow up to the Case Number, which you 
have highlighted in the duplicate search output section.

2. A pop-up dialog appears: "Do you want to add this ICSR as a Follow-up to the 
Case Number<Num>?"

3. Click OK to proceed.

4. The Argus application attaches the incoming ICSR as a follow-up, to the selected 
case number highlighted in the duplicate search screen.

12.3 Processed E2B Reports
The Processed E2B Reports page contains a list of all the processed E2B Reports.

12.3.1 Search Criteria Section
The system enables you to enter search parameters in the Search Criteria section.

The following table lists and describes the fields in the Search Criteria section.

Field Description

Trading Partner Enter the trading partner. Click Filter to select an agency to filter by that 
particular Trading Partner. This allows you to select multiple agencies 
by clicking Add from the Select Reporting Destinations dialog.
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12.3.2 Total Number of Rows Section
The system places the search results in the Total Number of Rows section.

Product Name Enables the user to select a Product Name as a search criterion.

When a user enters a value in the text box in a pop-up invoked for 
Product Name from Incoming E2b Reports screen and clicks Search, the 
system performs a wild character search on Product Name on all the 
products against all the cases pending for processing in the Incoming 
E2b Reports screen. The pop-up displays the results of the product 
names that matched. If no value is entered in the textbox, it displays all 
the products against all the cases pending for processing in the 
Incoming E2b Reports screen. The result set is limited to 1000.

When a user enters a value in the text box in this pop-up invoked for 
Generic Name from Incoming E2b Reports and clicks Search, the system 
performs a wild character search on all the Generic Names against all 
the cases pending for processing in the Incoming E2b Reports screen. 
The pop-up displays the results of the generic names that matched. 
When no value is entered in the text box, it displays all the available 
generic names for all the cases pending for processing in the Incoming 
E2b Reports screen. The result set is limited to 1000.

When a user enters a value in the text box in this pop-up invoked for 
Product Name from Processed E2B Reports screen and clicks Search, the 
system performs a wild character search on all the Product Names 
against all the cases processed from the Processed E2B Reports screen.

The pop-up displays the results of the Product names that matched. 
When no value is entered in the text box, it displays all the available 
products for all the cases processed from the Processed E2B Reports 
screen. The result set is limited to 1000.

When retrieving the result set, the system displays the default 
processing page icon.

When the user selects a value from the results displayed, the system 
displays the selected value in bold. The system allows only a single 
value selection.

The OK button is displayed until a value is selected from the search 
result. The Cancel button always stays enabled.

When the user selects a value and clicks the OK button, the system 
updates the Product Name or Generic Name correspondingly of the 
screen that invoked this pop-up.

When the user clicks Cancel, the Product Name or Generic Name of the 
screen that invoked this pop-up is not updated.

Import Status Enables the user to select Import Status as a search criterion.

Report Type Select the report type, as applicable.

Date Range Enables the user to select and specify the Date Range as the search 
criteria.

Start Date Enables the user to enter the start date for the search.

End Date Enables the user to enter the end date for the search.

Range Enables the user to select a Range as a search criteria.

Retrieve Enables the user to retrieve any stored search criteria.

Field Description



Processed E2B Reports

Reports: Bulk Reporting, ICSR Pending, and Processed ICSR Reports 12-15

The following table describes the columns in the Total Number of Rows section.

Field Description

Originated Case# Displays the Originated Case Number of the case.

Initial/F-U/Nullification Displays the Initial/F-U/Nullification status.

Trading Partner Displays the name of the trading partner.

World Wide Unique# Displays the World Wide Unique # of the case.

Import Status Displays the import status of the case.

Warnings / Errors Displays warnings/errors associated, if any.

Accepted / Rejected By Displays who accepted or rejected the case.

Notes Displays the notes for the case, if any.

Interchange Date Displays the Case Number with which the case has been 
imported on the specified interchange date.

Date Imported/Rejected Displays the date the case was imported/rejected.

ICK/ACK Sent Displays the status of the ICK/ACK.

■ Yellow is displayed if it is still pending.

■ Orange is displayed if it is accepted by warnings / 
errors.

■ Red is displayed if Rejected by user or system.

■ Green denotes successful import in the system.

EDI Out Displays the EDI Out status.

■ Yellow is displayed if it is still pending to send the 
report out of the EDI / XML or PHY out folders.

■ Green is displayed if it is already sent out of the EDI / 
XML or PHY out folders.

■ Red denotes that the EDI gateway failed to send the 
report out of the EDI / XML or PHY out folders.
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13Dashboards

This chapter describes the dashboards in the Argus Safety application.

13.1 Dashboards Options
Dashboards option is available on the menu bar. Place the cursor over Dashboards in 
the menu bar to view the options available in it.

The following is list of available dashboard options.

■ Open Case Summary Reports

■ Open Action Items Reports

■ Quick Signal Reports

■ Increased Frequency Wizard

■ Expedited Report Status

■ Workflow Status

■ Reports Due Soon

■ Personal Argus Status

■ Case Workload

13.1.1 Open Case Summary Reports
The Open Case Summary Report displays a summary of all open cases sorted in 
ascending order according to the number of days the case has been open.
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To view the Open Case Summary Report
1. Select Dashboards --> Open Case Summary.

2. The system displays the Open Case Summary Report in PDF format.

When using the Open Case Summary Report, be aware of the following:

■ The Date Received column prints the initial receipt date or the latest follow-up 
date for the case.

■ If there are no follow-ups for a case, the system calculates open cases based on the 
initial receipt date.

■ If there are follow-ups for a case, the system calculates the days open based on the 
most recent follow-up in the case. If the latest follow-up date is older than the 
previous follow-up, it considers only the last follow-up.

■ The system also calculates days open based on the latest follow-up date for the 
case.

The following table lists and describes each field in the Open Case Summary Report

Field Description

As of (date) Displays the report as per the current date (in dd-mmm-yyyy format).

Case ID Displays the Case ID of each listed case.

Date Received Displays the date when the case was received.

Product Displays the Product Name.

Event Displays the Event Info/Preferred Term.

Assigned To Displays the Workflow/Case Owner.

Days Open Displays the number of days since the initial receipt date.

Status Displays the Case Status.

Total Cases Displayed at the end of the report, it shows the total number of cases 
listed in this Open Case Summary Report.
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13.1.2 Open Action Items Reports
The Open Action Items Report displays all outstanding action items. This report is 
sorted as per the Case ID of the listed cases.

To view the Open Action Items Report
1. Select Dashboards --> Open Action Items.

2. The system displays the Open Action Items Report in PDF format as shown in the 
following illustration.

The following tables lists and describes the fields in the Open Action Items Report.

13.1.3 Quick Signal Report
The Quick Signal Report displays the changes in numbers of events over the past 
year. This report is a summary listing of events, which have triggered signals.

Field Description

As of (date) Displays the report as per the current date (in dd-mmm-yyyy format)

Case ID Displays the Case ID of each listed case.

Action Item Lists the status of the case and the action that needs to be taken.

Date Assigned Displays the date when the case was opened/assigned.

Assigned To Displays the Workflow/Case Owner.

Date Due Displays the date when the action item was due.

Days Open Displays the number of days that have lapsed since the date when the 
case was opened.
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Click the following link for information about the information in the fields on the 
report.

13.1.3.1 Quick Signal Report Fields
The following table lists and describes the fields in the Quick Signal Report.

To enter information in the Product Browser
1. Select Quick Signal Report from Dashboards.

2. This displays the Product Browser dialog.

To search through the Product Browser dialog
1. Click the entities being displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For 
example, if Product Name is searched, it displays the Product Name as well as the 
Family Name and Trade Name.

2.  Search for Products based on the following criteria:

Field Description

Product Displays the Product Name.

As of Displays the report as per the current date (in dd-mmm-yyyy format).

Term Displays the Event Information in alphabetical order Body system and 
sort them within the body system in descending order.

Last 6 Months 
(Selected Drug)

Displays the number of cases received in the past 6 months for the 
selected drug.

All Cases (Selected 
Drug)

Displays the total number of cases recorded for the selected drug.

Last 6 Months (All 
Products)

Displays the number of cases received in the past 6 months for all the 
drugs.

All Cases (All 
Products)

Displays the total number of cases for all the drugs.
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■ Ingredient - Displays the ingredients of the product

■ Family - Displays the family of the product

■ Product Name - Displays the Formulation (Dosage Form), Concentration 
(Strength) and Indication to aid in the selection of the correct product.

■ Trade Name - Searches the License Trade Name, Country fields.

3. When the system displays the results, select the appropriate Product.

4. Click Select to view the Quick Signal Report that matches the entered criteria.

13.1.4 Memorized Reports
The system enables you to recall a previously memorized case listing or case data 
analysis report for printing. In addition to the reports for a specific user, the system 
displays a list of reports whare are shared by all users.

You can select a memorized report from the dialog box. When you select the report, 
the system enables the Open button to permit you to open the selected memorized 
report. Click Cancel to close the dialog box. Click Delete to delte the selected 
ememorized report.

To memorize a configured report, click the Memorize button on the configuration 
dialog box for the Case Listing or Case Data Analysis report.The system opens the 
Memorized Report .

The system enables you to save the memorized report, make it available for , and 
Share the report with other users.

13.1.5 Increased Frequency Wizard
The Increased Frequency Wizard displays events that have occurred at increased 
frequency for a given product and indication, based on a FDA formula (modified 
t-test).

To generate an Increased Frequency Wizard
1. Select Dashboards --> Increased Frequency.

2. When the system opens the Increased Frequency Wizard, enter the appropriate 
information in the fields and click Generate.

Increased Frequency Criteria Fields and Field Descriptions
The following table lists and describes the fields in the Increased Frequency Criteria 
section.

Field Description

Product Allows the user to select the product on which this report is to be based.

Indication Allows the user to select an indication for this product.

Reporting Date 
Range From Date

Defines the starting date.

Reporting Date 
Range To Date

Defines the ending date.

Comparison Date 
Range From Date

Defines the starting date for the comparison period.



Dashboards Options

Dashboards 13-6

The following table lists and describes the information that appears in the Increased 
Frequency Report.

13.1.5.1 Increased Frequency Wizard
The Increased Frequency Wizard enables you to determine which events have 
occurred at increased frequency for a given product and indication based on an FDA 
formula (modified t-test).Select Utilities --> Increased Frequency Wizard to open the 
Increased Frequency Wizard dialog box shown in the following illustration.

The following table lists and describes the fields on the Increased Frequency Wizard 
dialog box.

13.1.6 Expedited Report Status
The Expedited Reporting Status page enables you to search for and field information 
about the status of expedited reports. Expedited Reporting Status also appears on the 

Comparison Date 
Range To Date

Defines the ending date for the comparison period.

Units Distributed in 
Reporting Interval

Allows the user to adjust the number of units distributed in the 
reporting interval.

Units Distributed in 
Comparison Interval

Allows the user to adjust the number of units distributed in the 
comparison interval.

Units Allows the user to adjust the unit term as appropriate.

Generate button Generates the Increase Frequency Report.

Field Description

Adverse Event Displays the name of the adverse event.

Number of Adverse Events Displays the number of adverse events.

Field/lControl Name Description

Product Enables you to select the product on which this report is to be based.

Indication Enables you to select an indication for the product

Reporting Date 
Range From

Enables you to define the starting date.

Reporting Date 
Range To

Enables you to define the ending date.

Comparison Date 
Range From Date

Enables you to define the starting date for the comparison period.

Comparison Date 
Range To DAte

Enables you to define the ending date for the comparison period.

Units Distributed in 
Reporting Interval

Enables you to adjust the number of units distributed during the 
reporting interval.

Units Distributied in 
Comparison Interval

Enables you to adjust the number of units distributed during the 
comparison interval.

Units Enables you to adjust the unit term as appropriate.

Generate Click Generate to generated the Increase Frequency Report.

Field Description
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Worklist Group menu. Additionally, if you have access to Expedited Report Status, 
you wil also have access to the Report Due Soon dashboard. 

1. Select Dashboards --> Expedited Report Status to open the Expedited Reporting 
Status screen.

2. When the system opens the Expedited Report Status screen, enter the appropriate 
information in the fields in the Search Case section and click Retrieve.

3. he system creates the report based on the search criteria you entered.

13.1.6.1 Expedited Report Status Fields and Field Descriptions
The Expedited Report Status screen contains the sections mentioned below:

■ Search Case

■ Grouped Expedited Reporting Status

■ Expedited Reporting Status

13.1.6.1.1 Search Case Status  This section enables you to enter the search parameters 
for the report

The following table lists and describes the fields

13.1.6.1.2 Grouped Expedited Reporting Status (Pie chart)  Click on the Color Coded Areas 
of the pie to open all the Reports or Cases within that section instead of just the bar.

Field Description

Product Family Allows the user to select which Product Family to be included in the 
dashboard.

Site Allows the user to filter the workflow statuses to the selected site.

Serious Case Displays if the case is serious or not.

If Yes is selected, the seriousness criteria are enabled.

Note: A case that does not have a seriousness specified (i.e. blank) is 
treated as serious.

Related Case Filters on the relatedness of the case. A case is only included if it meets 
the relatedness criterion.

Death/LT Only Select this option to include any case that has any of the Fatal or 
Life-Threatening seriousness criteria.

All Other Serious If this seriousness criterion is checked, the case only gets included if 
any of the following seriousness criteria of any event are checked: 
Hospitalized, Disability, Congenital Anomaly, Medically Significant, 
Intervention Required or Other.

Cases Enables you to search for cases.

Reports Enables you to search for reports.

View All Enables you to view all.

Retrieve Prints the currently selected dashboard, including filter criteria.
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13.1.6.1.3 Expedited Reporting Status (Bars)  Click on a bar to open the Worklist 
displaying the cases that belong to the reports or the actual reports. These reports 
belong to the specified timeframe.

13.1.7 Workflow Status
You can view the Workflow Status based on case owner, site, case seriousness, and 
other criteria. 

To view the Workflow Status
1. Select Dashboards --> Workflow Status to open the Workflow Status Screen.

2. When the system opens the Workflow Status screen, enter the appropriate data in 
the Search Case fields and click Search.

3. The system displays the Workflow Status information.

13.1.7.1 General Usage Information
When using the Workflow Status screen, be aware of the following:

■ Workflow Status appears on the Worklist Group menu.

■ You can:

Click on a bar graph and select from a dashboard menu to open the list of cases in 
the Workflow Status Dashboards.

Click on the graphical bars to drill down on the specific workflow state details.

■ If no updates are made to cases during case processing, the cases the system 
displays the number of cases you clicked during the drill down.

■ If one or more cases change workflow state between loading the dashboard screen 
and loading the worklist-specific screen, a discrepancy in case numbers may occur.

■ The system maintains user preferences once you return to the Workflow Status 
Dashboard.

■ By default, the system displays only the first filtering results and makes other 
filters available when you click More Filtering.

■ Worklist Status. This screen provides filtering capabilities by site, workflow state, 
product family, date range, advanced condition, serious or non-serious, study or 
non-study by clicking the More Filtering option. The More Filtering options also 
hide additional filtering elements.

■ Site Filter. The Site Filter is a multiple selection screen that enables you to use the 
CTRL and Shift keys to select multiple sites. The default value is All Product 
Family. When you use the site filter, the system displays all active (undeleted) 
sites in the Argus Code List. However, the system does not display LAM sites.

■ Workflow State Filter. The Workflow State filter is a multiple selection screen. You 
can select use the CRTL and Shift keys to select multiple groups.

– The system displays all active (undeleted) workflow states, except 
archived/closed, in the Argus Utilities - Configuration.

– The default selected value is <All>Product Family.

– The Product Family filter is a type ahead field.

– The default selection on the type ahead is blank (no filtering on Product 
Family). By default, the system displays a maximum of 25 rows.
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– The system displays all active (undeleted) product families configured in the 
Argus Code List Product & Family in the Product Family Filter results.

■ Date Range Filter. In this module, the Date Range function works in the same 
manner as it does in other parts of the application.

– The default value for range is last month.

– The system automatically populates the values in the From and To fields with 
the dates based on the This Month option.

– The date fields functions as they do in other parts of the application.

– The system evaluates Aware Date to fall in between the date range specified in 
the Date Range filter.

■ Advanced Condition Filter.The Advanced Condition functions as it does in other 
part of the application.

■ Serious or Non-Serious Filter. Five (5) sub-filtering options are available.

– All

This is the default option. When you select this option, the report returns all 
cases whether serious or non-serious.

– Serious

When you select this option, the system returns only those cases that are 
serious. The system evaluates seriousness at the event level. If any event is 
serious, the system considers the case serious and returns it in the results.

– Non-Serious

When you select this option, the report returns only non-serious cases. All the 
events must be non-serious before the system returns the case in the search 
results.

– Death/LT Only

When you select this option, the report returns cases that have an event where 
Death or Life Threatening is checked. The system disables this check box when 
you select the non-serious option.

– Serious other than death or life-threateningFilter. 

When you select this option, the report returns only those cases that have an 
event with a seriousness criteria other than Death or Life Threatening.The 
system disables this check box when you select the Non-Serious option.

■ Report Type Filter. The Report Type filter is a multi-selection screen that enables 
you use the CTRL and Shift keys to select multiple items. The default value is All.

■ Project ID Filter. The Project ID filter is a multi-selection screen that enables you 
to use the CTRL and Shift keys to select multiple items. The default value is All. 
All active Project ID values are configured in the Argus Utilities Protocol ID Code 
List.

■ Default Report Configuration Filter. When no other filters are used, the default 
report configuration returns all cases for the current month. The system uses the 
case Aware Date for evaluation purposes.

■ Search Filter. When you click Search, the system displays the Workflow Status 
screen.
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■ When you click the Bar Graph, the system displays a menu. You can select Late, 
Over Normal, Normal or All to go to the worklist-specific screen. When you 
double-clicks the bar, the system displays the worklist-specific screen.

■ Print. When you click Print, the system uses the standard Argus Print function to 
print the search results. This is the same as CDA print functionality.

13.1.7.2 Workflow Status Fields and Field Descriptions
The Workflow Status screen includes the following sections:

■ Search Case

■ Workflow Status

13.1.7.2.1 Search Case  The Search Case section enables you to enter appropriate search 
criteria to search for workflow information.

The following table lists and describes the fields in the Search Case section.

13.1.7.2.2 More Filtering Section  The More Filtering section provides additional criteria 
for filtering cases. The following is an illustration of the More Filtering section.

The following table lists and describes the fields in the More Filtering section.

Field Description

Site Allows the user to filter the workflow statuses to the selected site.

Date Range From/To Enables you to filter workflow status based on a specific date range

Range Enables you to filter workflow status based on a pre-define date range 
(e.g., last 30 days, etc.)

Case Owner Enables you to filter the workflow status based on the case owner.

Related Case Filters on the relatedness of the case. A case is only included if it meets 
the relatedness criterion.

Search Click Search to search for the workflow status.

More Filtering Click More Filter to display more filtering options on the More 
Filtering section

Print Prints the currently selected dashboard, including filter criteria.

Field Description

Workflow State Enables you to filter the workflow status based on workflow state (e.g., 
data entry, medical review, etc.)

Report Type Enables you to filter the workflow status based on the report type.
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13.1.7.2.3 Workflow Status (Bars)  Bar graph colors indicate the following statuses:

■ Red -- Late Cases

■ Yellow -- Outside of Normal Cases

■ Green -- Normal Cases.

Click on the bar to view a Worklist with cases of the selected state (red, green or 
yellow).

13.1.8 Reports Due Soon
As report scheduling is commonly configured to be executed when significant changes 
are made to a case, it is possible that expedited reports may be delayed if a case never 
gets locked. You cannot know that a report is late if it has never been scheduled. In 
order to address this potential compliance issue Argus Safety assesses case 
reportability prior to formal report scheduling. Workflow and Expedited Status 
monitoring screens identify unlocked cases due soon.

To view a list of unlocked cases with reports due
1. Select Dashboards --> Reports Due Soon from Dashboards.

2. The system opens the Unlocked Cases with Possible Reports Due Soon screen is 
displayed.

The Workflow and Expedited status include another report with cases that have not 
had reports scheduled but that may generate a report with a due date in the near 
future. This graph is displayed below the graph detailing the actual case status.The 
reports included in this sub-dashboard are limited to the filter criteria specified for the 
main dashboard

The following table lists and describes the fields on the Reports Due Soon screen.

Project ID Enables you to filter the workflow status based on the Project ID.

Serious or 
Non-Serious

Enables you to filter workflow status based on the Serious/Non-serious 
criteria as follows:

■ All -- Search for all workflow statuses

■ Serious -- Search for workflow status for serious cases

■ Non-Serious -- Search for workflow status for non-serious cases

■ Death/LT Only -- Search for workflow status for Death or 
life-threatening cases

■ All Other Serious -- Search for the workflow status for all serious 
cases other than death or life-threatening.

Product Family Search for workflow status based on product family.

Advanced Condition Search for workflow status based on a selected advanced condition

AC Enables you to create an Advanced Condition.

Print Prints the currently selected dashboard, including filter criteria.

Field Description

State Name Displays the workflow state of each listed case is.

Field Description
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Click the graphical bar to view a Worklist with cases of the selected state (red or 
yellow).

13.1.9 Personal Argus Status
The Personal Argus Status screen of the Argus Safety application displays a list of 
Cases Assigned, Contact Log Entries and Action Item Entries sections that are specific 
to the logged-in user. 

To view the Personal Argus Status screen
1. Select Dashboards --> Personal Argus Status.

2. The system opens the Personal Argus Status screen

To search for a case
Use the following procedure to search for a specific case.

1. Type the case number in the Case Quick Launch field of the Home page and click 
Open.

2. Click the link displaying a case number to view the case details.

By default, each section and header column is sorted by Case Number in 
ascending order.

3. Select the check box for any of the headers to enable that section.

The sections in which the check box is not selected are displayed at the bottom of 
the screen.

13.1.9.1 Cases Assigned Section
The system displays the Workflow status for displayed cases in the Cases Assigned 
section. You can right-click on the case row and select the Accept option. This moves 
the cases to their Worklist Open list.

The following table describes the fields in the Cases Assigned section:

Graph Red bars indicate that the report is likely to be due within the next 5 
days.

Yellow bars indicate that the report is likely to be due in the next 10 
days.

Total Displays the number of cases within the displayed workflow state.

R/Y Number of cases in Red/Yellow

Field Description

Country (Case 
Number)

Displays the name of the country to which the case belongs, with the 
Case Number listed in brackets.

Report Type Displays the report type of the case.

Product Displays the product name.

Event Displays the event name

Field Description
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13.1.9.2 Contact Log Entries Section
The following table describes the fields in the Contact Log Entries section:

13.1.9.3 Action Items Entries
The following table below describes the fields in the section:

13.1.10 Case Workload
The Case Workload feature enables an administrator to view the case workload for 
individuals and one or more sites. The Case Workload feature is available for only 
Workflow Managers. For example, if a user belongs to a group which has access to this 
menu option but is not a Workflow Manager, this option will not be displayed.

To view case workload information
1. Select Dashboards --> Case Workload.

2. The system opens the Case Workload screen.

The following table lists and describes the fields in th Case Workload screen.

Field Description

Country (Case 
Number)

Displays the name of the country to which the case belongs, with the 
Case Number listed in brackets.

Contact Date Displays the contact date

Description Displays the description of the case

Field Description

Country (Case 
Number)

Displays the name of the country to which the case belongs, with the 
Case Number listed in brackets.

Due On Displays the date when the case is due.

Description Displays a description of the case.

Overdue Action 
Items

Displays the Action items where the action item due date is before 
today's date (system date)

Field Description

Site Enables you to view the Cases part of the site.

Displays the specific Worklist where the user can view the case 
numbers.

Click + to view the next level and expand either the Workflow State or 
Workflow Group.

Workflow State Enables you to view the Workflow State of the Cases part of the site.

Displays the specific Worklist where the user can view the case 
numbers.

Click + to view the next level and expand to User Name.

Click the Header to toggle between Workflow Group or Workflow 
States.
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Workflow Group Displays the Workflow Group of the Cases part of the site.

Displays the specific Worklist where the user can view the case 
numbers.

Click the Header to toggle between Workflow Group or Workflow 
States.

Click + to view the next level and expand to User Name.

Week Forecast Enables the user to view the number of cases projected in the next 5 
days for the current workflow state or group.

If a case is routed to multiple workflow states/groups, it is counted 
multiple times within the Week Forecast.

The Projected Week Forecast is based on the Dynamic Workflow 
calculation for the entire case, as per the configuration settings.

User Name Enables you to view the User Name to whom the cases are assigned.

Displays the specific Worklist where the user can view the case 
numbers.

Click + to view the next level and expand to Priority.

Online Users can view the Online icon and their User Names appear in 
bold.

Priority Enables you to view the Priority of the Cases part of the User.

Click the link to view the specific Worklist where the user can view the 
case numbers.

Due In Enables you to view the Due In of the Cases part of the User.

Displays the specific Worklist where the user can view the case 
numbers.

Due In is based on the Days remaining field, similar to the Worklist | 
New dialog.

# of Cases Enables you to view the Total number of the Cases for the row entity.

Click the link to view the specific Worklist where the user can view the 
case numbers.

Refresh Enables you to only refresh the number and the entities but not the 
entire page.

Enter a value in the text field for Auto-Refresh automatically refresh the 
dialog every N minutes up to a maximum of 99 minutes.

Expand All (+) Enables you to expand all entities across the Summary Tabulation.

Collapse All (|) Enables you to collapse all entities across the Summary Tabulation, 
leaving only the Sites Total.

Print Enables you to print the Load Balancing Dashboard in PDF format.

Export to XLS Enables you to export the Load Balancing Dashboard in Excel format.

Field Description
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14Utilities

This chapter discusses the different utility functions to help you view, change, or 
retrieve case-related information.

14.1 Utilities
To access the Utilities menu, place the cursor over the Utilities menu bar to view the 
available options.The following utilities are available to you.

■ Change Password

■ MedDRA Browser

■ User Login List

■ Logs

■ ICSR

■ Case Undelete

■ Batch Reports

■ End of Study

■ Clear Cache

■ Advanced Condition Library

14.1.1 Change Password
The Change Password functionality allows users to change the password that they use 
to login to Argus. When you log on to the system for the first time, change the 
password that has been assigned to you.
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To change your password
1. Select Change Password from the Utilities menu.

2. When the system opens the Change Password dialog box:

■ Enter your current password in the Old Password field.

■ Enter your new password in the New Password field.

■ Re-enter your new password in the Confirm Password field to verify it.

■ Click OK to change your password,

3. Your password has been changed.

Be aware of the following:

■ If the system has difficulty confirming the password, it presents the Password 
Confirmation Failure dialog box.

■ You cannot re-enter the password you are currently using when the system 
prompts you to change your password.

■ When you update your password, the system displays the system date and time.

14.1.2 MedDRA Browser
Use the Medical Dictionary for Regulatory Activities (MedDRA) to encode diseases, 
symptoms, signs, and so forth. In Argus Safety, the usage of such a dictionary provides 
consistency to the assignment of terms for adverse events.

Note: LDAP users cannot change their passwords.
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1. Select Utilities --> MedDRA Browser.

2. The system opens the MedDRA Browser screen.

14.1.3 User Login List
The User Login List displays a list of all the current users and their security levels. It 
also displays a list of all the currently logged in users. The following is an illustration 
of the User Login List.

To view the User Login List
1. Select Utilities --> User Login List.

2. The system opens the User Login List screen.

14.1.3.1 General Usage Information
When using the User Log List, be aware of the following:

■ You can click a column heading to sort the displayed records.

■ By default, the system displays the User Login List in ascending order based on 
Login Time.



Utilities

Utilities 14-4

The following table lists and describes the fields on the User Login List.

■ You can configure the number of cases to display from the Page Size drop-down 
list in the User Login List dialog box. The Page Size drop-down list contains the 
following values:

■ 50

■ 100 (default)

■ 250

■ 500

■ 1000

■ 2000

■ The system displays the number of cases currently in view and automatically 
updates the range as defined by the Page Size drop-down list. For example, if the 
user selects 100, the system separates the rows to display into groups of 100 cases.

■ You can go directly to a range of cases by selecting a range from the Displaying 
Rows drop-down list.

■ You can scroll through the User Login List search results in page-by-page 
increments.

■ You can select multiple users or click the All users check box in the header.

■ When you select a user and click Reset User, the system resets all the selected 
users in the list.

Field Description

Full Name Displays the full name of the user.

Login Time Displays the login time.

Workflow Manager Displays whether the user is a workflow manager or not.

OS User Name Displays the Operating System user name.

Terminal Displays the name of the terminal.

Reset User Allows you to reset all the users selected in the list.

Print List Allows you to print the user login list.
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■ The system does not permit you to reset your login.

14.1.4 Logs
Logs are a repository of all the cases in the database, displaying the Activity, Audit 
Data, User ID, and Date/Time entries. Three (3) types of logs are available in Argus:

■ View Audit Log

■ LAM Audit Log

■ View Error Log

To view a log
1. Select Utilities --> Logs --> <Log Type> to view a log.

2. The system open the selected log type.

14.1.5 View Audit Log
The audit log is a chart that show modifications that have been made to a particular 
case since the case's inception.

It also shows which user made the changes, the date and time the changes were made, 
and the old and new field values. Run the AG Service Audit Log update to audit log 
all the cases.

To view an Audit Log
1. Select Utilities --> Logs --> View Audit Log.

2. The system opens the Audit Log screen.

14.1.5.1 Search Conditions Section
The Search Conditions section enables you to enter information about the logs you 
want to view.

The following table lists and describes the fields in the Search Conditions section.

Field Description

Category Select the category for the search criterion.

Tip: You can also search for Advanced Conditions in this Application 
release.

The system enables you to Select All to view all updates performed by a 
user. You can select a category and filter on a specific field elements, and 
you can view all revisions at the same time by clicking the checkbox near 
the Revisions column.

Case Number Enables you to search for logs for a specific case number

Date Range Select the date range from the given drop-down list. This selection 
automatically populates the From and To fields.

From Enter the initial date of the time period to be searched.

To Enter the end date of the time period to be searched.

User Name Select the User Name for the search.

Search button Displays the results of the specified search criteria.
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14.1.5.2 Total Number of Rows Section
The system displays the search results in the Total Number of Rows section.

The following table lists and describes the fields in the Total Number of Rows section.

14.1.5.3 Audit Log Details Screen
The Audit Log functionality tracks all central coding activities for the code-able event 
and products.

Audit log for the case has the record of the central coding related changes. These 
changes display the Username as the associated Central Coding Username 
concatenated with Central Coding.

Multiple selections can be made to view the details of revisions.

To view the Audit Log Details screen
1. Click the Action icon to view the Audit Log Details screen.

2. 2. Click a row displaying a revision to display the details in the upper portion of 
the screen.

The following table describes the fields in the Audit Log Details screen.

Field Description

Action Displays the Audit Log Details screen

Activity Displays the status of the activity. Displays whether it has changed or 
not.

Audit Data Displays the audit data in the following format:

Name of the entity (such as Advanced Condition): deleted or changed 
(as applicable) in entity (such as Advanced Condition)

User Displays the last user who made changes to the case.

Date/Time Displays the last time the case was changed.

Note: The time displayed is as per GMT.

Print List button Prints the list of all the logs.

Field Description

Total Number of 
Rows

Displays the total number of rows in the list.

Parent Displays the parent screen where the change has been made.

Field Displays the field where the change has been made.

Old Value Displays the previous value.

New Value Displays the new, changed value.

Rev Displays the revision number. The list is sorted in descending order of 
the revisions that have been made so the latest revision is displayed at 
the top.

User Name Displays the name of the last user who made a change.

Revisions Date Displays the last date when the change was made.

User Displays the name of the user who last made the revision.
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14.1.6 LAM Audit Log
The LAM Audit Log enables you to track changes made while using the LAM module.

To view the LAM Audit Log
1. Select Utilities --> Logs --> LAM Audit Log.

2. The system opens the LAM Audit Log screen.

14.1.6.1 General Usage Information
■ When using the Argus Safety Audit Log, be aware of the following:

■ In the Argus Audit Log Options, Category has an <ALL> option that enables 
viewing of all updates made by a user.

■ If you select All, you must select the appropriate User Name from the drop-down 
to enable the Search button. The system updates the default User Name to the 
name of the user who is logged in.

■ The system identifies the category on the UI.

■ The print list displays the Category.

■ The system updates the element field label based on the category selected by the 
user. If you do not enter an element value, the system returns the audit details as is 
does in the current system.

■ You can view All revisions at the same time by selecting the check box near the 
revisions column. This system displays the entire audit trail for the elements.

14.1.6.1.1 Using the Argus Affiliate Audit Log  When using the Argus Affiliate Audit Log 
be aware of the following:

■ You can filter for a specific Affiliate event in the audit log.

■ You can view all revisions at the same time by selecting the check box near the 
revisions column. The system displays the entire Audit trail for the elements.

■ You can view all LAM user updates made for Argus Safety cases under the LAM 
Audit Trial. For example, the action Items which can be closed or local labeling 
performed by a Affiliate user is visible under the LAM audit trail.

■ Central User updates do not display under the LAM audit trail.

■ Any user who has access to LAM Audit Log can view All cases associated with 
that site.

■ The audit trail detail print includes only the revisions the selected by the user.

14.1.6.1.2 Search Conditions  The Search Conditions section enables you to enter 
information for retrieving the audit logs you want to view.

The following table lists and describes the fields in the Search Conditions sections.

Field Description

Local Event Number Enter the appropriate local event number.

From Enter the initial date of the time period to be searched.

To Enter the end date of the time period to be searched.

Search button Displays the results of the specified search criteria.
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14.1.6.1.3 Total Number of Rows  The system puts the search results in the Total Number 
of Rows section.

The following table lists and describes the fields in this section.

14.1.6.1.4 Audit Log Details  The Audit Log functionality tracks all central coding 
activities for the code-able event and products.

Audit log for the case has the record of the central coding related changes. These 
changes display the Username as the associated Central Coding Username 
concatenated with Central Coding.

Multiple selections can be made to view the details of revisions.

To view the Audit Log Details screen
1. Click the Action icon to view the Audit Log Details screen.

2. Click a row displaying a revision to display the details in the upper portion of the 
screen.

The following table describes the fields in the Audit Log Details screen.

Field Description

Action Displays the Audit Log Details screen.

Activity Displays the status of the activity. Displays whether it has changed or 
has been added.

Audit Data Displays the audit data.

Category Displays the category data.

User Displays the last user who made changes to the case.

Date/Time Displays the last time the case was changed.

Note: The time displayed is as per GMT.

Print List button Prints the list of all the logs.

Field Description

Total Number of 
Rows

Displays the total number of rows in the list.

Parent Displays the parent screen where the change has been made.

Field Displays the field where the change has been made.

Old Value Displays the previous value.

New Value Displays the new, changed value.

Rev Displays the revision number. The list is sorted in descending order of 
the revisions that have been made so the latest revision is displayed at 
the top.

User Name Displays the name of the last user who made a change.

Revisions Date Displays the last date when the change was made.

User Displays the name of the user who last made the revision.
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14.1.7 Error Log
The Error Log screen provides information about errors that occurred during case 
processing.

To view the error log
1. Select Utilities --> Logs --> View Error Log.

2. The system opens the Error Log screen.

3. In the Search Conditions section, enter or select a date range and click Search.

4. The system displays the search results in the Total Number of Rows section.

5. Locate the error log you want to view and click to view the error message text.

14.1.7.1 Search Conditions Section
The Search Conditions section enables you to search for error logs based on 
pre-defined or custom date ranges.

The following table lists and describes the fields in the Search Conditions section.

14.1.7.2 Total Number of Rows Section
Total Number of Rows

The system retrieves the error logs for the specified date range and places the results in 
the Total Number of Rows section.

The following table lists and describes the fields in the Total Number of Rows section.

Field Description

Date Range Select the date range from the given drop-down list. This selection 
automatically populates the From and To fields.

From Enter the initial date of the time period to be searched.

To Enter the end date of the time period to be searched.

Search button Displays the results of the specified search criteria.

Field Description

Total Number of 
Rows

Displays the total number of rows in the list.

Argus User Name Displays the Argus User Name of the user who got the error.

OS User Name Displays the OS User Name of the user who got the error.

Error Date Displays the date and time of the error.

Application Displays the name of the application where the error occurred.

Terminal Displays the name of the terminal where the error occurred.

Machine Displays the name of the machine where the error occurred.

Error Text Displays the text of the error.

Note: click the Zoom icon to view the complete text.

Print List button Prints the list of all the errors.
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14.1.8 ICSR Tracking Screens
The purpose of the ICSR Transmit Status and ICSR Receive Status screens is to 
monitor the incoming and outgoing messages and acknowledgements. ICSR screens 
are categorized as:

■ ICSR Transmit

■ ICSR Receive Status

To view the ICSR screens
1. Select Utilities -> ICSR -> <ICSR Category>.

2. The system opens the appropriate ICSR screen.

14.1.8.1 ICSR Transmit Status Screen
The ICSR Transmit Status screen enables you to track outgoing messages. The 
following is an illustration of the ICSR Transmit Status screen:

To view ICSR transmit status data
1. Select Utilities --> ICSR --> ICSR Transmit Status.

2. When the system opens the ICSR Transmit Status screen:

■ Enter the appropriate search criteria in the Search Reports section.

■ Click Search to display the search results in the Total Number of Rows 
section.

14.1.8.1.1 Search Reports  The Search Reports section enables you to enter information 
for retrieving transmission information.

The following table lists and describes the fields in the Search Reports section.

14.1.8.1.2 Total Number of Rows  The system displays the search results in the Total 
Number of Rows section.

The following table lists and describes the fields in this section.

Field Description

Agency/Trading 
Partner

Select the agency/trading partner as the receiver from this list.

Search button Displays all the ICSR messages and acknowledgments only for the 
specified receiver.

Note: If 'Any' is selected as the Agency, the search results display all 
messages and acknowledgements for all receivers.

Transmit Date Range Select this radio button to specify the date range for all transmissions.

From Enter the initial date of the specified period

To Enter the end date of the specified period.

Message # Range Select this radio button to specify the date range for all messages.

From Enter the initial date of the specified period.

To Enter the end date of the specified period.

Range Select the desired range from the list.

Type Select the desired type from the list.
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14.1.8.1.3 Type Icon Options  Click the Type icon to view these options:

■ Any - Displays all the ICSR messages and acknowledgments

■ MSG - Double-click on MSG to view messages in the ICSR Viewer.

■ ACK - Double-click on ACK to view the acknowledgement.

When you click these options, the system opens the Message Acknowledgement 
screen shown in the following illustration. This screen contains all the safety report 
detail information such as, if the report is loaded or not loaded with error and enables 
you to monitor message acknowledgements.

The following table lists and describes the fields in the Message Acknowledgement 
Status dialog box.

Field Description

Total Number of 
Rows

Displays the total number of rows that displayed in the list, as shown in 
the parenthesis.

Type Allows the user to view the type of entity transmitted.

Click the Details icon to view the attachment as a PDF.

Reports Allows the user to view the number of attachments transmitted.

Trading Partner Allows the user to view the Reporting Destination to which the 
attachment is transmitted.

Control # This field is left blank for attachment transmission only.

Local Msg# Displays the local message number.

Remote Msg# Displays the remote message number.

File Name Allows the user to view the filename transmitted by EDI Gateway.

Transmit to EDI Allows the user to view the date and time when the attachment was 
transmitted to the EDI Gateway.

EDI Tracking ID Allows the user to view the EDI Tracking ID.

EDI Transmit Date Allows the user to view the EDI Transmit Date and Time from the 
gateway.

Transmission Status Allows the user to view the Transmission Status of the attachment file 
transmitted from EDI Gateway such as Failure / Success / Pending.

EDI Receive Receipt Allows the user to view the date and time of the EDI MDN 
Acknowledgement date.

Print button Prints the list.

Field Description

ICSR Message Number Displays the ICSR Message Number.

Acknowledgement Message # Displays the Acknowledgement Message Number.

Acknowledgement Message 
Date

Displays the Acknowledgement Message Date.

ICSR Message Date Displays the ICSR Message Date.

ICSR Message Receiver ID Displays the ICSR Message Receiver ID.

ICSR Message Sender ID Displays the ICSR Message Sender ID.
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14.1.8.2 ICSR Receive Status
The ICSR Receive Status screen enables you to monitor incoming ICSR messages. The 
following is an illustration of the ICSR Receive Status screen:

14.1.8.2.1 Search Reports  The Search Reports section enables you to search for 
received messages.

The following table lists and describes the fields in the Search Reports section.

14.1.8.2.2 Total Number of Rows  The Total Number of Rows section contains the search 
results.

The following table lists and describes the columns:

Transmission Acknowledgement 
Code

Displays the Transmission Acknowledgement Code.

Report Number Displays the Report Number.

Error Message/Comments Displays any error message or comments.

Authority / Company Number Displays the Authority / Company Number.

Other Number Displays the Other Number.

Report Type Displays the type of the Report.

Field Description

Agency/Trading 
Partner

Select the agency/trading partner as the receiver from this list.

Receive Date Range Select this radio button to specify the date range for all transmissions.

From Enter the initial date of the specified period.

To Enter the end date of the specified period.

Range Select a predefined date range from the drop-down list.

Message # Range Select this radio button to specify the date range for all messages.

From Enter the initial date of the specified period.

To Enter the end date of the specified period.

Type Select the desired message type from the list.

Search Initiates the search and displays all the ICSR messages and 
acknowledgments only for the specified receiver.

Note: If 'Any' is selected as the Agency, the search results display all 
messages and acknowledgements for all receivers.

Field Description

Total Number of 
Rows

Displays the total number of rows that displayed in the list, as shown in 
the parenthesis.

Type Displays the Type icon containing options.

Trading Partner Displays the name of the trading partner.

Control # Displays the control number.

Field Description
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14.1.8.2.3 Type Icon Options  Click the Type icon to view these options:

■ Any - Displays all the ICSR messages and acknowledgments

■ MSG - Double-click on MSG to view messages in the ICSR Viewer.

■ ACK - Double-click on ACK to view the acknowledgement.

When you click these options, the system opens the Message Acknowledgement 
screen. This screen contains all the safety report detail information such as, if the 
report is loaded or not loaded with error and enables you to monitor message 
acknowledgements.

The following table lists and describes the fields in the Message Acknowledgement 
Status dialog box.

14.1.9 Case Undelete
The Case Undelete option enables you to restore deleted cases.

To restore deleted cases
1. Select Utilities --> Case Undelete.

Local Msg# Displays the local message number.

Remote Msg# Displays the remote message number.

Total Reports Displays the total number of reports.

Rejected Reports Displays the number of rejected reports.

File Name Displays the file name.

Receive from EDI Displays the messages received from EDI.

Transmission Status Displays the Transmission Status.

Print Enables you to print the list.

Field Description

ICSR Message Number Displays the ICSR Message Number.

Acknowledgement Message # Displays the Acknowledgement Message Number.

Acknowledgement Message 
Date

Displays the Acknowledgement Message Date.

ICSR Message Date Displays the ICSR Message Date.

ICSR Message Receiver ID Displays the ICSR Message Receiver ID.

ICSR Message Sender ID Displays the ICSR Message Sender ID.

Transmission 
Acknowledgement Code

Displays the Transmission Acknowledgement Code.

Report Number Displays the Report Number.

Error Message/Comments Displays any error message or comments.

Authority / Company 
Number

Displays the Authority / Company Number.

Other Number Displays the Other Number.

Report Type Displays the type of the Report.
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2. When the system opens the Undeleted Cases screen, enter the appropriate 
information in the Case Search Criteria fields and click Search.

14.1.9.1 Case Search Criteria Fields and Field Descriptions
The Case Search Criteria enables you to enter information to help you retrieve deleted 
cases.

The following table lists and describes the fields in this section.

1. When the system displays the search results in the Total Number of Rows section:

■ Locate the case you want to restore and click the check box associated with its 
case number.

■ Click Case Undelete.

14.1.9.2 Total Number of Rows Fields and Field Descriptions
The system displays the search results in the Total Number of Rows section on the 
Case Undelete screen.

The following table lists and describes the columns in the Total Number of Rows 
Section

Field Description

Case Number Enables you to enter the number for a specific case.

Date Range Enables you to select a date range from which cases may be selected. 
The selection made from the Date Range drop-down list automatically 
populates the From and To fields.

From Displays the initial date of the search period

To Displays the end date of the search period

Search Click to display the Search results that match the specified search 
criteria

Field Description

Total Number of 
Rows

Displays the total number of rows in the list

Check Box Enables you to select the case to restore.

Case Number Displays the case number of each deleted case.

Initial Receipt Date Displays the initial receipt date of the case.

Product Displays the product category that the belongs to.

Event Displays the event related to the deleted case.

Workflow State Displays the workflow state of the case.

Serious Displays if the deleted case was serious or not.

Deleted By Displays the name of the user who deleted the case.

Deleted Date Displays when the case was deleted.

Justification Displays the justification for deleting the case.

Note: Click the check box corresponding to the case to view the 
justification for its deletion.
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1. When the system opens the Action Justification dialog box:

■ Enter the justification manually in the Please enter a justification for 
performing this action field

OR

Select a preconfigured justification from the Select a standard justification for 
this field drop-down list.

■ Click OK.

14.1.9.3 General Usage Information
When using Case Undelete functions, be aware of the following:

■ You can search for a specific case from the Case Undelete dialog shown in the 
following illustration.

■ If you enter the Case Number to search for a specific case, the following apply:

The system disables the date range fields including From and To.

If you enter an invalid case number, the system displays the following message:

The Case Number entered is not valid. Please enter a correct Case Number and search 
again.

■ You can configure the number of cases to display in the Case Undelete dialog box 
from the Page Size drop-down list.

■ The Page Size drop-down list contains the following values:

– 50

– 100 (default)

– 250

– 500

– 1000

– 2000

■ The system displays the number of cases currently in view and automatically 
updates the range as defined by the Page Size drop-down list. For example, if you 
select 100, the system separates the rows to display into groups of 100 cases.

■ You can go directly to a range of cases by selecting a range from the Displaying 
Rows drop-down list.

■ You can scroll through the Case Undelete search results in page-by-page 
increments as defined in the Page Size drop-down list.

14.1.9.4 Action Justification Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Action Justification dialog box.

Case Undelete Displays the Justification dialog box.

Enables you to restore the selected case number.

Print List Prints the current worklist for reference.

Field Description



Utilities

Utilities 14-16

14.1.10 Batch Reports
The Batch Reports dialog displays a list of those batch reports that have been 
scheduled for generation.

To view a list of batch reports
1. Select Batch Reports from Utilities in the menu bar.

2. The system opens Batch Reports dialog box with a list of batch reports along with 
their report titles and next run dates.

***********************************************************************************************

Field Description

Please enter a justification for 
performing this action

Enter the text that justifies the need to un-delete a 
case.

Select a standard justification for this 
field

Contains standard, pre-configured descriptions of 
justifications for un-deletion.

Spell Check Checks the entered/selected text for any 
grammatical errors.

OK Saves the justification entered/selected for case 
un-deletion.

Cancel Exits out of this dialog without saving any 
justification.



Utilities

Utilities 14-17

To delete a batch report from the list
1. Select the check box corresponding to the batch report to delete.

2. Click Delete.

14.1.11 End of Study Unblinding
When a study is complete, use the End of Study Unblinding (EOSU) Utility to 
unblind all the cases associated with the study at the same time instead of unblinding 
them one by one.

EOSU does not pick a case that is globally or locally unlocked, or pending local or 
global report submission .

To unblind a study
1. Select Utilities --> End of Study.

2. The system opens the End-of-Study-Unblinding dialog box.

***********************************************************************************************

14.1.11.1 End-of-Study-Unblinding Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the End-of-Study-Unblinding 
dialog box.

1. Select the appropriate study from the End-of-Study Unblinding drop-down list.

2. When the system displays the selected information, locate the appropriate study 
and click Select in the End of Study dialog.

Field Description

Display only 
Unbroken cases

Enables the user to view only unbroken cases

End of Study 
Unblinding

Only those studies that are "Eligible for unblinding" (as determined via 
List Maintenance) are displayed in this list. Select a study from this list. 
This populates the list of cases based on the study chosen.

Case ID Displays the ID of each case.

AE Date Displays the Associated Event Date for the case.

Pat ID Displays the Patient ID.

Rand No Displays the Randomization Number of the case.

Drug Received Displays the name of the drug received.

Dosage Displays the Select button to view the Dosage Regimens screen.
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3. When the system opens the Dosage Regimens dialog box, enter the drug dosage 
information as required.

4. Click OK to save the changes, update the cases, and close this dialog.

14.1.12 Clear Cache
This section describes the steps required to clear cache. This action clears the 
previously stored information in the system.

To clear your cache of previously stored information
1. Select Utilities --> Clear Cache.

2. The system clears the cache and displays the following message in the Clear 
Cache dialog box.

14.1.13 Advanced Condition Library
The Advanced Condition Library option enables you to access the advanced 
condition library and do the following:

■ Create a new advanced condition

■ Reassign an advanced condition

■ Set advanced condition permission levels

■ Modify an existing advanced condition

■ Delete an advanced condition

■ Print a list of advanced conditions

To open the Advanced Condition Library
1. Select Utilities --> Advanced Condition Library.

2. The system opens the Advanced Condition Library screen.

For further information about Advanced Conditions, see Advanced Conditions.

Note: For each case that is unblinded by this method, the Blinding 
Status is adjusted to "Broken After Study" if the study type is single or 
double blinded and fills information about the Unblinding Date, 
Study Drug, Follow-up Received Date, Mark case as Significant, and 
Dosage Regimen.
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All the fields on this page are type-ahead fields.

To search for existing query sets or advanced conditions, enter the search criteria and 
click Search.

The following table lists and describes the fields in the Advanced Condition Library.

Field Description

Name The name of the Query Set or Advanced Condition given by the user.

Description A description of the Query Set or Advanced Condition given by the 
user.

Last Modified The date the last modification was made.

Owner The current owner of the Query Set or Advanced Condition.

Shared Displays whether the Query Set or Advanced Condition has been 
shared or not.

Query Set Displays whether the record in the row is a Query Set or not.

SQL Displays a View link that redirects the user to a Qery Set or Advanced 
Condition dialog for the selected record.

HitList Appears only if the selected Query Set or Advanced Condition has a 
HitList. It displays a link displaying the number of hits on the last 
HitList update.
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15Multi-Tenancy

This chapter describes Multi-tenancy and the Global Portlets in Argus Safety that are 
used to manage work across multiple clients in a multi-tenant environment.

15.1 Introduction to Multi-tenancy
Multi-tenancy refers to a principle in software architecture where a single instance of 
the software runs on a server, serving multiple client organizations (tenants).

With a multi-tenant architecture, the software application is designed to virtually 
partition its data and configuration so that each client organization works with a 
customized virtual application instance.

15.1.1 Multi-tenancy in Argus Safety
The Multi-tenancy feature in Argus Safety allows an organization to use a single 
database for multiple clients. For example, Contract Research Organizations (CROs) 
offer a range of global safety and pharmacovigilance services, which span from limited 
case management activities to full clinical trial and post-marketing services.  

The multi-tenancy feature allows multiple pharmaceutical clients of a CRO to reside as 
separate and unique tenants in a single database with their data completely segregated 
and restricted to authorized users. This enables the CRO to achieve standard 
configuration across clients while at the same time provides the ability to a CRO to 
have differentiation in configurations to specific clients as required. It provides the 
ability to a CRO to quickly set up a new client based on existing configuration and 
authorize users to the new client. It provides the ability to CRO users who have access 
across multiple clients to view their work across clients, understand their sum of work 
across clients and make decisions based on the priority.

Argus Safety assists manufacturers of pharmaceuticals and devices by providing a 
simple and efficient way to comply with international and domestic regulatory safety 
reporting requirements.  It also facilitates internal company safety surveillance by 
providing tools for signal detection and for analyzing the overall safety profile of both 
investigational compounds and marketed products.

Contract Research Organizations (CROs) provide services to pharmaceutical and 
device manufacturers, that range from case management activities to clinical trials. The 
multi-tenancy feature allows an organization to provide services to many clients while 
keeping client data isolated.

Multi-tenancy is enabled during the Argus Safety installation. Policies and rules are 
centrally administrated and shared, with the option to personalize for each client.
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15.1.2 Data Segregation
Multi-tenancy allows an organization to use a single database for many clients, which    
reduces the amount of hardware needed for an implementation. Fewer patches and 
dictionary upgrades are required, which decreases the resources necessary to support 
an implementation.  This also allows administrators to use standard configurations, 
such as code lists, workflow steps and user/new client setup.

The entire Argus Safety application and  all of its components and data are partitioned 
by Enterprise ID. The Enterprise ID is a unique identifier for a customer's client and 
contract. The appropriate context of the Enterprise ID selected by the user that the user 
has access to, is set by the system and operates within the partition of this context.

15.1.2.1 Data Segregation by Module 
The following table describes how each module in the Oracle Health Sciences Safety 
suite provides data segregation in a multi-tenant environment.

Note: It is not recommended that you open the Argus Safety 
application for multiple enterprises at the same time. Close the Argus 
Safety application for the previous enterprise before opening  it for the 
next enterprise to avoid data issues. 

It is recommended that you use the Application Access portlet to open 
the Argus Safety application for different enterprises, as it takes care 
of closing the previous enterprise before opening the new one. 

Module Cross Enterprise?
Accessed Via 
Portal? Notes

Global Worklists Yes Yes Displays data from 
across multiple 
enterprises

Global User 
Management 

Yes Yes Displays data from 
across multiple 
enterprises

Global Enterprise 
Management 

Yes Yes Displays data from 
across multiple 
enterprises.

Applications Access Yes Yes Displays Application 
Access options from 
across multiple 
enterprises

Argus Safety No No Displays data for one 
enterprise at a time to 
the logged-in user 
based on the  selected 
enterprise.

Console No No Displays data only 
for the enterprise for 
which Argus Safety 
was opened by the 
user.
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Affiliate No No Displays data for one 
enterprise at a time to 
the logged-in user, 
based on the selected 
enterprise.

EOSU Tool No No Displays data for one 
enterprise at a time to 
the logged-in user, 
based on the selected 
enterprise.

ESM Mapping Utility No No Displays data for one 
enterprise at a time to 
the logged-in user, 
based on the selected 
enterprise.

However, the screens 
related to ESM 
Service 
Configuration 
display data related 
to all the active 
enterprises,  
irrespective of the 
user access rights to 
those enterprises.

ESM Service Yes No ESM Service  process 
data from all the 
enterprises, as it is a 
background service.

ESM Service 
Configuration

Yes No As ESM Service is 
common across all 
the enterprises, hence 
its configuration tool 
is also common.

AG Service Yes No Argus Safety Service  
processes data from 
all the enterprises as 
it is a background 
service.

AG Service 
Configuration Tool

Yes No As AG Service is 
common across all 
the enterprises, hence 
its configuration tool 
is also common.

MedDRA Re-code 
Tool

Yes No Allows the option to 
perform recoding of 
MedDRA terms 
across the 
enterprises.

MedDRA Dictionary 
Load

Yes No Single 
instance/version of 
the loaded MedDRA 
dictionary is 
available for all the 
enterprises.

Module Cross Enterprise?
Accessed Via 
Portal? Notes
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Who Dictionary Load Yes No Single 
instance/version of 
the loaded WHO 
Drug dictionaries (B2 
as well as C formats) 
is available for all the 
enterprises.

MedDRA/WHO Web 
Services

Yes No These web services 
remain common to be 
used across all the 
enterprises. Their 
configuration is 
maintained in a 
common XML file on 
the web server(s).

J Drug Dictionary Yes No Single 
instance/version of 
the loaded J Drug 
dictionary are 
available for all  
enterprises.

Case Intake No No Case Intake messages 
for separate 
enterprises are 
segregated and 
loaded into 
appropriate 
enterprise partitions.

Literature Intake No No Literature Case 
Intake data for 
separate enterprises 
are segregated and 
loaded into 
appropriate 
enterprise partitions.

New Case from 
Image

No No Scanned Image folder 
paths for separate 
enterprises are 
segregated and 
loaded into correct 
enterprise partitions.

PSL No No The PSL interface 
segregates the 
incoming requests for 
each enterprise 
partition.

DLP No No Partitions the case 
revisions by 
enterprises.

TMS Integration No No TMS integration for 
single-pharma 
installations only.

Module Cross Enterprise?
Accessed Via 
Portal? Notes
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15.1.2.2 Data Segregation impact on system level configuration items
Following table specifies some specific system level configuration items which are 
configured through Argus Console. It specifies the impact on these configuration items 
due to data segregation design for multi-tenant installations and also specifies the 
recommendations for customers on these items.

Dossier No No As this module is 
linked to Periodic 
Reports, hence it  
partitions the 
periodic reports data 
by enterprise.

Configuration Item Application Design
Recommendation for 
Customers

Enable/Disable 
MedDRA/WHO Web 
Service Encoding 

System keeps it segregated for each 
enterprise.

However, the underlying web service 
used for MedDRA/WHO is common for 
all the enterprises as their configurations 
are maintained in common XML file on 
the web server(s).

None

Lot Number Web 
Service configuration

System keeps it segregated for each 
enterprise.

As this is related to the 
product, it is recommened 
to keep  specific for each 
enterprise.

Documentum 
Configuration

System keeps it segregated for each 
enterprise.

All parameters except for 
Cabinet Name are expected 
to be maintained as same  
for different enterprises.

Enable/disable 
LDAP 

&

LDAP Server 
configuration

This will be maintained by application 
as common for all enterprises.

None

Enabled Modules The system keeps it segregated for each 
enterprise.

None

Enable/disable SSO 

&

SSO Header 
Configuration

This will be maintained by application 
as common for all enterprises.

None

Argus Insight URL System keeps it segregated for each 
enterprise.

It is expected to be 
maintained same for across 
all enterprises by the 
customer.

Argus Safety Load 
Balancer Server

System keeps it segregated for each 
enterprise.

It is expected to be 
maintained same for across 
all enterprises by the 
customer.

Module Cross Enterprise?
Accessed Via 
Portal? Notes
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15.1.2.3 Dictionaries
All  dictionaries are stored in database schema separately outside Argus Safety and 
Interchange schema. The Argus-supported dictionaries are:

■ MedDRA

■ MedDRA J

■ WHO Drug

■ J Drug

Only one copy of each dictionary version is maintained in the database and is not 
segregated by enterprise. The dictionary version that is applicable for a particular 
enterprise/client is defined in the common profile switches:  Case Form Configuration' 
Auto Encoding, Dictionary & Central Encoding. Since these switches are segregated 
for each Enterprise, these dictionaries can be different versions for different 
enterprises, as required.

J Drug dictionary is not configured through Console common profile switches (Case 
Form Configuration' Auto Encoding, Dictionary & Central Encoding), and is internally 
maintained as single version, therefore, it remains a common J Drug dictionary for all 
enterprises.

15.1.2.3.1 Coding Web Service  

The Case Processing Dictionary Browser common profile switches are segregated by 
enterprises to allow different configurations for different enterprises.

However, the URL and other configuration for WHO Drug and MedDRA web services 
remain in configuration XML on the Web Servers as per existing design and hence 
remain common across all enterprises. 

User Information System keeps it segregated for each 
enterprise.

For multi-tenant 
installations, user attributes 
can be synchronized for all 
the enterprises through 
Global User Management.

However, user attributes 
can also be updated for a 
specific enterprise through 
Console as well.

Default Enterprise System keeps it segregated for each 
enterprise.

This is a new internal 
common profile switch that 
marks an enterprise as the 
Default enterprise. This is 
set during the time of 
install. Default enterprise 
once created during 
database creation is fixed. 
This is required to avoid the 
data synchronization issues 
that may occur for AG 
Service users in different 
enterprises.

SMTP Configuration System keeps it segregated for each 
enterprise.

None

Configuration Item Application Design
Recommendation for 
Customers
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In a multi-tenant installation, if the provider chooses to operate using Coding via web 
service, they should use the same web service across all enterprises.

15.2 Global Worklists
 Global Worklists lets you access work items across enterprises where you have access. 
It  also allows you to filter the worklist to a specific enterprise where you have access. 
When filtered to a specific enterprise, any further operation on the retrieved worklist 
items are restricted to that enterprise.

For unauthorized users, the Global Worklist is not visible and their access remains 
restricted based on portal privileges. The context menu on the Global Worklist 
displays menu items according to rights and permissions of a user in a particular 
enterprise.

The user preferences of each Global Worklist are saved for the user each time the 
Worklist is loaded.

15.2.1 Global Worklist Tabs
■ Worklist New: displays the list of new cases across all the enterprises or a specific 

enterprise, that the user has access, as well as cases assigned to user/ group but 
not yet accepted. 

■ Worklist Open: displays the list of new cases across all the enterprises or a specific 
enterprise, that the user has access, as well as cases assigned to user/ group but 
not yet accepted.

■ Worklist Contacts: Display the list of pending letters and allows you to generate 
the letters.

■ Worklist Action Items: Allows the owner of the action item and workflow 
managers to view and/or close the selected action item.

15.2.1.1 Link to Argus Safety

■ Case number - hyperlink on the case number  allows you to open the case in the 
Argus Safety application, with context set to the enterprise that the case belongs 
to.

■ Enterprise -  hyperlink on the Enterprise Short Name allows you to open  
Worklist-Open in the Argus Safety application, with context set to the enterprise 
that the case belongs to. The Worklist opens  with preferences configured for you 
in that enterprise.

15.2.2 Case Actions
■ Open Read-only - opens the case in read-only mode in the Argus Safety 

application, with context set to the enterprise that the case belongs to.

■ Accept Case - accepts the case and assigns your user name as responsible for that 
case



Global Worklists

Multi-Tenancy 15-8

■ Adjust Priority -  modifies the priority level of the case

■ Adjust Assignment - modifies the user assigned to the case, limited by your access 
to the enterprise and the case

■ Adjust Case Owner - modifies the owner of the case, limited by the your access to 
the enterprise and the case

■ Close Case -  closes the case after entering the Case Closure details

■ Coding Review - opens the exiting Argus Safety Coding Review screen as a dialog 
and supports all  existing actions within this dialog

■ Medical Review - opens the  Argus Safety Medical Review screen as a dialog and  
supports all the existing actions within this dialog

■ Print/Print List - prints the current Worklist

15.2.3 Search Case
The list of cases displayed in the worklist include active enterprises where you have 
access. Your view is restricted to the search criteria result set, entered into the Value 
search field. You may filter the content of this worklist to a specific enterprise. When 
there is no filtering applied, all cases across enterprises are displayed.

 Filter 
You can filter your search by the following:

■ Case Number

■ Workflow State

■ Product

■ Event Preferred Term

■ Event as reported

■ Case Report Type

■ Product Group

Note: Multiple case actions are not supported, such as:  Close 
Multiple Cases, Route Multiple Cases, Print Multiple Cases and 
Assign Multiple Cases
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Value
Once you have selected an item to filter by, the Value field loads the corresponding 
choices. For example, select Product and the list of Products loads into the Value field.  
You can also type into the field to search the list. 

Only view locked Cases requiring Follow-up
Select the Only view locked Cases requiring Follow-up option to limit your search to 
these types of cases. 

15.2.3.1 View Options

Your view options for Worklist New are Individual,  Group or All.  Individual is the 
default selection. 

■ Select  Group to list all cases across authorized enterprises, which are assigned to 
any other member of groups that you are a member of and that have not yet been 
accepted by the assigned user.

■ Select  All  to view every open case across all user groups and  enterprises (or 
specific enterprises) where you have access.  

15.2.3.1.1 List Actions  

■ Sorting - sort by any list header

■ Pagination - select page size and number of displaying rows.  

15.2.4 Global Enterprise Management
From the Global Enterprise Management tab, you can:

■ Add a new enterprise

■ Define new enterprise attributes 

■ Copy configuration from an existing enterprise 

Note: Items that are unavailable will not appear in the filter list. 
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■ Associate users to the new enterprise

15.2.5 Add New Enterprise

1. Click Add New Enterprise.

2. Enter information about your Enterprise. Enterprise Name and Enterprise Short 
Name are required fields. 

3. Click Next.

4. Select an Enterprise to use as a template for your new Enterprise from Copy 
Configuration Data Source. You can makes changes to the configuration once the 
enterprise has been set up. 

5. Click Setup.

6. Click Finish.

15.2.6 Global User Management
Global User Management is intended to configure users across multiple enterprises. 
When user configuration changes need to affect only a specific enterprise, it needs to 
be done from the Argus Safety Console: User Management screen for that enterprise.  
Your access is restricted depending on  your access to this Portlet at the Portal server 
level.

This release allows local users (Argus J user in this release) to locally lock a case for 
which local Japan data entry/assessment is complete, triggering the scheduling 
and/or generation of the applicable local reports. The system has also been enhanced 
to allow a local user to locally unlock the case after a local lock is done and modify 
local data.

A new checkbox called Allow Local Locking has been provided under Argus Console 
> Access Management > Users to allow a local user to be set up with the privilege to 
locally lock or unlock a case. By default, the checkbox is unchecked.

See the Oracle Argus Safety Administrator Guide for more information. 

Browser
The browser displays a left hand pane that lists the existing users (distinct users based 
on Login User ID) in the system, in a tree view. The tree displays users from the 
enterprise partitions for which the user has access.
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15.2.6.1 Associate Enterprise 
Associates existing users in one enterprise to other enterprises.

1. Select an enterprise from Copy User Attributes From. The enterprise selected  is  
used to set the attribute values for the user in the new enterprise to which the user 
is being associated. The attribute values for the already associated enterprises 
remain the same.

2. Add an Available Enterprise or Add All available enterprises.

3. Select Save. 
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During Save, all the user attributes are copied from the Enterprise selected in the Copy 
User Attributes From to all the newly associated Enterprises.

15.2.6.1.1 Print  

Click Print and select Current User or All Users. Based on the selection, you can  print 
the User details of the current User or all Users.

15.2.6.2 Synchronizable User Attributes 
The purpose of the Synchronizable User Attibutes section is to allow you to apply 
updates to user attributes displayed in this section, and keep them in sync across all 
enterprises.  

The users that are listed to be administered in this screen are restricted by the 
following rules:

1. Admin, System users and the users for which the Service User is checked in 
Console are not listed.

2. Only the users from the enterprises for which you have access to the Console User 
management screen, i.e. you should have access to all of the following in those 
enterprises:

■ Console User Management screen ' Application Access field ' Console checkbox is 
checked.



Global Worklists

Multi-Tenancy 15-13

■ Console Group Management screen ' Menus section ' Console, Access 
Management and User radio options are set to enabled at least for one user group 
in the respective enterprise partition. 

■ Is not marked as "Account Disabled"

When you select the Synchronize User Attributes tab, the right hand pane displays a 
list of enterprises to which the user being administered belongs to. The right hand 
pane displays a list of Synchronizable user attributes in a grid.
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15.2.6.3 Configure Synchronizable Attributes

Configure Synchronizable Attributes appears in the bottom of the left hand pane of 
the Global User Management Portlet. Configure Synchronizable Attributes allows the 
Portlet user to configure a list of user attributes as synchronizable fields. When 
configured, these user attributes appear in the "Synchronize User Attributes" section. 

When selected, the user attribute value specified in the Synchronized Value column is  
applied across  enterprises. If unselected, the user attribute is not saved. Selecting the 
header of this column selects  all the attributes listed.

The following user attributes are available for the Portlet user to add or remove from 
the Synchronizable Attributes list in the following order which is in sync with the 
ordering of these fields on Console ' User Management screen.

These user attributes are available as out-of-the-box Synchronizable fields listed below:

■ User Name

■ Email Address

■ Enable LDAP Login

■ LDAP Server Alias

■ Application Access

■ Default Application

■ Account disabled

■ User Roles

■ Allow unblinding of cases

■ Protect from unblinded information

■ Protect from printing unblinded information

■ Allow locking of cases

■ Allow Local Locking

■ Enable Local Unlocking

■ Allow closing of cases

■ Allow Forced unlock (Global and Local)

■ Allow Global Unlock on Pending Local Lock

■ Route on close case

■ Enable Checklist on Route

Any changes to these  fields are applied across all the enterprises for which you are 
restricted to based on the above points.

Note: If you make changes to the data on one of these tabs and 
attempts to move away from this current tab without saving the 
changes, then the warning message "You have made changes to the 
existing item, if you press OK, changes will be lost." dispalys. Click 
OK to ignore changes. Click Cancel to stay on the current tab.
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15.2.6.4 Modifying User Attributes

The value of the Synchronizable fields can be modified for a specific enterprise using  
Argus Console>User Management>Access Management so that these attributes can 
be different for that enterprise as compared other enterprises.

If User Name and Email address fields are updated in Argus Safety Console for a user 
which belongs to multiple enterprises, an error displays.

15.2.7 Application Access
Applications Access allows you to launch  Argus Applications for any enterprise 
where you have access.

It is not recommended that you open the Argus Safety application for multiple 
enterprises at the same time. Close the Argus Safety application for the previous 
enterprise before opening  it for the next enterprise to avoid data issues. 

It is recommended that you use the Application Access portlet to open the Argus 
Safety application for different enterprises, as it takes care of closing the previous 
enterprise before opening the new one. 

15.2.7.1 Enterprise
Select Enterprise to display a list of active Enterprises to which you have access  and is 
not marked as Account Disabled.  The list is alphabetically sorted by Enterprise Short 
Names. This first Enterprise in your list  is selected by default.

15.2.7.2 Application
Application lists the Argus appications that you can launch from the Application 
Access tab.  Application lists  only  those options, which are enabled in the selected 
enterprise in Argus Safety Console>User Management>Application Access. 

■ Argus Safety - Opens the Argus Safety application homepage with the context set 
to the selected Enterprise. 

Tip: Maintain administrative users with these privileges for all 
enterprises in the system, in-order to apply the updates to these fields 
across all the enterprises. This prevents some enterprises from  
becoming out-of-sync for some users for these attributes.

Tip: For an Affiliate user, this opens as Argus Affiliate application 
for the selected enterprise. This action will not open the Insight 
application, even if it is configured as the Default Application in 
Argus Console.
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■ Argus Safety Case Book-In - Opens the Case Book-in screen within the Argus 
Safety application, with the context set to the selected enterprise.  This action   
does not launch the Argus Insight application, even if your Default Application in 
Argus Safety Console.

Argus Safety allows new Case Book-In to be done aided by an image file where an 
image file can be selected from a pre-defined folder and allows you to fill-in the 
case book-in parameters manually using the details available on the image file. 

In multi-tenant installations, the common profile switch defined as Case 
Processing - Default Network directory for scanned images is partitioned by 
enterprise/client, allowing you to define separate image folders to accept 
company-specific image files for New Case from Image functionality.

Tip: For an Affiliate user, this opens the New LAM Event Entry 
screen within Argus Affiliate application for the selected Enterprise.

Note: Argus Safety, Argus Affiliate, Argus Safety Case Book-in and 
Argus Affiliate Event Entry options only display if the user has access 
to these modules and have User Group menu level access to these 
screens in the respective enterprises. 

Open each of the applications - Argus Safety and Insight in separate 
windows independent of each other. However, if you attempt to open 
the same application again for same/different enterprise, then it opens 
in the same window in which that application is already opened.
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